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Using This Online Manual

Symbols Used in This Document
Touch-enabled Device Users (Windows)

Symbols Used in This Document

Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

Note
Instructions including notes for operation and additional explanations.

Basics

Instructions explaining basic operations of your product.

Note
• Icons may vary depending on your product.

Touch-enabled Device Users (Windows)
For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

• Microsoft is a registered trademark of Microsoft Corporation.
• Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.
• Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad,

iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other countries.
• IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under

license.
• Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Play, Google Drive,

Google Apps and Google Analytics are either registered trademarks or trademarks of Google Inc.
• Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB

(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

• Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.
• Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its

subsidiaries and/or affiliates in the USA and/or other countries.

Note
• The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License

23



Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for
the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
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copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;

and
3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,

patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
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limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.
END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California

All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
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* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright c 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
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This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----

Copyright (c) 2003-2012, Sparta, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com

Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
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IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----

Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: ScienceLogic, LLC copyright notice (BSD) -----

Copyright (c) 2009, ScienceLogic, LLC

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of ScienceLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
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CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

LEADTOOLS

Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

-----------------------------------------------------------

Copyright 1990-2009 Adobe Systems Incorporated.
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names
of its contributors may be used to endorse or promote
products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-----------------------------------------------------------

MIT License
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Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University

Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.

COPYRIGHT (c) 1989-2000.

On-Line Applications Research Corporation (OAR).

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.
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(1) Red Hat Incorporated

Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it will
be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley

Copyright (c) 1981-2000 The Regents of the University of California.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

----------------------------

2006-Jan-27

Copyright 1996-2002, 2006 by

David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

============

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.
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This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which all
encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
(`as is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(`royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. (`credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The
FreeType Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

"""

Portions of this software are copyright © <year> The FreeType

Project (www.freetype.org). All rights reserved.

"""

Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

===========

0. Definitions

--------------

Throughout this license, the terms `package', `FreeType Project', and `FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
`FreeType Project', be they named as alpha, beta or final release.

`You' refers to the licensee, or person using the project, where `using' is a generic term including
compiling the project's source code as well as linking it to form a `program' or `executable'.

This program is referred to as `a program using the FreeType engine'.

This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.
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1. No Warranty

--------------

THE FREETYPE PROJECT IS PROVIDED `AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

-----------------

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (`FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

--------------

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: `FreeType Project', `FreeType Engine', `FreeType library',
or `FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts

-----------

There are two mailing lists related to FreeType:

o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.
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If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.

Our home page can be found at

http://www.freetype.org

--- end of FTL.TXT ---

The following applies only to products supporting Wi-Fi.

(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.
* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS,"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Connecting Device to Printer Directly via Wireless LAN (Direct
Connection)

The printer supports "wireless direct" in which you can connect to the printer wirelessly from devices (e.g.
smartphone, or tablet) without a wireless router.

Switch to "wireless direct" to print wirelessly.

Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct Connection)
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Available Connection Methods

The following connection methods are available on the printer.

Wireless Connection

• With a wireless router

• Without a wireless router

Wired Connection

USB Connection
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Wireless Connection
There are two methods for connecting the printer to your device (e.g. smartphone or tablet). One method
is to connect using a wireless router, and the other method is to connect without using a wireless router.

The two connection methods cannot be used at the same time.

If you have a wireless router, we recommend you use the method described in Connection Using a
Wireless Router.

When connecting another device while a device is already connected to the printer, connect it using the
same connection method as the connected device.

If you connect using a different connection method, the connection to the device in use will be disabled.

• Connection Using a Wireless Router

◦ Connect the printer and a device using a wireless router.
◦ Connection methods vary depending on the wireless router type.
◦ You can change network settings such as the SSID and security protocol on the printer.

◦ When the connection between a device and a wireless router is completed and  (Wi-Fi icon) is
displayed in the device's screen, you can connect the device to the printer using the wireless
router.
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• Connection without Using a Wireless Router

◦ Connect the printer and a device without using a wireless router. Connect the device and the
printer directly using the printer's wireless direct.

◦ If you connect a device connected to the Internet via a wireless router to the printer that is in the
wireless direct, the connection between the device and wireless router will be disabled. In that
case, the connection of the device may switch to a mobile data connection automatically
depending on your device. Transmission fees for connecting to the Internet using a mobile data
connection apply.

◦ In the wireless direct, you can connect up to five devices at the same time. If you try to connect
another device while five devices are already connected, disconnect a device you do not use and
configure settings again.

◦ Network settings such as the SSID and security protocol are specified automatically.

Wired Connection
Connect the printer and a hub or router with an Ethernet cable. Prepare an Ethernet cable.

USB Connection
Connect the printer and a computer with a USB cable. Prepare a USB cable.

• Restrictions

(Appears in a new window)
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Handling and Use of Paper

Paper

Types of Paper

Paper Sizes

Using Paper Other Than Genuine Paper and feed confirmed Paper

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using
Existing Settings

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by
Adding a Media Type

Paper Information List

Updating paper information

Handling rolls

Loading Rolls on the Roll Holder

Loading the Upper Roll on the Printer

Loading the Lower Roll on the Roll Unit (Option)

Changing the Type of Paper

Specifying the Paper Length

Removing the Upper Roll from the Printer

Removing the Lower Roll from the Roll Unit (Option)

Removing Rolls From the Roll Holder

Clearing Jammed Roll Paper

Feeding Roll Paper Manually

Keeping Track of the Amount of Roll Paper Left

Specifying the Ink Drying Time for Rolls

Specifying the Cutting Method for Rolls

Cutting the Leading Edge of Roll Paper Automatically

Reducing Dust from Cutting Rolls

Automatically Switch Rolls
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Handling sheets

Loading Sheets in the Printer

Changing the Type of Paper

Printing From a Desired Starting Point

Removing Sheets

Clearing a Jammed Sheet

Stacker

Parts of the Stacker

Using the Stacker

Example Stacker Configurations

Basket

Parts of the Basket

Using the Basket

Example Basket Configurations

Storing the Basket

Roll Unit

Parts of the Roll Unit

Roll Unit

Switching Roll Unit Modes

Using the Roll Unit In Take-Up Mode

Removing Printed Paper from the Roll Unit

Media Configuration Tool Guide
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Paper

Types of Paper

Paper Sizes

Using Paper Other Than Genuine Paper and feed confirmed Paper

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using
Existing Settings

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by
Adding a Media Type

Paper Information List

Updating paper information
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Types of Paper

The following media types are supported by the printer. For details on the media types supported by the
printer, see "Paper Information List."

• Plain Paper

• Coated Paper

• Photo Paper

• Glossy Paper

• Proofing Paper

• CAD-dedicated Paper Etc.

The Paper Information List includes the following information.

• Types of paper

• Paper handling

• Paper product specifications

• Use precautions

• Setting of printer driver, control panel etc.

Note
• For instructions on using paper not included in the Paper Information List, see "Using Paper Other Than

Genuine Paper and feed confirmed Paper."

• Method of Updating Supported Paper

Paper that is supported by the printer may be newly released on the Canon website.

To use newly released paper, register the latest paper information on the printer with the Media
Configuration Tool. (See "Updating paper information.")

Important
• Even if you are not using the printer driver, you should install the Media Configuration Tool in order

to register the media types for your region in the printer.

(See "Media Configuration Tool Guide" (Windows).)

(See "Media Configuration Tool Guide" (macOS).)
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Paper Sizes

Rolls
Rolls that meet the following conditions are supported.

• Outer diameter is 6.7 inches (170 mm) or less

• Inner diameter of paper core: 2 or 3 inches

• Printing side out

Roll Width Printer Driver Roll Paper Width Settings Borderless Printing (*1)

24.00 inches (609.6 mm) 24 in Roll (609.6mm) Recommended(*2)

23.62 inches (600.0 mm) 600mm Roll (600.0mm) Possible(*3)

23.39 inches (594.0 mm) A1/A2 Roll (594.0mm) Recommended(*2)

20.28 inches (515.0 mm) B2/B3 Roll (515.0mm) Recommended(*2)

20.00 inches (508.0 mm) 20 in Roll (508.0mm) Possible(*3)

19.69 inches (500.0 mm) 500mm Roll (500.0mm) Possible(*3)

17.00 inches (431.8 mm) 17 in Roll (431.8mm) Recommended(*2)

16.54 inches (420.0 mm) A2/A3 Roll (420.0mm) Possible(*3)

16.00 inches (406.4 mm) 16 in Roll (406.4mm) Possible(*3)

14.00 inches (355.6 mm) 14 in Roll (355.6mm) Recommended(*2)

12.95 inches (329.0 mm) A3+ Roll (329.0mm) Possible(*3)

12.00 inches (304.8 mm) 12 in Roll (304.8mm) Possible(*3)

11.81 inches (300.0 mm) 300mm Roll (300.0mm) Possible(*3)

11.69 inches (297.0 mm) A3/A4 Roll (297.0mm) Possible(*3)

10.12 inches (257.0 mm) B4 Roll (257.0mm) Possible(*3)

10.00 inches (254.0 mm) 10 in Roll (254.0mm) Recommended(*2)

8.00 inches (203.2 mm) 8 in Roll (203.2mm) Possible(*3)

*1:For details on media types that can be used for borderless printing, see "Paper Information List."
*2:When you perform borderless printing, it is recommended that you use these widths.
*3:As opposed to standard borderless printing, there will be a small margin on the left and right because
the paper width is set a little bit smaller than the width of the document.

Sheets
Sheets of the following sizes are supported.
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Paper Sizes Dimensions

A1 23.39 x 33.11 inches (594.0 x 841.0 mm)

A2 16.54 x 23.39 inches (420.0 x 594.0 mm)

A2+ 17.00 x 24.00 inches (431.8 x 609.6 mm)

A3 11.69 x 16.54 inches (297.0 x 420.0 mm)

A3+ 12.95 x 19.02 inches (329.0 x 483.0 mm)

A4 8.27 x 11.69 inches (210.0 x 297.0 mm)

ISO B2 19.69 x 27.83 inches (500.0 x 707.0 mm)

ISO B3 13.90 x 19.69 inches (353.0 x 500.0 mm)

ISO B4 9.84 x 13.90 inches (250.0 x 353.0 mm)

JIS B2 20.28 x 28.66 inches (515.0 x 728.0 mm)

JIS B3 14.33 x 20.28 inches (364.0 x 515.0 mm)

JIS B4 10.12 x 14.33 inches (257.0 x 364.0 mm)

22"x34" (ANSI D) 22.00 x 34.00 inches (558.8 x 863.6 mm)

17"x22" (ANSI C) 17.00 x 22.00 inches (431.8 x 558.8 mm)

11"x17" (Ledger) 11.00 x 17.00 inches (279.4 x 431.8 mm)

13"x19" (Super B) 13.00 x 19.00 inches (330.2 x 482.6 mm)

Letter (8.5"x11") 8.50 x 11.00 inches (215.9 x 279.4 mm)

Legal (8.5"x14") 8.50 x 14.00 inches (215.9 x 355.6 mm)

24"x36" (ARCH D) 24.00 x 36.00 inches (609.6 x 914.4 mm)

18"x24" (ARCH C) 18.00 x 24.00 inches (457.2 x 609.6 mm)

12"x18" (ARCH B) 12.00 x 18.00 inches (304.8 x 457.2 mm)

9"x12" (ARCH A) 9.00 x 12.00 inches (228.6 x 304.8 mm)

DIN C2 18.03 x 25.51 inches (458.0 x 648.0 mm)

DIN C3 12.76 x 18.03 inches (324.0 x 458.0 mm)

DIN C4 9.02 x 12.76 inches (229.0 x 324.0 mm)

20"x24" 20.00 x 24.00 inches (508.0 x 609.6 mm)

18"x22" 18.00 x 22.00 inches (457.2 x 558.8 mm)

14"x17" 14.00 x 17.00 inches (355.6 x 431.8 mm)
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Paper Sizes Dimensions

12"x16" 12.00 x 16.00 inches (304.8 x 406.4 mm)

10"x12" 10.00 x 12.00 inches (254.0 x 304.8 mm)

10"x15" 10.00 x 15.00 inches (254.0 x 381.0 mm)

8"x10" 8.00 x 10.00 inches (203.2 x 254.0 mm)

US Photo 16"x20" 16.00 x 20.00 inches (406.4 x 508.0 mm)

Poster 20"x30" 20.00 x 30.00 inches (508.0 x 762.0 mm)

13"x22" 12.95 x 21.97 inches (329.0 x 558.0 mm)

Poster 300x900mm 11.81 x 35.43 inches (300.0 x 900.0 mm)

Custom Paper Size 8.00 x 8.00 inches (203.2 × 203.2 mm) to 24.02 x 70.87 inches (610.0 ×
1800.0 mm)

Note
• For details on non-standard sizes, see "Setting Paper Dimensions (Custom Size)" (Windows) or

"Setting Paper Dimensions (Custom Size)" (macOS).

• Borderless printing is not supported on sheets.
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Using Paper Other Than Genuine Paper and feed confirmed Paper

When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use
paper that meets the following conditions.

Note
• For Canon genuine paper/feed confirmed paper, see "Paper Information List."

• Paper where the size is described in "Paper Sizes"  (See "Paper Sizes.")

• Paper where the thickness is described in "Paper Thickness" in "Specifications"  (See "Specifications.")

• Paper where bleeding and ink overflow does not occur when printing

• Paper that does not warp severely when loading the paper or printing

Important
• If you use paper other than Canon genuine paper and feed confirmed paper, Canon provides absolutely

no guarantees regarding print quality or paper feed properties. For Canon genuine paper/feed
confirmed paper, see "Paper Information List."

After loading the paper in the printer, select the media type in the control panel and printer driver and then
perform the printing. For the media type, you can select easily from existing settings or you can create and
use settings for the paper you are using.

Printing Using Existing Settings
You can print easily by selecting from existing settings provided in the printer control panel and printer
driver. (See "Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing
Settings.")

Printing Using Additional Settings
You can use the Media Configuration Tool function for adding custom paper to create settings suitable for
non-Canon genuine paper/feed confirmed paper and add as a new media type to the printer's Control
Panel and the printer driver for printing. (See "Printing on Paper Other Than Genuine Paper and feed
confirmed Paper by Adding a Media Type.")
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Printing on Paper Other Than Genuine Paper and feed confirmed
Paper Using Existing Settings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making
complicated settings by selecting the existing settings provided in the printer control panel and printer driver
depending on the media type you are using. The existing settings consist of general-purpose paper settings
provided for different media types.

Important
• The Canon genuine paper settings provided in the printer control panel and printer driver are optimized

for Canon genuine paper. If these settings are selected for printing on paper other than Canon genuine
paper, the ink may bleed or the print head may rub against the paper. To easily print on paper other
than Canon genuine paper and feed confirmed paper, we recommend that you select one of the
following general-purpose paper settings.

Note
• For an overview of the media types, see "Types of Paper."

• For instructions on selecting the media type with the control panel, see "Types of Paper". For
instructions on selecting the media type with the printer driver, see "How to Open the Printer Driver
Setup Window" (Windows) or "How to Open the Printer Driver Setup Window" (macOS).

Choosing General-Purpose Paper Settings
These settings anticipate a wide variety of paper other than Canon genuine paper and feed confirmed
paper, and, therefore, these settings make it difficult for bleeding ink and print head rubbing to occur. For
details on the relationships between the conditions of paper other than Canon genuine paper and feed
confirmed paper and the media type to select, see "Paper Information List."

Note
• If you cannot obtain the desired results by selecting the general-purpose paper settings, use the

custom paper adding function in Media Configuration Tool to create settings suitable for the paper
you are using. For details, see "Printing on Paper Other Than Genuine Paper and feed confirmed
Paper by Adding a Media Type."
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Printing on Paper Other Than Genuine Paper and feed confirmed
Paper by Adding a Media Type

Media Configuration Tool provides a function for adding custom paper for better print quality and improved
paper feed properties when printing on paper other than Canon genuine paper/feed confirmed paper than
when printing with general-purpose settings. You can use this function to configure settings such as the
amount of ink used and the height of the print head according to the characteristics of the paper being used,
and thereby realize higher print quality. Also, you can add the settings created with this function as a new
media type to the printer control panel and printer driver.

For details on Media Configuration Tool, refer as follows.

Media Configuration Tool Guide (Windows)

Media Configuration Tool Guide (macOS)

Important
• For details on how to select the added media type in the control panel, see "Changing the Type of

Paper."

• You can select the media type to be used in printing from Media Type in the Main sheet (Windows) or
Quality & Media (macOS) in the printer driver. For details, see "Main Tab Description" (Windows) or
"Quality & Media" (macOS).

• We recommend that you use an ICC profile created using commercially available profile creation
software to perform color management accurately on paper other than Canon genuine paper and feed
confirmed paper. You can register the ICC profile you created when creating a custom paper with
Media Configuration Tool.

(See "Adding Custom Paper" (Windows).)

(See "Adding Custom Paper" (macOS).)
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Updating paper information

You can update the printer's media information to the latest information by applying the latest version of the
Media Information File.

For details on the procedure for applying the Media Information File, refer to the following.

Media Configuration Tool Guide (Windows)

Media Configuration Tool Guide (macOS)

Important
• If you are using the Media Configuration Tool, the new Media Information File is downloaded

automatically when released on the Canon website. A computer connected to the Internet is required to
download the Media Information File.
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Handling rolls

Loading Rolls on the Roll Holder

Loading the Upper Roll on the Printer

Loading the Lower Roll on the Roll Unit (Option)

Changing the Type of Paper

Specifying the Paper Length

Removing the Upper Roll from the Printer

Removing the Lower Roll from the Roll Unit (Option)

Removing Rolls From the Roll Holder

Feeding Roll Paper Manually

Keeping Track of the Amount of Roll Paper Left

Specifying the Ink Drying Time for Rolls

Specifying the Cutting Method for Rolls

Cutting the Leading Edge of Roll Paper Automatically

Reducing Dust from Cutting Rolls

Automatically Switch Rolls
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Loading Rolls on the Roll Holder

When printing on roll paper, attach the roll paper to the Roll Holder.

Roll paper comes in two types: 2-inch and 3-inch cores. If using 3-inch core roll paper, attach the 3-Inch
Paper Core Attachment to the Roll Holder and holder stopper.

Caution
• Set the roll on its side on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and

dropping a roll may cause injury.

Important
• When handling the roll, be careful not to soil the printing surface. This may affect the printing quality.

We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

• Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding
problems and affect the printing quality. Be careful not to cut through any barcodes printed on the roll.

• Align the edges of the paper on both ends of the roll. This may cause feeding problems.

Note
• For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information

List".

1. Push holder stopper lever (A) toward shaft to release lock, and while holding in position (B),
remove holder stopper from Roll Holder.
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Important
• Do not use the roll holder for feeding paper with the spacer (C) removed from the flange. It will

result in the paper being sent askew.

2. If using 3-inch core paper, align 3-Inch Paper Core Attachment tabs (A) with Roll Holder
holes (B) and insert firmly.

3. With leading edge of roll paper facing forward as shown, insert Roll Holder from right side of
roll. Insert firmly until roll paper touches flange (A) of Roll Holder.
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Important
• When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage the

Roll Holder.

• If you stand the roll holder vertically and set the roll paper by dropping, the roll holder may be
damaged.

4. If using 3-inch core roll paper, attach 3-Inch Paper Core Attachment to holder stopper.

Align the tabs (A) of the attachment with the holes (B) of the holder stopper, and insert firmly.

5. Insert holder stopper from left into Roll Holder as shown, and while holding in position (B),
push firmly until holder stopper flange (A) touches roll paper. Lift holder stopper lever (C)
from shaft to lock.
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Loading the Upper Roll on the Printer

Follow these steps to load rolls in the printer.

When selecting Enable in Roll paper auto feed, the roll paper is fed automatically by simply loading it.

Important
• Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be

advanced correctly when you turn the printer on.

• Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these
areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top Cover.").

• If Paper retention setting is set to Release, the roll paper is not fed automatically.

• For details on the paper that can feed roll paper automatically, see "Paper Information List."

Note
• When using the roll unit, you can also load roll paper on the roll unit separately from the printer that is

described here. (See "Loading the Lower Roll on the Roll Unit (Option).")

• When roll paper cannot be fed automatically, see "Roll Paper Is not Switched Automatically."

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

• When selecting Enable in Roll paper auto feed.

Go to step 2.

• When selecting Disable in Roll paper auto feed.

1. Tap  area.

2. Tap Load paper or Replace paper, check message that appears, and then tap Yes.

Note
• If any cut sheet has been fed, or roll paper that will not be used has been fed from Roll 1 (Upper),

a message is shown requesting you to remove it.
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After following the instructions on the screen to remove the paper, redo the operation.

• If roll paper is loaded in Roll 1 (Upper) but Roll 1 (Upper) is not selected as the paper source, a
message asking you whether or not to change paper is displayed.

Tap Replace paper, remove the paper, and go to the next step.

2. Open top cover and lift output guide.

3. Hold flanges (A) so that roll holder's white gear is on left, align roll holder shaft with roll
holder slot left and right guide grooves (B), and load.
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Caution
• Be careful not to drop the roll and hurt yourself when loading it.

• Be careful not to pinch your fingers between the Roll Holder shaft and the guide grooves (B) when
loading the roll paper.

Important
• If the leading edge of the roll paper is secured with tape or a paper band so that it will not unravel,

remove the tape or paper band before loading the roll paper into the roll holder slot.

If you load the paper into the roll holder slot with the leading edge secured, only part of the roll
paper is fed to the paper feed slot, resulting in damage to the roll paper.

• If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the
leading edge of the roll paper with scissors or the like and straighten it.

• Load the roll paper so that it is not loaded in the opposite direction.

• Make sure there is no slack in the roll paper, and then load it.

• Depending on the surrounding environment, the leading edge of roll paper is stuck because of
static electricity or humidity so that the roll paper may not be able to be fed correctly. In this case,
set Roll paper auto feed to Disable, and then feed the roll paper.

• If the roll paper is decentered, it may not be able to be fed correctly. In this case, set Roll paper
auto feed to Disable, and then feed the roll paper.

• When Roll paper auto feed is Enable and if you attach the roll holder without the roll paper
loaded on the roll holder, Preparing to feed the paper... appears on the operation panel. In this
case, press the Stop button on the operation panel to cancel feeding.

Note
• For the procedure for attaching the roll paper to the Roll Holder, see "Loading Rolls on the Roll

Holder."

• When selecting Enable in Roll paper auto feed.

Go to step 4.

• When selecting Disable in Roll paper auto feed.

Pull out roll paper evenly, insert leading edge between roll paper and arrows (A) directly beneath it,
and feed roll paper until you hear a sound.
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Important
• If the roll paper has become unwound, remove the slack before loading the roll paper.

• When feeding the leading edge of the roll paper, make sure the entire width of the roll paper is
separating and feeding from the roll. If the roll paper is fed with some of the roll paper still
stuck to the roll, the roll paper will be damaged.

• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may
affect the printing quality. We recommend wearing clean cloth gloves when handling rolls to
protect the printing surface.

• If the paper is wrinkled or warped, straighten it out before loading it.

• Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.

• Depending on the paper, the roll paper may be scratched when being fed and not feed well. In
this case, you must feed the paper manually after setting Paper retention setting to Release
on the touch screen. Lift the release lever, advance the roll paper until its leading edge
appears on platen, lower the release lever, and then proceed to the next step. However, if
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Paper retention setting is set to Release, automatic switching of the upper and lower rolls is
not possible.

4. Lower output guide.

5. Close top cover.

• When selecting Enable in Roll paper auto feed.

The roll paper is fed.

• When selecting Disable in Roll paper auto feed.

Tap Start feeding, and then the roll paper is fed.

Once paper feeding starts, you will need to do the following, based on the Manage remaining roll
amount setting and the barcode printed on rolls. (See "Keeping Track of the Amount of Roll Paper
Left.")

• When selecting Disable or Warning message in Manage remaining roll amount.

A menu for selecting the media type appears on the touch screen. Operate the touch screen and
select the media type to be used.

• When selecting Barcodes in Manage remaining roll amount and if the barcode is printed.

The type and amount of paper left is automatically detected based on the barcode printed on the
roll. There is no need to specify the type and length of the paper.
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• When selecting Barcodes in Manage remaining roll amount and if the barcode is not
printed.

A menu for selection of the media type and length is shown on the touch screen. Operate the touch
screen, select the media type to be used, and enter its length.

Important
• When selecting Enable in Keep media type, there is no need to specify the type of the paper.

• Cut the edge of the roll using the Cut paper function if the edge is creased or soiled. (See
"Specifying the Cutting Method for Rolls.")

• When selecting the media type on the touch screen, make sure the media type set in the printer
driver and the media type loaded on the printer match.

Note
• For details on media types that you can select, see "Paper Information List."

• Adjusting the printhead alignment with the type of paper to be used in printing may enhance
printing quality. (See "Automatic Adjustment to Straighten Lines and Colors.")
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Loading the Lower Roll on the Roll Unit (Option)

Follow these steps to load roll paper in the roll unit (Roll 2 (Lower)).

When selecting Enable in Roll paper auto feed, the roll paper is fed automatically by simply loading it.

Important
• Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be

advanced correctly when you turn the printer on.

• Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these
areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top Cover.").

• If using the roll unit as the feed device, depending on the basket position, the ejected roll paper's cut
end enters the roll unit and may cause a paper jam or affect the print quality when set to "Borderless
Printing" or "Trim Edge First" when loading the paper. In this case, change the basket position, and
then print. (See "Example Basket Configurations.")

• If Paper retention setting is set to Release, the roll paper is not fed automatically.

• For details on the paper that can feed roll paper automatically, see "Paper Information List."

Note
• When roll paper cannot be fed automatically, see "Roll Paper Is not Switched Automatically."

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

• When selecting Enable in Roll paper auto feed.

Go to step 2.

• When selecting Disable in Roll paper auto feed.

1. Tap  area.

2. Tap Load paper or Replace paper, check message that appears, and then tap Yes.
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Note
• If any cut sheet has been fed, or roll paper that will not be used has been fed from Roll 1 (Upper),

a message is shown requesting you to remove it.

After following the instructions on the screen to remove the paper, redo the operation.

• If roll paper is loaded in Roll 1 (Upper) but Roll 1 (Upper) is not selected as the paper source, a
message asking you whether or not to change paper is displayed.

Tap Replace paper, remove the paper, and go to the next step.

2. Change Roll Holder Lock switch on roll unit to release position.

3. Hold flanges (A) so that roll holder's white gear is on left, align roll holder shaft with roll
holder slot left and right guide grooves (B), and load.
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Caution
• Be careful not to drop the roll and hurt yourself when loading it.

• Be careful not to pinch your fingers between the Roll Holder shaft and the guide grooves (B) when
loading the roll paper.

Important
• If the leading edge of the roll paper is secured with tape or a paper band so that it will not unravel,

remove the tape or paper band before loading the roll paper into the roll holder slot.

If you load the paper into the roll holder slot with the leading edge secured, only part of the roll
paper is fed to the paper feed slot, resulting in damage to the roll paper.

• If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the
leading edge of the roll paper with scissors or the like and straighten it.

• Load the roll paper so that it is not loaded in the opposite direction.

• Make sure there is no slack in the roll paper, and then load it.

• Depending on the surrounding environment, the leading edge of roll paper is stuck because of
static electricity or humidity so that the roll paper may not be able to be fed correctly. In this case,
set Roll paper auto feed to Disable, and then feed the roll paper.

• If the roll paper is decentered, it may not be able to be fed correctly. In this case, set Roll paper
auto feed to Disable, and then feed the roll paper.
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• When Roll paper auto feed is Enable and if you attach the roll holder without the roll paper
loaded on the roll holder, Preparing to feed the paper... appears on the operation panel. In this
case, press the Stop button on the operation panel to cancel feeding.

Note
• For the procedure for attaching the roll paper to the Roll Holder, see "Loading Rolls on the Roll

Holder."

4. Change Roll Holder Lock switch on roll unit to locked position.

Important
• If you do not change Roll Holder Lock switch to locked position, the roll paper cannot be fed

automatically.

5. Change feed flap switch on top of roll unit to feed icon position on the left.
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• When selecting Enable in Roll paper auto feed.

The roll paper is fed.

• When selecting Disable in Roll paper auto feed.

Pull out roll paper evenly, insert leading edge between roll paper and arrows (A) directly beneath it,
and feed roll paper until you hear a sound.

Tap Start feeding, and then the roll paper is fed.
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Important
• If the roll paper has become unwound, remove the slack before loading the roll paper.

• When feeding the leading edge of the roll paper, make sure the entire width of the roll paper is
separating and feeding from the roll. If the roll paper is fed with some of the roll paper still stuck to
the roll, the roll paper will be damaged.

• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect
the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

• If the paper is wrinkled or warped, straighten it out before loading it.

• Load the roll so that there is no gap between the right edge of the paper and the Roll Holder.

• Depending on the paper, the roll paper may be scratched when being fed and not feed well. In this
case, you must feed the paper manually after setting Paper retention setting to Release on the
touch screen. Lift the release lever, advance the roll paper until its leading edge appears on
platen, lower the release lever, and then proceed to the next step. However, if Paper retention
setting is set to Release, automatic switching of the upper and lower rolls is not possible.

Once paper feeding starts, you will need to do the following, based on the Manage remaining roll
amount setting and the barcode printed on rolls. (See "Keeping Track of the Amount of Roll Paper
Left.")

• When selecting Disable or Warning message in Manage remaining roll amount.

A menu for selecting the media type appears on the touch screen. Operate the touch screen and
select the media type to be used.

• When selecting Barcodes in Manage remaining roll amount and if the barcode is printed.

The type and amount of paper left is automatically detected based on the barcode printed on the
roll. There is no need to specify the type and length of the paper.

• When selecting Barcodes in Manage remaining roll amount and if the barcode is not
printed.

A menu for selection of the media type and length is shown on the touch screen. Operate the touch
screen, select the media type to be used, and enter its length.

Important
• When selecting Enable in Keep media type, there is no need to specify the type of the paper.
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• Cut the edge of the roll using the Cut paper function if the edge is creased or soiled. (See
"Specifying the Cutting Method for Rolls.")

• When selecting the media type on the touch screen, make sure the media type set in the printer
driver and the media type loaded on the printer match.

Note
• For details on media types that you can select, see "Paper Information List."

• Adjusting the printhead alignment with the type of paper to be used in printing may enhance
printing quality. (See "Automatic Adjustment to Straighten Lines and Colors.")
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Changing the Type of Paper

Follow these steps to change the type of paper specified on the printer after you have loaded paper.

If you continue using the same type of paper and set Keep media type to Enable, when you load paper, the
media type selected before Enable was set is selected automatically, eliminating the need to set the media
type. (See "Using the Same Type of Paper Regularly.")

Important
• For best printing results, the printer fine-tunes the print head height and the feed amount for each type

of paper. Be sure to select the type of paper to use correctly before printing.

• Because the printer fine-tunes the feed amount for each type of paper, the margins and the size of
printed images may vary depending on the type of paper used. If margins and the size of images are
not as you expected, adjust the paper feed amount.

(See "Adjusting Feed Amount.")

• Rolls and sheets have different printing areas, and sheets having a larger bottom margin than rolls.

(See "Print Area.")

Changing the Type of Paper

Note
• When you load roll paper, a menu for selecting the media type appears on the touch screen. Tap the

media type.

If no barcode has been printed on the roll paper and you have set Manage remaining roll amount to
Enable, specify the roll length after selecting the media type. (See "Specifying the Paper Length.")

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap paper feed slot where paper whose type you want to change is loaded.

3. Tap Paper settings.
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4. Tap Type.

5. Tap media type of roll paper loaded in printer.

Important
• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may

cause feed errors and affect printing quality.

Note
• For details on media types, see "Paper Information List." At the factory default settings, Plain

Paper is selected for the media type.

• When the release lever is operated, the settings automatically return to the last selected media
type.

Using the Same Type of Paper Regularly
Configure this setting so that current media type settings will be automatically selected when you load the
same type of paper later.

1. Tap Device settings on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap Paper-related settings.

3. Tap Keep media type.

4. Tap Enable.

Note
• The specified media type setting is updated in the following situations.

• When using sheets, if you send a print job before loading a sheet, the media type setting is
updated to match the type of paper specified by the print job.
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• If a barcode is printed on the roll paper and you have set Manage remaining roll amount to
Enable in the operation panel menu, the media type setting is updated to match the media type
specified by the barcode.

• To change the media type setting, see "Changing the Type of Paper."
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Specifying the Paper Length

When changing the length of paper after the paper has been advanced, specify the length as follows.

Note
• Specify the roll paper length when you have set Manage remaining roll amount to Barcodes. (See

"Keeping Track of the Amount of Roll Paper Left.")

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap paper feed slot where paper whose length you want to change is loaded.

3. Tap Paper settings.

4. Tap Length.

5. Enter roll paper length.

Specify the roll length as follows.

1. Tap the gray numerical input field.

2. Tap the keypad appearing on the touch screen, enter the roll paper length, and then tap OK.

3. Check the entered length and tap OK.
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Removing the Upper Roll from the Printer

Remove rolls from the printer as follows.

Note
• If you need to cut a printed roll, select Feed/cut in the printer menu and cut the roll paper at the desired

position. (See "Specifying the Cutting Method for Rolls.")

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap  area.

3. Tap Remove paper.

4. Tap Yes.

The roll is rewound.

Important
• If Manage remaining roll amount is set to Barcodes in the operation panel menu, a barcode is

printed on the leading edge of the roll paper.

Do not remove the roll before the barcode is printed. You will be unable to keep track of the
amount of roll paper left. (See "Keeping Track of the Amount of Roll Paper Left.")

5. Open top cover and lift output guide.
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6. Using both hands, rotate the Roll Holder in the direction of the arrow to rewind the roll.

7. Hold Roll Holder by its flanges (A) and remove from roll holder slot.
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Note
• For instructions on removing the Roll Holder from rolls, see "Removing Rolls From the Roll

Holder."

8. Lower output guide and close top cover.

Note
• To load new paper in the printer at this point, see "Loading the Upper Roll on the Printer."

• Clean inside the top cover before loading paper.

(See "Cleaning Inside the Top Cover.")
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Removing the Lower Roll from the Roll Unit (Option)

Follow these steps to remove roll paper from the roll unit.

Note
• If you need to cut a printed roll, select Feed/cut in the printer menu and cut the roll paper at the desired

position. (See "Specifying the Cutting Method for Rolls.")

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap  area.

3. Tap Remove paper.

4. Check touch screen message and tap Yes.

The roll is rewound.

Important
• If Manage remaining roll amount is set to Barcodes in the operation panel menu, a barcode is

printed on the leading edge of the roll paper.

Do not remove the roll before the barcode is printed. You will be unable to keep track of the
amount of roll paper left. (See "Keeping Track of the Amount of Roll Paper Left.")

5. Using both hands, rotate roll holder in direction of arrow to rewind roll paper.
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6. Change Roll Holder Lock switch on roll unit to release position.

7. Hold roll holder by its flanges (A) and remove from roll holder slot.
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Note
• For instruction on removing the roll paper from the roll holder, see "Removing Rolls From the Roll

Holder."

• To load new paper in the printer at this point, see "Loading the Upper Roll on the Printer."
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Removing Rolls From the Roll Holder

1. Push holder stopper lever (A) toward shaft to release lock, and while holding in position (B),
remove holder stopper from roll holder.

2. Remove roll holder from roll paper.

3. To remove 3-Inch Paper Core Attachment, press tabs (A) inward and remove attachment.

• roll holder Side

• holder stopper Side
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Important
• Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If

paper is not stored properly, the printing surface may become scratched, which may affect the printing
quality when you use it again.
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Feeding Roll Paper Manually

After feeding the roll paper, you can move it forward and back.

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap  or  area.

3. Tap Feed/cut.

4. Tap or touch Advance and Rewind to move roll paper forward or back.

Note
• Tapping Advance or Rewind moves the roll paper approximately 0.04 inch (1 mm).

Touching Advance or Rewind moves the roll paper until you release the key. If "Cannot advance
the paper any more." appears on the touch screen, release the key.

5. Tap OK when you have determined position of roll paper.
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Keeping Track of the Amount of Roll Paper Left

There are two methods of managing the amount of roll paper left: by using the barcode and by estimating
the amount of roll paper left.

Managing by the Barcode for the Amount of Roll Paper Left
When you set Manage remaining roll amount to Barcodes in Device settings on the Home screen, the
amount of remaining roll paper and the media type information are printed as a barcode and text when the
paper is removed. When Manage remaining roll amount is set to Barcodes and you load roll paper with
a printed barcode, the media type and remaining amount are automatically detected after the roll paper is
loaded. The barcode will be cut off after it has been read.

Important
• If the barcode on the roll paper is not detected, enter the media type and length on the touch screen.

The length of the paper at this time can be set in Roll length (change default).

Setting the Length of the Roll Paper when Managing by the Barcode

Follow the steps below when setting Manage remaining roll amount to Barcodes.

1. Tap Device settings on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap Paper-related settings.

3. Tap Manage remaining roll amount.

4. Tap Barcodes.

5. Check the length of the roll paper.
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Important
• When selecting Enable in Roll paper auto feed, the screen for checking the length of the roll

paper is displayed for only 5 seconds.

Note
• The length of the roll paper to be displayed can be set in Roll length (change default).

Setting the Length of the Roll Paper when Managing by the Barcode

• If the length of the roll paper to be displayed is different from the length of the roll paper actually
used, set the actual length.

6. Select the timing when the warning message appears.

Note
• If you increase the level in Roll amount warning setting, the warning message appears

sooner.

Setting the Default Value of the Amount of Roll Paper Left when Managing by the
Barcode
When you select Barcodes in Manage remaining roll amount and if you feed roll paper on which no
barcode is printed, such as new roll paper, the screen to enter the roll paper length (remaining amount)
appears.

In this screen, the length (remaining amount) of default value appears. If the length is not correct, tap the
screen and enter a correct length.

When you want to change the length (remaining amount) of default value, follow the steps below.

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap paper feed slot where roll paper for which you want to set the roll paper length is
loaded.
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3. Tap Paper settings.

4. Tap Advanced.

5. Tap Roll length (change default).

Managing by Estimating the Amount of Roll Paper Left
When you set Manage remaining roll amount to Warning message in Device settings on the Home
screen, if the amount of roll paper left decreases, the Status lamp on the operation panel lights up orange
and the warning message is displayed. The barcode is not printed.

The time to display warning message can be set in Roll amount warning setting. If you increase the
level in Roll amount warning setting, the warning message appears sooner.

Important
• If the type of paper is not selected correctly, the amount of roll paper left may not be estimated

correctly.

• When using the types of paper which are not displayed on "Paper Information List," set the paper
thickness and the size of paper core with Media Configuration Tool.

Media Configuration Tool Guide (Windows)

Media Configuration Tool Guide (macOS)
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Specifying the Ink Drying Time for Rolls

When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface
during ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait
for the ink to dry after printing.

Note
• If the Cutter touches the print surface on which the ink is not dry, the paper surface may become

scratched or soiled, or the paper surface may rub when the paper falls and the surface may become
soiled.

To wait for the ink to dry without allowing printed materials to fall after printing, set Cutting mode on the
printer menu to Eject cut. (See "Specifying the Cutting Method for Rolls.")

• The settings can also be made from the touch screen on the printer. From Paper settings, select
Paper settings > Advanced and set Pause between scans and Pause between pages.

Windows

1. Display the printer driver dialog box.

(See "How to Open the Printer Driver Setup Window.")

2. Select Main sheet and click Specify... for Media Type.
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3. In the Paper Detailed Settings dialog box displayed next, select the desired values from
the lists for Between Pages and Between Scans in Drying Time, and then click OK.

(See "Main Tab Description.")

macOS

1. Choose Print in the application menu.

2. Select Paper Detailed Settings panel.
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3. Select desired values from lists for Dry Time (Between Pages) and Dry Time (Between
Scans).

(See "Paper Detailed Settings.")
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Specifying the Cutting Method for Rolls

How rolls are cut after ejection varies depending on printer settings.

• Automatic cut

The roll is automatically cut by the cutter blade according to the printer driver settings.

◦ Printer Setting

Roll Paper 1/Roll Paper 2 > Paper settings > Advanced > Cutting mode > Automatic cut

◦ Driver Setting

Automatic Cutting > Yes

See "Cutting Roll Paper after Printing" (Windows).

See "Cutting Roll Paper after Printing" (macOS).

• Eject (when the paper surface is being scratched / to wait for ink to dry)

Select this to move the cutter by touch screen operation and cut paper. With Automatic cut, the paper
drops and may rub against the basket, resulting in damage to the print surface, but you can cut using
this method and supporting the paper so that it does not drop to avoid damage to the paper. Also, you
can prevent paper that has not dried from dropping by visually checking the ink has dried, and then
cutting the paper.

After printing, tap Cut paper and cut the roll paper on the cutter blade.

◦ Printer Setting

Roll Paper 1/Roll Paper 2 > Paper settings > Advanced > Cutting mode > Eject cut

◦ Driver Setting

Automatic Cutting > Yes

See "Cutting Roll Paper after Printing" (Windows).

See "Cutting Roll Paper after Printing" (macOS).

• Manual (when using media that cannot be cut with the cutter blade)

Select this if the paper cannot be cut on the cutter blade.

Cut each page from the roll using scissors. For continuous printing (if you will cut each page later),
select Automatic Cutting > Yes or select Print Cut Guideline.

◦ Printer Setting

Roll Paper 1/Roll Paper 2 > Paper settings > Advanced > Cutting mode > User cut

◦ Driver Setting

Automatic Cutting > No, Yes, Print Cut Guideline

See "Cutting Roll Paper after Printing" (Windows).

See "Cutting Roll Paper after Printing" (macOS).
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• Paper cutting (to have the roll cut at your specified position)

Select this when you want to cut the roll paper by operating the cutter blade using the touch screen after
printing with No or Print Cut Guideline selected in Automatic Cutting in the printer driver.

Otherwise choose this option if you want to cut the roll edge after loading a roll.

◦ Printer Setting

Roll Paper 1/Roll Paper 2 > Feed/cut > Cut paper > Yes

◦ Driver Setting

Automatic Cutting > No, Print Cut Guideline

See "Cutting Roll Paper after Printing" (Windows).

See "Cutting Roll Paper after Printing" (macOS).

Note
• Automatic and Eject are valid only when you have selected Automatic Cutting > Yes in the printer

driver.

• With Eject, printing does not resume after a series of jobs have been printed continuously until the roll is
cut.

• Eject cut is the preset selection in Cutting mode for some types of paper. For this paper, we
recommend keeping the preset cutting mode.

• If documents printed using Automatic, Eject, or manual cutting are short, rolls are advanced a specific
amount before cutting to prevent problems with cutting and paper ejection. This may create a wider
bottom margin, in some cases.

Cut rolls manually in the following cases:

Eject (when the paper surface is being scratched / to wait for ink to dry)

Important
• When cutting wide printed documents after ejection, have two people support the documents. If the

paper drops, printed documents may be damaged.

• Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect
the printing quality or cause rough cut edges.

Note
• Once the following step has been performed, the procedure can be started from step 7 the next time.

• Printing the second and subsequent times

• Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of touch screen.
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Note
• If the Home screen does not appear, tap the HOME button.

2. Tap paper feed slot where roll paper for which you want to set cutting method is loaded.

3. Tap Paper settings.

4. Tap Advanced.

5. Tap Cutting mode.

6. Tap Eject cut.

7. Print the job.

When printing is finished, the printer will stop without cutting.

8. While holding printed document to prevent it from dropping, tap Cut paper to cut roll
paper.

Manual (when using media that cannot be cut with the cutter blade)

Note
• Once the following step has been performed, the procedure can be started from step 8 the next time.

• Printing the second and subsequent times

• Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of touch screen.
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Note
• If the Home screen does not appear, tap the HOME button.

2. Tap paper feed slot where roll paper for which you want to set cutting method is loaded.

3. Tap Paper settings.

4. Tap Advanced.

5. Tap Cutting mode.

6. Tap User cut.

7. When Do you want to set to detect the leading edge of the paper? is displayed, select
Detect (recommended).

8. Print the job.

The printer stops advancing the paper after printing.

9. Tap Advance paper.

Roll paper is fed to the specified cut position and then automatically stopped.

10. Cut the roll paper manually with scissors or the like.
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11. Tap OK.

After the roll is rewound, it stops automatically.

Manual (for paper of which the leading edge rubs the printhead)

Note
• Once the following step has been performed, the procedure can be started from step 8 the next time.

• Printing the second and subsequent times

• Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap paper feed slot where roll paper for which you want to set cutting method is loaded.

3. Tap Paper settings.
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4. Tap Advanced.

5. Tap Cutting mode.

6. Tap User cut.

7. When Do you want to set to detect the leading edge of the paper? is displayed, select
Do not detect.

Note
• If you set the detection of paper leading edge to Do not detect, a margin of about 4.0 inches

(10 cm) is created at the paper leading edge when printing starts.

• When the detection of paper leading edge is set to Do not detect, printing will start at the
position at which the roll was set for the first printing after replacing a roll. Thus, the margin of
the paper leading edge will enlarge.

(See "Loading the Upper Roll on the Printer.")

8. Tap Back button twice to display roll paper screen.

9. Tap Feed/cut.

10. Tap or touch Advance or Rewindand align paper's leading edge with position (A).

11. Print the job.

The printer stops advancing the paper after printing.
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12. Tap Advance paper.

Roll paper is fed to the specified cut position and then automatically stopped.

13. Cut the roll paper manually with scissors or the like.

14. Tap OK.

After the roll is rewound, it stops automatically.

Paper cutting (to have the roll cut at your specified position)

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap paper feed slot where roll paper you want to cut is loaded.

3. Tap Feed/cut.

4. Tap or touch Advance or Rewind to feed roll paper to desired cutting position.

95



5. Tap Cut paper.

6. Tap Yes.

After the roll paper is cut, it is rewound automatically.
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Cutting the Leading Edge of Roll Paper Automatically

If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print
correctly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by
using Trim edge first in the touch screen menu.

The following settings are available for Trim edge first.

• Auto

If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the
leading edge straight and eject the fragment of paper to prevent printing on the platen and soiling the
printer.

• Auto (default length)

The amount to cut from the leading edge of the paper varies depending on the media type and is cut to
a prescribed length. For the leading edge precut length, see "Paper Information List".

• Auto (specified length)

Specify the amount to cut from the leading edge of paper on the touch screen. The amount to cut from
the leading edge can be specified in the range of lengths that appear on the touch screen. The range of
lengths differs according to the media type.

Note
• The amount to cut from the leading edge of paper cannot be set shorter than the length that

appears on the touch screen.

• Manual

The amount to cut from the leading edge of paper can be adjusted by using the touch screen.

To cut the paper after adjusting, tap Cut paper and Yes.

After cutting the paper, tap Complete paper loading.

Note
• If you do not tap Complete paper loading after cutting the paper, you cannot print the next job.

• OFF

The edge is not cut and scraps are not removed.

Follow these steps to change the Trim edge first setting.
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1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap  or .

3. Tap Paper settings.

4. Tap Advanced.

5. Tap Trim edge first.

6. Tap desired Trim edge first settings.

This setting takes effect the next time you load a roll.
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Reducing Dust from Cutting Rolls

If the paper tends to generate dust when cut, such as with Backlit Film, you can reduce flying dust by setting
Cut-dust reduction to ON from the touch screen menu, which will coat the leading and trailing edges of the
printed document with ink. As a result, you can reduce problems with the print head. You can set Cut-dust
reduction according to the media type.

Important
• Do not set Cut-dust reduction to ON for paper that wrinkles easily, such as Plain Paper or lightweight

paper. If not cut properly, the paper may jam.

• Borderless printing is not available when Cut-dust reduction is set to ON. When performing borderless
printing, set Cut-dust reduction to OFF.

Follow these steps to set Cut-dust reduction to ON.

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap  or  area.

3. Tap Paper settings.

4. Tap Advanced.
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5. Tap Cut-dust reduction.

6. Tap ON.
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Automatically Switch Rolls

By using the roll unit as a roll paper feed device, you can load an upper roll (Roll 1 on printer) and a lower
roll (Roll 2 on the roll unit), and print on while automatically changing between Roll 1 and Roll 2 depending
on the print job.

For details on how to switch between Roll 1 and Roll 2, see "How to Switch Paper Rolls" (Windows) or "How
to Switch Paper Rolls" (macOS).

Important
• If Paper retention setting is set to Release, automatic switching of roll paper cannot be used.
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Handling sheets

Loading Sheets in the Printer

Changing the Type of Paper

Printing From a Desired Starting Point

Removing Sheets

Clearing a Jammed Sheet
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Loading Sheets in the Printer

Follow these steps to load sheets in the printer.

Important
• Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.

• Load the paper straight. Loading paper askew will cause an error. (See "1317.")

• If you are not using the stand, make sure there is no object under the printer. If there is any object
under the printer, it may cause damage of the paper or jamming.

Note
• Before loading cut sheets, check whether or not the inside of the top cover or the output guide is soiled.

If these areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top
Cover.").

• Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

1. Select sheets as the paper source.

• If a print job was received

Sheets are automatically selected, and the media type and size specified by the print job are
shown on the touch screen.

Tap OK and Load paper.

• If no print job was received

1. Tap paper settings display area on touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap  area.

3. Tap Load paper or Replace paper.

Note
• If any paper has been advanced that will not be used, a message is shown requesting you to

remove it.
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Follow the instructions on the screen to remove the paper, and redo the operation.

2. Open top cover and lift release lever.

Important
• Do not touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching these may

cause malfunction.

3. Place cut sheet with the print side up, insert in portrait orientation between platen (A) and
paper retainer (B), and align paper's far edge using the following steps.

1. Load while aligning with right side paper alignment line (C).
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2. Align far edge of inserted sheet with leading edge of paper alignment line (D) as shown.

When you insert the sheet, it will adhere automatically to the surface of the platen.

Important
• Load the sheet so that it is parallel to the right paper alignment line (C). Loading paper askew will

cause an error.

• Warped paper may rub against the print head. Straighten paper if it is warped before loading.

Note
• You can also align the cut sheet based on its near edge. In this case, load the cut sheet aligning

its near edge with marks (E) on the platen and the right edge with the right-side paper alignment
line (F).
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• You can adjust the vacuum strength holding the paper against the platen when the release lever
is up. If it is difficult to load the paper, tap Suction on the touch screen and adjust the vacuum
strength. You can adjust the vacuum strength to 5 levels.

However, even if you increase the suction, it may not be sufficient to hold some types of paper
against the platen well. In this case, use your hand to load the paper.

• Sheets are held in place by suction through holes on the platen. Although the suction may
produce a noise when paper is loaded in some positions, it does not indicate a problem. If the
noise is distracting, try moving the paper over slightly to the left or right (up to 0.04 inch (1 mm))
while keeping it parallel to the paper alignment line.

• The suction remains on for about 30 seconds during loading. If you cannot finish loading a sheet
during this time, pull the sheet away and reinsert it to start the suction again.

4. Lower release lever and close top cover.
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• If a print job was received

Tap OK to feed the paper and begin printing.

• If no print job was received

A menu for selecting the media type appears.

Select the media type loaded and tap OK.

The printer now starts feeding the paper.

Note
• For details on media types that you can select, see "Paper Information List."
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Printing From a Desired Starting Point

Print on sheets from a desired starting point as follows.

Setting Detect paper width to Disable

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap  area.

3. Tap Paper settings.

4. Tap Advanced.

5. Select Detect paper width and tap Disable.

Load paper in the desired position to start printing from
Follow these instructions to load paper at the desired starting position for printing when Detect paper
width is set to Disable.

1. If you did not send a print job in advance, a menu for selection of the type of paper is
displayed.

Tap media type loaded.

Note
• If a print job was received before the paper was fed, the media type and size specified by the

job are shown on the touch screen.

Go to step 2.
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2. When "[Detect paper width] is disabled. Do you want to keep it disabled and
continue?" appears on touch screen, tap Keep it disabled and continue.

3. Open top cover and check position where paper is loaded.

To start printing from the current position, close the top cover.

To reposition the paper, lift the release lever.
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4. Load paper keeping right edge of paper aligned with extended line of paper alignment line
(A) on right side of printer and position from which to start printing aligned with groove (B)
at far end of platen.
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5. Lower release lever and close top cover.
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6. When screen for selecting paper size appears, select size of paper loaded.
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Removing Sheets

Remove sheets from the printer as follows.

1. Tap paper settings display area on Home screen of touch screen.

Note
• If the Home screen does not appear, tap the HOME button.

2. Tap  area.

3. Tap Remove paper.

4. Check touch screen message and tap Yes.

5. When instructions for removing sheet appear on touch screen, lift release lever while
holding sheet, and remove sheet.
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6. Lower release lever.
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Stacker

Parts of the Stacker

Using the Stacker

Example Stacker Configurations
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Parts of the Stacker

(A) Rod (fixed)
Move it forward and back to switch the position of the stacker.

(B) Basket
A cloth tray that catches ejected documents.

(C) Arm
When using the stacker with the Position 1, attach the rod (adjustable) to the lower of the arm.

Example Stacker Configurations

(D) Rod (adjustable)
Changes the position of the stacker by moving the rod (adjustable) to the lower of the arm or the upper
of the stand.

(E) Stand
A stand that holds the stacker. Equipped with casters to facilitate moving the printer.

When using the stacker with the Position 2, the Position 3 or the Position 4, attach the rod (adjustable)
to the upper of the stand.

Example Stacker Configurations

(F) Paper Stopper
When stacking printed materials with a 24-inch width or of A1 portrait, attach it to the lower of the
second part from the right of the flapper.

Store the paper stopper in the accessory pocket of the stand when not in use.

(G) Flapper
Changes the position of the stacker by setting the flapper vertically or horizontally.
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Using the Stacker

Install the stacker to the printer before printing, when stacking the printed materials in the stacker.

Installing the Stacker to the Printer

Change the position of the stacker depending on the size of the printed materials.

Example Stacker Configurations

Remove the stacker from the printer, when loading the paper in the printer.

Removing Stacker from the Printer

Important
• Do not apply excessive force to the basket and the flapper. Doing so may damage the basket and the

flapper.

• If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.

• When the basket which is included in the stand is attached to the stand, detach the basket and the
basket arm, and then use the stacker. If the basket remains attached, you cannot use the stacker.

• When using the stacker, make space in front of the printer enough to detach the stacker in advance.

Installing the Stacker to the Printer

1. Set all locks of the four casters of the stacker to the OFF position.

2. Move the stacker to front of the printer with the stand, and then push in the convex
portions (A) on both sides of the foot of the stacker until they hit the stand of the printer.

118



3. Set all locks of the four casters of the stacker to the ON position.
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Removing Stacker from the Printer

1. Set all locks of the four casters of the stacker to the OFF position.

2. Pull out the stacker toward you to remove the stacker from the printer.
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Example Stacker Configurations

The stacker is used by changing the position depending on the paper size of the printed materials.

Important
• Depending on the types of paper, it cannot be stacked in the Position 2, Position 3, or Position 4. In this

case, use the Position 1.

Stacking Printed Materials (Position 1)
This is the position when you stack the printed materials.

Pull down the rod (fixed) (C) toward you. Set the rod (adjustable) in the groove (B) at the lower of the arm,
and then set the flapper (A) vertically so that the stacker configuration is the Position 1.

Stacking Printed Materials with a 36-inch Width or of A0 Portrait (Position 2)
This is the position when you stack the printed materials with a 36-inch width or of A0 portrait.

• Paper orientation

Portrait

• Supported paper size

◦ 36"x48" (ARCH E) 36.00 x 48.00 inches (914.4 x 1219.2 mm)
◦ A0 33.11 x 46.81 inches (841.0 x 1189.0 mm)

Set the rod (adjustable) in the groove (B) at the upper of the stand, and then push down the rod (fixed) (C)
to the printer side. Then set the flapper (A) vertically so that the stacker configuration is the Position 2.
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Stacking Printed Materials with a 24-inch Width or of A1 Portrait (Position 3)
This is the position when you stack the printed materials with a 24-inch width or of A1 portrait.

• Paper orientation

Portrait

• Supported paper size

◦ 24"x36" (ARCH D) 24.00 x 36.00 inches (609.6 x 914.4 mm)
◦ A1 23.39 x 33.11 inches (594.0 x 841.0 mm)

Pull down the rod (fixed) (E) toward you. Set the rod (adjustable) in the groove (B) at the upper of the
stand, and then set the flapper (A) vertically so that the stacker configuration is the Position 3. Then attach
the paper stopper (C) stored in the accessory pocket of the stand to the lower of the second part (D) from
the right side of the flapper.
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Stacking Printed Materials with a 36-inch Width, of A1 Landscape, with a 24-
inch Width, or of A2 Landscape (Position 4)
This is the position when you stack the printed materials with a 36-inch width, of A1 landscape, with a 24-
inch width, or of A2 landscape.

• Paper orientation

Landscape

• Supported paper size

◦ 24"x36" (ARCH D) 24.00 x 36.00 inches (609.6 x 914.4 mm)
◦ 18"x24" (ARCH C) 18.00 x 24.00 inches (457.2 x 609.6 mm)
◦ A1 23.39 x 33.11 inches (594.0 x 841.0 mm)
◦ A2 16.54 x 23.39 inches (420.0 x 594.0 mm)

Pull down the rod (fixed) (C) toward you. Set the rod (adjustable) in the groove (B) at the upper of the
stand, and then set the flapper (A) horizontally so that the stacker configuration is the Position 4.
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Basket

Parts of the Basket

Using the Basket

Example Basket Configurations

Storing the Basket
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Parts of the Basket

(A) Basket Rod (tag side)
Secures the cloth basket to the tips of the basket arm.

(B) Basket Arm
Retains the basket rod (tag side).

By changing the length and the angle, you can make the basket suitable for various conditions.

When not using the basket, you can lower it and store alongside of the stand. (See "Storing the
Basket.")

(C) Basket
A cloth tray that catches ejected documents.

(D) White Tag
Marks indicating basket attachment orientation.

(E) Basket Rewind Button
Press this button when rewinding the basket after it has been wound on the basket rod (tag side).

(F) Basket Rod (cord side)
Secures the cloth basket on the rod holder.

(G) Rod Holder
Retains the basket rod (cord side).

For instructions on using the basket, see "Using the Basket."
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Using the Basket

By changing the following four items for the basket, you can use the basket in various ways to suit your
application.

• Length of basket arm

• Tilt of basket arm

• Attachment position of basket

• Length of basket

This section describes how to change the basket.

For specific examples of basket use, see "Example Basket Configurations."

Important
• When changing the position of the basket, first return the basket to a unwound state while pressing the

basket rewind button on the right end of the basket rod (tag side), and then make the change.

• If the basket rod (tag side) has come off the basket arm, attach it by inserting the projections on both
ends of the basket rod (tag side) into oval holes on the tip of the basket arm.

• When moving the printer, remove the basket.

• Do not apply excessive force to the basket. Doing so may damage the basket.

• If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.

Changing Length of basket arm
You can change the length of the basket arm in two steps.

To lengthen, expand the left/right basket arm in the direction of the arrow.

To shorten, contract the left/right basket arm in the opposite direction of the arrow.

127



Important
• When lengthening the basket arm, first return the basket to an unwound state while pressing the

basket rewind button on the right edge of the basket rod (tag side), and then make the change.

Changing Tilt of basket arm
You can change the tilt of the basket arm in three steps.

When securing the basket arm, attach the basket locking support to the basket arms (A) on both sides.
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Important
• If you are changing the angle of the basket arm, make sure the thick part of the basket arm is pulled

out as far as possible.

• When changing the angle of the basket arm, hold the thick part of the left/right basket arm, and adjust
them.

• While using the basket locking support, do not apply excessive force to the orientation in which you
lower the basket arm. Doing so may damage the basket.

• While using the basket locking support, you cannot use "Printing on Large-Format or Easily Damaged
Paper (Position 3)." When using this position, detach the basket locking support.

• While using the basket locking support, you cannot store the basket. When you store the basket,
detach the basket locking support.

Storing the Basket

Changing Attachment Position of basket
You can attach the basket rod (cord side) to the stand's rod holder or the front of the printer.

To attach, hang both sides of the basket rod (cord side) on the paired attachment locations shown in the
illustration.
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Important
• When attaching the basket rod (cord side) to the front of the printer, make sure both ends of the rod

(A) are securely hooked onto the attachment parts.
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Changing Length of basket
You can adjust the basket length by rotating the basket rod (tag side).

To shorten, rotate the basket rod (tag side) in the direction of the arrow to wind the basket.

To lengthen, rotate the basket rod (tag side) in the opposite direction of the arrow while pressing the
basket rewind button (A) on the right end of the basket rod (tag side). You can return the wound basket to
its original position.
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Example Basket Configurations

Various positions are possible for the basket that collects the printed materials.

In this section, we present the following five positions as examples of using the basket. Switch the position
of the basket to suit to the media type and the print job.

Using Without roll unit (Position 1)

Using With roll unit (Position 2)

Printing on Large-Format or Easily Damaged Paper (Position 3)

Stacking Printed Materials (Position 4)

Moving Printed Materials to Next Work Area Immediately (Position 5)

For instructions on switching the basket position, see "Using the Basket."

Important
• If replacing the roll paper or using the roll unit as a take-up device, you must store the basket. For

instructions on storing the basket, see "Storing the Basket."

• If the printed materials collected are damaged or folded, select Eject cut in Cutting mode or use the
basket in a different position. (See "Specifying the Cutting Method for Rolls.")

Note
• For details on the printer dimensions when using the basket, see "Specifications."

Using Without roll unit (Position 1)
You can use the basket in the following positions when not using the roll unit.
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Important
• The number of sheets that can be collected in the basket is one. If printing multiple pages, print after

removing each sheet.

• If using the roll unit as a feed device, we recommend using it as described in "Using With roll unit
(Position 2)".

• If using the roll unit and using the Position 1 basket, the printed materials may come in contact with
the roll unit depending on the paper, resulting in damage.

• If using the roll unit as a feed device and using the Position 1 basket, the ejected roll paper's cut end
enters the roll unit and may cause a paper jam or affect the print quality when set to Borderless
Printing or Trim edge first when loading the paper.

• Roll paper up to 62 inches (1,575 mm) in length can be collected in the basket. If printing on longer
roll paper, use as described in "Printing on Large-Format or Easily Damaged Paper (Position 3)" or
use with the roll unit as the take-up device.

Using With roll unit (Position 2)
You can use the basket in the following positions when using the roll unit as a feed device.

This position is useful also when rewinding printed roll paper by hand.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, and extend the basket arm as far as possible at the angle shown to achieve this position.

You can adjust the basket length so that it is easy to use.

Important
• You can place up to approximately 4.41 lbs (2 kg) of printed materials in the basket. If the weight of

the printed materials is greater than that, the basket may fall over.
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Printing on Large-Format or Easily Damaged Paper (Position 3)
If printing on large-format or easily damaged paper, you can use the basket in the following position.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible, and lower it to the angle shown. Next, adjust the length
so that the basket is pulled into this position.

Important
• Always select Eject cut in Cutting mode when used in this position. If you select Automatic cut, the

printed materials may be damaged. (See "Specifying the Cutting Method for Rolls.")

• Be extra careful when using paper that tends to curl or is damaged easily in this position.

• With some types of paper, the leading edge may curl or bend during ejection. In this case, straighten
out the paper. Printed documents may be damaged if the paper is curled or bent.

• Depending on the paper, the paper may be caught between the output guide and the basket when
being ejected. In this case, fix the paper that is caught. If the paper is caught, printed documents may
be damaged.

Stacking Printed Materials (Position 4)
You can use the basket in following positions when you want to stack printed materials.

Move the basket rod (cord side) to the lower of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible in the angle shown. Next, adjust the length so that the
basket is pulled into this position.
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Important
• In the following cases, use as described in "Using Without roll unit (Position 1)" or "Using With roll

unit (Position 2)". If printing multiple pages in these positions, print after removing each sheet.

• Printed materials other than A2 portrait

• Paper curls an extreme amount due to paper characteristics and printing environment

• If there is not much paper remaining on the roll, and the paper curls an extreme amount

Moving Printed Materials to Next Work Area Immediately (Position 5)
You can use the basket in the following position when moving the printed materials to the next work area
immediately.

Move the basket rod (cord side) to the upper of the two pairs of attachment locations on the front of the
printer, extend the basket arm as far as possible in the angle shown. Next, adjust the length so that the
basket is pulled into this position.
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Important
• Be extra careful when using paper that tends to curl or is damaged easily in this position.

• With some types of paper, the leading edge may curl or bend during ejection. In this case, straighten
out the paper. Printed documents may be damaged if the paper is curled or bent.

• Depending on the paper, the paper may be caught between the output guide and the basket when
being ejected. In this case, fix the paper that is caught. If the paper is caught, printed documents may
be damaged.
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Storing the Basket

Store the basket in the following two positions when not in use. Select the position to suit the circumstances.

If Changing Roll Paper or Using roll unit as Take-up Device

Using Without basket (Only When roll unit Is Not Used)

If Changing Roll Paper or Using roll unit as Take-up Device
If replacing the roll paper or using the roll unit as a take-up device, store the basket.

You can store the basket, by attaching the basket rod (cord side) to the rod holder, lowering the basket
arm until level, and then pushing as far back as possible.

Important
• If changing the basket position, first release and rewind the basket. If it is not released and rewound,

the change may not be performed smoothly, or the basket may be damaged. (See "Using the
Basket.").

• If you are changing the angle of the basket arm, make sure the thick part of the basket arm is pulled
out as far as possible.

• If the basket rod (tag side) has come off the basket arm, attach it by inserting the projections on both
ends of the basket rod (tag side) into oval holes on the tip of the basket arm.

• Do not apply excessive force to the basket. Doing so may damage the basket.

Using Without basket (Only When roll unit Is Not Used)
If you are not using the roll unit, you can easily store the basket by holding the thick parts of the left/right
basket arm in the Position 1  (See "Example Basket Configurations.") state, and moving them in the
direction of the arrow.
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Roll Unit

Parts of the Roll Unit

Roll Unit

Switching Roll Unit Modes

Using the Roll Unit In Take-Up Mode

Removing Printed Paper from the Roll Unit
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Parts of the Roll Unit

(A) Roll Holder Lock Switch
Locks and releases the Roll Holder loaded in the roll unit.

(B) Feed Mode Lamp
Lights up when you have selected the feed mode on the roll unit.

(C) Auto Take-up Lamp
Lights up when the paper is being taken up.

(D) Pause Lamp
Lights up when the paper winding is paused.

(E) Take-up Button
You can rotate the roll unit the desired amount as long as winding is not in progress. When the winding
direction is set to inward winding, the unit takes up the paper; when it is set to outward winding, the unit
rewinds the paper.

(F) Rewind Button
You can rotate the roll unit the desired amount as long as winding is not in progress. When the winding
direction is set to inward winding, the unit rewinds the paper; when it is set to outward winding, the unit
takes up the paper.

(G) Auto Take-up/Pause Button
Pauses and resumes the taking up of paper.

(H) Inward/Outward Winding Changeover Switch
Changes the winding direction when the paper is wound (inward winding and outward winding).

(I) Take-up Mode Lamp
Lights up when you have selected the take-up mode on the roll unit.

(J) Roll Holder Slot
Slide the Roll Holder into these guide grooves.
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(K) 3-Inch Paper Core Attachment
Attaches to the Roll Holder when you are using a roll paper with a 3-inch paper core.

(L) Feed Flap Switch
Change the feed flap position depending on the roll unit mode.

(M) Roll Holder
Load the roll on this holder.

(N) Holder Stopper
This part secures the roll paper on the Roll Holder.
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Roll Unit

The roll unit functions as a feed device that can accommodate an additional roll for a total of two rolls on the
printer and as a take-up device that automatically takes up the printed roll paper.

Switch between these two functions depending on the circumstances.

For instructions on attaching the roll unit, see the Roll Unit Setup Guide.

142



Switching Roll Unit Modes

Before using the roll unit, follow these steps to select the mode you want to use.

Important
• After switching the roll unit function, you must use a separate computer to apply the roll unit settings to

the printer driver. For details, see "Reflect Roll Unit Settings in the Printer Driver" (Windows) or "Reflect
Roll Unit Settings in the Printer Driver" (macOS).

• If you change the roll unit from a take-up device to a feed device, first cut the paper that has been taken
up.

1. Tap paper settings display area on Home screen of touch screen.

Important
• If the Home screen does not appear, tap the HOME button.

2. Tap  or  area.

3. Change function of roll unit.

• Using as feed device

1. Tap Roll unit use setting.

2. Tap ON when message confirming roll unit's change to feed mode appears.
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Note
• If you change the mode without cutting the roll paper with the printer's cutter, a screen

confirming whether or not the paper taken up has been cut appears after you tap ON. If
the paper has not been cut, select No and cut the paper that has been taken up first.

3. Load roll paper on roll unit.

For details, see "Loading the Lower Roll on the Roll Unit (Option)."

• Using as take-up device

1. Tap Roll unit use setting.

2. Tap ON when message confirming roll unit's change to take-up mode appears.

3. Tap to select paper cutting settings when using take-up mode.

Note
• If you selected Do not cut, the roll paper will not be cut after printing regardless of the

Cutting mode setting  (See "Specifying the Cutting Method for Rolls.") on the printer.
Select this option when you want to print multiple pages consecutively without cutting.

• If you selected Use the cutting mode setting, cutting for each page will be performed
according to the Cutting mode setting (See "Specifying the Cutting Method for Rolls.") on
the printer.

• If you select Use the cutting mode setting, and Automatic Cutting is set in the Cutting
mode settings  (See "Specifying the Cutting Method for Rolls.")on the printer, we
recommend setting Wind up after cutting to Enable. When set to Disable, a printed
document that has been taken up is cut automatically without being pressed, resulting in
fraying.

• If roll paper is loaded from the roll unit to the printer, a screen confirming whether or not to
remove the roll paper appears. If you select Yes, the roll paper is positioned so that it can
be removed and the roll unit changes to a take-up device.

4. Tap Yes or No when message confirming whether roll unit will be used immediately in take-up
mode appears.

If you tap Yes, the steps for loading the paper on the roll unit appear on the touch screen.

If you tap No, the operation ends here. Load the paper on the roll unit when printing. However,
in this case, you must load the paper while printing is progressing, so instructions will not
appear on the touch screen.

For details on loading paper on the roll unit set as a take-up device, see "Using the Roll Unit In
Take-Up Mode."

Note
• If you select Yes, a margin of approximately 23.62 inches (600 mm) is generated at the

leading edge because the roll paper advances to the roll unit before printing.
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Using the Roll Unit In Take-Up Mode

Important
• For details on the roll paper compatible with winding, see "Paper Information List.".

• Before loading the roll paper to be taken up on the roll unit, set the roll unit mode to take-up device on
the printer touch screen. (See "Switching Roll Unit Modes.")

• The following operation assumes that the roll holder is not installed on the roll unit and that roll paper is
not loaded on the roll holder. If the roll holder is installed on the roll unit, first remove the roll holder from
the roll unit, and then remove the roll paper loaded on the roll holder. (See "Removing the Lower Roll
from the Roll Unit (Option).") (See "Removing Rolls From the Roll Holder.")

• Paper winding is possible until the outer diameter of the wound paper is the same as the outer diameter
of the holder stopper.

• When printing on lightweight paper or without a border, the border of the paper may get wrinkled
coming in contact with the roll holder, resulting in poor winding. If these problems occur when winding
using a 2-inch core, remove the spacer held in place by 4 hex screws on the roll holder flange, and then
wind.

1. Store basket. (See "Storing the Basket.")

2. Push holder stopper lever (A) toward shaft to release lock, and while holding in position (B),
remove holder stopper from roll holder.

3. If taking up roll paper whose paper core has an inner diameter of 3 inches (76.2 mm), insert
3-Inch Paper Core Attachment in roll holder and holder stopper.

Align the 3-Inch Paper Core Attachment tabs (A) with the holes on the roll holder or holder stopper (B)
and insert firmly.
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• roll holder Side

• holder stopper Side

4. Insert paper core, which is for winding roll paper, into roll holder.

Important
• We recommend using a paper core that is wider than the paper to be wound when winding paper.

If you use a narrower paper core, use with a gap between the holder stopper and the paper.

• Always use a paper core for winding that is the same thickness or is thicker than the roll paper's
paper core. If you use a paper core that is thinner, it may affect take up.

5. Insert holder stopper from left into roll holder as shown, and then while holding in position
(B), push firmly until holder stopper flange (A) touches roll paper. Lift holder stopper lever
(C) from shaft to lock.
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6. Change Roll Holder Lock switch on roll unit to release direction.

7. Hold flanges (A) so that roll holder's white gear is on left, align roll holder shaft with roll
holder slot left and right guide grooves (B), and load.
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8. Change Roll Holder Lock switch on roll unit to lock direction.
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9. Change the feed flap switch on top of the roll unit so that the switch indicator (A) is aligned
with ● (B) position on the take-up icon.

10. Change Inward/Outward Winding Changeover switch on roll unit to desired winding
direction.
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Note
• For the winding direction of the roll paper, you can select either outward winding to make the

printed surface on the outside of the roll or inward winding to make the printed surface on the
inside of the roll.

11. Follow these steps to secure the leading edge of the roll paper to the paper core with tape.

• If message appears on touch screen to confirm whether or not to advance paper
automatically so it can be secured with tape

1. Tap Yes.

The leading edge of the roll paper advances until it is close to the roll unit.

2. Hold center of leading edge of roll paper, align right edge of take-up spool paper core's right
edge and tape center to paper core while pulling on roll paper evenly.

◦ Outward Winding

◦ Inward Winding
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Important
• If winding with inward winding, you must pass the leading edge of the roll paper to the

back of the paper core and secure with tape. If this operation is difficult, you can also
remove the roll holder, push the roll paper into the back, reinstall the roll holder, and pass
the roll paper to the back of the paper core.

3. Align right edge of roll paper to right edge of paper core while pulling on roll paper evenly, and
secure with tape.

4. While making sure that roll paper is flat, secure left edge of roll paper to paper core with tape.

◦ Outward Winding

◦ Inward Winding
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Important
• Secure the left and right edges of the roll paper with tape within 1.97 inches (50 mm) of

the edges so that neither end of the roll paper lift up.

• When rewinding heavyweight paper, use strong adhesive tape to fasten it. Otherwise, a
rewinding problem may result.

• If you use a paper core narrower than the paper to be wound, adjust the position of the
holder stopper, so that there is a gap between the holder stopper and the paper.

5. Make sure the leading edge of the roll paper is not lifting up from the paper core, and if there
are places lifting up, tape in additional places so that the paper does not lift up.

6. Push roll holder downward, check that roll holder is not lifting up, and tap OK.

◦ Outward Winding

152



◦ Inward Winding

Important
• If the roll holder lifts up, it may cause an error.

7. To stabilize operations when starting taking up, advance roll paper with operation panel and
wind roll paper approximately one revolution. (See "Feeding Roll Paper Manually.")

8. Push roll holder downward again, and check that roll holder is not lifting up.

The winding preparation is complete. When printing to the roll starts, the roll paper can be
automatically wound.

• If Ready to print appears on touch screen

1. Manually advance roll paper  (See "Feeding Roll Paper Manually.") or start printing, and wait
for leading edge of roll paper to reach roll unit.

2. Hold center of leading edge of roll paper, align right edge of take-up spool paper core's right
edge and tape center to paper core while pulling on roll paper evenly.

◦ Outward Winding
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◦ Inward Winding

Important
• If winding with inward winding, you must pass the leading edge of the roll paper to the

back of the paper core and secure with tape. If this operation is difficult, you can also
remove the roll holder, push the roll paper into the back, reinstall the roll holder, and pass
the roll paper to the back of the paper core.

3. Align right edge of roll paper to right edge of paper core while pulling on roll paper evenly, and
secure with tape.

4. While making sure that roll paper is flat, secure left edge of roll paper to paper core with tape.

◦ Outward Winding
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◦ Inward Winding

Important
• Secure the left and right edges of the roll paper with tape within 1.97 inches (50 mm) of

the edges so that neither end of the roll paper lift up.

• When rewinding heavyweight paper, use strong adhesive tape to fasten it. Otherwise, a
rewinding problem may result.

• If you use a paper core narrower than the paper to be wound, adjust the position of the
holder stopper, so that there is a gap between the holder stopper and the paper.

5. Make sure the leading edge of the roll paper is not lifting up from the paper core, and if there
are places lifting up, tape in additional places so that the paper does not lift up.

6. Push roll holder downward and check that roll holder is not lifting up.
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◦ Outward Winding

◦ Inward Winding

Important
• If the roll holder lifts up, it may cause an error.

7. Make sure Inward/Outward Winding Changeover switch on roll unit is in desired direction
and press Auto Take-up/Pause button.

The Pause lamp, which has been lighted up to this point, turns off, and the Auto Take-up
lamp lights up instead.

The winding preparation is complete. During printing, the winding starts. Before printing, the
winding starts at the same time as the printing.
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Important
• When winding inwardly, loosening of the wound paper can be prevented by pressing the

roll paper with the arm. However, doing so may produce pressure traces on the paper. In
this case, tap the roll unit area of the media information display area and set Paper
retention setting to Release.
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Removing Printed Paper from the Roll Unit

Note

• By tapping the paper settings display area and then  area when setting Take-up mode and setting
Wind up after cutting to Enable in advance, you can omit steps 6 and 7 below, because when the
paper is cut after printing, the next paper will be automatically taken up after that. However, be careful
when using easily damaged roll paper because the roll paper touches the roller when paper is cut.

1. Tap paper settings display area on Home screen of touch screen.

Important
• If the Home screen does not appear, tap the HOME button.

2. Tap  area.

3. Tap Feed/cut.

4. Tap Advance or Rewind to advance roll paper a little.

With the winding direction set to outward winding, advance the length of one circumference of the roll or
more to protect the print side.

5. Tap Cut paper.

6. Hold printed paper between output guide and roll unit, then tap Yes.
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The roll is now cut.

Important
• When cutting the roll paper, always hold the printed paper. If cut without holding the printed paper,

the paper may fall to the floor and become soiled.

7. While holding trailing edge of printed paper, press Take-up or Rewind button to wind
printed paper.

Apply adhesive tape to the rewound paper to hold it in place, if necessary.

Important
• Be careful not to scratch the printed surface.

8. Change Roll Holder Lock switch on roll unit to release side.
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9. Hold roll holder by its flanges (A), and remove from roll unit.

10. Push holder stopper lever (A) toward shaft to release lock, and while holding in position (B),
remove holder stopper from roll holder.
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11. Remove printed material that has been taken up, from roll holder for each paper core.
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Changing Settings from Operation Panel/Web Browser

Operations and Touch Screen

Operation Panel

Touch Screen

Checking Instructions During Printer Operations

Changing Settings from Operation Panel

Printer Menu Operations

Menu Operations

Menu Structure

Changing Settings from Operation Panel

Setting Items on Operation Panel

HP-GL/2 Settings

Status Print

Changing Printer's Setting Using Web Browser

Configuration changes using the Web Browser

Changeable Setting Items Using Web Browser

Setting Password

Registering Printer's Root Certificate to Web Browser for SSL Communication
(Remote UI)

Registering Printer's Root Certificate to Local Computer for SSL Communication

Generating Server Certificate (Self-signed Certificate)

Setting Mail Server

Receiving Printer Status by E-mail
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Operations and Touch Screen

Operation Panel

Touch Screen

Checking Instructions During Printer Operations
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Operation Panel

(A) ON button/ON lamp
Turns the printer on and off.

Turning the Printer On and Off

The ON lamp is lit when the printer is on or in Sleep mode.

(B) HOME button
The HOME screen appears.

Touch Screen

(C) Back button
Displays the screen before the current screen.

(D) Stop button
Cancels print jobs in progress and ends the ink drying period.

(E) touch screen
Shows printer menus, as well as the printer status and messages. You can select menu items and
display buttons by gently touching the screen with your fingertip.

Touch Screen

(F) Status lamp
• Flashing (white)

During printing, this lamp flashes when the printer is receiving or processing print jobs. Otherwise,
this lamp flashes when the print job is paused or the printer is updating the firmware.

• Lit (orange)

A warning message is displayed.

• Flashing (orange)

An error message is displayed.

• Off
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There are no active print jobs, warnings, or errors.

Note
• When the printer is in Sleep mode, you can touch the touch screen to recover from Sleep mode.
• When Operation panel lock is enabled, touch screen operations are invalid. For details on Operation

panel lock, see Changeable Setting Items Using Web Browser.
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Touch Screen

After the printer starts up, the HOME screen appears on the touch screen.

From the HOME screen, you can check the printer status and select the maintenance, settings, and other
menus. Drag the HOME screen up and down, and select the display position.

Basic Touch Screen Operations

(A) Printer Information Display Area
Displays the printer status, messages, and other information. Tap this item when a message appears to
view the message on the list screen and to jump to the screen with detailed information and operations.

(B) Ink Display Area
Displays the ink status. Tap this item to view the remaining amount of ink and how to replace the ink
tanks.

(C) Paper Setting Display Area
Displays the media information for each feeding location. Tap this item to configure the size and type of
the paper loaded.

(D) Other Menu Items
Displays the items used to perform maintenance and configure the various settings.

Printer Menu Operations

Basic Touch Screen Operations
You can select various functions and settings by gently touching and swiping the touch screen with your
fingertip.

Important
• Take the following precautions when operating the touch screen. Otherwise, the touch screen may

malfunction or become damaged.

• Do not forcibly press the touch screen with your finger.
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• Do not press the touch screen with an object other than your finger (such as a ballpoint pen,
pencil, fingernail, or other object with a sharp tip).

• Do not operate the touch screen with wet or dirty hands.
• Do not place objects on top of the touch screen.

• Do not place a protective film over the touch screen. Removing it can damage the touch screen.

Tap

Gently touch with your fingertip and then release.

Use this when selecting an item on the screen.

Touch

Gently touch with your fingertip.

To go (or return) to a menu or list, touch the directional mark.

Flick

Drag and release your finger up, down, left, or right.

Use this to quickly scroll through a menu or list.

Drag

Move your finger up, down, left, or right while gently keeping it in contact with the touch screen.
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Use this to move a menu or list while viewing it.

Notification Messages
When the ink is low or there is another notification, New notice appears in the printer information display
area. Tap this to display the Notice list screen to view messages with the newest one appearing first. Tap
a message to display the message details screen to view the details and take action.
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Checking Instructions During Printer Operations

You can refer to instructions on the touch screen when loading paper, replacing ink tanks, or performing
other operations.

How to view instructions
Once you complete an action described in the instructions, the printer detects the action and switches to
the next instruction screen.

Operation screens are switched every 3 seconds, and the sequence of operations is shown repeatedly.

For actions the printer cannot detect, tap OK to display the instruction screen for the next step.

Example: Ink tank replacement
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Changing Settings from Operation Panel

Printer Menu Operations

Menu Operations

Menu Structure

Changing Settings from Operation Panel

Setting Items on Operation Panel

HP-GL/2 Settings

Status Print
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Printer Menu Operations

The printer menu is classified into regular menu items available when no print job is in progress and menu
during printing items only available while printing is in progress.

Flicking HOME screen and tapping the menu displays each setting item.

The menus below are available.

1. Printer status

Displays the printer status and wireless LAN connection status.

2. Ink status

Displays the ink status.

3. Paper information

Perform paper settings. (grays-out while a print job is in progress)

4. Maintenance

Perform maintenance settings. (grays-out while a print job is in progress)

5. Job management

Perform job management settings.

6. Print from USB flash drive

Perform print settings when you print data on a USB flash drive.

7. LAN settings

Perform LAN settings. (grays-out while a print job is in progress)

8. Device settings

Perform various printer settings. (grays-out while a print job is in progress)

9. Printer information

Displays various printer information.

Note
• By default, menu settings apply to all print jobs. However, for settings that are also available in the

printer driver, the values specified in the printer driver take priority.
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Menu Operations

The operation panel features a touch screen (A) and buttons (B).

Touch icons on the touch screen's HOME screen to select menus.

A. Touch screen

B. Buttons on the operation panel

For more on the touch screen operations:

Touch Screen

Example of Using Touch Screen
These touch screen operations are available when you print data on a USB flash drive.

Drag up or down, and then tap an item to select it.
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Tapping A displays the print settings menu.

Drag up or down, and then tap an item to select it.
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After the list is displayed, tap a setting to select it.

Tap D to confirm the settings.

Tap C to display the screen for selecting the number of copies.

Tap a number to specify the number of copies, and then tap OK.

Tap B to display the preview screen.

Touch the Back button to return to the previous screen.
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Menu Structure

• Ink information

Current estimated ink levels

Replace

Order ink now

• Paper settings

Roll paper 1

Replace paper

Feed/cut

Remove paper

Paper settings

Width/Length/Type/Advanced

Roll paper 2

Replace paper

Feed/cut

Remove paper

Roll unit use setting

Paper settings

Width/Length/Type/Advanced

Take-up mode

Roll unit use setting

Auto feed to take-up position

Skip errors during take-up

ON/OFF

Wind up after cutting

Enable/Disable

Paper retention setting

Release/Retain
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Use in take-up mode

Use/Do not use

Manual

Replace paper

Remove paper

Paper settings

Page size/Type/Advanced

• Maintenance

Print nozzle check pattern

Print head cleaning

Cleaning

All colors/Pattern 1/Pattern 2

Deep cleaning

All colors/Pattern 1/Pattern 2

System cleaning

All colors/Pattern 1/Pattern 2

Print head alignment

Auto (standard)

Roll paper 1/Roll paper 2/Manual

Auto (fine)

Roll paper 1/Roll paper 2/Manual

Manual

Roll paper 1/Roll paper 2/Manual

Print head angle adjustment

Paper feed adjustment

Set priority

Roll paper 1
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Auto/Prioritize print quality/Prioritize length accuracy

Roll paper 2

Auto/Prioritize print quality/Prioritize length accuracy

Manual

Auto/Prioritize print quality/Prioritize length accuracy

Adjust print quality

Auto

Roll paper 1/Roll paper 2/Manual

Manual

Roll paper 1/Roll paper 2/Manual

Adjust feed length

Print alignment pattern

Roll paper 1/Roll paper 2/Manual

Change adjustment values

-0.70% to 0.70% (by 0.02% increment)

Maintenance cartridge info

Maintenance cartridge usage

Replace

Head replacement

Replace cutter blade unit

Platen cleaning

Prepare to move

Move indoors on the same floor

Move indoors to a different floor

Transport outdoors

• Job management

Print job
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List of print jobs

Delete/Priority printing/Release hold

Saved job

Job box list

Job list

Delete/Start print

Print the job list

Job history

Display job history

Print job history

Pause printing

Enable

Disable

Delete all print jobs

• Print from USB flash drive

Folder/file list

Number of copies

Preview

Settings

Start print

• LAN settings

Change LAN

Activate wired LAN

Activate wireless LAN

Activate direct connect.

Disable LAN

Wireless LAN setup
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Easy wireless connect

Standard setup

WPS (Push button method)

Other setup

Advanced setup/WPS (PIN code method)

• Device settings

Test print

Print nozzle check pattern

Status print

Status print (administrator)

Print LAN details

Print setting print

Print advanced paper settings

Print job history

Print menu map

Print color list for palettes

Print settings

Print head movable width setting

Data width/Maximum movable width/Paper width

Prioritize paper size

Enable/Disable

PDF print settings

Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color (correct off)/Mono-
chrome/Monochrome BMP

Print quality

5 (Fast)/4/3/2/1 (High)

Input resolution
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600 dpi/300 dpi

Print target

Photo/Line drawing

Paper settings

Paper src

Auto select/Roll paper (auto)/Roll paper 1/Roll paper 2/Manual

Margin

3mm/5mm

Border

Borderless/Bordered

Rotate

0 degrees/90 degrees

Enlarge/Reduce

Fit paper size/Same size/Scaling

Processing options

Warning display

Enable/Disable

JPEG print settings

Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color (correct off)/Mono-
chrome/Monochrome BMP

Print quality

5 (Fast)/4/3/2/1 (High)

Input resolution

600 dpi/300 dpi

Print target

Photo/Line drawing

Paper settings
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Paper src

Auto select/Roll paper (auto)/Roll paper 1/Roll paper 2/Manual

Margin

3mm/5mm

Border

Borderless/Bordered

Rotate

0 degrees/90 degrees

Enlarge/Reduce

Fit paper size/Same size/Scaling

HP-GL/2 print settings

Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color (correct off)/Mono-
chrome/Monochrome BMP

Print quality

5 (Fast)/4/3/2/1 (High)

Input resolution

600 dpi/300 dpi

Print target

Photo/Line drawing

Paper settings

Paper src

Auto select/Roll paper (auto)/Roll paper 1/Roll paper 2/Manual

Margin

3mm/5mm

Oversize

Disable/Enable

Conserve paper
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OFF/ON

Rotate

0 degrees/90 degrees

Auto rotation

ON/OFF

Enlarge/Reduce

Fit paper size/Same size/Scaling

Print centered

OFF/ON

Cut to standard size

ON/OFF

Nesting

Use nesting function/Nesting WaitTime/Print cut lines

Line management

Merge

OFF/ON

Smooth

Software/Smoothing

Thicken fine lines

OFF/ON

Adjust faint lines

OFF/ON

Width correction

Black/gray / Color

Print color list for palettes

Processing options

Warning display

Enable/Disable

Detect image size
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OFF/Command priority/Detected size

Print from USB flash settings

Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color
(correct off)/Monochrome/Monochrome
BMP

Print quality

5 (Fast)/4/3/2/1 (High)

Print target

Photo/Line drawing

Paper settings

Paper src

Auto select/Roll paper (auto)/Roll paper 1/Roll paper 2/Manual

Margin

3mm/5mm

Border

Borderless/Bordered

Rotate

0 degrees/90 degrees

Enlarge/Reduce

Fit paper size/Same size/Scaling

Direct print settings from FTP

Print settings 1

Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color
(correct off)/Monochrome/Monochrome
BMP

Print quality
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5 (Fast)/4/3/2/1 (High)

Print target

Photo/Line drawing

Paper settings

Paper src

Auto select/Roll paper (auto)/Roll paper 1/
Roll paper 2/Manual

Margin

3mm/5mm

Border

Borderless/Bordered

Rotate

0 degrees/90 degrees

Enlarge/Reduce

Fit paper size/Same size/Scaling

Print settings 2

Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color
(correct off)/Monochrome/Monochrome
BMP

Print quality

5 (Fast)/4/3/2/1 (High)

Print target

Photo/Line drawing

Paper settings

Paper src

Auto select/Roll paper (auto)/Roll paper 1/
Roll paper 2/Manual

Margin
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3mm/5mm

Border

Borderless/Bordered

Rotate

0 degrees/90 degrees

Enlarge/Reduce

Fit paper size/Same size/Scaling

Print settings 3

Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color
(correct off)/Monochrome/Monochrome
BMP

Print quality

5 (Fast)/4/3/2/1 (High)

Print target

Photo/Line drawing

Paper settings

Paper src

Auto select/Roll paper (auto)/Roll paper 1/
Roll paper 2/Manual

Margin

3mm/5mm

Border

Borderless/Bordered

Rotate

0 degrees/90 degrees

Enlarge/Reduce

Fit paper size/Same size/Scaling

Print settings 4
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Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color
(correct off)/Monochrome/Monochrome
BMP

Print quality

5 (Fast)/4/3/2/1 (High)

Print target

Photo/Line drawing

Paper settings

Paper src

Auto select/Roll paper (auto)/Roll paper 1/
Roll paper 2/Manual

Margin

3mm/5mm

Border

Borderless/Bordered

Rotate

0 degrees/90 degrees

Enlarge/Reduce

Fit paper size/Same size/Scaling

Default print settings

Print quality settings

Color mode

Color (perceptual)/Color (saturation)/Color (correct off)/Mono-
chrome/Monochrome BMP

Print quality

5 (Fast)/4/3/2/1 (High)

Print target

Photo/Line drawing
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Print setting print

LAN settings

Change LAN

Activate wired LAN

Activate wireless LAN

Activate direct connect.

Disable LAN

Wireless LAN setup

Easy wireless connect

Standard setup

WPS (Push button method)

Other setup

Advanced setup/WPS (PIN code method)

Confirm LAN settings

LAN setting list

WLAN setting list

Wireless Direct setting list

Print LAN details

Other settings

Set printer name

TCP/IP settings

IPv4

IP address/DNS server/Proxy server

IPv6

Enable/disable IPv6/IPsec settings/Use DHCPv6/Manual ad-
dress/DNS server

WSD setting

Enable/disable WSD

Enable/Disable
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Optimize inbound WSD

Enable/Disable

Timeout setting

20 minutes/15 minutes/10 minutes/5 minutes/1 minute

Bonjour settings

Enable/disable Bonjour

Enable/Disable

Service name

IEEE802.1X settings

Authentication

Do not use/TLS/TTLS/PEAP

EAP-TTLS internal auth. method

MSCHAPv2/PAP

Weak encryption restriction

Restrict/Do not restrict

Weak certificate restriction

Restrict/Do not restrict

Advanced setup

User-ID/Username/Password/Authentication server name

Last authentication result

SNTP settings

Client operation status

Active/Inactive

NTP/SNTP server address

Polling interval

Spanning tree setting

Active/Inactive

LPR protocol setting

Enable/Disable
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RAW protocol

ON/OFF

LLMNR

ON/OFF

Gigabit Ethernet settings

Autonegotiation/10 Mbps half duplex/10 Mbps full duplex/100 Mbps half duplex/100
Mbps full duplex/1 Gbps full duplex

Use Dedicated Port

ON/OFF

Wireless LAN DRX setting

Enable/Disable

Wired LAN DRX setting

Enable/Disable

Wireless Direct settings

Update SSID/password

Wireless Direct device name

Connection request confirmation

ON/OFF

Reset SSL certificates

Reset LAN settings

Paper-related settings

Roll paper auto feed

Enable/Disable

Keep media type

Enable/Disable

Manage remaining roll amount

Barcodes/Warning message/Disable

Roll amount warning setting
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Roll amount 1 (later warning)/Roll amount 2/Roll amount 3 (standard)/Roll amount 4/Roll amount 5/
Roll amount 6 (earlier warning)

Switch roll paper when low

Enable/Disable

Roll paper auto switching

Identify size/Do not identify size

Detect paper setting mismatch

Pause/Display warning/Do not detect/Hold job

Paper retention setting

Release/Retain

Advanced paper settings

Paper size recognition settings

Cut sheet setting 1/Roll paper setting 1/Roll paper setting 2/Roll paper setting 3/Roll paper
setting 4/Roll paper setting 5/Roll paper setting 6/Roll paper setting 7

Adjust roll unit

Print advanced paper settings

Reset paper settings for all paper

Auto maintenance settings

Auto nozzle check

Standard/1 page/10 pages/Disable

Nozzle check error display

Enable/Disable

System cleaning frequency

Standard/Short

Print pattern after new head

ON/OFF

Hard disk settings

Output method

Print/Print (auto delete)/Save to job box
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Save first and print

ON/OFF

Common job box setting

Print/Print (auto delete)

Data deletion

Fast/Fast secure/Secure

Monitoring service settings

Enable/disable monitoring service

Enable/Disable

Communication test

Yes/No

Communication log

Device user settings

Energy saving settings

Auto power off

5 minutes/10 min./30 min./1 hour/4 hours/8 hours/12 hours/OFF

Sleep timer

5 minutes/10 min./15 min./20 min./30 min./40 min./50 min./60 min./210 min.

Operation restrictions

Job history

Restrict/Do not restrict

Remote UI

Restrict/Do not restrict

Print from USB flash drive

Restrict/Do not restrict

Use USB connection

Use/Do not use

Date/time setting
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Date display format

YYYY/MM/DD / MM/DD/YYYY / DD/MM/YYYY

Time zone (GMT)

0/+1/+2/+3/+4/+5/+6/+7/+8/+9/+10/+11/+12/-12/-11/-10/-9/-8/-7/-6/-5/-4/-3/-2/-1

Length unit setting

Meters/Feet/inches

Buzzer setting

Enable/Disable

EOP timer setting

10 seconds/30 seconds/1 minute/2 minutes/5 minutes/10 minutes/30 minutes/60 minutes

Job history sending setting

Send/Do not send

Language selection

Firmware update

Install update

Check current version

Update notification setting

Yes/No

DNS server setup

Auto setup/Manual setup

Proxy server setup

Use/Do not use

Administrator password setting

Remote UI or other tools/LCD, Remote UI, or other tools

• Printer information

System information

Hard disk information
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Error history

Hardware error

Recoverable error

Paper feed/transfer error

Usage totals

Head information

Head alignment performance log

Values applied with auto settings
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Changing Settings from Operation Panel

This section describes the procedure to change the settings in the Device settings screen, taking the steps
to specify Print head movable width setting as an example.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Device settings.

Menu Operations

The Device settings screen appears.

3. Tap setting item to adjust.

The setting screen for the selected item appears.

4. Tap setting item.

5. Tap setting to specify.

196



For more on setting items on the operation panel:

Setting Items on Operation Panel
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Setting Items on Operation Panel

Note
• The administrator password is required to change some setting items if it is enabled for changing

settings using the operation panel.

For more on setting items which the administrator password is required:

Setting Administrator Password on Operation Panel

Items for Security
Administrator password setting

Items for Printer
Device user settings
Hard disk settings
Language selection
Firmware update

Items for Paper/Printing
Paper-related settings
Print settings

Items for Maintenance/Management
Job management
Printer information
Test print
LAN settings
Auto maintenance settings
Monitoring service settings
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Job management

Select this setting item from HOME screen.

• Print job

Displays the print job list. Tapping a job displays the details. You can also delete or preempt jobs on this
menu.

• Saved job

Displays the saved print job list. You can print job list on each saving box.

Note
• Enter the password if it is enabled for a personal box using Remote UI.

• Job history

Important
• The administrator password is required to display the job history if it is enabled for changing

settings using the operation panel.

◦ Display job history

Displays the print job history. Tapping a print job displays the details.

◦ Print job history

Prints out the print job history.

• Pause printing

Selecting Enable while a print job is in progress pauses the print job after the current job is completed.

• Delete all print jobs

Deletes all jobs in the job queue.
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Test print

Select this setting item from Device settings.

• Print nozzle check pattern

Prints out the nozzle check pattern.

Checking for Nozzle Clogging

• Status print

Prints out the printer status and setting value information.

Status Print

• Print LAN details

Prints out the network setting information list.

Printing Network Settings

• Print setting print

Prints out the print settings list.

• Print advanced paper settings

Prints out the setting values specified by Advanced paper settings.

• Print job history

Prints out a record of print jobs, including the paper type and size, amount of ink consumed, and so on.
Ink consumption indicates a rough estimate of the amount of ink consumed per print job.

Job management

• Print menu map

Prints out the menu list.

• Print color list for palettes

Prints out color pallet information.
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Print settings

Select this setting item from Device settings.

• Print head movable width setting

Adjusts the print head movable width.

• Prioritize paper size

Select Enable to use the paper size setting as the basis for printing instead of other settings. The text or
images in the margin are not printed.

Select Disable to give priority to printing text or images.

Note
• The printed paper length is longer than the actual paper length. This is because the printed paper

includes the upper/lower margins specified by Roll Paper Safety Margin and Leading Edge
Margin in the printer driver and excludes the paper margins.

• PDF print settings

Performs PDF print settings.

• JPEG print settings

Performs JPEG print settings.

• HP-GL/2 print settings

Performs HP-GL/2 print settings.

HP-GL/2 Settings

• Print from USB flash settings

Performs settings for printing data saved on the USB flash drive.

Setting Items for Printing Using Operation Panel

• Direct print settings from FTP

Performs print settings when printing directly from FTP. You can perform four settings individually.

• Default print settings

Prints out the default values of print settings.

• Print setting print

Prints out the print settings list.
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HP-GL/2 Settings

Menus on HP-GL/2 print settings

Menu Setting Combinations

Standard Size Table
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LAN settings

Select this setting item from Device settings.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

• Change LAN

Enables either wireless LAN, wired LAN, or wireless direct. You can also disable all.

• Wireless LAN setup

Selects the setup method for wireless LAN connection.

Note
• You can also enter this setting menu by selecting LAN settings on the HOME screen. In this case,

enable wireless LAN.

◦ Easy wireless connect

Select if you specify the settings of the access point information to the printer directly from a device
(e.g. smartphone, or tablet) without operating the wireless router. Follow the on-screen instructions
of the connecting device for the setup procedure.

◦ Standard setup

Select when you perform settings for wireless LAN manually using the operation panel of the printer.

◦ WPS (Push button method)

Select when you perform settings for wireless LAN using a wireless router supporting a Wi-Fi
Protected Setup (WPS) push button method. Follow the on-screen instructions during setup.

◦ Other setup

■ Advanced setup

Select when you perform settings for wireless LAN manually. You can specify multiple WEP
keys.

■ WPS (PIN code method)

Select when you perform settings for wireless LAN using a wireless router supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.

• Confirm LAN settings

The list of wireless/wired LAN settings or the wireless direct of this printer is displayed on the touch
screen.

For more information on the printer's network setting is printed out:

Printing Network Settings

Important
• The network settings printout contains important information about your network. Handle it with

care.
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◦ LAN setting list

The list of wired LAN settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the
printer settings.)

Items Setting

Connection Active/Inactive

IPv4 address XXX. XXX. XXX. XXX (12 characters)

IPv4 subnet mask XXX. XXX. XXX. XXX (12 characters)

IPv4 default gateway XXX. XXX. XXX. XXX (12 characters)

IPv4 DNS dynamic setting Active/Inactive

IPv4 DNS host name XXXXXXXXXXXX

IPv4 DNS domain name XXXXXXXXXXXX

IPv6 link-local address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 link-local prefix length XXX (up to 3 digits)

IPv6 manual address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 manual prefix length XXX (up to 3 digits)

IPv6 stateless address 1 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 stateless prefix length 1 XXX (up to 3 digits)

IPv6 stateless address 2 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 stateless prefix length 2 XXX (up to 3 digits)

IPv6 stateless address 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 stateless prefix length 3 XXX (up to 3 digits)

IPv6 stateless address 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 stateless prefix length 4 XXX (up to 3 digits)

IPv6 default gateway 1 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

204



IPv6 default gateway 2 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 default gateway 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 default gateway 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

DHCPv6 Active/Inactive

DHCPv6 stateful address XXXXXXXXXXXX

DHCPv6 stateful prefix length XXX (up to 3 digits)

IPv6 primary DNS server address XXXXXXXXXXXX

IPv6 secondary DNS server add. XXXXXXXXXXXX

IPv6 DNS dyn. update: manual Active/Inactive

IPv6 DNS dyn. update: stateless Active/Inactive

IPv6 DNS dyn. update: stateful Active/Inactive

IPv6 Use IPv4 host/domain name Active/Inactive

IPv6 DNS host name XXXXXXXXXXXX

IPv6 DNS domain name XXXXXXXXXXXX

MAC address XX:XX:XX:XX:XX:XX (12 characters)

IPsec settings Enable (ESP)/Enable (ESP & AH)/Enable (AH)/Disable

Pre-shared key XXXXXXXXXXXXXXXX (16 characters)

Authentication TLS/TTLS/PEAP/TTLS/PEAP/EAP-TTLS internal auth. method/
MSCHAPv2/PAP/Do not use

EAP-TTLS internal auth. method MSCHAPv2/PAP

Weak encryption restriction Restrict/Do not restrict

Weak certificate restriction Restrict/Do not restrict

Authentication server name XXXXXXXXXXXX

Client operation status XXXXXXXXXXXX

NTP/SNTP server address XXXXXXXXXXXX

Polling interval XXXXXXXXXXXX

Spanning tree setting XXXXXXXXXXXX

Printer name XXXXXXXXXXXXXXX (up to 15 characters)
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Bonjour service name XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX (up to 52 characters)

Root cert. thumbprint (SHA-1) XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX

Root cert. thumbprint (SHA-256) XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX

("XX" represents alphanumeric characters.)

◦ WLAN setting list

The list of wireless LAN settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the
printer settings.)

Items Setting

Connection Active/Inactive

SSID XXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXX (up to 32 characters)

Communication mode Infrastructure

Channel XX (up to 2 digits)

Wireless LAN security Inactive/WEP(64bit)/WEP(128bit)/WPA-PSK(TKIP)/WPA-PSK(AES)/
WPA2-PSK(TKIP)/WPA2-PSK(AES)

IPv4 address XXX. XXX. XXX. XXX (12 characters)

IPv4 subnet mask XXX. XXX. XXX. XXX (12 characters)

IPv4 default gateway XXX. XXX. XXX. XXX (12 characters)

IPv4 DNS dynamic setting Active/Inactive

IPv4 DNS host name XXXXXXXXXXXX

IPv4 DNS domain name XXXXXXXXXXXX

IPv6 link-local address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 link-local prefix length XXX (up to 3 digits)

IPv6 manual address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 manual prefix length XXX (up to 3 digits)
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IPv6 stateless address 1 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 stateless prefix length 1 XXX (up to 3 digits)

IPv6 stateless address 2 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 stateless prefix length 2 XXX (up to 3 digits)

IPv6 stateless address 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 stateless prefix length 3 XXX (up to 3 digits)

IPv6 stateless address 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 stateless prefix length 4 XXX (up to 3 digits)

IPv6 default gateway 1 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 default gateway 2 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 default gateway 3 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 default gateway 4 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

DHCPv6 Active/Inactive

DHCPv6 stateful address XXXXXXXXXXXX

DHCPv6 stateful prefix length XXX (up to 3 digits)

IPv6 primary DNS server address XXXXXXXXXXXX

IPv6 secondary DNS server add. XXXXXXXXXXXX

IPv6 DNS dyn. update: manual Active/Inactive

IPv6 DNS dyn. update: stateless Active/Inactive

IPv6 DNS dyn. update: stateful Active/Inactive

IPv6 Use IPv4 host/domain name Active/Inactive

IPv6 DNS host name XXXXXXXXXXXX

IPv6 DNS domain name XXXXXXXXXXXX

MAC address XX:XX:XX:XX:XX:XX (12 characters)

IPsec settings Enable (ESP)/Enable (ESP & AH)/Enable (AH)/Disable
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Pre-shared key XXXXXXXXXXXXXXXX (16 characters)

Client operation status XXXXXXXXXXXX

NTP/SNTP server address XXXXXXXXXXXX

Polling interval XXXXXXXXXXXX

Printer name XXXXXXXXXXXXXXX (up to 15 characters)

Bonjour service name XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX (up to 52 characters)

Root cert. thumbprint (SHA-1) XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX

Root cert. thumbprint (SHA-256) XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX

("XX" represents alphanumeric characters.)

◦ Wireless Direct setting list

The list of wireless direct settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the
printer settings.)

Items Setting

Connection Active/Inactive

SSID DIRECT-XXXX-XXXXXXseries

Password XXXXXXXXXX (10 characters)

Communication mode Wireless Direct

Channel 3

Wireless LAN security WPA2-PSK(AES)

IPv4 address XXX. XXX. XXX. XXX (12 characters)

IPv4 subnet mask XXX. XXX. XXX. XXX (12 characters)

IPv4 default gateway XXX. XXX. XXX. XXX (12 characters)

IPv4 DNS dynamic setting Active/Inactive

IPv4 DNS host name XXXXXXXXXXXX

IPv4 DNS domain name XXXXXXXXXXXX

IPv6 link-local address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)
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IPv6 link-local prefix length XXX (up to 3 digits)

MAC address XX:XX:XX:XX:XX:XX (12 characters)

IPsec settings Enable (ESP)/Enable (ESP & AH)/Enable (AH)/Disable

Pre-shared key XXXXXXXXXXXXXXXX (16 characters)

Printer name XXXXXXXXXXXXXXX (up to 15 characters)

Bonjour service name XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX (up to 52 characters)

Wireless Direct device name XXXXXX-XXXXXXseries

Root cert. thumbprint (SHA-1) XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX

Root cert. thumbprint (SHA-256) XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX

("XX" represents alphanumeric characters.)

◦ Print LAN details

Prints out the network setting information list.

Printing Network Settings

Note
• You can also print out the network setting information list by selecting Print LAN details on

Test print.

Test print

• Other settings

Important
• You cannot select the items below when Disable LAN is selected for Change LAN.

◦ Set printer name

Specifies the printer name. You can use up to 15 characters for the name.

Note
• You cannot use the same printer name as that already used for other LAN connected devices.
• You cannot use a hyphen for the initial or last character of the printer name.

◦ TCP/IP settings

Performs IPv4 or IPv6 setting.

◦ WSD setting
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Setting items when you use WSD (one of the network protocols supported in Windows 10, Windows
8.1, and Windows 7).

■ Enable/disable WSD

Selects whether WSD is enabled or disabled.

Note
• When this setting is enabled, the printer icon is displayed on the Network Explorer in

Windows 10, Windows 8.1, and Windows 7.

■ Optimize inbound WSD

Selecting Enable allows you to receive the WSD printing data faster.

■ Timeout setting

Specifies the timeout length.

◦ Bonjour settings

Setting items for LAN using Bonjour for macOS.

■ Enable/disable Bonjour

Selecting Enable allows you to use Bonjour to perform the network settings.

■ Service name

Specifies the Bonjour service name. You can use up to 48 characters for the name.

Note
• You cannot use the same service name as that already used for other LAN connected

devices.

◦ IEEE802.1X settings

Performs various settings for IEEE802.1.X.

◦ SNTP settings

Performs various settings for SNTP (Simple Network Time Protocol).

◦ Spanning tree setting

Enables/Disables spanning tree. Selecting Enable avoids circulating data on a network.

◦ LPR protocol setting

Enables/Disables the LPR setting.

◦ RAW protocol

Enables/Disables RAW printing.

◦ LLMNR

Enables/Disables LLMNR (Link-Local Multicast Name Resolution). Selecting Active allows the
printer to detect printer's IP address from the printer name without a DNS server.

◦ Gigabit Ethernet settings

Specifies the communication speed and communication method when using Gigabit Ethernet.

◦ Use Dedicated Port
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Selects whether to use a dedicated port for a command sent from a Canon application to the printer.

Selecting ON allows you to use the dedicated port.

◦ Wireless LAN DRX setting

Selecting Enable allows you to activate discontinuous reception when using wireless LAN.

◦ Wired LAN DRX setting

Selecting Enable allows you to activate discontinuous reception when the printer is connected to a
device compatible with wired LAN.

◦ Wireless Direct settings

Setting items are available when you connect a device to the printer.

Important
• You can select these setting items only when Activate direct connect. is selected for Change

LAN.

■ Update SSID/password

Selecting Yes updates the identifier (SSID) and password for wireless direct.

■ Wireless Direct device name

Changes the printer's name displayed on a Wi-Fi Direct compatible device.

■ Connection request confirmation

Selecting Yes displays the confirmation screen when a Wi-Fi Direct compatible device is
connecting the printer.

Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct Connection)

◦ Reset SSL certificates

Initializes SSL certificate information.

• Reset LAN settings

Initializes the network settings on the printer.

After resetting, perform setup again as necessary.
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Device user settings

Select this setting item from Device settings.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

• Energy saving settings

To save electricity, enable this setting to turn off the printer automatically or to enter sleep mode when
specified length of time has elapsed.

◦ Auto power off

Sets the time until the printer turns off automatically. If no operations are performed on the printer for
the specified duration of the time after entering Sleep mode, the printer automatically turns off.

◦ Sleep timer

Specifies the length of time to enter sleep mode automatically when no operation is made.

• Operation restrictions

Restricts the following operations.

◦ Job history

Restricts to display the print job history.

◦ Remote UI

Restricts to use Remote UI.

◦ Print from USB flash drive

Restricts to print data on USB flash drive.

• Use USB connection

Enables/Disables USB connection.

• Date/time setting

Sets the current date and time.

• Date display format

Sets the format of dates displayed on the touch screen and printed on photos.

• Time zone (GMT)

Specifies the time zone according to a country or region you live in.

Specifying the time zone allows you to display the correct time and date an e-mail was sent on your mail
software.

Select the time difference from GMT (Greenwich mean time) according to a country or region you live in.

• Length unit setting

Selects the length unit (meter or feet/inch).
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• Buzzer setting

The printer beeps once for warnings, and 3 times for errors when Enable is selected.

• EOP timer setting

Specify the timeout period before cancellation of print jobs that cannot be received by the printer.

• Job history sending setting

The printer sends a job history tool when Send is selected.

213



Language selection

Select this setting item from Device settings.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

Changes the language for the messages and menus on the touch screen.
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Paper-related settings

Select this setting item from Device settings.

• Roll paper auto feed

Enables/disables feeding roll paper automatically when you load it on the roll unit.

Selecting Enable detects the paper edge automatically and paper is loaded automatically only by
putting roll paper on the roll unit.

Select Disable if you load roll paper manually, or if you have any problem in feeding roll paper
automatically.

• Keep media type

Select Enable to keep using the same type of paper.

• Manage remaining roll amount

Selects the method to manage remaining roll amount and that to display warning when the roll is
running short.

◦ Barcodes

Manages remaining roll amount by using a barcode.

By using the barcode every time you replace a roll, you can manage remaining roll amount properly.
Specify the roll length properly when you load a new roll.

◦ Warning message

Estimates remaining roll amount by using media type and roll diameter information. A warning
appears when remaining roll amount comes closer to the specified value.

Depending on the environment you are using the printer, selecting this setting may not manage
remaining roll amount as precisely as you expected. We recommend you select a higher value for
this setting item.

◦ Disable

Select to disable managing remaining roll amount.

• Roll amount warning setting

Specifies when to warn the remaining roll paper amount.

• Switch roll paper when low

Switches the roll paper for printing automatically when the roll is running out while printing is in progress.

◦ Enable

This setting is valid only when Barcodes is selected for Manage remaining roll amount.

The roll paper for printing is switched with several rolls remaining.

◦ Disable

Switches the roll paper for printing by estimating the remaining amount based on the roll amount
value you entered.

To switch the roll, several rolls need to remain in the roll.
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Without several rolls when switching the roll, you may fail in roll switching.

In addition, if the roll length is not specified properly, paper may remain when switching, or it may
have run out while printing is in progress.

• Roll paper auto switching

Enables/Disables switching roll paper feed position by detecting the paper size.

• Detect paper setting mismatch

Selects printer action when you start printing with the paper size, the media type, and print settings
different from those registered.

• Paper retention setting

Selects whether to contact the roll nip with the rolls in feeding paper.

If you select Retain, the roll nip contacts with the rolls and automatic feeding is enabled.

If you select Release, the roll nip does not contact with the rolls and you can feed paper manually.
Selecting Release does not allow you to switch the paper source of rolls (upper or lower) automatically.

• Advanced paper settings

Specifies advanced paper settings for each paper feed position.

Important
• You can select Extension for borderless printing as a setting item for some paper types.

If you select Small for Paper with adequate width on this setting item, a slight border remains on
the paper. In addition, the paper may be smudged with extra ink.

• Paper size recognition settings

Selects which size is preferred when paper size detection is enabled.

◦ Cut sheet setting 1

Select whether ISO A3+ or 13"x19"(Super B) is applied when a sheet of an intermediate size is
detected.

◦ Roll paper setting 1

Select whether A3 or 300 mm is applied when a roll of an intermediate size is detected.

◦ Roll paper setting 2

Select whether B4 or 10 inch is applied when a roll of an intermediate size is detected.

◦ Roll paper setting 3

Select whether 300 mm or 12 inch is applied when a roll of an intermediate size is detected.

◦ Roll paper setting 4

Select whether 500 mm or 20"x24" is applied when a roll of an intermediate size is detected.

◦ Roll paper setting 5

Select whether B2 or 20"x24" is applied when a roll of an intermediate size is detected.

◦ Roll paper setting 6
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Select whether A1 or 600 mm is applied when a roll of an intermediate size is detected.

◦ Roll paper setting 7

Select whether 600 mm or 24 inch is applied when a sheet of an intermediate size is detected.

• Adjust roll unit

Select this setting item when you replace the roll unit.

• Print advanced paper settings

Tapping Yes prints out each setting specified in Advanced paper settings.

• Reset paper settings for all paper

Tapping Yes initializes each setting specified in Advanced paper settings.

Entering the administrator password is required if it is enabled.

Important
• When you set the paper settings back to the factory default, added or updated paper information

using Media Configuration Tool is erased.

In addition, the color calibration values are also erased.

Perform color calibration to specify the color calibration values.
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Auto maintenance settings

Select this setting item from Device settings.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

• Auto nozzle check

Enables/Disables automatic nozzle checking. You can also select the page interval to perform automatic
nozzle checking.

• Nozzle check error display

Enables/Disables displaying the nozzle check error.

• System cleaning frequency

Specifies the frequency of automatic system cleaning.

Note
• To maintain print quality, we recommend you select Short if you use the printer at a higher place.

• Print pattern after new head

Selects whether you print an adjustment pattern after replacing the print head.
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Administrator password setting

Select this setting item from Device settings.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

You can specify or disable the administrator password.

If you specify the administrator password, select the range and specify the administrator password.

Remote UI or other tools
Entering the administrator password is required to change the setting items using Remote UI or some
software.

LCD, Remote UI, or other tools
Entering the administrator password is required to change the setting items using the operation panel of
the printer, Remote UI, or some software.

For details:

Setting Administrator Password on Operation Panel
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Setting Administrator Password on Operation Panel

You can specify or disable the administrator password.

Specifying the administrator password requires you to enter the password to use the items or change the
settings below.

• LAN settings
• Device user settings
• Language selection
• Auto maintenance settings
• Hard disk settings
• Administrator password setting
• Status print (administrator)
• Monitoring service settings

Follow the procedure below to specify the administrator password.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Device settings.

Menu Operations

The Device settings screen appears.

3. Tap Administrator password setting.

4. When confirmation screen to specify administrator password is displayed, tap Yes.

If an administrator password is not specified, the register confirmation message appears. Tapping Yes
displays the message again. Tap OK.

Important
• The administrator password is set at the time of purchase. The printer's serial number is used as

the password.

For the administrator password, refer to Administrator Password.

5. Tap Change administrator password.

If you do not specify an administrator password, tap Remove administrator password. Tapping Yes
displays the message again. Tap OK.

6. Tap range where administrator password is valid.

Remote UI or other tools
Entering the administrator password is required to change the setting items using Remote UI or
some software.
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LCD, Remote UI, or other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, Remote UI, or some software.

7. Enter administrator password.

Important
• The following character restrictions apply to the password:

• Set the password by using 4 to 32 characters.
• The allowed characters are single-byte alphanumeric characters.
• For security reasons, we recommend you use 6 and more alphanumeric characters.

8. Tap Apply.

9. Enter administrator password you specified again.

10. Tap Apply.

The administrator password is enabled.

When You Want to Change or Disable the Administrator Password:
When the administrator password is enabled, tapping Device settings and Administrator password
setting in this order and entering the administrator password displays Change administrator password
and Remove administrator password on the touch screen. Select either item and follow the on-screen
instructions to perform settings.
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Hard disk settings

Select this setting item from Device settings.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

• Output method

Selects the printing method for jobs received from software other than the printer driver. When using the
printer driver, configure settings on the printer driver.

◦ Print

Performs printing as usual.

◦ Print (auto delete)

Deletes the data from the printer's hard disk after printing is completed.

◦ Save to job box

Only saves the print job in the box without printing it.

• Save first and print

A setting for jobs received from software other than the printer driver. When using the printer driver,
configure settings on the printer driver. Select ON to print the job after it has been saved.

• Common job box setting

Select Print (auto delete) to print without saving jobs in the box shared among multiple users.

• Data deletion

Selects the method to delete data on printer's hard disk.

Erasing Data on Printer's Hard Disk
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Monitoring service settings

Select this setting item from Device settings.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

• Enable/disable monitoring service

Selecting Active allows the printer to send error details to the service center.

• Communication test

Performs a communication test with the service center.

• Communication log

Displays the list of error numbers (up to 30), error code, and time the error occurs. Tapping an item
displays the error details.
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Printer information

Select this setting item from HOME screen.

• System information

Displays printer's system information.

• Hard disk information

Displays the total hard disk capacity and the mail box free space.

• Error history

Displays the error history.

◦ Hardware error

Displays the hardware error codes (up to 5).

◦ Recoverable error

Displays the recoverable error (e.g. paper or ink related error) codes (up to 5).

◦ Paper feed/transfer error

Displays the error codes for errors which occur during paper feed/transfer (up to 5).

Tapping an error code displays the error details.

For more on the error code, refer to List of Support Code for Error.

• Usage totals

Displays the printer's record of use such as total print area or the amount of ink consumption.

• Head information

Displays the print head serial number, elapsed days since the current print head was installed, and dot
count.

• Head alignment performance log

Displays the print head alignment performance log (up to 5).

• Values applied with auto settings

Displays the print settings applied the last print job.
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HP-GL/2 Settings

Menus on HP-GL/2 print settings

Menu Setting Combinations

Standard Size Table
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Menus on HP-GL/2 print settings

Color mode

Print quality

Input resolution

Print target

Paper src

Margin

Oversize

Conserve paper

Rotate

Auto rotation

Enlarge/Reduce

Print centered

Cut to standard size

Use nesting function

Nesting WaitTime

Print cut lines

Merge

Smooth

Thicken fine lines

Adjust faint lines

Width correction

Print color list for palettes

Warning display

Detect image size
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Color mode

Lets you specify the color(s) to use when printing HP-GL/2 data.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Print quality
settings.

• Color (perceptual) (Initial setting)

◦ If you select Line drawing for Print target:

Reproduces colors of general images naturally and features smooth gradation. In addition, selecting
this setting allows you to adjust colors easily using an application software.

◦ If you select Photo for Print target:

Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting
this setting allows you to adjust colors easily using an application software.

• Color (saturation)

◦ If you select Line drawing for Print target:

Prints in easy-to-see colors suitable for line drawing.

◦ If you select Photo for Print target:

Reproduces vivid colors on data such as a poster.

• Color (correct off)

Performs printing without color matching.

• Monochrome

◦ If you select Line drawing for Print target:

Select this setting to print a line drawing using black ink.

◦ If you select Photo for Print target:

Prints color data converting to monochrome. Continuous tones are reproduced using gray halftones.

• Monochrome BMP

The colors other than white are printed in black.
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Print quality

Lets you specify print quality.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Print quality
settings.

• 5 (Fast)

Select this setting for faster printing.

• 4

Printing speed is faster than that in selecting 3.

• 3 (Initial setting)

Select this setting for standard printing that balances print quality and printing speed.

• 2

Printing quality is higher than that in selecting 3.

• 1 (High)

Select this setting to give print quality priority.

This causes printing to take longer than other settings, but print quality is higher.
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Input resolution

Specifies the resolution for internal rendering process.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Print quality
settings.

• 600 dpi (Initial setting)

Specifies 600 dpi for internal rendering resolution.

This setting raises the accuracy of internal processes for finer printing.

• 300 dpi

Specifies 300 dpi for internal rendering resolution.

This setting increases the speed of internal processes for faster printing.
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Print target

Specifies the print target of HP-GL/2 data.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Print quality
settings.

• Line drawing (Initial setting)

Select this setting to print a drawing data which includes lines.

• Photo

Select this setting to print a data which includes illustration or photo.
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Paper src

Specifies the paper type (sheet or roll) for HP-GL/2 data printing.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

• Auto select (Initial setting)

Select an appropriate paper source automatically.

• Roll paper (auto)

Select a roll paper source (upper or lower) automatically.

• Roll paper 1

Select this setting to print on the upper roll paper.

• Roll paper 2

Select this setting to print on the lower roll paper.

• Manual

Select this setting to print on the sheets.
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Margin

Specifies the margins for HP-GL/2 data printing.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

Note
• If the Leading edge margin (roll) and/or Leading edge margin (sheet) settings on Advanced paper

settings are different from the settings here, the larger of the settings is given priority.

• 3mm (Initial setting)

Specifies 3 mm margin.

However, the trailing edge margin for cut sheet paper is 20 mm.

• 5mm

Specifies 5 mm margin.

However, the trailing edge margin for cut sheet paper is 20 mm.
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Oversize

Specifies whether margins are within or outside the HP-GL/2 data image drawing range.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

• Enable (Initial setting)

Specifies margins outside the HP-GL/2 data image drawing range.

Adding margins outside the image drawing range will not cause part of the image to be cut off.

However, you will need to print on paper of a size that is greater than the size of the image drawing
range specified by the HP-GL/2 data plus the top, bottom, left, and right margins.

• Disable

Specifies margins inside the HP-GL/2 data image drawing range.

Depending on the layout, adding margins inside the image drawing range may cause part of the image
to be cut off.

Note
• Some CAD applications can cause the origin to be out of position and part of the image to be cut

off. Experiment with the Disable and Enable settings of this function to find the one that works
best.

OVERSIZE SETTING EXAMPLES

A. Printed page size
B. Image drawing range

When you print an image above, using Oversize allows you to select where to apply margins (outside/
inside the image) based on the image drawing range.

Select Enable to apply margins outside the image, or select Disable to apply those inside.

• When Disable is selected:

Printing is performed based on the image drawing image range. The origin is specified on the upper
left of the paper.

Margins are added to the inside of the image drawing range.
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B. Image drawing range

C. Margins

If the actual drawing image is smaller than the specified image drawing range, the image is not cut off
by the margins.

• When Enable is selected:

Printing is performed based on the image drawing image range. The origin is specified on the upper
left of the paper.

Margins are added to the outside of the image drawing range.

B. Image drawing range

C. Margins

When you specify the paper size for printing, select the size which covers both the image drawing
range and margins.
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D. Paper for printing

E. Image drawing range with margins

If you select the paper size which cannot cover the margins, the image may be cut off.
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F. Range which cannot be printed

G. Paper for printing

236



Conserve paper

When printing on roll paper, eliminates blank space (margins) above and/or below the image (if there is any)
to conserve paper.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

• OFF (Initial setting)

Paper is not conserved.

• ON

Blank space above and below the image is eliminated when printing.

CONSERVE PAPER SETTING EXAMPLES
Print data (image drawing range)

• When OFF is selected:

• When ON is selected:
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Rotate

Rotates the image according to the specified setting.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

• 0 degrees (Initial setting)

Image is not rotated.

• 90 degrees

Specified image is rotated by 90 degrees.

If the part of rotated image is out of the paper width, the part is not printed.

Note
• When the print data includes HP RTL, the HP RTL image part is not rotated.

Note
• If ON is selected for Auto rotation, priority is given to the Auto rotation setting.
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Auto rotation

Printing on paper while Auto rotation is set to ON causes the image to be rotated automatically in
accordance with the most efficient image layout in order to conserve paper and avoid images running off the
edges of the paper.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

• OFF (Initial setting)

Images are not rotated automatically.

• ON

Image is rotated by 90 degrees in the cases described below.

◦ When the output page is in portrait orientation and the long side is shorter than the roll paper width
◦ When the output page is in landscape orientation, and the long side is longer than the paper width

and the short side is shorter than the paper width

Even if the long edge and short edge of the output page are both longer than the paper width, and
the output page is in landscape orientation, the image is rotated to expand the print range.

Note
• The length that the roll paper will be cut to depends on rotation.
• The desired printing results may not be obtained when HP-GL/2 data that does not include

image drawing range information is received.

In this case, select Command priority or Detected size for Detect image size.

• When the print data includes HP RTL, the HP RTL image part is not rotated.

AUTO ROTATE EXAMPLES
• Efficient layout

• Prevents image from running off edge.
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• Even if the image runs off the edge of the paper, it is rotated to expand the print range.
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Enlarge/Reduce

Enlarges or reduces images

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

• Same size (Initial setting)

Image is not enlarged/reduced.

• Scaling

Enlarges or reduces the image to the specified scaling value for printing.

Scaling can be specified within a range of 25 % to 400 %.

Note
• Data line or margin widths are not enlarged or reduced.

• Fit paper size

Enlarges or reduces the image for printing to fit to the paper loaded in the printer.

Note
• Data line widths are not enlarged or reduced.
• Margin widths are not enlarged or reduced. Because of this, paper size scaling and post-processing

image scaling may not be the same.
• Nesting cannot be performed while Fit paper size is selected.
• The maximum enlarge/reduce rate for this setting is calculated by (maximum width/1 inch x 100 %).

Therefore, the maximum rate is 2400 % for 24 inch model, 3600 % for 36 inch model, and 4400 %
for 44 inch model. If the calculation result exceeds the maximum rate, the image is enlarged
according to the maximum rate for each model.

ENLARGE/REDUCE Scaling SETTING EXAMPLE
The output object area is enlarged or reduced as specified by the Scaling setting. The origin is in the
upper-left corner.

For example, doubling the length and width of A4 size paper results in A2 size paper.

If there are margins of 3 mm, the A4 size output object area measures 291 mm x 204 mm.

Specify a value of 200% for the Scaling setting to produce a post-processing size of 582 mm x 408 mm.

(Note that ambient conditions may cause paper to expand and contract.)
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A. Output object area
B. 200% post-processing size

ENLARGE/REDUCE Fit paper size SETTING EXAMPLE
Fit paper size expands or reduces the long side of the print data's output object area so it matches the
long side of the output page size output object area. The origin is in the upper-left corner.

Margin widths are not enlarged or reduced. Because of this, paper size scaling and post-processing
image scaling may not be the same.

For example, doubling the length and width of A4 size paper results in A2 size paper.

If there are margins of 3 mm, the A4 size output object area measures 291 mm x 204 mm.

Specifying Fit paper size will result in a post-processing size of approximately 588 mm x 412 mm.

(Note that ambient conditions may cause paper to expand and contract.)
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A. Output object area
B. Fit to long side post-processing size
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Print centered

Prints the output object area in the center of the paper.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

• OFF (Initial setting)

The output object area is not printed in the center of the paper.

• ON

◦ For cut sheet paper

Prints the output object area in the center of the paper.

◦ For roll paper

Prints the output object area in the horizontal center of the paper.

Note
• The output object area is not printed in the center when the paper size is smaller than the

output page size.
• Nesting cannot be performed while ON is selected.

PRINT CENTERED EXAMPLES
• OFF is selected when printing on sheet

• ON is selected when printing on sheet

• OFF is selected when printing on roll
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• ON is selected when printing on roll

245



Cut to standard size

Specifies standard size as the output page size when printing on roll paper.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings.

• If OFF (Initial setting) is selected:

Cutting according to standard size is not performed.

• If ON is selected:

Cuts to standard size in accordance with the roll paper width.

When there are two lengths/widths applicable for a given roll paper width, the optimum size is selected
automatically.

Note
• Nesting cannot be performed while ON is selected.
• If ON is selected for Conserve paper and there is blank space above/below the image, the size will

not be standard size.
• When ON is selected for Print centered, printing will be in the center of the standard size.
• If there is no standard size corresponding to the roll paper width, operation is the same as if OFF is

selected. No message is displayed.
• When there are multiple width/length candidates in the roll 1 (upper) and roll 2 (lower) in a double-

roll printer model, the optimum standard size is selected automatically under the following
conditions.

• When any of the candidates accommodates the output page size, the standard size closest to
the minimum image range is selected for efficient printing.

• When none of the candidates accommodates the output page size, the largest standard size is
selected to expand the print range.

• For information about supported standard sizes, see the appendix at the back of this manual.

STANDARD CUT EXAMPLES
• A3-size width roll paper

A. Position of cut when OFF
B. Position of cut when ON

• A3-size width roll paper
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A. Position of cut when OFF
B. Position of cut when ON
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Use nesting function

When printing on roll paper, this function can be used to print multiple pages sequentially across the side of
the paper.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings
> Nesting.

• Disable (Initial setting)

Nesting is not performed.

• Enable

Print data is temporarily stored as a nesting wait page, and printed in a layout that arranges the pages
so they fill the width of the roll paper. Pages are aligned in the sequence they are received.

Up to 24 pages can be aligned across the paper. Pages are laid out in the next line from the 25th page.

Cutting is performed in accordance with the longest page among the aligned pages.

Note
• The desired printing results may not be obtained when HP-GL/2 data that does not include image

drawing range information is received.

In this case, select Command priority or Detected size for Detect image size.

• When the printer is being used in a network environment, nesting can be performed on HP-GL/2
data from multiple users.

• Nesting cannot be performed while any of the items below are specified.

• When Fit paper is selected for Enlarge/Reduce
• When ON is selected for Print centered
• When ON is selected for Cut to standard size

• In the cases below, printing starts even if the nesting wait page does not fill the entire width of the
roll paper.

• When data other than HP-GL/2 or HP RTL data is received.
• When data which you will print on paper other than a roll is received.

When the printer is being used in a network environment, the above types of data may be sent
from another user and preempt other jobs in the print queue.

• When the wait time specified by Nesting WaitTime elapses.
• During nesting wait, when Start print is selected on the touch screen and then tapping OK.
• When data with different print settings is received.

NESTING EXAMPLE
• When Disable is selected:
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• When Enable is selected:
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Nesting WaitTime

Can be used to set the wait time until printing starts after nesting wait page receipt is paused.

Time can be specified in the range of 1 to 99 minutes. (The initial value is 2 minutes.)

The wait time is counted from the point the last page was completed, and counted from the beginning every
time new nesting job is received.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings
> Nesting.
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Print cut lines

Prints cut lines to separate nested data.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Paper settings
> Nesting.

• Disable (Initial setting)

Cut lines are not printed.

• Enable

Cut lines that separate pages are printed.

CUT LINES EXAMPLE
• When Disable is selected:

• When Enable is selected:
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Merge

Specifies how colors should be processed when lines overlap.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Line
management.

Note
• The data is given priority when a specification command is included in the HP-GL/2 data.
• If the HP-GL/2 data does not include a specification command, the operation is performed using the

specified selection value.

• OFF (Initial setting)

The section where lines overlap becomes the same color as one of the intersecting lines.

• ON

The section where lines overlap becomes the mixed color of the intersecting lines.

ENABLE MERGE EXAMPLE
• When OFF is selected:

A. Data drawn previously
B. Data drawn later than A

• When ON is selected:

252



Smooth

Makes arc drawing smoother.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Line
management.

• Software (Initial setting)

Draws arcs using HP-GL/2 data settings.

Default value of the central angle of an arc in HP-GL/2 is 5° (Regular 72-sided polygon) if the angle is
not specified using a HP-GL/2 command.

• Smoothing

Draws curves that are smoother than arcs with a central angle of 1°.

SMOOTHING EXAMPLES
• When Software is selected:

• When Smoothing is selected:
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Thicken fine lines

Performs correction to avoid breaks in fine lines.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Line
management.

• OFF (Initial setting)

Thin lines are not corrected.

Some line thicknesses may cause them to become broken.

• ON

Corrects line widths so fine lines are drawn more sharply, without breaking.

The line color is not changed.
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Adjust faint lines

Performs correction so that bright colored fine lines are printed more clearly.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Line
management.

• OFF (Initial setting)

Fine lines are not corrected.

• ON

Adjusts the colors of brightly colored fine lines so they are drawn more clearly.
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Width correction

Corrects pen widths in accordance with a specific correction setting. Correction settings can be configured
for two groups: Black/gray and Color.

Select and apply the correction amount according to the pen color when performing a line drawing
command of HP-GL/2 data.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Line
management.

Note
• This setting is not applied for the white pen, which has the same RGB values (255).
• This setting is applied to vector data line widths.
• When this setting is a minus value, it is not applied to fine lines of widths that are less than the minimum

line width of the printer.
• If the setting value is smaller than 1 dot, the value of 1 dot width is applied.
• When ON is selected for Thicken fine lines, the resulting line may be thicker than the specified setting.

• Black/gray

For configuring the correction setting of black and gray line widths.

A value within the range of -20 to +20 can be specified. 1 unit of the correction value is equivalent to
0.025 mm.

• Color

For configuring the correction setting of color line widths.

A value within the range of -20 to +20 can be specified. 1 unit of the correction value is equivalent to
0.025 mm.

LINE WIDTH CORRECTION EXAMPLE
• Negative (-) setting

• Positive (+) setting
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Print color list for palettes

Prints out the color pallet which shows how 256 colors of HP-GL/2 command appear using the printer's ink.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Line
management.
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Warning display

Displays HP-GL/2 warnings.

The display is switched when two GL/2 warnings below occur.

• Warnings when the printer’s parameter setting specification does not support the parameter settings of
created HP-GL/2 data

• HP-GL/2 warning commands when the printer does not support the created HP-GL/2 data

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Processing
options.

Note
• Warning is always displayed when one of the errors below occurs regardless of the setting.

• When virtual GL/2 memory exceeds acceptable level
• When GL/2 display list memory is insufficient
• When the number of polygon vertexes which GL/2 data has exceeds acceptable level

• Warning is always displayed on the status monitor or Remote UI regardless of the setting.

• Disable (Initial setting)

Does not display specific GL/2 warning on the touch screen.

• Enable

Displays specific GL/2 warning on the touch screen.
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Detect image size

Specifies the output object area method that provides efficient printing, which avoids parts of images being
cut off when a HP-GL/2 data does not include image drawing range information.

Select this setting item from Device settings > Print settings > HP-GL/2 print settings > Processing
options.

• OFF (Initial setting)

◦ If image drawing range information is included in HP-GL/2 data:

The output object area is in accordance with the image drawing range information.

The origin specified by the image drawing range information is drawn in the upper-left corner of the
paper.

◦ If image drawing range information is not included in HP-GL/2 data:

The output object area uses the printer's maximum roll paper width as the horizontal dimension and
1.5 times the maximum roll paper width as the vertical dimension.

Even though the particular page included in multiple pages does not contain a command which
specifies the image drawing range, note that the image drawing range specified for the just previous
page is applied if previous pages contain the command.

• Command priority

◦ If image drawing range information is included in HP-GL/2 data:

The output object area is in accordance with the image drawing range information.

The origin specified by the image drawing range information is drawn in the upper-left corner of the
paper.

◦ If image drawing range information is not included in HP-GL/2 data:

Applies the minimum image range detected as the output object area.

The upper left corner of the detected minimum image range is drawn in the upper left corner of the
paper.

• Detected size

Applies the minimum image range detected as the output object area.

Image drawing range information included in HP-GL/2 data is not used.

The upper left corner of the detected minimum image range is drawn in the upper left corner of the
paper.

Note
• If part of an image is being cut off or if an image is out of alignment, try using each of the settings in the

following sequence: OFF, Command priority, Detected size.
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DETECT IMAGE SIZE EXAMPLE

A. Image drawing range specified by the command

B. Graphic data range

Though the image drawing range is specified for this kind of drawing image above, the part of the image
may be cut off if you do not specify the image drawing range.

Select Detected size if the image drawing range is not specified.

This section describes settings both when the image drawing range is specified and not specified.

• When the image drawing range is specified:

When OFF (Initial setting) or Command priority is selected:

When the image drawing range is specified, printing area is specified based on the setting. The origin
is specified on the upper left of the paper.

The figure below shows the printing image.

A. Image drawing range specified by the command

C. Paper cut position

If you select Detected size, the graphic data is detected for printing without using the specified image
drawing range. See "When Detected size is selected:" on "When the image drawing range is not
specified:".

• When the image drawing range is not specified:
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The result varies depending on the selected item.

◦ When OFF is selected:

The maximum roll paper width is applied as the width of printed area, and the 1.5 times of the
maximum roll paper width is applied as the length of it. The paper cut position is specified outside
of the printed area.

◦ When Command priority is selected:

The minimum image area is applied as the printed area.

The result is the same when you select Detected size.

See "When Detected size is selected:".

◦ When Detected size is selected:

The minimum image range including images is detected based on image data in HP-GL2 data.

In addition, if the image drawing range is not specified by Command priority , the minimum
image range including images is detected, as the area cannot be specified.

The figure below shows the printing image.

B. Graphic data range

C. Paper cut position
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Menu Setting Combinations

Conserve paper and Auto rotation

Enlarge/Reduce (Specify scaling) and Auto rotation

Print centered and Cut to standard size

Cut to standard size and Auto rotation and Enlarge/Reduce (Fit to paper)

Use nesting function and Auto rotation

Paper switching on a DOUBLE-roll printer model and Auto rotation

Paper switching on a DOUBLE-roll printer model and Enlarge/Reduce (Specify
scaling)

Detect image size and Oversize

Detect image size and Print centered
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Conserve paper and Auto rotation

When Conserve paper and Auto rotation are both specified, Auto rotation is performed first, followed by
the Conserve paper process.

After Auto rotation is applied to the print data, the image is printed with upper and lower blank areas
removed.

Conserve paper AND Auto rotation EXAMPLE

Print data (image drawing range)

Image after auto rotation

A. Blank area

Printed image
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Printed without upper/lower blank area.
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Enlarge/Reduce (Specify scaling) and Auto rotation

When both Enlarge/Reduce (Specify scaling) and Auto rotation are specified, Enlarge/Reduce (Specify
scaling) is done first and then Auto rotation is done to determine if printing is possible.

Printing is done without Auto rotation if the size of the image after doing Enlarge/Reduce (Specify scaling)
would cause the image to run off the edge of the paper were Auto rotation executed.

Enlarge/Reduce (Specify scaling) AND Auto rotation EXAMPLE

Print data (image drawing range)

• Printed image with Enlarge/Reduce (Specify scaling) only.

• Printed image when the image runs off the edge of paper.

Auto rotation is not performed.
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Print centered and Cut to standard size

When both Print centered and Cut to standard size are specified, first the optimum standard size is
determined based on the HP-GL/2 data and the roll paper loaded on the printer.

Next, Print centered is performed in accordance with the standard size.

Print centered AND Cut to standard size EXAMPLE
When A3 width roll paper is loaded, A3 portrait is chosen as the optimal standard size based on the roll
paper width and image size.

Next, Print centered is performed in accordance with the A3 portrait.

Print data (image drawing range)

A. Virtual area for A3 size (portrait)
B. Virtual area for A4 size (landscape)

• Printed image when ON is selected for Print centered and OFF is selected for Cut to standard size
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A. Position of cut

• Printed image when ON is selected for Print centered and ON is selected for Cut to standard size

A. Position of cut for A3 size (portrait)
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Cut to standard size and Auto rotation and Enlarge/Reduce (Fit to
paper)

When Cut to standard size, Auto rotation, and Enlarge/Reduce (Fit to paper) are all specified, first the
optimum standard size is determined based on the HP-GL/2 data and the roll paper loaded on the printer.

Next, Auto rotation and Enlarge/Reduce (Fit to paper) processes are performed in accordance with the
resulting standard size.

SMALL IMAGE EXAMPLE
When A3 width roll paper is loaded, A4 landscape is chosen as the optimal standard size based on the
roll paper width and image size.

Next, Auto rotation is performed in accordance with the A4 landscape. Finally, the image is enlarged and
printed to match A4 size paper.

Print data (image drawing range)

A. Virtual area for A4 size

Since the image fits on A4 size paper, A4 landscape is chosen as the standard size.

• Image after auto rotation

• Printed image after fit to paper
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A. Position of cut for A4 size

LARGE IMAGE EXAMPLE
When A3 width roll paper is loaded, A3 portrait is chosen as the optimal standard size based on the roll
paper width and image size.

Next, Auto rotation is performed in accordance with the A3 portrait. Finally, the image is reduced and
printed to match A3 size paper.

Print data (image drawing range)

A. Virtual area for A3 size

Since the image does not fit on A3 size paper, A3 portrait is chosen as the maximum standard size.

• Image after auto rotation
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• Printed image after reduced

A. Position of cut for A3 size
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Use nesting function and Auto rotation

When both Use nesting function and Auto rotation are specified, Auto rotation is performed as each
page is received and then the nesting process is performed.

The image on each received page is rotated as required to achieve an efficient layout that conserves paper
or to prevent the image from running off the edges of the paper, the images are laid out to fill the width of the
roll paper, and then printing is performed.

Use nesting function AND Auto rotation EXAMPLE

Print data (image drawing range)

The printing data images above are rotated for better paper usage (auto rotation).

The images above are positioned as shown below.

If an image is running off the edge of the paper as shown above, the image is rotated so that it fits in the
paper width.
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The images are positioned as shown below and printing is performed.
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Paper switching on a DOUBLE-roll printer model and Auto rotation

When ON is selected for Auto rotation, first a decision is made about performing Auto rotation and the
paper with less margin in the width direction is selected and starts printing.

At this point, it is decided whether to apply Auto rotation and then the paper source is selected considering
the condition such as whether the image is cut off or not, margin of paper width, and paper consumption.

This function is available when the paper settings of the printer are specified.

• Both upper and lower roll paper loaded, with paper fed from the upper roll.
• Identify size is selected for Device settings > Paper-related settings > Roll paper auto switching.
• Auto select is selected for Device settings > Print settings > HP-GL/2 print settings > Paper

settings > Paper src.

When the output page is in portrait orientation, image rotation is done first to conserve paper.

For a rotated image that is in landscape orientation, either the upper or lower paper roll is selected for
printing based on which roll results in the narrower side margins.

EXAMPLE OF PAPER SWITCHING ON A DOUBLE-ROLL PRINTER MODEL
AND Auto rotation

Print data (image drawing range)

Image after auto rotation

Image printed on upper roll paper already fed (Not printed)
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Image printed on lower roll paper already fed (Actually printed)

If the lower roll of paper has smaller margins than the upper roll of paper, from which the paper has been
fed, then paper is switched automatically, and the image is printed on the lower roll paper.
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Paper switching on a DOUBLE-roll printer model and Enlarge/
Reduce (Specify scaling)

The example below shows printing when Enlarge/Reduce (Specify scaling) is specified on a double-roll
printer model.

This function is available when the paper settings of the printer are specified.

• Different size of roll paper is loaded on the upper/lower roll, with paper source switching enabled.
• Identify size is selected for Device settings > Paper-related settings > Roll paper auto switching.
• Auto select is selected for Device settings > Print settings > HP-GL/2 print settings > Paper

settings > Paper src.

EXAMPLE OF PAPER SWITCHING ON A DOUBLE-ROLL PRINTER MODEL
AND Enlarge/Reduce (Specify scaling)

A4 size image

First, the image is enlarged and then the paper that can be used for printing the enlarged image is
selected.

A4 size image enlarged by 160 %

When the A1 width roll paper is loaded on the upper roll, A3 width roll paper on the lower, and the paper
source can be switched, and when an A4 size image is enlarged by 160 % specified in Scaling on
Enlarge/Reduce, the A1 width roll paper is selected, as the image width exceeds that of A3.
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Detect image size and Oversize

Operation is as described below when both Detect image size and Oversize are specified.

• When OFF or Command priority is selected for Detect image size and Disable is selected for
Oversize:

Oversize is disabled in accordance with the command-specified image drawing range.

Margins are added within the command-specified image drawing range.

Depending on the layout, part of the image may be cut off.

• When OFF or Command priority is selected for Detect image size and Enable is selected for
Oversize:

Oversize is enabled in accordance with the command-specified image drawing range.

Margins are added within the command-specified image drawing range.

The image is not cut off by the margins.

However, you will need to print on paper of a size that is greater than the size of the image drawing
range specified by the HP-GL/2 data plus the top, bottom, left, and right margins.

• When Detected size is selected for Detect image size and Disable is selected for Oversize:

Oversize is disabled and processing of the detected minimum image range is performed.

Margins are added within the detected minimum image range and parts of the image are cut off.

• When Detected size is selected for Detect image size and Enable is selected for Oversize:

Oversize is enabled and processing of the detected minimum image range is performed.

Margins are added outside the detected minimum image range.

The image is not cut off by the margins.

Detect image size AND Oversize EXAMPLE

The example below shows printing of data in which a figure is located in the upper left corner with
margins below and to the right, on roll paper that is larger than the command-specified image
drawing range (size normally specified by the application).

A. Command-specified image drawing range (when OFF or Command priority is selected for Detect
image size)

B. Minimum image range detected (when Detected size is selected for Detect image size)
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• When OFF or Command priority is selected for Detect image size and Disable is selected for
Oversize:

C: Position of cut

Cut at length of command-specified image drawing range.

• When OFF or Command priority is selected for Detect image size and Enable is selected for
Oversize:

D: Position of cut

Cut at length of upper and lower margins added to length of command-specified image drawing
range.

• When Detected size is selected for Detect image size and Disable is selected for Oversize:

E: Position of cut

Cut at length of minimum image range detected.
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• When Detected size is selected for Detect image size and Enable is selected for Oversize:

F: Position of cut

Cut at length of upper and lower margins added to length of minimum image range detected.
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Detect image size and Print centered

Operation is as described below when both Detect image size and Print centered are specified.

• When OFF or Command priority is selected for Detect image size:

Print centered is performed in accordance with the command-specified image drawing range.

• When Detected size is selected for Detect image size:

Print centered is performed in accordance with the detected minimum image range.

Detect image size AND Print centered EXAMPLE

• When OFF or Command priority is selected for Detect image size:

A. Command-specified image drawing range

Printed image

A. Position of cut

Prints the command-specified image drawing range in the horizontal center of the roll paper.

• When Detected size is selected for Detect image size:

A. Minimum image range detected
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Printed image

A. Position of cut

Prints the minimum image range in the horizontal center of the paper.
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Standard Size Table

The table below shows the standard sizes supported by Cut to standard size.

For details on the page size supported by your printer, refer to User's Guide.

Standard Size (Portrait) Width (mm) Height (mm) Standard Size (Landscape) Width (mm) Height (mm)

ISO A0 841.0 1189.0 ISO A1 841.0 594.0

ISO A1 594.0 841.0 ISO A2 594.0 420.0

ISO A2 420.0 594.0 ISO A3 420.0 297.0

A3 Nobi 329.0 483.0 No standard – –

ISO A3 297.0 420.0 ISO A4 297.0 210.0

ISO A4 210.0 297.0 No standard – –

Standard Size (Portrait) Width (mm) Height (mm) Standard Size (Landscape) Width (mm) Height (mm)

ISO B1 707.0 1000.0 ISO B2 707.0 500.0

ISO B2 500.0 707.0 ISO B3 500.0 353.0

ISO B4 250.0 353.0 No standard – –

Standard Size (Portrait) Width (mm) Height (mm) Standard Size (Landscape) Width (mm) Height (mm)

JIS B0 1030.0 1456.0 JIS B1 1030.0 728.0

JIS B1 728.0 1030.0 JIS B2 728.0 515.0

JIS B2 515.0 728.0 JIS B3 515.0 364.0

JIS B3 364.0 515.0 JIS B4 364.0 257.0

JIS B4 257.0 364.0 No standard – –

Standard Size (Portrait) Width (mm) Height (mm) Standard Size (Landscape) Width (mm) Height (mm)

ANSI E 863.6 1117.6 ANSI D 863.6 558.8

ANSI F1 711.2 1016.0 No standard – –

ANSI D 558.8 863.6 ANSI C 558.8 431.8

ANSI C 431.8 558.8 Ledger 431.8 279.4

Ledger 279.4 431.8 Letter 279.4 215.9

Letter 215.9 279.4 No standard – –

No standard – – Legal 355.6 215.9
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Standard Size (Portrait) Width (mm) Height (mm) Standard Size (Landscape) Width (mm) Height (mm)

ARCH E 914.4 1219.2 ARCH D 914.4 609.6

ARCH E1 762.0 1066.8 No standard – –

ARCH E2 660.4 965.2 No standard – –

ARCH E3 685.8 990.6 No standard – –

ARCH D 609.6 914.4 ARCH C 609.6 457.2

ARCH C 457.2 609.6 ARCH B 457.2 304.8

ARCH B 304.8 457.2 ARCH A 304.8 228.6

ARCH A 228.6 304.8 No standard – –

Standard Size (Portrait) Width (mm) Height (mm) Standard Size (Landscape) Width (mm) Height (mm)

DIN C1 648.0 917.0 DIN C2 648.0 458.0

DIN C2 458.0 648.0 DIN C3 458.0 324.0

DIN C3 324.0 458.0 DIN C4 324.0 229.0

DIN C4 229.0 324.0 No standard – –
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Status Print

You can print a "Status Print" report indicating the current status of the printer.

With "Status Print", information is printed regarding the printer firmware version, various settings, and the
status of consumables.

Follow the procedure below to print.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Device settings.

Menu Operations

3. Tap Test print.

4. Tap Status print.

Note
• If you specify the administrator password, tap Status print (administrator).

The printer starts printing.

The following information is included.

Canon xxxxxxxxxxxxxxxxxxxx Status Print Printer model

S/N Printer serial number

Firm Firmware version

Boot Boot ROM version

Date When the status print report was printed

Paper Info Prints information on the loaded paper for each paper feed posi-
tion.

Job Menu

Job History

Log * Information history
about each job (Job
name is printed as
"*".)

* Printed only when you select Status print (administrator).

Settings
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Printer Settings

Print Settings Setting value of Print head mov-
able width setting/Prioritize pa-
per size

Paper-related
settings

Setting value of Prioritize paper
size

Device settings

Auto mainte-
nance settings

Each setting value of Auto main-
tenance settings

Hard disk set-
tings

Each setting value of Hard disk
settings

Device user set-
tings

Each setting value of Device
user settings

Language se-
lection

Each setting value of Language
selection

Roll unit use
setting *2

Each setting value of Roll unit
use setting

*2 Printed only when you select ON.

Maintenance

Color calibration Setting value of Color calibration

Usage Condition

Hard disk information Hard disk capacity and Job box free space

Hardware error History information of Hardware error

Error History information of Recoverable error

Warning History information of warning

Maintenance cartridge us-
age / Remaining ink level

Information of Ink consumed

Duty counter Information of Duty counter

PARTS STATUS

COUNTER Prints out the parts status.

Head information
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HEAD LOT NUMBER/ DATE OF IN-
STALLATION

Print head lot number

Head alignment performance log

COUNTER

Media Use of each specified media

THE NUMBER OF CUTS Total number of cuts

AFTER INSTALLATION Days of use
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Changing Printer's Setting Using Web Browser

Configuration changes using the Web Browser

Changeable Setting Items Using Web Browser

Setting Password

Registering Printer's Root Certificate to Web Browser for SSL Communication
(Remote UI)

Registering Printer's Root Certificate to Local Computer for SSL
Communication

Generating Server Certificate (Self-signed Certificate)

Setting Mail Server

Receiving Printer Status by E-mail
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Configuration changes using the Web Browser

You can check the printer status and change the printer settings using the web browser on your
smartphone, tablet, or computer.

To check the printer status and to change the printer settings, display "Remote UI" on the web browser.

Note
• Remote UI is a software that enables you to perform operations, which are usually performed on the

printer's operation panel, using a Web browser over a network.

LAN connection with the printer is required to use Remote UI.

• You can use Remote UI on the following OS and the web browser.

• iOS device

OS: iOS 8.0 or later

Web browser: iOS standard Web browser (Mobile Safari)

• Android device

OS: Android 4.1 or later

Web browser: Android standard Web browser (Browser or Chrome)

• macOS device

OS: Mac OS X 10.9 or later

Web browser: Safari 7.0 or later

• Windows device

OS: Windows 7 SP1 or later

Web browser: Internet Explorer 11 or later, Google Chrome, Mozilla Firefox

1. Make sure printer is turned on.

2. Check printer's IP address.

Check the printer's IP address by following the steps below.

1. Flick HOME screen and tap  Device settings.

Menu Operations

The menu screen appears.

2. Tap LAN settings.

3. Tap Confirm LAN settings.

4. Tap LAN setting list or WLAN setting list.

5. Tap Yes.

6. Check IPv4 address.
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3. Open web browser on your smartphone, tablet, or computer and enter IP address.

Enter as following in the URL field of the web browser.

http://XXX.XX.X.XXX

Enter the IP address in "XXX.XX.X.XXX".

When you access, "Remote UI" will be displayed on the web browser on your smartphone, tablet, or
computer.

4. If you display Remote UI for the first time on your smartphone, tablet, or computer, select
For secure communication.

Download the root certificate, and then register it.

Registering Printer's Root Certificate to Web Browser

Note
• Once you register the root certificate to the web browser on your smartphone, tablet, or computer,

this step is not necessary after the next time.
• If the root certificate is not registered, a message to warn you that the secure connection is not

guaranteed may appear.

5. Select Log in.

The password authentication screen appears.

Note
• When the standard user mode is enabled, choose either administrator mode or standard user

mode to log on.

After choosing a mode and selecting Log in, the password authentication screen of each mode
appears.

6. Enter password.

When the password authentication is complete, the menus that can be utilized are displayed on the web
browser.

Important
• The password is set at the time of purchase. The password is the printer serial number. The

printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

For details on setting password, see Setting Password.

7. Check printer status and change printer settings.

For changeable setting items, see below.

Changeable Setting Items Using Web Browser

289



8. When you finish checking printer status and changing printer settings, select Log out.

9. Close web browser.
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Changeable Setting Items Using Web Browser

Note
• The items described here and the items displayed in the web browser may differ in display order.
• The item which can be used is different in administrator mode or in standard user mode.

Items for Security
Security (Item for administrator)

This function allows you to specify the password, the standard user mode settings, and SSL/TLS
settings of certificate for encrypted communication.

This function allows you to specify the password, the standard user mode settings, the operation
restrictions, and SSL/TLS settings of certificate for encrypted communication.

For details on setting password, see Setting Password.

Operation panel lock (Item for administrator)
Select this item from Custom settings on Device settings.

Selecting Enable disables any operations using the operation panel.

A message informing you that operations are invalid appears when you tap the touch screen. An
error or warning is displayed even while this function is enabled.

Items for Maintenance/Management
Utilities

This function allows you to set and execute the printer utility functions such as cleaning.

Job management
This function allows you to display the job history and print it. In addition, you can delete jobs from
this item.

Note
• When you are logging on in administrator mode, you can restrict this function in standard user mode.

System info and LAN settings
This function allows you to check the system information and to change the LAN settings.

Using IP filtering in Other settings in LAN settings, you can permit or refuse the connection of a
specific IP address for IPv4 address or IPv6 address.

Using SNMP settings in Other settings in LAN settings, you can specify the SNMP and MIB setting
to management the printer via a network.

Important
• If you have refused the IP address of administrator's device using IP filtering by mistake, reset LAN

settings of the printer. To reset LAN settings, select System info and LAN settings > LAN settings
> Other settings > Reset LAN settings, and then select Yes.

Note
• Some of the menu is available only when you logged on in administrator mode.
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Language selection (Item for administrator)
This function allows you to change the language on the display.

Items for Printer
Device settings

This function allows you to change the printer settings such as the quiet setting, the energy saving
settings, and the print settings.

Additionally, this function allows you to receive the printer status information such as the remaining
ink level and the error.

Setting Mail Server
Receiving Printer Status by E-mail

You can disable any operations using the operation panel from Operation panel lock on Custom
settings.

Note
• Some of the menu is available only when you logged on in administrator mode.

Other Items
Printer status

This function displays printer information such as the remaining ink amount, the status, and detailed
error information.

You can also connect to the ink purchase site or support page, and use Web Services.

Manual (Online)
This function displays the Online Manual.
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Setting Password

Each of passwords for administrator and standard user can be set.

When logging on with password for administrator, all settings can be changed.

When logging on with password for standard user, some of the settings can be changed.

When logging on with password for administrator, you can restrict the function for standard user.

Setting Administrator Password
Setting Standard User Password

Note
• Password can be set only when you are logged in administrator mode.

Setting Administrator Password
Change the administrator password by following the steps below.

Important
• The password is set at the time of purchase. The password is the printer serial number. The printer

serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

1. Display printer status on web browser.

2. Select Security.

The menus appear.

3. Select Administrator password setting.

4. Select Change administrator password.

If the administrator password is not set, registration confirming message is displayed. Select Yes.
When message is displayed again, select OK.

5. Select range where administrator password is valid and select OK.

Remote UI or other tools
Entering the administrator password is required to change the setting items using the Remote UI
or some software.

Operation panel/Remote UI/other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, the Remote UI, or some software.

6. Enter password and select OK.

Important
• The following character restrictions apply to the password:
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• Set the password by using 4 to 32 characters.
• The allowed characters are single-byte alphanumeric characters.
• For security reasons, we recommend you use 6 and more alphanumeric characters.

7. When completion message appears, select OK.

Setting Standard User Password
For restricting the function for standard user, enable the standard user mode and set a standard user
password by following the steps below.

1. Display printer status on web browser.

2. Select Security.

The menus appear.

3. Select Standard user mode settings.

4. When confirming message appears, select Yes.

5. Enter password and select OK.

Important
• The following character restrictions apply to the password:

• Set the password by using 4 to 32 characters.
• The allowed characters are single-byte alphanumeric characters.
• For security reasons, we recommend you use 6 and more alphanumeric characters.

6. When completion message appears, select OK.
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Registering Printer's Root Certificate to Web Browser for SSL
Communication (Remote UI)

If the printer's root certificate has not been registered to the web browser, a message to warn you that the
secure connection is not guaranteed may appear.

When you display Remote UI for the first time on your smartphone, tablet, or computer, download the root
certificate, and then register it to the web browser. The secure connection will be confirmed and a message
will not appear. However, the message may appear depending on a web browser even after you have
registered the root certificate.

How to register the root certificate varies depending on the web browser.

For Internet Explorer
For Safari
For Chrome on Android
For Mobile Safari on iOS

Operating procedure may differ depending on the version of your web browser. For other web browser, refer
to each help.

Important
• Make sure that you have accessed to the printer IP address correctly by checking the URL field of the

web browser before registering the root certificate.

• If the printer is connected via IPv6 using Windows, you need to generate a server certificate using
Remote UI.

For details, see Generating Server Certificate (Self-signed Certificate).

For Internet Explorer

1. Select Download on Remote UI.

Downloading the root certificate is started.

2. If confirmation screen appears, select Open.

Certificate screen is displayed.

Note
• To save the certificate file to your device and register it, select Save. Select Internet options

from Tool menu of Internet Explorer, register the root certificate from Certificates on Content
sheet.

3. Select Install Certificate.

Certificate Import Wizard screen is displayed.

4. Select Next.
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5. Select Place all certificates in the following store.

6. Select Browse.

Select Certificate Store screen is displayed.

7. Select Trusted Root Certification Authorities and OK.

8. Select Next on Certificate Import Wizard screen.

9. If Completing the Certificate Import Wizard appears, select Finish.

Security Warning screen is displayed.

10. Make sure that thumbprint on Security Warning screen matches printer's thumbprint.

For printer's thumbprint, touch the HOME button, select Device settings -> LAN settings -> Confirm
LAN settings -> WLAN setting list or LAN setting list -> Yes, and then check Root cert.
thumbprint (SHA-1) or Root cert. thumbprint (SHA-256).

11. If thumbprint on Security Warning screen matches printer's thumbprint, select Yes.

12. Select OK on Certificate Import Wizard screen.

The root certificate registration is completed.

For Safari

1. Select Download on Remote UI.

Downloading the root certificate is started.

2. Open the downloaded file.

Keychain access starts up and Add Certificates screen is displayed.

3. Select Add.

Information on the certificate is displayed.

Note
• You can also add the certificate by selecting Show Certificate, checking certificate name to

add, and then selecting the same certificate on Keychain access.

4. Make sure that fingerprint of certificate detail information matches printer's thumbprint.

For printer's thumbprint, touch the HOME button, select Device settings -> LAN settings -> Confirm
LAN settings -> WLAN setting list or LAN setting list -> Yes, and then check Root cert.
thumbprint (SHA-1) or Root cert. thumbprint (SHA-256).

296



5. If fingerprint of certificate detail information matches printer's thumbprint, display
information on certificate from the menu or by double-clicking the certificate, and select
Always Trust on Trust.

The root certificate registration is completed.

Note
• If a password is set on your device, entering a password may be required.

For Chrome on Android

1. Select Download on Remote UI.

Downloading the root certificate is started and then Name the certificate screen is displayed.

2. As entering the root certificate name is required, enter an arbitrary certificate name and
select OK.

The root certificate registration is completed.

Note
• If PIN or password is not set as security type, the attention screen may appear. Select OK, and

then set the security type to PIN or password.

After Root Certificate Registration
We recommend that you make sure that the correct root certificate has been registered.

To make sure that the correct root certificate has been registered, make sure that thumbprint of
certificate information matches printer's thumbprint. Follow the steps below.

Note
• Some Android devices cannot be checked the thumbprint of a registered route certificate.

1. From Settings menu on your device, select Security, Trust credentials, and USER.

The list of downloaded certificates appears.

2. Select downloaded certificate.

The certificate information appears.

3. Make sure that thumbprint of certificate information matches printer's thumbprint.

For printer's thumbprint, touch the HOME button, select Device settings -> LAN settings ->
Confirm LAN settings -> WLAN setting list or LAN setting list -> Yes, and then check Root
cert. thumbprint (SHA-1) or Root cert. thumbprint (SHA-256).

4. If thumbprint of certificate information screen matches printer's thumbprint, select OK.

The root certificate registration is completed.
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If the message to warn you that the secure connection is not guaranteed appears when you select
Log in on Remote UI after registering the root certificate, restart the web browser. The message
will not appear on the web browser.

Note
• Depending on the Android device, a warning may appear even after registering the proper root

certificate.

For Mobile Safari on iOS

1. Select Download on Remote UI.

Downloading the root certificate is started and then Install Profile screen is displayed.

2. Select Install.

Warning screen is displayed.

Note
• If a password is set on your device, entering a password may be required.

3. Select Install.

4. Select Install on displayed dialog.

The root certificate registration is completed.
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Registering Printer's Root Certificate to Local Computer for SSL
Communication

To use Device Management Console or Accounting Manager, etc. when you connect the printer to a
computer using SSL encrypted communication, you need to register (import) the printer’s root certificate to
your computer.

Procedure to register the certificate varies depending on your operation environment.

Important
• If the printer is connected via IPv6 using Windows, you need to generate a server certificate using

Remote UI.

For details, see Generating Server Certificate (Self-signed Certificate).

For Windows 10/Windows 8.1
For Windows 7
For macOS

Operation procedure may differ depending on your OS version.

For Windows 10/Windows 8.1
The procedure below describes how to import a root certificate in Windows 10/Windows 8.1.

1. Specify printer’s IP address using web browser.

Enter the printer’s IP address in the address bar of your web browser and press the Enter key.

The Remote UI screen appears.

2. Click For secure communication.

The For secure communication screen appears.

Note
• You can download a certificate from Status Monitor.

1. Open status monitor.

Open the printer's property, and click Status Monitor on Main.

2. Download a certificate.

Select Download Security Certificate from the Remote UI menu.

3. Click Download.

4. Select Open or Save.

5. Select Open.

If you select Save in step 4, double-click the saved certificate.
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The Certificate screen appears.

6. Click Install Certificate.

The Certificate Import Wizard screen appears.

7. Select Local Machine.

1. Select Local Machine on the startup screen of Certificate Import Wizard.

2. Click Next.

3. Click Yes on the displayed screen.

8. Select Place all certificates in the following store on the Certificate Store screen.

9. Select Trusted Root Certificate Authorities.

1. Click Browse to open the Select Certificate Store screen.

2. Select Trusted Root Certificate Authorities from the list and click OK.

3. Click Next on the Certificate Store screen.

10. Click Finish.

When the Completing the Certificate Import Wizard screen appears, check the settings and click
Finish.

For Windows 7
The procedure below describes how to import a root certificate in Windows 7.
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Important
• Be sure to create a certificate snap-in before importing a root certificate.

The root certificate will be registered to the local user if you import it without creating a certificate
snap-in.

Creating Certificate Snap-in

1. Start up Microsoft Management Console

Enter MMC on Search programs and files in the Start menu and press the Enter key.

2. Select Yes on displayed screen.

3. Click Add/Remove Snap-in from File menu.

The Add or Remove Snap-ins screen appears.

4. Add Certificate snap-in.

1. Select Certificates from Available snap-ins list and click Add.

2. Select Computer account for This snap-in will always manage certificates for on the
Certificates snap-in screen and click Next.

3. Select Local computer on the Select computer screen and click Finish.

4. Click OK on the Add or Remove Snap-ins screen.

Downloading Certificate

1. Specify printer’s IP address using web browser.

Enter the printer’s IP address in the address bar of your web browser and press the Enter key.

The Remote UI screen appears.
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2. Click For secure communication.

The For secure communication screen appears.

Note
• You can download a certificate from Status Monitor.

1. Open status monitor.

Open the printer's property, and click Status Monitor on Main.

2. Download a certificate.

Select Download Security Certificate from the Remote UI menu.

3. Click Download.

4. Select Save.

Importing Certificate

1. Open Certificate Import Wizard.

1. On the left window, open Trusted Root Certificate from Certificate on Console Root.

2. Right-click Certificates and select Import from All tasks.

2. Specify certificate file to import.

1. Click Next.

2. Specify the certificate file to import on File name and click Next.

3. Specify certificate store.

1. Click Place all certificates in the following store.

2. Select Trusted Root Certificate Authorities for Certificates Store.

4. Finish certificate import wizard.

1. Click Next and check the specified settings.

2. Click Finish to finish the wizard.

3. Click OK on the displayed screen.

Checking Imported Certificate
Make sure the imported certificate has been registered to your computer.

1. Display certificate list.
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On the left window of Microsoft Management Console, select Console Root -> Certificates (Local
Computer) -> Trusted Root Certificate Authorities in this order, and click Certificates to display
the certificate list.

2. Check registered certificate.

Make sure the imported certificate name is displayed on the list.

Note
• Make sure you can see the registered certificate from Current user by creating the Current

user snap-in.

Note
• When you finish Microsoft Management Console, a message asking you whether to save the console

setting. If you continue to apply the same settings next, click Yes to save.

For macOS
The procedure below describes how to import a root certificate in macOS.

1. Specify printer’s IP address using web browser.

Enter the printer’s IP address in the address bar of your web browser and press the Enter key.

The Remote UI screen appears.

2. Click For secure communication.

The For secure communication screen appears.

3. Click Download.

The root certificate will be downloaded.

4. Open downloaded certificate file.

When the download procedure is completed, a downloaded item pops up on the right of the screen.

Double-click the downloaded certificate on the list starts up Keychain Access and the Add
Certificates screen appears.

Note

• If the downloaded item does not pop up, click the Show Downloads  button on the right.
• Clicking the magnifying glass icon on the right of download list displays the folder containing the

certificate.

5. Click Add.

Select the destination for the certificate on Keychain.
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Clicking Add displays information on the certificate.

Note
• You can add the certificate by selecting the same certificate on Keychain Access. Check the

name of certification to add after selecting View Certificates.

6. Check certificate.

Make sure the fingerprint of certificate shown on Details corresponds with the root certificate
thumbprint of the printer.

Select Device settings -> LAN settings -> Confirm LAN settings -> LAN setting list or WLAN
setting list -> Yes in this order, and check Root cert. thumbprint (SHA-1) or Root cert. thumbprint
(SHA-256) to check the root certificate thumbprint of the printer.

7. Click Always Trust.

If the fingerprint of certificate detail information matches printer's thumbprint, display information on
certificate from the menu or by double-clicking the certificate, and select Always Trust on Trust.

The root certificate has been registered.

Note
• Entering the password may be required if you specify it for your printer.
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Generating Server Certificate (Self-signed Certificate)

When you use SSL connection via IPv6 network, you need to generate an IPv6 server certificate using the
printer.

Generate the server certificate from Remote UI.

Follow the procedure below.

1. Checking Printer's IP Address

2. Generating Server Certificate

3. Checking Generated Server Certificate

Important
• If you generate an IPv6 server certificate, you cannot use SSL communication via IPv4. In addition, a

warning message may appear if you are using Remote UI.

To reset the IPv6 server certificate, select Device settings -> LAN settings -> Other settings in this
order, and select Yes for Reset SSL certificates from the operation panel.

Checking Printer's IP Address

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Device settings.

Menu Operations

The Device settings screen appears.

3. Tap LAN settings.

4. Tap Confirm LAN settings.

5. Tap LAN setting list or WLAN setting list according to the printer connection method.

6. Check displayed message and tap Yes.

7. Check the value on IPv6 link-local address.

Write down the value on IPv6 link-local address for your reference when you open Remote UI or
generate a server certificate.

Generating Server Certificate

1. Open web browser on your smartphone, tablet, or computer and enter the printer IP
address.

305



Enter as following in the URL field of the web browser.

http://[XXXX::XXXX:XXXX:XXXX:XXXX]

On "XXXX::XXXX:XXXX:XXXX:XXXX", enter the abbreviation value on IPv6 link-local address.

The top screen of Remote UI appears.

2. Select Log in on Remote UI.

Note
• If you specify the administrator password, enter the password.

3. Select Security.

4. Select SSL/TLS settings.

5. Select Generate key and certificate.

6. Select Generate self-signed cert.

The Generate self-signed cert screen appears.

Specify each setting item.

• Signature algorithm

Select SHA256.

• Public key length (bits)

Select 2048 bits.

• Specify the expiration date.

Enter the date you generated the server certificate on Valid from.

Enter the date the server certificate expires on Valid to.

• Enter the common name.

Enter the value in Common name you checked and wrote down on IPv6 link-local address
shown on the touch screen.

Note
• When you enter the common name, add [ ] to each end of the abbreviation value of the

printer's IPv6 address .
• Do not use a comma or make a space for the common name.

7. Select Next.

You need not enter anything on Country, State or province, Locality, Organization, or
Organizational unit.

8. Select Generate.
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The server certificate starts to be generated.

When the server certificate has been generated, Generated a self-signed certificate. appears.

9. Select Restart LAN.

LAN will be restarted.

When LAN has been restarted, Printer status on Remote UI appears.

Note
• If you cannot access to Remote UI after you restart LAN, reload your web browser.

Checking Generated Server Certificate

1. Select Security on Remote UI.

2. Select SSL/TLS settings.

The SSL/TLS settings screen appears.

3. Select Check key and certificate.

The Check key and certificate screen appears.

Make sure the issuer of the root certificate is displayed on Issuer, and the value you entered is
displayed on Common name on Subject.
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Setting Mail Server

To use mail function, specify the mail server settings.

Note
• If you did not specify the time zone setting using the printer's operation panel, a message to inform you

that the correct time may not be reflected on the sent e-mail appears. We recommended that you set
the time zone setting using the printer's operation panel.

For the time zone setting, see Device user settings.

• These functions can be set only when you are logged in administrator mode.

1. Display printer status on web browser.

2. Select Device settings.

The menus appear.

3. Select Set mail server.

4. Select Set mail server.

The setting items for mail server appear.

5. Specify mail server settings.

Specify the following items.

Sender address
Enter the e-mail address of the sender (this printer).

Outgoing mail server (SMTP)
Enter the address of your SMTP server.

Port number (SMTP)
Enter the port number of your SMTP server.

Secure connection (SSL)
Select if you use the secure connection (SSL).

Don't verify certificates
Select if you do not verify the certificate.

Authentication method
Select one of the following authentication methods.

SMTP authentication
Select if you send e-mail with SMTP authentication.

Next, you can specify the following settings.

• Outgoing account

Enter the account name for sending to perform the authentication.

• Outgoing password
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Enter the password for sending to perform the authentication.

POP before SMTP
Select if you send e-mail with POP before SMTP authentication.

Next, you can specify the following settings.

• Incoming mail server (POP3)

Enter the address of your POP server.

• Port number (POP3)

Enter the port number of your POP server.

• Incoming account

Enter the account name for receiving to perform the authentication.

• Incoming password

Enter the password for receiving to perform the authentication.

• Use APOP authentication

Select if you send the password by the encryption transmission.

• Clear mailbox

Select if you delete the e-mails that remain in the POP3 server.

Important
• When this setting is enabled, e-mail in the Inbox on the server will have all been removed. If you

specify the e-mail address of your everyday, be sure to disable this setting as unread e-mail is
not deleted. We recommended that you prepare this printer dedicated e-mail account not to
accidentally delete the unread e-mail.

No authentication
Select if the authentication is not necessary.

6. After specifying mail server settings, select OK.

The setting operation is completed.
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Receiving Printer Status by E-mail

You receive the printer status information such as the remaining ink level and the error from the printer.

Note
• Specify the mail server settings in advance.

Setting Mail Server

• If you did not specify the date and time setting using the printer's operation panel, the date and time
may not be reflected on the sent e-mail. We recommended that you set the date and time setting using
the printer's operation panel.

For the date and time setting, see Device user settings.

• These functions can be set only when you are logged in administrator mode.

Specify the information settings by following the steps below.

1. Display printer status on web browser.

2. Select Device settings.

The menus appear.

3. Select Status notification e-mail.

4. Select Notification recipients.

The screen to register the destination appears.

5. Specify destination settings.

Up to 5 destinations can be registered by following the steps below.

1. Select number of destination.

2. Select Register.

3. Enter e-mail address, and then select printer status to send information.

4. Select OK.

The registration for destination is completed.

6. Select Device settings > Status notification e-mail > Retry settings.

7. Specify resending settings.

The number of resending can be specified by following the steps below.

1. Specify number of resending.

2. Specify interval of resending.

3. Select OK.

310



The resending setting is completed.
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Printer Parts

Printer Parts

Front

Back

Top Cover (Inside)

Carriage

Ink Tank Cover (Inside)
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Printer Hard Disk Operations
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Parts of the Stacker
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Printer Parts

Front

Back

Top Cover (Inside)

Carriage

Ink Tank Cover (Inside)

Operation Panel

Stand Parts

Parts of the Basket
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Front

(A) Top Cover
Open this cover to install the print head, load paper, and remove any jammed paper from inside the
printer as needed. (See "Top Cover (Inside).")

(B) Output Guide
Guides printed documents as they are ejected. Open this guide when loading a roll.

(C) Roll holder Slot
Slide the Roll Holder into this slot.

(D) Roll Holder
Load the roll on this holder.

(E) Holder Stopper
Secure the roll on the Roll Holder with this part.

(F) Release Lever
To release paper retainer, lift the lever.

(G) Maintenance Cartridge Cover
Open this cover to replace the maintenance cartridge.
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(H) Maintenance Cartridge
Ink used for maintenance purposes such as head cleaning is absorbed. (Replace the cartridge when it
is full.)

(I) Stand
A stand that holds the printer. Equipped with casters to facilitate moving it. (See "Stand Parts.")

(J) USB flash drive port
Insert a USB flash drive to this port.

(K) Touch Screen
Use this screen to operate the printer and check the printer status. (See "Operation Panel.")

(L) Ink Tank Cover
Open this cover to replace the ink tank. (See "Ink Tank Cover (Inside).")
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Back

(A) Carrying Grips
When carrying the printer, have six people hold it by these handles under both sides.

(B) USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.

(C) Wired LAN Connector
Connect an Ethernet cable to this port. The lamp is lit if the Ethernet cable is connected correctly and
communication is possible between the computer and printer.

(D) Power Cord Connector
Connect the power cord to this connector.

(E) Roll Unit Power Supply Inlet
Connect the connection cord for the roll unit.

(F) Spare Ink Box
Stores the ink tank that is not used.
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Top Cover (Inside)

(A) Top Cover Roller
Prevents paper from rising when ejected.

(B) Cleaning Brush
When cleaning inside the printer under the top cover, use this brush to sweep away paper dust on the
platen.

(C) Cutter Blade
A round-bladed cutter for automatic paper cutting.

(D) Paper Alignment Line
Align paper with this line when loading it.

(E) Carriage
Moves the print head. It serves a key role in printing. (See "Carriage.")

(F) Carriage Shaft
The Carriage slides along this shaft.

(G) Platen
The print head moves across the platen to print. Vacuum holes on the platen hold paper in place.

(H) Borderless Printing Ink Grooves
For catching ink outside the edges of paper during borderless printing.

(I) Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.
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Carriage

(A) Angle Adjustment Lever
Fine-tunes the line misalignment when printing.

(B) Print Head Locking Cover
Secures the print head.

(C) Print Head
The printhead is equipped with ink nozzles. The carriage serves a key role in printing.

(D) Print Head Lock Lever
Lock print head locking cover.
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Ink Tank Cover (Inside)

*1:The figure shows the printer as loaded with a 23.7 fl oz (700 ml) ink tank.

(A) Ink Color Label
Load an ink tank that matches the color and name on this label.

(B) Ink Lamp (red)
Indicates the state of the ink tank as follows when the ink tank cover is opened.

• On

The ink tank is installed correctly.

• Off

No ink tank is installed, or the ink level detection function is disabled.

• Flashing

Ink tank is empty.

Note

• When there is little ink left, the ink lamp is lit and  appears on the touch screen.

(C) Ink Tank
Cartridges of ink in various colors.

(D) Ink Tank Lock Lever
A lever that locks the ink tank in place and protects it. Lift and lower the lever when replacing an ink
tank. To open it, lift the stopper of the lever until it stops, and then push it down toward the front. To
close it, push it down until it clicks into place.
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Hard Disk

Printer Hard Disk Operations

Checking Free Hard Disk Space

Erasing Data on Printer's Hard Disk
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Printer Hard Disk Operations

Printer hard disk operations are available from the following programs and interfaces.

• Printer driver

• Remote UI

• Operation panel

The hard disk operations available through each interface are as follows.

Operation Printer driver Remote UI Operation
panel

Saving print jobs Save in mail box ✓ - -

Do not save print jobs in the common box - - ✓

Save print jobs sent from sources other than
the printer driver

- - ✓

Operations with saved jobs Print saved jobs - ✓ ✓

Delete saved jobs - ✓ ✓

Job queue management Display job queue - ✓ ✓

Delete - ✓ ✓

Preempt jobs - ✓ ✓

Operations with held jobs - ✓ ✓

Mail box management Move saved jobs - ✓ -

Modify saved jobs - ✓ -

Modify mail boxes - ✓ -

Print a list of saved jobs - - ✓

Display a list of saved jobs - ✓ ✓

Other operations Display free hard disk space - ✓ ✓

Initialize hard disk - - ✓

Display the time of printing - ✓ ✓

Display error messages - ✓ ✓
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Checking Free Hard Disk Space

Check the space available on the printer's hard disk as follows.

This operation is available using the operation panel or Remote UI.

Using Operation Panel
Using Remote UI

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Printer information.

Menu Operations

3. Tap Hard disk information.

The free hard disk space appears.

Using Remote UI

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Hard disk information.

The free hard disk space is shown in the upper-right corner.
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Erasing Data on Printer's Hard Disk

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.
• For a more secure method of preventing data recovery, we recommend physically or magnetically

destroying the hard disk. In this case, the hard disk can no longer be used.
• You cannot erase HDD data if there is a job queue. Additionally, print jobs are not processed while data

erasing is in progress.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Device settings.

Menu Operations

3. Tap Hard disk settings.

4. Enter administrator password if it is enabled.

5. Tap erasing method.

Fast
Erases file management data for print job data stored on the printer's hard disk. Choose this method
for relatively fast erasure. Because only the file management data is erased, the print job data itself
is not erased.

Fast secure
Erases the data encryption key specified for the hard disk drive. Specifying the encryption key again
does not allow you to read and use data saved in the past safely and fast. Select to erase highly
confidential data.

Secure
Overwrites the entire hard disk with 00, FF, and random data (one time each) after the data
encryption key specified for the hard disk drive is erased. Verification is performed to check if the
data was correctly written. Choose this method to erase especially confidential data. It is virtually
impossible to recover the overwritten data. Conforms to the DoD5220.22-M standard of the U.S.
Department of Defense.

6. Check the message that is displayed and tap Yes.

Data on the hard disk are erased.
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Optional accessories

Stand

Stand Parts

Parts of the Basket

Roll unit

Parts of the Roll Unit

Stacker

Parts of the Stacker
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Stand

The following Stand can be used with the printer.

• Printer Stand SD-21

For more information on the main parts of the Stand, see "Stand Parts."

Important
• When moving the Stand, be sure to set the locking caster lock to the OFF position to release the lock.

If you move it while the locking caster are locked, the floor may become scratched.

Note
• For instructions on installing the Stand, see the Setup Guide provided with the Stand.
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Stand Parts

(A) Stand Unit
A stand that holds the printer. Equipped with casters to facilitate moving the printer.

(B) Basket
Catches the ejected printed documents. (See "Parts of the Basket.")

For instructions on how to use the basket, see "Using the Basket" and "Example Basket
Configurations".

(C) Locking Caster
A locking caster that, when the lock is in the ON position, immobilizes the printer.

When moving the Stand, be sure to set the locking caster lock to the OFF position to release the lock.

If you move it while the locking casters are locked, the floor may become scratched.

(D) Accessory Pocket
Store printer manuals, assembly tools, and other items in this pocket.
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Parts of the Basket

(A) Basket Rod (tag side)
Secures the cloth basket to the tips of the basket arm.

(B) Basket Arm
Retains the basket rod (tag side).

By changing the length and the angle, you can make the basket suitable for various conditions.

When not using the basket, you can lower it and store alongside of the stand. (See "Storing the
Basket.")

(C) Basket
A cloth tray that catches ejected documents.

(D) White Tag
Marks indicating basket attachment orientation.

(E) Basket Rewind Button
Press this button when rewinding the basket after it has been wound on the basket rod (tag side).

(F) Basket Rod (cord side)
Secures the cloth basket on the rod holder.

(G) Rod Holder
Retains the basket rod (cord side).

For instructions on using the basket, see "Using the Basket."
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Roll Unit

You can use the following roll unit with this printer.

• roll unit RU-22

For details on the main parts of the roll unit, see "Parts of the Roll Unit."

Note
• For instructions on installing the roll unit, see the documentation provided with the roll unit.
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Parts of the Roll Unit

(A) Roll Holder Lock Switch
Locks and releases the Roll Holder loaded in the roll unit.

(B) Feed Mode Lamp
Lights up when you have selected the feed mode on the roll unit.

(C) Auto Take-up Lamp
Lights up when the paper is being taken up.

(D) Pause Lamp
Lights up when the paper winding is paused.

(E) Take-up Button
You can rotate the roll unit the desired amount as long as winding is not in progress. When the winding
direction is set to inward winding, the unit takes up the paper; when it is set to outward winding, the unit
rewinds the paper.

(F) Rewind Button
You can rotate the roll unit the desired amount as long as winding is not in progress. When the winding
direction is set to inward winding, the unit rewinds the paper; when it is set to outward winding, the unit
takes up the paper.

(G) Auto Take-up/Pause Button
Pauses and resumes the taking up of paper.

(H) Inward/Outward Winding Changeover Switch
Changes the winding direction when the paper is wound (inward winding and outward winding).

(I) Take-up Mode Lamp
Lights up when you have selected the take-up mode on the roll unit.

(J) Roll Holder Slot
Slide the Roll Holder into these guide grooves.
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(K) 3-Inch Paper Core Attachment
Attaches to the Roll Holder when you are using a roll paper with a 3-inch paper core.

(L) Feed Flap Switch
Change the feed flap position depending on the roll unit mode.

(M) Roll Holder
Load the roll on this holder.

(N) Holder Stopper
This part secures the roll paper on the Roll Holder.
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Stacker

The following stacker can be used in this printer.

• Stacker SS-21

For details on the main parts of the stacker, see "Parts of the Stacker."

Important
• When moving the stacker, be sure to set the locking caster lock to the OFF position to release the lock.

If you move it while the locking casters are locked, the floor may become scratched.

Note
• For instructions on installing the stacker, see Setup Guide provided with the stacker.

• Depending on your region, these might be included as standard or they might be available as optional
accessories.
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Parts of the Stacker

(A) Rod (fixed)
Move it forward and back to switch the position of the stacker.

(B) Basket
A cloth tray that catches ejected documents.

(C) Arm
When using the stacker with the Position 1, attach the rod (adjustable) to the lower of the arm.

Example Stacker Configurations

(D) Rod (adjustable)
Changes the position of the stacker by moving the rod (adjustable) to the lower of the arm or the upper
of the stand.

(E) Stand
A stand that holds the stacker. Equipped with casters to facilitate moving the printer.

When using the stacker with the Position 2, the Position 3 or the Position 4, attach the rod (adjustable)
to the upper of the stand.

Example Stacker Configurations

(F) Paper Stopper
When stacking printed materials with a 24-inch width or of A1 portrait, attach it to the lower of the
second part from the right of the flapper.

Store the paper stopper in the accessory pocket of the stand when not in use.

(G) Flapper
Changes the position of the stacker by setting the flapper vertically or horizontally.
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Network Setting

Network Connection Tips

Printer Connection Methods

Default Network Settings

Another Printer Found with Same Name

Connecting to Another Computer via LAN/Changing from USB to LAN
Connection

Printing Network Settings

Reconfiguration Method of LAN Connection/Reconfiguration Method of Wireless
LAN Connection

Reconfiguration of Network Settings using the Remote UI

Network Status and Troubleshooting

Network Settings (IJ Network Device Setup Utility) (Windows)

IJ Network Device Setup Utility

Starting Up IJ Network Device Setup Utility

Diagnosing and Repairing Network Settings

Performing/Changing Network Settings

List of Models Which Does Not Support Diagnosis and Repair Function

Other Network Information

Network Settings (IJ Network Device Setup Utility) (Mac OS)

IJ Network Device Setup Utility

Starting Up IJ Network Device Setup Utility

Diagnosing and Repairing Network Settings

List of Models Which Does Not Support Diagnose and Repair Function

Other Network Information

Sharing the Printer on a Network (Windows)

Setting Up a Shared Printer

Restrictions on Printer Sharing
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Sharing the Printer on a Network (macOS)

Settings on Print Server

Settings on Client PC

Restrictions on Printer Sharing

Connecting Smartphone/Tablet to Printer via Wireless LAN

Connecting Smartphone/Tablet to Printer via Wireless LAN Router
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Network Connection Tips

Printer Connection Methods

Default Network Settings

Another Printer Found with Same Name

Connecting to Another Computer via LAN/Changing from USB to LAN
Connection

Printing Network Settings

Reconfiguration Method of LAN Connection/Reconfiguration Method of
Wireless LAN Connection

Reconfiguration of Network Settings using the Remote UI

Network Status and Troubleshooting
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Printer Connection Methods

Select one of the connection methods below to connect the printer to a smartphone/tablet.

Wireless LAN Connection
Wired LAN Connection
USB Connection

Wireless LAN Connection
Connect the printer to a smartphone/tablet via wireless LAN.

Select one of the methods below for wireless LAN connection.

• Connecting using a wireless router

Note
• USB connection with a computer is available even while the printer is connected to a computer or

smartphone/tablet.

• Connecting without a wireless router (Wireless Direct)

For more on wireless LAN connection:

Restrictions
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Wired LAN Connection
Connect the printer and computer to a router using a LAN cable.

Note
• USB connection with a computer is available even while the printer is connected to a computer via

wired LAN.

For more on wired LAN connection:

What Is Ethernet Cable?
Restrictions

USB Connection
Connect the printer to a computer using a USB cable.
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For more on USB connection:

What Is USB Cable?
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Default Network Settings

LAN Connection Defaults

Item Default

Change LAN Activate wired LAN

SSID BJNPSETUP

Communication mode Infrastructure

Wireless LAN security Disable

IP address (IPv4) Auto setup

IP address (IPv6) Auto setup

Set printer name* XXXXXXXXXXXX

Enable/disable IPv6 Enable

Enable/disable WSD Disable

Timeout setting 15 minutes

Enable/disable Bonjour Enable

Service name Canon TX-2000

LPR protocol setting Enable

Wireless LAN DRX setting Enable

Wired LAN DRX setting Enable

("XX" represents alphanumeric characters.)

* Default value depends on printer. To check value, use operation panel.

LAN settings

Wireless Direct Defaults

Item Default

SSID (Identifier for wireless direct) DIRECT-abXX-TX-2000 *1

Password YYYYYYYYYY *2

Wireless LAN security WPA2-PSK (AES)

Wireless Direct device name ZZZZZZ-TX-2000 *3

Connection request confirmation Displayed

*1 "ab" is specified at random and "XX" represents last two digits of printer's wireless MAC address.
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*2 The password is specified automatically when the printer is turned on for the first time.

*3 "ZZZZZZ" represents last six digits of printer's wireless MAC address.
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Another Printer Found with Same Name

When the printer is found during setup, other printers with the same name may appear on the results
screen.

Select a printer with checking the printer settings against those on detection result screen.

Check the printer's MAC address or serial to select the correct printer from the results.

Note
• Serial number may not appear on result screen.

Check the printer's MAC address and the serial number by one of the following methods.

• Display on the touch screen.

MAC address

LAN settings

Serial number

Printer information

• Print the network settings.

Printing Network Settings
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Connecting to Another Computer via LAN/Changing from USB to
LAN Connection

For Windows:
For macOS:

For Windows:
To add a computer to connect to the printer on a LAN or to change from USB to LAN connection, perform
setup using the Setup CD-ROM or follow the instructions on the Canon website.

For macOS:
To connect an additional computer to the printer via LAN, or to change from USB to LAN connection,
follow the instructions on the Canon website.

342



Printing Network Settings

Use the operation panel to print the printer's current network settings.

Important
• The network settings printout contains important information about your network. Handle it with care.

1. Make sure printer is turned on.

2. Load plain paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer

If you use sheets, prepare at least 10 sheets (A4 or Letter-sized).

Loading Sheets in the Printer

3. Flick HOME screen and tap  Device settings.

Menu Operations

The menu screen appears.

4. Tap Test print.

If you specify the administrator password, enter the password.

5. Tap Print LAN details.

6. Tap Yes.

The printer starts printing network settings information.

Note
• You can also print the printer's network settings. Tap Device settings on the HOME screen, tap

LAN settings and Confirm LAN settings in this order, and then tap Print LAN details and tap
Yes.

The printed network settings information is as follows: (Some setting values are not displayed depending
on the printer settings.)

Item Description Setting

LAN Setting Basic setting information -

Basic Info IPv4 setting information (Wired LAN) -

LAN Interface Mode Current interface Wired LAN/Wireless LAN(Infra)/Wire-
less LAN(AP)/Wireless(Wireless di-
rect)/Disabled
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Link Active Operation status Inactive/Active

IP Address IPv4 IP address XXX.XXX.XXX.XXX

Gateway Address IPv4 default gateway XXX.XXX.XXX.XXX

Subnet Mask IPv4 subnet mask XXX.XXX.XXX.XXX

IP Mode Acquiring method of IPv4 IP address Auto IP/DHCP/Manual

Use DNS Auto Mode Acquiring DNS server automatically On/Off

Primary DNS Server Address Primary DNS server address XXX.XXX.XXX.XXX

Secondary DNS Server Address Secondary DNS server address XXX.XXX.XXX.XXX

Control Filtering SNMP filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select IP filtering method Disabled/Enabled

IP Filtering Permission Address IP filtering permission address -

Start Address 1 Start address 1 XXX.XXX.XXX.XXX

End Address 1 End address 1 XXX.XXX.XXX.XXX

Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX.XXX.XXX.XXX

End Address 2 End address 2 XXX.XXX.XXX.XXX

Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX.XXX.XXX.XXX

End Address 3 End address 3 XXX.XXX.XXX.XXX

Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX.XXX.XXX.XXX

End Address 4 End address 4 XXX.XXX.XXX.XXX

Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX.XXX.XXX.XXX

End Address 5 End address 5 XXX.XXX.XXX.XXX

Use Single On 5 Use single on 5 On/Off

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 1 Start address 1 XXX.XXX.XXX.XXX
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End Address 1 End address 1 XXX.XXX.XXX.XXX

Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX.XXX.XXX.XXX

End Address 2 End address 2 XXX.XXX.XXX.XXX

Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX.XXX.XXX.XXX

End Address 3 End address 3 XXX.XXX.XXX.XXX

Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX.XXX.XXX.XXX

End Address 4 End address 4 XXX.XXX.XXX.XXX

Use Single On 4 Use single on 4 On/Off

LAN Setting Basic setting information -

Basic Info IPv4 setting information (Wired LAN) -

Control Filtering SNMP filtering setting information -

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 5 Start address 5 XXX.XXX.XXX.XXX

End Address 5 End address 5 XXX.XXX.XXX.XXX

Use Single On 5 Use single on 5 On/Off

Print Filtering Print filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select IP filtering method Disabled/Enabled

IP Filtering Permission Address IP filtering permission address -

Start Address 1 Start address 1 XXX.XXX.XXX.XXX

End Address 1 End address 1 XXX.XXX.XXX.XXX

Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX.XXX.XXX.XXX

End Address 2 End address 2 XXX.XXX.XXX.XXX

Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX.XXX.XXX.XXX
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End Address 3 End address 3 XXX.XXX.XXX.XXX

Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX.XXX.XXX.XXX

End Address 4 End address 4 XXX.XXX.XXX.XXX

Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX.XXX.XXX.XXX

End Address 5 End address 5 XXX.XXX.XXX.XXX

Use Single On 5 Use single on 5 On/Off

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 1 Start address 1 XXX.XXX.XXX.XXX

End Address 1 End address 1 XXX.XXX.XXX.XXX

Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX.XXX.XXX.XXX

End Address 2 End address 2 XXX.XXX.XXX.XXX

Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX.XXX.XXX.XXX

End Address 3 End address 3 XXX.XXX.XXX.XXX

Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX.XXX.XXX.XXX

End Address 4 End address 4 XXX.XXX.XXX.XXX

Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX.XXX.XXX.XXX

End Address 5 End address 5 XXX.XXX.XXX.XXX

Use Single On 5 Use single on 5 On/Off

LAN Setting Basic setting information -

IPv6 Info IPv6 setting information (Wired LAN) -

Link Local Address Link local address -

IP Address IPv6 IP address XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX
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Prefix Length Link local address prefix length XXX (0 to 128)

Use Manual Mode Operation status of IPv6 manual ad-
dress

On/Off

Manual Address Manual address -

IP Address IPv6 IP address XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length Prefix length XXX (0 to 128)

Use Stateful Address Mode Operation status of stateful address
mode

On/Off

Stateful Address Stateful address -

IP Address IPv6 IP address XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length Prefix length XXX (0 to 128)

Stateless Address Stateless address -

IP Address 1 IP address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length 1 Prefix length 1 XXX (0 to 128)

IP Address 2 IP address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length 2 Prefix length 2 XXX (0 to 128)

IP Address 3 IP address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length 3 Prefix length 3 XXX (0 to 128)

IP Address 4 IP address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length 4 Prefix length 4 XXX (0 to 128)

Gateway Address Gateway address -

IP Address 1 IP address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length 1 Prefix length 1 XXX (0 to 128)

IP Address 2 IP address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length 2 Prefix length 2 XXX (0 to 128)
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IP Address 3 IP address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length 3 Prefix length 3 XXX (0 to 128)

IP Address 4 IP address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Prefix Length 4 Prefix length 4 XXX (0 to 128)

Use DNS Auto Mode Acquiring DNS server automatically On/Off

Primary DNS Server Address Primary DNS server address XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Secondary DNS Server Address Secondary DNS server address XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Control Filtering SNMP filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select IP filtering method Disabled/Enabled

IPv6 Filtering Permission Info IPv6 filtering permission information -

IP Filtering Start Address 1 IP filtering start address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 1 IP filtering end address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 1 Use single on 1 On/Off

LAN Setting Basic setting information -

IPv6 Info IPv6 setting information (Wired LAN) -

Control Filtering SNMP filtering setting information -

IP Filtering Start Address 2 IP filtering start address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 2 IP filtering end address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 2 Use single on 2 On/Off

IP Filtering Start Address 3 IP filtering start address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 3 IP filtering end address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 3 Use single on 3 On/Off
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IP Filtering Start Address 4 IP filtering start address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 4 IP filtering end address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 4 Use single on 4 On/Off

IP Filtering Start Address 5 IP filtering start address 5 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 5 IP filtering end address 5 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 5 Use single on 5 On/Off

IPv6 Filtering Prohibit Info IPv6 Filtering prohibit information -

IP Filtering Start Address 1 IP filtering start address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 1 IP filtering end address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 1 Use single on 1 On/Off

IP Filtering Start Address 2 IP filtering start address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 2 IP filtering end address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 2 Use single on 2 On/Off

IP Filtering Start Address 3 IP filtering start address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 3 IP filtering end address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 4 IP filtering end address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 4 Use single on 4 On/Off

IP Filtering Start Address 5 IP filtering start address 5 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 5 IP filtering end address 5 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX
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Use Single On 5 Use single on 5 On/Off

Print Filtering Print filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select IP filtering method Disabled/Enabled

IP Filtering Permission Info IP filtering permission information -

IP Filtering Start Address 1 IP filtering start address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 1 IP filtering end address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 1 Use single on 1 On/Off

IP Filtering Start Address 2 IP filtering start address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 2 IP filtering end address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 2 Use single on 2 On/Off

LAN Setting Basic setting information -

IPv6 Info IPv6 setting information (Wired LAN) -

Print Filtering Print filtering setting information -

IP Filtering Start Address 3 IP filtering start address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 3 IP filtering end address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 4 IP filtering end address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 4 Use single on 4 On/Off

IP Filtering Start Address 5 IP filtering start address 5 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 5 IP filtering end address 5 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 5 Use single on 5 On/Off
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IPv6 Filtering Prohibit Info IPv6 Filtering prohibit information -

IP Filtering Start Address 1 IP filtering start address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 1 IP filtering end address 1 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 1 Use single on 1 On/Off

IP Filtering Start Address 2 IP filtering start address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 2 IP filtering end address 2 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 2 Use single on 2 On/Off

IP Filtering Start Address 3 IP filtering start address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 3 IP filtering end address 3 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 4 IP filtering end address 4 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 4 Use single on 4 On/Off

IP Filtering Start Address 5 IP filtering start address 5 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

IP Filtering End Address 5 IP filtering end address 5 XXXX:XXXX:XXXX:XXXX
XXXX:XXXX:XXXX:XXXX

Use Single On 5 Use single on 5 On/Off

MAC Info MAC address setting information
(Wired/Wireless LAN)

-

MAC Address(Wired) MAC address (Wired LAN) XX:XX:XX:XX:XX:XX

MAC Address(Wireless) MAC address (Wireless LAN) XX:XX:XX:XX:XX:XX

Use MAC Address Filtering Operation status of MAC address fil-
tering

On/Off

MAC Filtering Select MAC address filtering method Disabled/Enabled

MAC Filtering Permission Info MAC filtering permission information -
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MAC Address 1 MAC address 1 XX:XX:XX:XX:XX:XX

MAC Address 2 MAC address 2 XX:XX:XX:XX:XX:XX

MAC Address 3 MAC address 3 XX:XX:XX:XX:XX:XX

MAC Address 4 MAC address 4 XX:XX:XX:XX:XX:XX

MAC Address 5 MAC address 5 XX:XX:XX:XX:XX:XX

LAN Setting Basic setting information -

MAC Info MAC address setting information
(Wired/Wireless LAN)

-

MAC Filtering Prohibit Info MAC filtering prohibit information -

MAC Address 1 MAC address 1 XX:XX:XX:XX:XX:XX

MAC Address 2 MAC address 2 XX:XX:XX:XX:XX:XX

MAC Address 3 MAC address 3 XX:XX:XX:XX:XX:XX

MAC Address 4 MAC address 4 XX:XX:XX:XX:XX:XX

MAC Address 5 MAC address 5 XX:XX:XX:XX:XX:XX

Proxy Setting Proxy server setting information -

Use Proxy Use proxy server On/Off

Proxy Server Address Proxy server address XXXXXXXXXXXXXXXX (up to 128
characters)

Proxy Port Number Proxy port specification 1 to 65535

Use User Authority Mode Use user authority mode On/Off

Proxy Server User Name Proxy server user name XXXXXXXXXXXXXXXX (up to 64
characters)

Wireless LAN Setting Wireless LAN setting information -

Channel Channel (infrastructure) XXX (0 to 255)

SSID SSID Wireless LAN (infrastructure) SSID
(up to 32 characters)

Security Type Security type for Wireless LAN (infra-
structure)

Disabled/WEP 64bit/WEP
128bit/WPA PSK TKIP/WPA PSK
AES/WPA2 PSK TKIP/WPA2 PSK
AES/MIXED

WEP1 WEP key 1 for Wireless LAN (infra-
structure)

XXXXXXXX (up to 32 characters)
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WEP2 WEP key 2 for Wireless LAN (infra-
structure)

XXXXXXXX (up to 32 characters)

WEP3 WEP key 3 for Wireless LAN (infra-
structure)

XXXXXXXX (up to 32 characters)

WEP4 WEP key 4 for Wireless LAN (infra-
structure)

XXXXXXXX (up to 32 characters)

WEP Certificate WEP certificate for Wireless LAN (in-
frastructure)

Open/Shared/Auto

WEP Format WEP format for Wireless LAN (infra-
structure)

Hex/String

Wireless Direct Setting Wireless direct setting information -

Channel Channel (Wireless direct) XXX (0 to 255)

SSID SSID Wireless LAN SSID (Wireless direct)

Security Type Security type for Wireless LAN (Wire-
less direct)

Disabled/WPA2 PSK TKIP/WPA2
PSK AES

Protocol Setting Protocol setting information -

Printer Name Printer name XXXXXXXX (up to 16 characters)

Use LPR Use LPR On/Off

Printer Location Printer location XXXXXXXX (up to 16 characters)

Use Wired Power Save Discontinuous reception (Wired LAN) On/Off

Use Wireless Power Save Discontinuous reception (Wireless
LAN)

On/Off

Use RAW Use RAW On/Off

Use LLMNR Use LLMNR On/Off

Use Spanning Tree Use spanning tree On/Off

WSD Setting WSD setting information -

Use WSD Use WSD On/Off

WSD Timeout Timeout 1/5/10/15/20 [min]

Use WSD Push Scan Use WSD push scan On/Off

Use WSD Rx Optimization Use WSD reception optimization On/Off

SNMP Setting SNMP setting information -

Use SNMPv1 Use SNMPv1 On/Off
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Use SNMPv3 Use SNMPv3 On/Off

SNMP Community Name1 SNMP community name 1 XXXXXXXX (up to 32 characters)

SNMP Community Name2 SNMP community name 2 XXXXXXXX (up to 32 characters)

SNMP Extra Access Authority SNMP extra access authority Disable/Read Only/Read Write

SNMP Access Authority1 SNMPv1 community1/2 access au-
thority

Read Only/Read Write

SNMP Access Authority2 SNMPv1 community1/2 access au-
thority

Disable/Read Only/Read Write

SNMPV3 Setting SNMPV3 setting information -

User1 User 1 -

User Name User name XXXXXXXX (up to 32 characters)

Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction MIB access restriction Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto
Priv

Authority Algorithm Authority algorithm Null/MD5/SHA1

Encryption Algorithm Encryption algorithm Null/AES/DES

User2 User 2 -

User Name User name XXXXXXXX (up to 32 characters)

Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction MIB access restriction Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto
Priv

Authority Algorithm Authority algorithm Null/MD5/SHA1

Encryption Algorithm Encryption algorithm Null/AES/DES

SNMPV3 Setting SNMPV3 setting information -

User3 User 3 -

User Name User name XXXXXXXX (up to 32 characters)

Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction MIB access restriction Read Only/Read Write
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Security Setting Security setting No Auth No Priv/Auth No Priv/Auto
Priv

Authority Algorithm Authority algorithm Null/MD5/SHA1

Encryption Algorithm Encryption algorithm Null/AES/DES

User4 User 4 -

User Name User name XXXXXXXX (up to 32 characters)

Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction MIB access restriction Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto
Priv

Authority Algorithm Authority algorithm Null/MD5/SHA1

Encryption Algorithm Encryption algorithm Null/AES/DES

User5 User 5 -

User Name User name XXXXXXXX (up to 32 characters)

Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction MIB access restriction Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto
Priv

Authority Algorithm Authority algorithm Null/MD5/SHA1

Encryption Algorithm Encryption algorithm Null/AES/DES

Dynamic DNS Setting Dynamic DNS setting -

IPv4 IPv4 -

Use Dynamic DNS Operation status of Dynamic DNS On/Off

Host Name Host name XXXXXXXX (up to 64 characters)

Domain Name Domain name XXXXXXXX (up to 65 characters)

IPv6 IPv6 -

Use Manual Address DNS dynamic setting of manual ad-
dress

On/Off

Use Stateless Address DNS dynamic setting of stateless ad-
dress

On/Off
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Use Stateful Address DNS dynamic setting of stateful ad-
dress

On/Off

Use Name As IPv4 Use same host name/domain name
as that used for IPv4

On/Off

Host Name Host name XXXXXXXX (up to 64 characters)

Domain Name Domain name XXXXXXXX (up to 65 characters)

SNTP Setting SNTP setting information -

Use SNTP Use SNTP On/Off

SNTP Polling Interval SNTP polling interval 1 to 48 [sec]

SNTP Server Name SNTP server name XXXXXXXX (up to 256 characters)

FTP Setting FTP setting information -

Use FTP Use FTP On/Off

Use FTP Authority Use FTP authority On/Off

FTP User Name FTP user name XXXXXXXX (up to 33 characters)

Bonjour Setting Bonjour setting information -

Use Bonjour Use Bonjour On/Off

Bonjour Service Name Bonjour service name Bonjour service name (Up to 50 al-
phanumeric characters)

802.1X Setting 802.1X setting information -

Authority Type Enable/disable 802.1X and authority
type

Do not use/EAP-TLS/EAP-TTLS/
PEAP

EAP TTLS Type Internal authority type for EAP-TTLS MSCHAPv2/PAP

Weak Encryption Restriction Weak encryption restriction Do not restrict/Restrict

Weak Certificate Restriction Weak certificate restriction Do not restrict/Restrict

Login Name Login name XXXXXXXX (up to 24 characters)

User Name User name XXXXXXXX (up to 24 characters)

Server Name Server name XXXXXXXX (up to 43 characters)

IPsec Setting IPsec setting information -

Use IPsec Use IPsec On/Off

Previous Shared Key Previous shared key for IPsec XXXXXXXX (up to 17 characters)

Phase2 Protocol IPsec phase2 protocol AH/ESP/AH+ESP
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IPP Setting IPP confirmation setting -

Use IPP Use IPP On/Off

Use IPP Authority Use IPP authority On/Off

IPP User Setting IPP confirmation user setting -

User1 User 1 -

User Name User name XXXXXXXX (up to 32 characters)

User2 User 2 -

User Name User name XXXXXXXX (up to 32 characters)

User3 User 3 -

User Name User name XXXXXXXX (up to 32 characters)

User4 User 4 -

User Name User name XXXXXXXX (up to 32 characters)

User5 User 5 -

User Name User name XXXXXXXX (up to 32 characters)

User6 User 6 -

User Name User name XXXXXXXX (up to 32 characters)

User7 User 7 -

User Name User name XXXXXXXX (up to 32 characters)

User8 User 8 -

User Name User name XXXXXXXX (up to 32 characters)

User9 User 9 -

User Name User name XXXXXXXX (up to 32 characters)

User10 User 10 -

User Name User name XXXXXXXX (up to 32 characters)

Email Setting E-mail setting information -

Retry Count E-mail retry count 0 to 5

Retry Interval E-mail retry interval 1 to 60 (min)

Use Email Notification Use E-mail notification On/Off

Use SSL Use SSL On/Off
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Use SSL Cert No Check Use SSL certification On/Off

Use Mailbox Delete Use mailbox delete On/Off

Email Setting E-mail setting information -

SMTP Server Address SMTP server address XXXXXXXX (up to 256 characters)

SMTP Server Port No SMTP server port number 1 to 65535

SMTP State SMTP state Invalid/Authorized/POP before SMTP

From Address 1 From address 1 XXXXXXXX (up to 128 characters)

To Address 1 To address 1 XXXXXXXX (up to 128 characters)

Reply Address 1 Reply address 1 XXXXXXXX (up to 128 characters)

Notice Conditions 1 Notice conditions 1 -

Job End Job end On/Off

Error Occurred Error occurred On/Off

Warning Occurred Warning occurred On/Off

Signature 1 Signature 1 XXXXXXXX (up to 128 characters)

To Address 2 To address 2 XXXXXXXX (up to 128 characters)

Reply Address 2 Reply address 2 XXXXXXXX (up to 128 characters)

Notice Conditions 2 Notice conditions 2 -

Job End Job end On/Off

Error Occurred Error occurred On/Off

Warning Occurred Warning occurred On/Off

Signature 2 Signature 2 XXXXXXXX (up to 128 characters)

RUI Setting RUI setting information -

Use RUI Use Remote UI On/Off

("XX" represents alphanumeric characters.)
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Reconfiguration Method of LAN Connection/Reconfiguration
Method of Wireless LAN Connection

Changing LAN Connection Method
Changing Wireless LAN Connection Method

Changing LAN Connection Method
Follow either procedure below to change LAN connection method (wired or wireless).

• For Windows:

◦ Use the Setup CD-ROM or follow the instructions on the Canon website to redo setup.
◦ Tap LAN settings and Change LAN in this order on the HOME screen, and then select Activate

wireless LAN or Activate wired LAN.

After that, perform settings on the Network Settings screen on IJ Network Device Setup Utility.

For details, refer to Performing/Changing Wireless LAN Settings or Performing/Changing Wired
LAN Settings.

• For macOS:

Follow the instructions on the Canon website to redo setup.

Changing Wireless LAN Connection Method
Follow either procedure below to change wireless LAN connection method (infrastructure or wireless
direct).

• For Windows:

◦ Use the Setup CD-ROM or follow the instructions on the Canon website to redo setup.
◦ Perform settings on the Network Settings screen on IJ Network Device Setup Utility.

Important
• Before you perform settings using IJ Network Device Setup Utility, turn on easy wireless

connect mode on the printer following the procedure below.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  LAN settings.

Menu Operations

If you specify the administrator password, enter the password.

3. Tap Wireless LAN setup.

4. Tap Easy wireless connect.

5. Check message and tap OK.

Follow instructions on your smartphone or tablet.

6. If message saying setup is completed appears, tap OK.
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• For macOS:

Follow the instructions on the Canon website to redo setup.

360



Reconfiguration of Network Settings using the Remote UI

You can use Remote UI on the following OS and the web browser.

• iOS device

OS: iOS 8.0 or later

Web browser: iOS standard Web browser (Mobile Safari)

• Android device

OS: Android 4.1 or later

Web browser: Android standard Web browser (Browser or Chrome)

• macOS device

OS: Mac OS X 10.9 or later

Web browser: Safari 7.0 or later

• Windows device

OS: Windows 7 SP1 or later

Web browser: Internet Explorer 11 or later, Google Chrome, Mozilla Firefox

For more on Remote UI, refer to Configuration changes using the Web Browser.

Important
• Enable JavaScript and cookies in the web browser.
• If you access Remote UI with the printer name instead of its IP address, make sure the DNS settings

are correctly configured.
• Depending on the network environment, you may not be able to start Remote UI.
• Make sure Do not restrict is selected for Remote UI on Operation restrictions in Device user

settings under Device settings.

Note
• Remote UI also offers many other features. You can display the ink levels, check error messages and

other status information, and cancel print jobs.
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Network Status and Troubleshooting

Check the network status referring to LAN setting information on the touch screen.

Confirm LAN settings

Network Status What to Do

Connected normal-
ly.

If you are unable to
print, see 1 on What
to Do.

1. If you are unable to print, check the items below:

• whether the computer is connected to wireless LAN
• whether the firewall of your security software is enabled
• whether a privacy separator, SSID separator, or Network separation function is enabled

on your wireless router

If one of the above is enabled, disable it before setup.

• whether the SSID of the printer (see "3-2-6" of network setting information printout)
matches that of the router to connect

2. To change the network connection method (wired/wireless), change it on the printer's net-
work setting screen.

Wireless LAN is dis-
abled on the printer.

Perform printer setup following the instructions of the manual.

Wired LAN connec-
tion is disabled.

• Make sure the printer is connected to the router with the LAN cable.

If the LAN cable is loose, connect the cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN
side of the router.

• Make sure the network devices (e.g. hub or router) are turned on.

IP address is not
assigned.

• If you specify the printer's IP address automatically, enable DHCP on the router.

• If you specify the printer's IP address manually, the address is disabled because it is out of
the valid range. You specified (0.0.0.0) as the IP address, for example.

Specify the valid IP address.

The default gateway
is not specified.

Check the items below to communicate by hopping routers (e.g. using a cloud application).

• If you specify the printer's IP address manually, make sure the correct default gateway ad-
dress is specified for the printer manually.

• Make sure the device specified as the default gateway is turned on.

• Specify the default gateway address correctly.

To check the default gateway, print out the network settings information.

Note
• For some printers, you can check the default gateway on the operation panel.

Cannot connect to
the specified net-
work.

Check the status of the printer, network devices (e.g. wireless router), or smartphone/tablet.

• If they are turned off, turn them on.
• Make sure wireless signal is strong.

Monitor signal status and move the printer and wireless router as necessary.

• The security key specified for the wireless router may not match that you entered.
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The security key is case-sensitive.

Enter the correct security key.

The number of con-
nected clients rea-
ches the upper limit.

Make sure wireless
signal is strong.

• Make sure the printer is not placed too far away from the wireless router.

• Wireless Direct does not allow more than 5 devices to be connected.

If you add a device to connect, disconnect a device you do not use before adding the device.

A link local address
is assigned.

• Perform printer setup again.
• The security key specified for the wireless router may not match that you entered.

The security key is case-sensitive.

Enter the correct security key.

The specified SSID
is left default value.

The SSID is not specified.

Enter the SSID specified for the destination.
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IJ Network Device Setup Utility (Windows)

IJ Network Device Setup Utility

Starting Up IJ Network Device Setup Utility

Diagnosing and Repairing Network Settings

Performing/Changing Network Settings
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IJ Network Device Setup Utility

IJ Network Device Setup Utility allows you to diagnose or repair the network status, and to manage printers
on network.

Use IJ Network Device Setup Utility for:

• Searching printers on network and performing initial network setup for detected printers
• Performing initial network setup by connecting the printer and computer using a USB cable (Not

available for some models)
• Changing printer network settings
• Diagnosing the settings of the printer and those of computer on which IJ Network Device Setup Utility is

installed if anything is wrong with connection. In addition, IJ Network Device Setup Utility repairs the
status of the printer and computer.

Important
• Depending on the printer you are using, an administrator password is already specified for the printer at

the time of purchase. When you change the network settings, authentication by the administrator
password is required.

For details:

Administrator Password

For improving security, we recommend to change the administrator password.

Changing Administrator Password

• To use the printer over LAN, make sure you have the equipment necessary for the connection type,
such as a wireless router or a LAN cable.

• When you install IJ Network Device Setup Utility, disable block function of firewall.
• Do not change network settings using IJ Network Device Setup Utility while printing is in progress.
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Starting Up IJ Network Device Setup Utility

Start up IJ Network Device Setup Utility as shown below.

• In Windows 10, click the Start button, select All apps, Canon Utilities, and then IJ Network Device
Setup Utility.

• In Windows 8.1 or Windows 8, select IJ Network Device Setup Utility on the Start screen to start IJ
Network Device Setup Utility. If IJ Network Device Setup Utility is not displayed on the Start screen,
select the Search charm and search for "IJ Network Device Setup Utility".

• In Windows 7 or Windows Vista, click Start and select All Programs, Canon Utilities, IJ Network
Device Setup Utility, and then IJ Network Device Setup Utility.

When you start up IJ Network Device Setup Utility, a message appears. Check the message and select
Yes. The screen below appears.

Select Diagnose and Repair or Printer Network Setup on the displayed screen.

• If you select Diagnose and Repair:

Diagnosing and Repairing Network Settings

• If you select Printer Network Setup:

Performing/Changing Network Settings
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Diagnosing and Repairing Network Settings

IJ Network Device Setup Utility diagnoses and repairs computer settings or connection between the
computer and printer when a problem (e.g. cannot print from a printer on the network) occurs.

Important
• Some models do not support diagnosis and repair function.

For details:

List of Models Which Does Not Support Diagnosis and Repair Function

Follow the procedure below.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Diagnose and Repair on the displayed screen.

Perform operations following the instructions on the screen.

Note
• This function checks the following items:

• whether the computer is connected to the router
• whether a web page on the Internet can be viewed
• whether the printer can be detected on the network
• whether the signal strength or communication level is sufficient (when using wireless LAN)
• whether the printer port setting matches with the network setting
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Performing/Changing Network Settings

Canon IJ Network Device Setup Utility Screen

Performing Network Settings
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Canon IJ Network Device Setup Utility Screen

Items on Canon IJ Network Device Setup Utility Screen
Menus on Canon IJ Network Device Setup Utility Screen
Items on Canon IJ Network Device Setup Utility Screen Toolbar

Items on Canon IJ Network Device Setup Utility Screen
The screen below appears when you start up IJ Network Device Setup Utility and select Printer Network
Setup. Detected printers are listed on the screen and the items below are shown.

1. Product Name

Displays the product name of detected printer. The icon below appears on the left if the printer cannot
be used.

: Appears when the printer has not been connected or configured.

: Appears when the IP address is duplicated to another printer.

: Appears when you cannot communicate with the printer.

Note
• If a printer you want to use is not detected, try to set the criteria for printer search.

Setting Criteria for Printer Search/Searching Specific Printer

• Right-clicking a printer displays setting items or items to confirm.

2. Serial Number (Last 5 Digits)

Displays the last five digits of printer's serial number.

3. Status

Displays the printer status as shown below.
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Available
Indicates the printer is available.

Setup Completed
Appears after performing network setup and clicking Set to close the window.

Not Connected
Indicates the printer is required to perform wireless LAN setup.

Performing/Changing Wireless LAN Settings

Not Set
Indicates the printer cannot be used on network, or IPv6 is disabled. Specify an IP address or
enable IPv6 on Network Settings....

Performing/Changing Wireless LAN Settings

IP Address Overlap
Indicates the IP address is duplicated to another printer.

Unknown
Indicates the printer recognized as Available in the past cannot be used currently.

Note
• If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

4. IP Address

Displays the printer IP address. Nothing is displayed if the printer status is Not Connected.

Note
• If USB is selected from the pulldown menu on the toolbar, "-" is displayed for the interface

(wireless/wired LAN) disabled on the printer setting.

5. Location

Displays the printer location if it is registered. Nothing is displayed if the printer status is Not
Connected.

Note
• If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

Assigning Printer Information

6. Connection Method

Displays printer connection method (wired or wireless LAN).

Note
• If USB is selected from the pulldown menu on the toolbar, either of the LAN connection method

(wired or wireless) available for the printer is displayed.
• If the printer supports both of the LAN connection methods, the printer is recognized as two

printers and they are displayed separately.
• If the printer does not support wired LAN, wired LAN is not displayed.
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• If you are using IJ Network Device Setup Utility on the computer which does not support
wireless LAN, wireless LAN is not displayed.

7. Setting Method

Displays printer setting method.

• Auto

Appears if the printer is used by IP address specified automatically.

• Manual

Appears if the printer is used by IP address specified manually.

Note
• If USB is selected from the pulldown menu on the toolbar, "-" is displayed for the interface

(wireless/wired LAN) disabled on the printer setting.

8. MAC Address

Displays the MAC address of the detected printer.

Note
• If USB is selected from the pulldown menu on the toolbar, "-" is displayed for the interface

(wireless/wired LAN) disabled on the printer setting.

9. Device Name

Displays the printer device name if it is registered.

Note
• If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

Assigning Printer Information

10. IPv6

On appears when an IPv6 address is assigned for the printer.

Note
• If USB is selected from the pulldown menu on the toolbar, "-" is displayed.

11. Displays the printer status and operation guides.

Selecting a printer from the printer list displays its current status and what to do next.

Menus on Canon IJ Network Device Setup Utility Screen
This section describes menus on IJ Network Device Setup Utility screen.

371



1. Printer Settings menu

Printer Settings Menu

2. View menu

View Menu

3. Option menu

Option Menu

4. Help menu

Help Menu

Items on Canon IJ Network Device Setup Utility Screen Toolbar
This section describes items on IJ Network Device Setup Utility Screen toolbar.

1. Perform wired or wireless LAN setup.

Note
• This item has the same function as Network Settings... in the Printer Settings menu.

2. Redetects printers.

Note
• This item has the same function as Update in the View menu.

3. Stops detecting printers.

Note
• This item has the same function as Cancel in the View menu.
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4. Switches the printer list. (IPv4, IPv6, or USB printers)

Note
• This item has the same function as Switch View in the View menu.
• You can also display the USB connected printer list. (Not available for some models.) In this

case, select USB.

5. Displays this guide.

Note
• This item has the same function as Online Manual in the Help menu.
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Performing Network Settings

Performing/Changing Wired LAN Settings

Performing/Changing Wireless LAN Settings

Assigning Printer Information
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Performing/Changing Wired LAN Settings

Follow the procedure below to perform/change wired LAN settings.

Note
• For some models, you can perform network setup for a USB connected printer using IJ Network Device

Setup Utility. Select USB on Switch View under the View menu to display printers for which you can
perform setup.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer to perform/change settings from printer list.

Select the printer with Wired LAN displayed on Connection Method and the setting other than
Unknown, Not Connected, or Setup Completed displayed on Status to perform settings.

To perform setup for a USB connected printer, select USB from the pulldown menu on the toolbar and
select the printer with Wired LAN displayed on Connection Method.

5. Select Network Settings... on Printer Settings menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

Note

• Clicking the  icon allows you to perform/change settings.

6. Enter password and click OK.

The Network Settings screen appears.

7. Perform/change settings.

You can switch the screen between IPv4 and IPv6. Click the tab to switch the protocol.

• IPv4 settings
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1. Use IPv4 address

Always selected. (displayed in a gray out state)

2. Get IP address automatically

Select this option to use an IP address automatically assigned by a DHCP server. DHCP
server functionality must be enabled on your router.

3. Use next IP address

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address, subnet mask, and default gateway.

• IPv6 settings

Note
• If USB is selected from the pulldown menu on the toolbar, you cannot perform IPv6 settings.

1. Use IPv6 address

Select when you use the printer with IPv6 environment.

2. Use Stateless Address:
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Select when you use an IP address assigned automatically. Use a router compatible with
IPv6.

Note
• This setting item is not available depending on the printer you are using.

3. Use Manual Address:

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address and IP address prefix length.

Note
• This setting item is not available depending on the printer you are using.

4. Use DHCPv6:

Select when you obtain an IP address using DHCPv6.

Note
• This setting item is not available depending on the printer you are using.

8. Click Set.
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Performing/Changing Wireless LAN Settings

Follow the procedure below to perform/change wireless LAN settings.

Important
• Enable Easy wireless connect (Cableless setup) before performing printer setup. (Not required if you

change the IP address.) For details, search for "NR049" on your printer's online manual and see the
page shown.

Note
• For some models, you can perform network setup for a USB connected printer using IJ Network Device

Setup Utility. Select USB on Switch View under the View menu to display printers.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer to perform/change settings from printer list.

Select the printer with Wireless LAN displayed on Connection Method and the setting other than
Unknown or Setup Completed displayed on Status to perform settings.

To perform setup for a USB connected printer, select USB from the pulldown menu on the toolbar and
select the printer with Wireless LAN displayed on Connection Method.

5. Select Network Settings... on Printer Settings menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

Note

• Clicking the  icon allows you to perform/change settings.

6. Enter password and click OK.

The Network Settings screen appears.

7. Perform/change settings.

You can switch the screen between IPv4 and IPv6. Click the tab to switch the protocol.

• IPv4/IPv6 settings
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1. Network Type:

Select the wireless LAN mode.

Infrastructure
Connects the printer to the wireless LAN with a wireless router.

Direct
Connects the printer to wireless communication devices (smartphone or tablet) without a
wireless router.

Note
• If Direct is selected, the Search... button is displayed in a gray out status.

In addition, you cannot connect to Internet from your computer depending on your
operating environment.

2. SSID:

The network identifier (SSID) of the wireless LAN currently used is displayed.

The identifier for Wireless Direct (SSID) appears while in Wireless Direct.

3. Search...

The Detected Wireless Routers screen is displayed to select a wireless router to connect to.
For a wireless router already connected to the computer, Available is displayed on
Communication Status.

If you select a wireless router with Not Connected on Communication Status from the list,
clicking Set displays the WPA/WPA2 or WEP setting screen for a wireless router.

If WEP Details Screen Appears
If WPA/WPA2 Details Screen Appears

4. Encryption Type:

Displays the encryption method used over the wireless LAN.
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• IPv4 settings

Note
• The setting items below are available only when Infrastructure is selected for Network

Type:.

If Direct is selected, the setting items below are displayed in a gray out status.

1. Use IPv4 address

Always selected. (displayed in a gray out state)

2. Get IP address automatically

Select this option to use an IP address automatically assigned by a DHCP server. DHCP
server functionality must be enabled on your router.

3. Use next IP address

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address, subnet mask, and default gateway.

• IPv6 settings

Note
• If USB is selected from the pulldown menu on the toolbar, you cannot perform IPv6 settings.
• The setting items below are available only when Infrastructure is selected for Network

Type:.

If Direct is selected, the setting items below are displayed in a gray out status.
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1. Use IPv6 address

Select when you use the printer with IPv6 environment.

2. Use Stateless Address:

Select when you use an IP address assigned automatically. Use a router compatible with
IPv6.

Note
• This setting item is not available depending on the printer you are using.

3. Use Manual Address:

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address and IP address prefix length.

Note
• This setting item is not available depending on the printer you are using.

4. Use DHCPv6:

Select when you obtain an IP address using DHCPv6.

Note
• This setting item is not available depending on the printer you are using.

8. Click Set.

381



Assigning Printer Information

Follow the procedure below to assign/change printer location name or device name.

The names appear on Device Name: and Location: on the Canon IJ Network Device Setup Utility
screen.

Note
• If USB is selected from the pulldown menu on the toolbar, this setting item is not available.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer to assign location name and device name.

Select the printer with Available displayed on Status.

5. Select Detailed Printer Settings... on Printer Settings menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

6. Enter password and click OK.

The Detailed Printer Settings screen appears.

7. Perform/change settings.

The setting items below are available.

1. Device Name:

Assigns the device name.

2. Location:

Assigns the location name.

8. Click Set.
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Initializing Network Settings

Follow the procedure below to initializing printer network settings.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer to initialize settings.

Select the printer with Available displayed on Status.

5. Select Reset LAN settings on Printer Settings menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

6. Enter password and click OK.

7. Click Yes on the displayed screen.

8. Click OK on the displayed screen.

The printer network settings are initialized.
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Changing Administrator Password

Follow the procedure below to change the administrator password.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer to change password.

Select the printer with Available displayed on Status.

5. Select Change Password... on Printer Settings menu.

The Change Printer Password screen appears.

For more on the password, refer to Administrator Password.

6. Enter current password and new password.

7. Enter new password in Confirm: again.

8. Click OK.

The administrator password is updated.
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Setting Criteria for Printer Search/Searching Specific Printer

You can set the criteria for printer search when you start up IJ Network Device Setup Utility or update the
printer search, or you can search the specific printer.

Changing these settings may detect the printer you want to use if it is not detected

Note
• If the printer you want to use is not detected, it may be detected by entering IP address, subnet mask,

or default gateway on the operation panel and search again.

Setting Criteria for Printer Search
Searching Specific Printer

Setting Criteria for Printer Search

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select Search Settings... on Option menu.

The Search Settings screen appears.

5. Enter criteria for printer search.

1. Search Time:

Specifies the time to search printers.

2. Time out:

Specifies the timeout length for not receiving a response from printer.

Note
• Printers you want to find are more likely to be detected as the values are larger, however, it may

take a while to search them.
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6. Click Set.

Searching Specific Printer

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select Specified Searching... on Option menu.

The Specified Searching screen appears.

5. Select item to specify and enter value.

1. IPv4 Address

Specifies the IPv4 address of the printer you want to search.

2. IPv6 Address

Specifies the IPv6 address of the printer you want to search.

3. Host Name

Specifies the host name of the printer you want to search.

6. Click Search.

IJ Network Device Setup Utility starts searching by the specified criteria and detected printers are
listed.
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If WEP Details Screen Appears

Enter the password (passphrase) according to wireless router's encryption method if you change a wireless
router to connect to the printer.

1. Enter items below when WEP Details screen appears.

1. WEP Key:

Enter the same key as the one set to the wireless router.

The number of characters and character type that can be entered differ depending on the
combination of the key length and key format.

 Key Length:

64bit 128bit

Key Format: ASCII 5 characters 13 characters

Hexadecimal (Hex) 10 digits 26 digits

2. Key Length:

Select either 64bit or 128bit.

3. Key Format:

Select either ASCII or Hex.

4. Key ID:

Select the Key ID (index) set to the wireless router.

2. Click Set.

Important
• If the printer cannot communicate with the computer after the encryption type of the printer was

switched, make sure encryption types for the computer and the wireless router match that set to
the printer.
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If WPA/WPA2 Details Screen Appears

Enter the password (passphrase) according to wireless router's encryption method if you change a wireless
router to connect to the printer.

1. Enter passphrase when WPA/WPA2 Details screen appears.

Enter the passphrase set to the wireless router. The passphrase should be a string of 8 to 63
alphanumeric characters or a 64-digit hexadecimal value.

If you do not know the wireless router passphrase, refer to the instruction manual provided with the
wireless router or contact its manufacturer.

2. Click Set.

Important
• If the printer cannot communicate with the computer after the encryption type of the printer was

switched, make sure encryption types for the computer and the wireless router match that set to
the printer.
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Checking Network Status

Checking Wireless Network Status

Displaying Computer Network Information

Displaying Printer Network Information

Checking Connection Status between Printer and Wireless Router

Checking Network Setting Difference
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Checking Wireless Network Status

Follow the procedure below to check the wireless network status (signal strength) between the printer and
computer.

If anything is wrong with the wireless LAN connection, check the network status from this menu.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer to check wireless network status from printer list.

Select the printer with Available displayed on Status.

5. Select Check Wireless Communication Status on View menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

6. Enter password and click OK.

• If the printer is connected to the computer with a wireless router:

The screen below appears.

• If the printer is connected to the computer using Wireless Direct:

The screen below appears.

Clicking Update measures the signal strength again.
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7. Click OK to close screen.
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Displaying Computer Network Information

Follow the procedure below to display the network information of the computer which the printer selected in
the Canon IJ Network Device Setup Utility screen connects to and on which IJ Network Device Setup
Utility is installed.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select Computer Network Information on View menu.

The screen below appears.

Clicking Copy Info copies all network information on the clipboard.

5. Click OK to close screen.
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Displaying Printer Network Information

Follow the procedure below to display the printer network information.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer to display network information from printer list.

Select the printer with Available displayed on Status.

5. Select Printer Network Information on View menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

6. Enter password and click OK.

The screen below appears.

Clicking Copy Info copies all network information on the clipboard.

7. Click OK to close screen.
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Checking Connection Status between Printer and Wireless Router

Follow the procedure below to check the wireless router information detected by the printer.

Detects wireless routers around the printer and the detected ones are listed. Use this menu to make sure
whether the printer is located properly.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer to check connection status between printer and wireless router from printer
list.

Select the printer with Available displayed on Status and Wireless LAN displayed on Connection
Method.

5. Select Status of Printer and Wireless Router Connection on View menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

6. Enter password and click OK.

The screen below appears.

Clicking Update searches wireless routers again.

7. Click OK to close screen.
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Checking Network Setting Difference

If you cannot use a printer you used on the network before, compare the current network status with that
when you could use the printer and check the difference.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

3. Select Printer Network Setup on the displayed screen.

Detected printers are listed.

4. Select printer with Unknown or Not Set displayed on Status from printer list.

5. Select Check Connection Status on View menu.

The screen below appears.

If the network status when you used the printer is different from the current status, Mismatch appears on
Status and the items are displayed in red. Check the red items.

6. Click OK to close screen.

Performing Network Settings via USB Connection
When the Check Connection Status screen is displayed, you can perform printer network setup by
connecting the printer and computer using a USB cable. Follow the procedure below.
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1. Click Set up the network connection via USB.

Follow the displayed message to connect the printer to perform setup to the computer using a USB
cable. Make sure the printer is turned on.

2. Click Yes on displayed screen.

The detected printers are listed.

3. Select printer to perform setup from the printer list.

Perform setup following the on-screen instructions.
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IJ Network Device Setup Utility Menus

Printer Settings Menu

View Menu

Option Menu

Help Menu
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Printer Settings Menu

This section describes the items displayed on the Printer Settings menu.

1. Network Settings...

Performs wired or wireless LAN settings.

Performing/Changing Wired LAN Settings
Performing/Changing Wireless LAN Settings

Note
• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this

item.

2. Detailed Printer Settings...

Assigns the printer device name and location name.

Assigning Printer Information

3. Reset LAN settings

Initializes the printer LAN settings.

Initializing Network Settings

4. Change Password...

Changes the password specified for the printer.

Changing Administrator Password

5. Set up device by using web browser

Check the printer information or perform settings in detail on the web page.

Note
• You can use this function on the following the OS and the web browser.

OS: Windows 7 SP1 or later

Web browser: Internet Explorer 11 or later, Google Chrome, Mozilla Firefox
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• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this
item

6. Exit

Finishes IJ Network Device Setup Utility.
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View Menu

This section describes the items displayed on the View menu.

1. Check Connection Status

If you cannot use a printer you used on the network before, compare the current network status with that
when you can use the printer and check the difference.

Checking Network Setting Difference

Note
• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this

item.

2. Check Wireless Communication Status

Check wireless LAN communication status.

Checking Wireless Network Status

Note
• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this

item.

3. Computer Network Information

Check the computer network information.

Displaying Computer Network Information

4. Printer Network Information

Check the printer network information.

Displaying Printer Network Information

5. Status of Printer and Wireless Router Connection
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Searches wireless routers and check the wireless router information (wireless channel, communication
status, and signal strength) detected by the printer.

Checking Connection Status between Printer and Wireless Router

6. Switch View

Switches the printer list between IPv4 printers and IPv6 printers. For some models, you can list USB
connected printers.

Note
• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this

item.

7. Delete from List

Deletes the selected printer from the printer list temporarily.

Selecting Update will detect the deleted printer if it exists on the network.

8. Cancel

Cancels printer search.

Note
• You can also cancel printer search by clicking the  icon.

9. Update

Searches printers again.

Note

• You can also search printers again by clicking the  icon.
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Option Menu

This section describes the items displayed on the Option menu.

1. Search Settings...

Specifies criteria for printer search.

Setting Criteria for Printer Search

2. Specified Searching...

Searches the printer by an IP address or host name.

Searching Specific Printer
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Help Menu

This section describes the items displayed on the Help menu.

1. Online Manual

Displays this guide.

2. Caution when Connecting to Wireless LAN

Displays the caution message for wireless LAN connection.

3. Changing Wired/Wireless LAN Connections

Displays the message on changing LAN connection method (wired or wireless) for the selected printer.

Note
• This item is displayed in a gray out status if USB is selected from the pulldown menu on the

toolbar.

4. About

Displays IJ Network Device Setup Utility version information.
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List of Models Which Does Not Support Diagnosis and Repair
Function

The following models does not support "Diagnose and Repair" function of IJ Network Device Setup Utility.

• G4000 series
• PRO-500 series
• PRO-1000 series
• MB2100 series
• MB2700 series
• MB5100 series
• MB5400 series
• iB4000 series
• PRO-520
• PRO-540
• PRO-540S
• PRO-560S
• PRO-2000
• PRO-4000
• PRO-4000S
• PRO-6000S
• TS9000 series
• TS8000 series
• TS6000 series
• TS5000 series
• MG3000 series
• E470 series
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Other Network Information

Technical Terms

Restrictions

Firewall

List of Devices Which May Interfere with Wireless LAN Communication

405



Technical Terms

In this section, technical terms used in the manual are explained.

A
B
C
D
E
F
H
I
K
L
M
O
P
R
S
T
U
W

A

• Ad-hoc

Client computer and printer setting where wireless communication occurs on a peer-to-peer basis,
i.e., all clients in with the same SSID/network name communicate directly with each other. No wireless
router is required. This printer does not support ad-hoc communication.

• Admin Password

Administrator password in IJ Network Device Setup Utility to restrict access to network users. It must
be entered to access the printer and change printer settings.

• AES

An encryption method. It is optional for WPA. Strong cryptographic algorithm adopted within U.S.
government organizations for information processing.

• Authentication Method

The method that a wireless router uses to authenticate a printer through a wireless LAN. The methods
are agreeable each other.

For WPA/WPA2, authentication method is PSK.
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B

• Bonjour

A service built into Mac OS X operating system to detect the connectable devices on a network
automatically.

C

• Channel

Frequency channel for wireless communication. In the infrastructure mode, the channel is
automatically adjusted to match that set to the wireless router. This printer supports channels 1 to 13.
(Channels 12 and 13 are not supported depending on the country or region of purchase.) Note that
the number of channels that can be used for your wireless LAN varies depending on the region or
country.

D

• Default Gateway

A relay device to connect to another network such as a router or a computer.

• Default router address

A default IP address set for a router.

• DHCP server functionality

The router assigns an IP address automatically whenever the printer or the personal computer on a
network starts up.

• DHCPv6

A protocol to assign necessary information automatically when a computer connects to network.
DHCPv6 can be used when IPv6 is enabled.

• DNS server

A server that converts device names into IP addresses. When specifying IP addresses manually,
specify the addresses of both a primary and a secondary server.

E

• Easy wireless connect (Cableless setup)

Specifies a wireless router settings using a device (e.g. smartphone) directly without using a wireless
router.
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F

• Firewall

It is a system that prevents an unlawful computer access in the network. To prevent, you can use the
firewall function of a broadband router, the security software installed in the computer, or operation
system for computer.

H

• Host name

A name for a computer or printer on network so that it can be recognized easily. Single-byte
alphanumeric characters are used generally.

I

• IEEE802.11b

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
11 Mbps.

• IEEE802.11g

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
54 Mbps. Compatible with 802.11b.

• IEEE802.11n

International standard for wireless LAN using the 2.4 GHz and 5 GHz frequency ranges. Even when
using two or more antennas simultaneously or obtaining a bigger transfer rate than before by using
multiple communication channels at the same time, the transmission speed may be influenced by the
connected apparatus.

At the maximum transfer rate of 600 Mbps, it is possible to communicate with multiple computer
terminals within a dozen or so metre radius.

Compatible with 802.11b and 802.11g.

• Infrastructure

One of the wireless communication methods. Wireless communication devices (e.g. computer or
printer) are connected to the network via a wireless router.

• IP Address

A unique number with four parts separated by dots. Every network device that is connected to the
Internet has an IP address. Example: 192.168.0.1

An IP address is usually assigned by a wireless router or a DHCP server of the router automatically.

• IPv4/IPv6

They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and IPv6 uses
128-bit addresses.
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K

• Key Format

Select either ASCII or Hex as the WEP key format. The character that can be used for the WEP key
differs depending on the selected key formats.

◦ ASCII

Specify with a 5 or 13-character string that can include alphanumeric and underscore "_"
characters. It is case-sensitive.

◦ Hex

Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, A to F, and a to f).

• Key Length

Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a more
complex WEP key.

L

• Link local address

An IP address generated automatically from a specific prefix (information of current network: fe80::)
and an interface identifier generated from printer's MAC address.

• Link Quality

The status of the connection between the wireless router and the printer excluding noise
(interference) is indicated with a value from 0 to 100%.

• LPR

A platform-independent printing protocol used in TCP/IP networks. It does not support bidirectional
communication.

M

• MAC Address

Also known as the physical address. A unique and permanent hardware identifier that is assigned to
network devices by its manufacturer. MAC addresses are 48 bits long and are written as a
hexadecimal number separated by colons, i.e., 11:22:33:44:55:66.

O

• Operation Status

Indicates the status on whether the printer can be used.
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P

• Prefix length

The number of bits on the network part of an IP address. The number of bits is 8 bit to 24 bit for IPv4,
and 64 bit for IPv6.

• Proxy server

A server that links a LAN-connected computer to the Internet. When using a proxy server, specify the
address and the port number of the proxy server.

• PSK

An encryption method employed by WPA/WPA2.

R

• Router

A relay device to connect to another network.

S

• Signal Strength

The strength of the signal received by the printer from the wireless router is indicated with a value
from 0 to 100%.

• SSID

Unique label for wireless LAN. It is often represented such as a network name or a wireless router
name.

SSID distinguishes one wireless LAN from another to prevent interference.

The printer and all clients on a wireless LAN must use the same SSID in order to communicate with
each other. The SSID can be up to 32 characters long, and is made up of alphanumeric characters.
The SSID may also be referred to by its network name.

• Stealth

In the stealth mode, a wireless router hides itself by not broadcasting its SSID. The client must specify
the SSID set to the wireless router to detect it.

• Stateful address

An IPv6 address acquired from a DHCP server using DHCPv6.

• Stateless address

A tentative IPv6 address generated automatically using a prefix included in RA (Router
Advertisement) and a MAC address. An IPv6 address is generated in an environment where a DHCP
server is not available.
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• Subnet Mask

IP address has two components, the network address and the host address. Subnet Mask used to
calculate the Subnet Mask address from the IP address. A Subnet Mask is usually assigned by a
wireless router or a DHCP server of the router automatically.

Example:

IP Address: 192.168.127.123

Subnet Mask: 255.255.255.0

Subnet Mask Address: 192.168.127.0

T

• TCP/IP

Suite of communications protocols used to connect hosts on the Internet or the LAN. This protocol
allows different terminals to communicate with each other.

• TKIP

An encryption protocol employed by WPA/WPA2.

U

• USB

Serial interface designed to enable you to "hot-swap" devices, i.e., by plugging and unplugging them
without turning off the power.

W

• WCN (Windows Connect Now)

Users running Windows Vista or later can obtain the setting information directly via wireless network
(WCN-NET).

• WEP/WEP Key

An encryption method employed by IEEE 802.11. Shared security key used to encrypt and decrypt
data sent over wireless networks. This printer supports key length of 64 bits or 128 bits, key format of
ASCII code or Hexadecimal, and key number of 1 to 4.

• Wi-Fi

International association that certifies interoperability of wireless LAN products based on the IEEE
802.11 specification.

This printer is a Wi-Fi authorized product.

• Wireless Direct

The printer is used as a wireless router to connect external wireless communication devices (e.g.
computers, smartphones, or tablets) in an environment where no wireless router is available. You can
connect up to 5 devices to the printer using Wireless Direct.
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• Wireless LAN

A network that, instead of being connected by physical wires, is connected by a wireless technology,
such as Wi-Fi.

• Wireless Router

A wireless transceiver or base station that receives information from wireless clients/the printer and
rebroadcasts it. Required in an infrastructure network.

• WPA

Security framework announced by the Wi-Fi Alliance in October 2002. The security has been
strengthened more than WEP.

◦ Authentication

WPA defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA-802.1x that do require an authentication server.

This printer supports WPA-PSK.

◦ Passphrase

This encrypted key is used to perform WPA-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.

• WPA2

Security framework released by the Wi-Fi Alliance in September 2004 as a later version of WPA.
Provides a stronger encryption mechanism through Advanced Encryption Standard (AES).

◦ Authentication

WPA2 defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA2-802.1x that do require an authentication server.

This printer supports WPA2-PSK.

◦ Passphrase

This encrypted key is used to perform WPA2-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.

• WPS (Wi-Fi Protected Setup)

WPS is a standard for easy and secure establishment of a wireless network.

There are 2 primary methods used in the Wi-Fi Protected Setup:

PIN entry: a mandatory method of setup for all WPS certified devices

Push button configuration (PBC): an actual push button on the hardware or through a simulated push
button in the software.
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Restrictions

If you use a printer over the wireless LAN, the printer may recognize nearby wireless systems, you should
set a network key (WEP or WPA/WPA2) to the wireless router to encrypt wireless transmission. Wireless
communication with a product that does not comply with the Wi-Fi standard cannot be guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.

If you use a printer with Wireless Direct, you cannot perform the following settings:

• Specifying an IP address manually
• Enabling/disabling IPv6
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Firewall

A firewall is a function of the security software installed in the computer or operation system for computer,
and is a system that is designed to prevent unauthorized access to a network.

Precautions When Firewall Function is Enabled
• A firewall function may limit communications between a printer and a computer. This may disable

printer setup and communications.
• During the printer setup, you may be prompted to enable or disable communications, depending on

the firewall function of the security software or operation system. If so, choose to enable
communications.

• When using IJ Network Device Setup Utility, you may be prompted to enable or disable
communications, depending on the firewall function of the security software. If so, choose to enable
communications.

• If you cannot set up the printer, temporarily disable the firewall function of the security software or
operation system.

Important
• If you disabled the firewall function, disconnect your network from the Internet.

• Some applications (like the network configuration software) override firewall settings. Check the
application's settings beforehand.

• If the printer you use is set to Get IP address automatically, the IP address changes every time the
printer connects to the network. This may disable printer setup and communications, depending on
the firewall settings. In this case, either change the firewall settings or assign a fixed IP address to the
printer. An IP address can be set using IJ Network Device Setup Utility.

Performing/Changing Wired LAN Settings
Performing/Changing Wireless LAN Settings

When assigning a fixed IP address to the printer, you will need to specify an IP address with which the
computer can communicate.

Note
• For the operation system firewall settings or the security software firewall settings, refer to the

instruction manual of the computer or software, or contact its manufacturer.
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List of Devices Which May Interfere with Wireless LAN
Communication

While using the printer via wireless LAN, the following devices near the printer or wireless router may cause
radio frequency interference and affects connection between the printer and wireless router. Radio
frequency interference may cause sending print jobs or printing speed to slow down.

• Microwave oven
• Baby monitor
• Wireless mouse
• Wireless keyboard
• Wireless earphone/headphones
• Wireless camera (e.g. security camera)

We recommend you take measures below to avoid radio frequency interference.

• Place the devices above as far away from the printer or wireless router as possible.
• Turn the devices off and stop using them temporarily.
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Sharing the Printer on a Network (Windows)

When computers are used in a network environment, documents can be printed from multiple computers
that share a single printer.

• Setting Up a Shared Printer

This section describes how to set up the print server and the client.

Note
• The Windows versions of the computers connected to the network do not necessarily have to be the

same.

Related Topic
Restrictions on Printer Sharing
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Setting Up a Shared Printer

On the print server, set up sharing of the printer driver. Then from the client, set up the connection to the
print server.

1. Install the printer driver on the print server system

2. Select as described below:

• If you are using Windows 10 or Windows Server 2016, select the Start menu -> Windows System
-> Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 8.1, Windows Server 2012 R2, or Windows Server 2012, from the
Desktop charms, select Settings -> Control Panel -> Hardware and Sound (Hardware) ->
Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control Panel -
> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

3. Click the icon for the model name of printer to be shared

Press the Alt key, and from the displayed File menu, select Printer properties -> Sharing tab.

Important
• When starting up the software and performing install or uninstall, a confirmation or warning dialog

box may appear.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

4. Set sharing

On the Sharing tab, check (or select) Share this printer, set the shared name as necessary, and then
click OK.

5. If the print server and the client have different architectures (32 bit or 64 bit), install an
additional driver

1. Display the Devices and Printers, Printers, or Printers and Faxes window.
2. Select the printer icon, click Print server properties, and select the Drivers tab.
3. Click Add....
4. When the Add Printer Driver Wizard window is displayed, click Next.
5. If the print server has a 32-bit architecture, select x64. If the print server has a 64-bit architecture,

select x86. Then click Next.
6. Click Have Disk....
7. In the Install From Disk window, open the "Driver" folder of the downloaded printer driver, specify

the "inf" file, and click OK.
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Note
• If the printer server is 32-bit, specify it as "xxxxxxx3.INF". If it is 64-bit, specify it as

"xxxxxxx6.INF".

8. Select the printer to be used, and click Next.
Note

• If an error message is displayed, select the other printer.

9. Click Finish

The setup on the print server system is complete. Next, set up the client systems.

6. On the client, open Explorer, and double-click the icon of the printer to be shared

7. Follow the window instructions, and install the printer driver

The setup on the client system is complete.
Even when you perform the setup on a different client, follow the same steps 6 and 7.
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Restrictions on Printer Sharing

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

Restriction on setting up printer sharing
• If "ntprint.inf" is requested when you install the driver from Add Printer, specify the file as follows:

1. Start Explorer on the print server and on the client with the different architecture, paste the
following path in the address bar, and press Enter on the keyboard:
%windir%\system32\driverstore\

2. Right-click the FileRepository folder, and click Properties.
3. On the Sharing tab, click Share.
4. In the message window displayed on the print server, specify "ntprint.inf_xxxxxxxx" in the folder

that was shared in step 3, and click OK.
If there are multiples copies, select the file with the latest update date and time.

Restrictions on sharing and using a printer
• A print completion message may be displayed. To disable the message display, follow the procedure

below.
◦ If you are using Windows 10, Windows 8.1, Windows Server 2016, Windows Server 2012 R2, or

Windows Server 2012:

In the Devices and Printers window of the client system, select the printer from Printers, and
click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

◦ If you are using Windows 7 or Windows Server 2008 R2:

In the Devices and Printers window of the client system, select the printer from Printers and
Faxes, and click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

• The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
support check box cleared on the Ports tab, the bidirectional communication function of the print
server may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.

• When you print from a client system, the following functions cannot be used.
◦ Canon imagePROGRAF Preview
◦ Canon imagePROGRAF Free Layout
◦ Edit from PosterArtist Lite

• When the functions on the Maintenance tab cannot be set properly from a client system, they may be
grayed out. In this case, change the settings from the print server.
When you change the settings of the print server, you should delete the icon of the shared printer
from the client system, and then specify the shared settings again in the client system.
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• If the same driver installed on the print server is also installed on the client, the network printer icon
may be created automatically.

• If an error occurs when you print a document on a shared printer from a client, the error message of
the Canon IJ status monitor is displayed on both the client and the print server. If a document is
printed out normally, the Canon IJ status monitor is displayed only on the client.
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Connecting Smartphone/Tablet to Printer via Wireless LAN

• To connect a smartphone or tablet to printer via a wireless LAN router:

Connecting Smartphone/Tablet to Printer via Wireless LAN Router

• To connect a smartphone or tablet to printer without a wireless LAN router:

Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct Connection)
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Connecting Smartphone/Tablet to Printer via Wireless LAN Router

You can connect devices (e.g. smartphone, or tablet) to the printer by two methods below.

• Wireless connection (connecting devices via a wireless router)
• Direct wireless connection (connecting devices using wireless direct)

This section describes connection via a wireless LAN router.

Follow the procedure below to connect via a wireless router.

1. Check printer LAN setting.

2. Connect smartphone/tablet to printer.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.
• Check the usage restrictions and change the printer LAN setting.

Restrictions

Checking Printer LAN Setting

Make sure the  icon is displayed on the upper right on the HOME screen.

If the  icon is not displayed, follow the procedure below to enable wireless LAN and to connect the
printer to the wireless router.

1. Flick HOME screen and tap  LAN settings.

Menu Operations

2. Tap Change LAN.

3. Tap Activate wireless LAN.

The printer wireless LAN is enabled and you can connect the wireless LAN you connected previously.

Connecting Smartphone/Tablet to Printer
For Android device
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For iOS device

• For Android device

1. Open "Settings" menu on your device.

2. Enable "Wi-Fi".

3. Select wireless router SSID you use from detected device list.

4. Enter wireless LAN router password.

Your device is connected to the printer.

5. Start printing from application.

• For iOS device

1. Open "Settings" menu on your device.

2. Enable "Wi-Fi".

3. Select wireless router SSID you use from detected device list.

4. Enter wireless LAN router password.

Your device is connected to the printer.

5. Start printing from application.

423



Adjustments for Better Print Quality

Adjusting the Print Head

Adjusting the Print Head

Troubleshooting Paper Abrasion and Blurry Images

Adjusting Feed Amount

Adjusting Feed Amount

Adjusting Vacuum Strength
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Adjusting the Print Head

Adjusting the Print Head

Troubleshooting Paper Abrasion and Blurry Images
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Adjusting the Print Head

If printed documents are affected by the following problems, try adjusting the print head.

• If printing is faint or affected by banding in different colors

Execute Print nozzle check pattern in the touch screen menu to check for print head nozzle clogging.

Checking for Nozzle Clogging

• If printed lines are misaligned, vertical lines are warped, or colors are out of alignment

If printed lines are misaligned, execute Print head angle adjustment in the touch screen menu to
adjust the print head angle.

Always adjust the print head angle after replacing the print head.

After executing Print head angle adjustment, adjust the print head position.

Adjusting Line Misalignment

If printed vertical lines are warped or colors are out of alignment, execute Print head alignment in the
touch screen menu to adjust the print head position.

First, execute Auto (standard) of Print head alignment. If the print result is not improved, execute
Auto (fine) or Manual.

Automatic Adjustment to Straighten Lines and Colors
Manual Adjustment to Straighten Lines and Colors

• If paper rubs against the print head, or image edges are blurred

Setting Paper Thickness (Head Height) in the touch screen menu and changing the height of the print
head may improve the situation.

Troubleshooting Paper Abrasion and Blurry Images
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Adjusting Line Misalignment

If printed lines are misaligned, execute Print head angle adjustment to adjust the print head angle. Print
head angle adjustment requires you to examine a printed test pattern and adjust the angle using the angle
adjustment lever.

Always adjust the print head angle after replacing the print head.

Note
• We recommend using the type of paper you use most often for adjustment.

Paper to Prepare

When using rolls
An unused roll at least 10.00 inches (254.0 mm) wide

When using sheets
One sheet of unused paper of at least A4/Letter size

Perform adjustment as follows.

1. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)
Loading Sheets in the Printer

Important
• Always make sure the loaded paper matches the type of paper specified on the printer.

Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

3. Tap Print head angle adjustment.

A confirmation message appears.

4. Tap Yes.

The carriage moves and the guidance for the print head angle adjustment procedure appears on the
touch screen.

5. Open the top cover.
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6. Align the angle adjustment lever with the red square and close the top cover.

A test pattern is printed for adjustment.

Important
• Do not touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching these may

cause malfunction.

428



7. Examine the test pattern for adjustment. Determine the straightest set of lines.

8. When message appears, open top cover and move angle adjustment lever to match
number (or square) of straightest set of lines.

If no single set of lines is perfectly straight, move the angle adjustment lever to a position between the
numbers (or between the number and the square) of the two sets of lines that are least misaligned.

9. Close the top cover.
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The print head is now straight, and adjustment is complete.
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Automatic Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment, execute Print head alignment and adjust
the print head position.

Choose from Auto (standard) or Auto (fine) for automatically adjusting the print head.

Minor warping and misaligned colors can usually be improved by executing Auto (standard). If there is no
improvement, perform Auto (fine) or Manual.

Manual Adjustment to Straighten Lines and Colors

When you execute Auto (standard) or Auto (fine), the adjustment pattern is printed, and the print head
position is adjusted based on the printing result automatically.

Important
• If the problem, such as misaligned lines, is conspicuous, adjust the print head angle first.

Adjusting Line Misalignment

• Because the results of adjustment vary depending on the type of paper used for adjustment, use the
same type of paper as you will use for printing.

• This function is not available with Tracing Paper, Translucent Matte Film, or Clear Film.

Note
• After print head replacement, execute Print head alignment. When Print pattern after new head is

set to ON, print head position adjustment is automatically executed after print head replacement.
• To change the paper type or for more beautiful color borders, perform Auto (standard).
• To ensure clear quality and when replacing the print head, perform Auto (fine) to fine-tune the position

between nozzles and colors. To ensure high-quality printing, we recommend that you execute Auto
(fine).

• If adjustment is not possible as expected using special paper, try another type of paper or try Manual
adjustment.

Manual Adjustment to Straighten Lines and Colors

Paper to Prepare

When using rolls
An unused roll at least 10.00 inches (254.0 mm) wide

When using sheets
Auto (standard): Three sheets of unused paper, A4/Letter size or larger (or one sheet when using A2
or larger)

Auto (fine): Five sheets of unused paper, A4/Letter size or larger (or one sheet when using A2 or
larger)

Perform adjustment as follows.
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1. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)
Loading Sheets in the Printer

Important
• Always make sure the loaded paper matches the type of paper specified on the printer.

Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

3. Tap Print head alignment.

4. Tap Auto (standard) or Auto (fine).

A confirmation message appears.

5. Tap Yes.

The paper source setting screen appears.

6. Tap paper source with loaded paper.

A test pattern is printed for adjustment.

Note
• If you are printing on sheets smaller than A2 size, a confirmation message prompting you to

continue printing appears on the touch screen. Tap OK and follow the instructions on the touch
screen.
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Manual Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment, execute Print head alignment and adjust
the print head position.

Normally, execute Auto (standard).

Automatic Adjustment to Straighten Lines and Colors

However, when printing on special paper or if printing is not improved after Auto (fine), try Manual.

Manual adjustment requires you to examine the printed test pattern and enter an adjustment value.

Note
• We recommend using the type of paper you use most often for adjustment.

Paper to Prepare

When using rolls
An unused roll at least 10.00 inches (254.0 mm) wide

When using sheets
Three sheets of unused paper, A4/Letter size or larger (or one sheet when using A2 or larger)

Perform adjustment as follows.

1. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)
Loading Sheets in the Printer

Important
• Always make sure the loaded paper matches the type of paper specified on the printer.

Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

3. Tap Print head alignment.

4. Tap Manual.

A confirmation message appears.
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Note
• If you do not execute Auto (fine), a confirmation message prompting you to execute Auto (fine)

appears. In this case, tap Yes and execute Auto (fine).

5. Tap Yes.

The paper source setting screen appears.

6. Tap paper source with loaded paper.

A test pattern is printed for adjustment.

7. Tap D-1.

8. Examine adjustment test pattern D-1 and determine the number with straight lines.

A: Example with straight lines
B: Example with misaligned lines

Note
• If two patterns seem equally good and you cannot decide which one is better, choose an

intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or 12 is
better.

9. Repeat steps 7–8 to specify adjustment value for D-2 to D-41.

Note that D-6, D-12, D-18, D-24, D-30, and D-36 cannot be configured.

10. Tap OK.

The adjustment value is now registered, and adjustment is complete.
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Troubleshooting Paper Abrasion and Blurry Images

The print head height setting affects printing quality.

Specifying a low print head height makes images clearer and enhances printing quality but may cause paper
to rub against the print head.

On the other hand, specifying a high print head height will prevent paper from rubbing against the print head
but may reduce the printing quality.

Important
• Paper rubbing against or becoming caught on the print head may jam or result in printed documents

that are soiled.

Note
• Raise or lower print head, depending on nature of the problem.

Paper rubs against the Print Head
The edges of the paper are dirty
Image edges are blurred or white banding occurs

1. Tap paper setting display area on HOME screen.

Touch Screen

The Paper settings screen appears.

2. Tap paper source for print head height adjustment, and then tap Paper settings.

The Paper settings screen appears.

3. Tap Advanced.

The Advanced paper settings screen appears.

4. Tap Paper Thickness (Head Height).

5. Drag slider to set paper thickness and tap OK.
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Note
• When Auto is set to ON, before printing, the printer automatically adjusts the print head height to

the level optimal for the ambient temperature and humidity. You can check the setting for the
previous print job in Values applied with auto settings.

Printer information

• When Auto is set to OFF, the setting selected during this procedure is applied.
• Depending on the type of paper, some setting values may not be available.
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Adjusting Feed Amount

Adjusting Feed Amount

Adjusting Vacuum Strength
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Adjusting Feed Amount

Selecting Feed Amount Adjustment Method

Automatic Banding Adjustment

Manual Banding Adjustment

Fine-Tuning Paper Feed Amount

Adjusting Line Length
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Selecting Feed Amount Adjustment Method

There are two methods of adjusting the paper feed amount, Prioritize print quality and Prioritize length
accuracy, either of which will be applied during printing.

Since the method that is applied during printing is determined from the value of the Set priority setting,
configure Set priority to match the print target.

Follow the procedure below to perform settings.

1. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading Sheets in the Printer

2. Flick HOME screen and tap  Maintenance.

Menu Operations

3. Tap Paper feed adjustment.

4. Tap Set priority.

5. Tap paper to adjust.

6. Tap setting.

Prioritize print quality
Adjusts the feed amount to reduce banding across the sheet in printed documents. Adjust print
quality settings are applied. When Paper feed fine adjustment is executed, the Paper feed fine
adjustment settings are applied in addition to the Adjust print quality settings.

Prioritize length accuracy
Adjusts the feed amount for better accuracy of lines in printed documents.

Auto
Prioritize print quality or Prioritize length accuracy is selected, depending on the setting as
selected in the printer driver at the time of printing.

7. Tap OK on displayed screen.
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Automatic Banding Adjustment

If printed images are affected by banding in different colors across the sheet, execute Adjust print quality
for automatic adjustment of the paper feed amount.

The printer prints and reads a test pattern for automatic adjustment of the feed amount.

Important
• When using highly transparent media, use manual adjustment.

Manual Banding Adjustment

Note
• We recommend executing the adjustment if you have changed the paper type or paper size.
• Always check the Set priority values.

Selecting Feed Amount Adjustment Method

• If additional fine-tuning is necessary, execute Paper feed fine adjustment.

Fine-Tuning Paper Feed Amount

• Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.

Adjusting Line Length

• This may take some time, depending on the type of paper.

Items to Prepare

When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets One sheet of unused paper of at least A4/Letter size

Follow the procedure below to adjust.

1. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading Sheets in the Printer

2. Flick HOME screen and tap  Maintenance.

Menu Operations

3. Tap Paper feed adjustment.

4. Tap Adjust print quality.

5. Tap Auto.
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6. Tap paper to adjust.

A test pattern is printed for adjustment and adjustment is finished.
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Manual Banding Adjustment

If printed images are affected by banding in different colors, execute Adjust print quality for adjustment of
the paper feed amount.

Use manual adjustment with highly transparent media.

Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

Note
• We recommend executing the adjustment if you have changed the paper type or paper size.
• Always check the Set priority values.

Selecting Feed Amount Adjustment Method

• If additional fine-tuning is necessary, execute Paper feed fine adjustment.

Fine-Tuning Paper Feed Amount

• Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.

Adjusting Line Length

Items to Prepare

When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets Two sheets of unused paper of at least A4/Letter size

Follow the procedure below to adjust.

1. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Important
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be

completed correctly unless the loaded paper matches the settings.

2. Flick HOME screen and tap  Maintenance.

Menu Operations

3. Tap Paper feed adjustment.

4. Tap Adjust print quality.

5. Tap Manual.

6. Tap paper to adjust.
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Test pattern A is printed for manual adjustment.

Note
• When printing on sheets, follow the instructions on the screen and remove the sheet.

7. Examine test pattern A for adjustment. Determine pattern in which banding is least
noticeable.

Note
• If banding seems least noticeable in two patterns but you cannot decide which one is better,

choose an intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or
12 is better.

8. Tap number you decided.

Test pattern B is printed for manual adjustment.

Note
• If you printed test pattern A on a sheet, follow the instructions on the screen and use another

sheet of the same type of paper. Additionally, after test pattern B is printed, follow the instructions
on the screen and remove the sheet.

9. Examine test pattern B for adjustment. Determine pattern in which banding is least
noticeable.

10. Tap number you decided.

The adjustment value is now registered, and adjustment is complete.
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Fine-Tuning Paper Feed Amount

If the contrast is uneven or banding in different colors appears at 30 mm (1.2 in) intervals in printed
documents, try executing Paper feed fine adjustment during printing to fine-tune the feed amount.

Note
• The Paper feed fine adjustment menu is only displayed during printing.

Additionally, it is displayed when you have selected Auto or Prioritize print quality in Set priority in
Paper feed adjustment.

• Always execute Adjust print quality before Paper feed fine adjustment.

Once you execute Adjust print quality, the Paper feed fine adjustment value will revert to 0.

Automatic Banding Adjustment
Manual Banding Adjustment

Follow the procedure below to adjust.

1. Flick HOME screen and tap  Maintenance while printing is in progress.

Menu Operations

2. Tap Paper feed fine adjustment.

3. Tap value.

At this time, if banding in dark colors appears, select a setting value in the range 1 to 5, and if banding in
light colors appears, select a setting value in the range -1 to -5.
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Adjusting Line Length

To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust feed length to
adjust the amount that paper is advanced.

There are two options in Adjust feed length : Print alignment pattern and Change adjustment values.

Note
• We recommend executing the adjustment if you have changed the paper type or paper size.
• Always check the Set priority values before adjustment.

Selecting Feed Amount Adjustment Method

Items to Prepare

When Using Rolls • An unused roll at least 254.0 mm (10.00 in) wide
• High-precision ruler

When Using Sheets • One sheet of unused paper of at least A4/Letter size
• High-precision ruler

Follow the procedure below to adjust.

1. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Important
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be

completed correctly unless the loaded paper matches the settings.

2. Flick HOME screen and tap  Maintenance.

Menu Operations

3. Tap Paper feed adjustment.

4. Tap Adjust feed length.

5. Tap Print alignment pattern or Change adjustment values.

• If you tap Print alignment pattern:

The test pattern is printed for you to measure the scale and calculate the discrepancy.

The scale bar prints "Millimeter" in 50 mm increments and "Inch" in 1-inch increments.
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• If you tap Change adjustment values:

No test pattern is printed. Instead, you will measure a document already printed to determine the
discrepancy.

6. Tap amount of discrepancy.

If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative
value.

The feed amount can be adjusted in 0.02% increments.
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Adjusting Vacuum Strength

When printing on heavyweight paper or paper that curls or wrinkles easily, if the print head rubs against
paper, adjusting the level of suction against paper on the platen may improve results.

Important
• Paper rubbing against or becoming caught on the print head may jam or result in printed documents

that are soiled.

1. Flick HOME screen and tap paper information area.

Menu Operations

2. Tap paper to change vacuum strength on Paper settings screen.

3. Tap Paper settings.

4. Tap Advanced.

5. Tap Transport unit vacuum strength.

6. Tap vacuum strength.
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Color Management

Device Management Console Guide
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Maintenance and Consumables

Ink Tanks

Ink Tanks

Replacing Ink Tanks

Checking Ink Tank Levels

When to Replace Ink Tanks

Print Head

Print Head

Checking for Nozzle Clogging

Cleaning the Print Head

Replacing the Print Head

Maintenance Cartridge

Maintenance Cartridge

Replacing the Maintenance Cartridge

Checking the Remaining Maintenance Cartridge Capacity

When to Replace the Maintenance Cartridge

Cutter Blade

Cutter Blade

Replacing the Cutter Blade

Performing Maintenance Functions from Your Computer (Windows)

Cleaning the Print Heads

Printing a Nozzle Check Pattern

Performing Maintenance Functions from Your Computer (macOS)

Opening Remote UI for Maintenance

Cleaning the Print Heads

Printing a Nozzle Check Pattern

Cleaning the Printer
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Cleaning the Printer Exterior

Cleaning Inside the Top Cover

Cleaning the Roll Unit

Cleaning the Print Head

Other Maintenance

Preparing to Transfer the Printer

Reinstalling the Printer

Firmware update
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Ink Tanks

Ink Tanks

Replacing Ink Tanks

Checking Ink Tank Levels

When to Replace Ink Tanks
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Ink Tanks

When purchasing, check the Model number.

5.4 fl oz (160 ml)

Colors Model number

Matte Black PFI-110 MBK

Black PFI-110 BK

Cyan PFI-110 C

Magenta PFI-110 M

Yellow PFI-110 Y

11.2 fl oz (330 ml)

Colors Model number

Matte Black PFI-310 MBK

Black PFI-310 BK

Cyan PFI-310 C

Magenta PFI-310 M

Yellow PFI-310 Y
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23.7 fl oz (700 ml)

Colors Model number

Matte Black PFI-710 MBK

Black PFI-710 BK

Cyan PFI-710 C

Magenta PFI-710 M

Yellow PFI-710 Y

Note
• For instructions on replacing the ink tanks, see Replacing Ink Tanks.
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Replacing Ink Tanks

Compatible Ink Tanks
For details on compatible ink tanks, see Ink Tanks.

You can replace ink tanks in 5.4 fl oz (160 ml), 11.2 fl oz (330 ml), and 23.7 fl oz (700 ml) capacities.

Note
• Depending on the color, you can also use an ink tank with a different capacity.

Precautions When Handling Ink Tanks
Take the following precautions when handling ink tanks.

Caution
• For safety, keep ink tanks out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important
• There may be ink around the ink holes of an ink tank you removed. Handle the ink tanks carefully

during replacement. The ink may stain clothing.
• Do not install ink tanks used in this printer in another model of printer. This will prevent correct ink

level detection, which may damage the printer or cause other problems.

• We recommend using up an ink tank in the course of printing within six months after breaking the
seal. Printing quality may be affected if you use older ink tanks.

• Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual
ink may become clogged inside the printer and affect printing quality.

How to Replace an Ink Tank
If a message indicates you should replace an ink tank, check the message details and go to step 2.

1. Selecting Ink Tank Replacement from Menu
2. Removing Ink Tanks

Removing ink tank (5.4 fl oz (160 ml) / 11.2 fl oz (330 ml))
Removing ink tank (23.7 fl oz (700 ml))

3. Loading New Ink Tanks

Loading ink tank (5.4 fl oz (160 ml) / 11.2 fl oz (330 ml))
Loading ink tank (23.7 fl oz (700 ml))

Important
• Do not remove an ink tank during initialization immediately after turning on the printer, or during print

head cleaning. Ink may leak out.

Note
• Ink tank replacement is possible even during printing, when print jobs are being canceled, or when

paper is being advanced.
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Selecting Ink Tank Replacement from Menu

1. Tap ink display area on HOME screen.

Touch Screen

The Current estimated ink levels screen appears.

2. Tap Replace.

Instructions for the ink tank replacement procedure appear on the touch screen.

Removing ink tank (5.4 fl oz (160 ml) / 11.2 fl oz (330 ml))

1. Open ink tank cover and check ink lamp.

The ink lamp flashes if there is no ink left.

Important
• Avoid jarring the printer a lot when replacing an ink tank. Handle the printer gently when

replacing tanks. Jarring the printer during printing may affect printing quality.

2. Pull forward handle part (A) of ink tank lock lever of color to replace while pressing button
at B.
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3. Pull out ink tank lock lever.

1. Pull ink tank lock lever straight up.

2. Pull ink tank lock lever toward the front.

3. Push ink tank lock lever firmly down until it does not return.
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Note
• Check that the ink tank lock lever does not return.

4. Remove ink tank by grips (A), and then tap OK.

Important
• Store the removed ink tank with ink remaining with the ink holes (B) facing up. Otherwise, ink

may leak and cause stains. Put the removed ink tank in a plastic bag and close the bag.

Note
• Dispose of the used ink tank in accordance with local regulations.
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Removing ink tank (23.7 fl oz (700 ml))

1. Open ink tank cover and check ink lamp.

The ink lamp flashes if there is no ink left.

Important
• Avoid jarring the printer a lot when replacing an ink tank. Handle the printer gently when

replacing tanks. Jarring the printer during printing may affect printing quality.

2. Pull forward handle part (A) of ink tank lock lever of color to replace while pressing button
at B.

3. Pull out ink tank lock lever.

1. Pull ink tank lock lever straight up.
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2. Pull ink tank lock lever toward the front.

3. Push ink tank lock lever firmly down until it does not return.

Note
• Check that the ink tank lock lever does not return.

4. Remove ink tank by handle (A), and then tap OK.
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Important
• Store the removed ink tank with ink remaining in the box with the ink holes (B) facing up.

Otherwise, ink may leak and cause stains.

Note
• Dispose of the used ink tank in accordance with local regulations.

Loading ink tank (5.4 fl oz (160 ml) / 11.2 fl oz (330 ml))

1. Before opening the pouch, tilt the ink tank to the left and right gently seven or eight times.
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Important
• Do not remove and agitate an ink tank that has already been installed in the printer. Ink may

leak out.
• Failure to agitate the ink tank may cause the ink components to precipitate and may affect

printing quality.

Note
• If the ink tank is at a low temperature, allow it to warm up to room temperature before installing.

2. Open the pouch and remove the ink tank.

Important
• Never touch the ink holes (A) or the metal contacts (B). This may cause stains, damage the ink

tank, and affect printing quality.

• Avoid dropping the ink tank after removing it from the pouch. Otherwise, ink may leak and
cause stains.
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3. Tap OK and insert ink tank into holder with ink holes down and metal contacts at rear.

Important
• An ink tank cannot be loaded in the holder if the color or orientation is incorrect.

If the ink tank does not fit in the holder, do not force it into the holder. Reinstall while checking
the label color display, ink tank color, and ink tank orientation.

4. Lift up ink tank lock lever, and then push it down.

5. Push handle part of ink tank lock lever firmly all the way in.
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6. Make sure ink lamp is lit.

Note
• If the ink lamp is not lit, reload the tank.

7. Close ink tank cover.
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Loading ink tank (23.7 fl oz (700 ml))

1. Before opening the pouch, hold the new ink tank with both hands and tilt it to the left and
right as shown, shaking it gently seven or eight times.

Caution
• A 23.7 fl oz (700 ml) ink tank is heavy, so use your whole arm to agitate it instead of just your

wrist. If you agitate the ink tank using just your wrist, you may injure your wrist.

Important
• Do not remove and agitate an ink tank that has already been installed in the printer. Ink may

leak out.
• Failure to agitate the ink tank may cause the ink components to precipitate and may affect

printing quality.

Note
• If the ink tank is at a low temperature, allow it to warm up to room temperature before installing.

2. Open the pouch and remove the ink tank.
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Important
• Never touch the ink holes (A) or the metal contacts (B). This may cause stains, damage the ink

tank, and affect printing quality.

• Avoid dropping the ink tank after removing it from the pouch. Otherwise, ink may leak and
cause stains.

3. Tap OK and insert ink tank into holder with ink holes down and metal contacts at rear.
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Important
• An ink tank cannot be loaded in the holder if the color or orientation is incorrect.

If the ink tank does not fit in the holder, do not force it into the holder. Reinstall while checking
the label color display, ink tank color, and ink tank orientation.

4. Lift up ink tank lock lever, and then push it down.

5. Push handle part of ink tank lock lever firmly all the way in.
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6. Make sure ink lamp is lit.

Note
• If the ink lamp is not lit, reload the tank.

7. Close ink tank cover.
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Checking Ink Tank Levels

On the touch screen, you can check how much ink is left in the ink tank.

1. Tap ink display area on HOME screen.

Touch Screen

The Current estimated ink levels screen appears.

This printer has ink tanks (A) and sub-ink tanks (B). Even if ink runs out, printing can continue with ink in
the sub-ink tanks.

When the remaining ink is low,  will appear on the remaining ink level. When ink runs out,  will
appear. See the figure below.

If the touch screen indicates to replace the ink tank, replace the ink tank. If a message is displayed
indicating to check the remaining ink levels, or after tasks that consume a lot of ink such as large-format
printing or head cleaning, check the remaining levels and replace ink tank as needed.

Replacing Ink Tanks

Note
• Tap Order ink now to view the ink supplier information.
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• When the function for detecting the remaining ink level is disabled,  will appear on the
remaining ink level.

• After replacing ink tanks, ink starts filling in the sub-ink tanks.

While sub-ink tanks are filling with ink,  will appear on the remaining ink level.
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When to Replace Ink Tanks

Replace or prepare to replace ink tanks in the following situations.

• If ink confirmation message appears on touch screen

If ink is low, the Status lamp lights orange and a notification message will appear on the touch screen.
You can continue to print, but prepare the ink tanks.

Checking Ink Tank Levels

• Before print jobs and maintenance that consume a lot of ink

If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance,
which require a lot of ink. Replace or prepare to replace the ink tanks in the following situations.

• If message for ink replacement appears on touch screen

When the ink runs out, the Status lamp flashes orange, a message regarding ink tanks replacement
appears on the touch screen, and printing is disabled. Replace the ink tank.
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Print Head

Print Head

Checking for Nozzle Clogging

Cleaning the Print Head

Replacing the Print Head
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Print Head

When purchasing, check the Model number.

Model number: PF-06

Note
• For instructions on replacing the print head, see Replacing the Print Head.
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Checking for Nozzle Clogging

If printing is faint or affected by banding in different colors, make sure the print head nozzles are clear by
printing a test pattern to check the nozzles.

Note
• By default, nozzles are checked at fixed intervals.

Auto maintenance settings

Paper to Prepare

When using rolls
An unused roll at least 10.00 inches (254.0 mm) wide

When using sheets
One sheet of unused paper of at least A4/Letter size

1. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)
Loading Sheets in the Printer

2. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

3. Tap Print nozzle check pattern.

A confirmation message appears.

4. Tap Yes.

The printer now prints a test pattern for checking the nozzles.

5. Check the printing results.

If the horizontal lines are not faint or incomplete, the nozzles are clear.

If some sections of the horizontal lines are faint or incomplete, the nozzles for those colors are clogged.
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If horizontal lines are faint or incomplete, execute print head cleaning.

Cleaning the Print Head
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Cleaning the Print Head

If printing is faint, cleaning the print head may improve results.

Choose one of three print head cleaning modes (Cleaning, Deep cleaning, or System cleaning),
depending on the problem to resolve.

• Cleaning

Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes the
least amount of ink.

It takes about 3 to 4 minutes.

• Deep cleaning

Use this mode if no ink is ejected at all or if Cleaning does not solve the problem.

It takes about 3 to 4 minutes.

• System cleaning

Use this mode if printing is not improved after Deep cleaning. System cleaning consumes a very large
amount of ink. Performing this frequently consumes the ink faster. Perform this only when needed.

It takes about 4 to 5 minutes.

Important
• Do not remove the maintenance cartridge or ink tanks during Cleaning, Deep cleaning, or System

cleaning.

Ink may leak or an error may occur.

• If printing is not improved after System cleaning, the print head may be at the end of its service life.
Contact your Canon dealer for assistance.

Note
• Check the nozzle check pattern and select an ink group for which to perform cleaning as needed. You

can clean all print heads or select pattern 1 or 2 to clean the print heads with a clogged nozzle.
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• By default, nozzles are checked at fixed intervals.

Auto maintenance settings

Perform cleaning as follows.

1. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

2. Tap Print head cleaning.

3. Tap Cleaning, Deep cleaning, or System cleaning.

4. Tap ink group to be cleaned.

• All colors
• Pattern 1: MBK1 / BK / MBK2
• Pattern 2: Y / M / C

A confirmation message appears.

5. Tap Yes.

Head cleaning is now executed.

6. Print a test pattern to check the nozzles and determine whether cleaning has cleared the
nozzles.

Checking for Nozzle Clogging
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Replacing the Print Head

If the touch screen indicates to replace the print head or if instructed to do so by your Canon dealer, replace
the print head.

Compatible Print Head
For details on compatible print head, see Print Head.

Precautions When Handling Print Head
Take the following precautions when handling the print head.

Caution
• For safety, keep print head out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
• Do not touch the print head immediately after printing. The print head becomes extremely hot, and

there is a risk of burns.

Important
• There may be ink around the nozzles of the print head you remove. Handle the print head carefully

during replacement. The ink may stain clothing.
• Do not open the print head pouch until immediately before installation. After removing the print head

from the pouch, install it right away. If the print head is left as is after the pouch is opened, the
nozzles may dry out, which may affect printing quality.

How to Replace Print Head

Caution
• When replacing the print head immediately after printing, wait a few minutes before replacing it. The

metal parts of the print head become hot during printing, and there is a risk of burns from touching
these parts.

Important
• Your hands may become dirty during print head replacement. Use the gloves provided in the box with

the new print head for replacement.

Note
• Prepare a new ink tank when ink levels are low.
• Prepare a new maintenance cartridge when the remaining capacity of the maintenance cartridge is

low.

1. Remove any paper that has been fed.

• When using a roll, rewind it.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)

478



• When using sheets, remove the sheet.

Removing Sheets

2. Clean inside top cover.

Cleaning Inside the Top Cover

3. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

4. Tap Head replacement.

A confirmation message appears.

5. Tap Yes.

Ink begins being drawn in. When it finishes, instructions for the print head replacement procedure
appear on the touch screen.

It takes about 3 minutes for ink to be drawn into the system and remove ink from the print head.

6. Open top cover.

7. If the print head locking cover and print head lock lever are dirty, use a damp cloth that
you have wrung out completely to wipe them clean.
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Important
• Do not touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching these

may cause malfunction.

8. If ventilation duct (A) is dirty, use damp cloth that you have wrung out completely to wipe
it clean.

If the carriage is obscuring the ventilation duct, move the carriage manually before cleaning the duct.

480



9. Pull down print head lock lever toward the front while holding its center (A) with your
fingertip.

10. Grab grip (A) and open print head locking cover.

11. Grab grips (A), remove print head, and then tap OK.
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Important
• Never touch the metal contacts of the carriage. Furthermore, do not allow any dirt or debris to

become adhered to the metal contacts of the carriage. These may damage the printer.

Note
• Dispose of the used print head in accordance with local regulations.

12. Take new print head out of its pouch by grabbing grips (A).

13. Remove orange protective caps (A, B).

Grab grip (C) to remove protective cap (B).
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Important
• Always carry the print head by holding its right and left grips. Never touch nozzle (D) or metal

contacts (E). This may damage the print head and affect printing quality.
• Never touch the ink holes (F). This may affect printing quality.

• The inside surface of the protective cap is coated with ink to protect the nozzle. Be careful not
to touch these surfaces when removing the caps.

• The print head contains ink to protect the nozzle. We recommend removing the protective cap
while holding it over the pouch that contained the print head or otherwise safely out of the way
to avoid spilling ink and staining your clothes or the surrounding area. If ink accidentally spills,
wipe off the ink with a dry cloth.

• If you need to put a print head somewhere temporarily before installation, do not set it down
with the nozzles and metal contacts facing down. If the nozzles or metal contacts are damaged,
it may affect the printing quality.

• Do not reattach the removed protective part. Dispose of these materials in accordance with
local regulations.

14. Turn ink holes (A) toward the front and insert print head into carriage.

Insert the print head all the way into the carriage, while taking care to keep parts that were protected
by the protective caps from touching the carriage.
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15. Lower print head locking cover to front and lock print head.

16. Lower print head lock lever toward the back.

17. Close top cover.
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Ink now fills the print head. It takes about 12 minutes.

Important
• While ink is being filled, definitely do not remove the ink tank or maintenance cartridge. Ink may

leak out.

Note
• Print head position adjustment is executed when Print pattern after new head is set to ON.

Follow the instructions on the touch screen to load paper.

Auto maintenance settings
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Maintenance Cartridge

Maintenance Cartridge

Replacing the Maintenance Cartridge

Checking the Remaining Maintenance Cartridge Capacity

When to Replace the Maintenance Cartridge
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Maintenance Cartridge

When purchasing, check the Model number.

Model number: MC-30

Note
• For instructions on replacing the maintenance cartridge, see Replacing the Maintenance Cartridge.
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Replacing the Maintenance Cartridge

Compatible Maintenance Cartridges
For details on compatible maintenance cartridge, see Maintenance Cartridge.

Precautions When Handling Maintenance Cartridge
Take the following precautions when handling the maintenance cartridge.

Caution
• For safety, keep maintenance cartridge out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important
• Do not remove the maintenance cartridge except to replace it. Ink may leak out.
• Do not remove a maintenance cartridge during initialization immediately after turning on the printer,

during print head cleaning, while ink is being drawn out, or during initialization immediately after
replacing the maintenance cartridge.

The maintenance cartridge may become damaged or ink may leak out.

• To prevent ink from leaking from a used maintenance cartridge, avoid dropping the cartridge or
storing it at an angle. Otherwise, ink may leak and cause stains.

• Ink adheres to the top of the maintenance cartridge after it has been used. Handle the maintenance
cartridge carefully during replacement. The ink may stain clothing.

How to Replace a Maintenance Cartridge
If a message indicates you should replace a maintenance cartridge, check the message details and go to
step 4.

1. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

2. Tap Maintenance cartridge info.

The Maintenance cartridge info screen appears.

3. Tap Replace.

Instructions for the maintenance cartridge replacement procedure appear on the touch screen.

4. Open box, and remove plastic bag and maintenance cartridge.
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Important
• Never touch the metal contacts (A). This may damage the maintenance cartridge.

5. Open maintenance cartridge cover.

6. Hold the used maintenance cartridge by the grip (A) with one hand and put your other
hand under the maintenance cartridge to hold it firmly on the bottom, keeping it level as
you pull it out.
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Important
• A used maintenance cartridge is heavy. Always grasp the cartridge firmly and keep the

cartridge level during removal and storage. If you drop a used maintenance cartridge or store it
at an angle, ink may leak and cause stains.

7. Put used maintenance cartridge in supplied plastic bag and store on flat surface.

8. Check the top and bottom of the maintenance cartridge, place in the box, and store the
box on a flat surface.

Important
• Always put the used maintenance cartridge back in the box and store the box on a flat surface.

Note
• Dispose of the used maintenance cartridge in accordance with local regulations.

9. Wipe away any soiling on the maintenance cartridge cover.
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Important
• Support the maintenance cartridge cover from underneath as you wipe it.

10. Keeping the new maintenance cartridge level, insert it all the way in.

The maintenance cartridge is initialized.

Important
• Do not remove the maintenance cartridge during initialization immediately after replacing the

maintenance cartridge. The maintenance cartridge may become damaged.

11. Close maintenance cartridge cover.
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Checking the Remaining Maintenance Cartridge Capacity

The maintenance cartridge absorbs excess ink from print head cleaning. You can confirm the remaining
capacity of the maintenance cartridge by checking the touch screen.

1. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

2. Tap Maintenance cartridge info.

The Maintenance cartridge info screen appears.

If the touch screen indicates to replace the maintenance cartridge, replace the maintenance cartridge.

If a message appears indicating to check the remaining capacity of the maintenance cartridge, or before
tasks that deplete much of the capacity such as head cleaning or preparations to move the printer, check
the remaining maintenance cartridge capacity and prepare a new maintenance cartridge as needed.

Replacing the Maintenance Cartridge
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When to Replace the Maintenance Cartridge

Replace or prepare to replace the maintenance cartridge in the following situations.

• If maintenance cartridge confirmation message appears on touch screen

When the maintenance cartridge is almost used up, the Status lamp lights orange and a notification
message will appear on the touch screen. You can continue to print, but check the remaining
maintenance cartridge capacity and prepare to replace the maintenance cartridge with a new one.

Checking the Remaining Maintenance Cartridge Capacity

• When the maintenance cartridge capacity is drastically depleted

Print head cleaning, print head replacement, and preparations to transfer the printer deplete much of the
maintenance cartridge capacity. (In particular, preparing to move the printer depletes a lot of the
capacity.)

Check the remaining maintenance cartridge capacity before this maintenance and replace the
maintenance cartridge if necessary.

• If message for maintenance cartridge replacement appears on touch screen

When the maintenance cartridge is used up, the Status lamp blinks orange, a message regarding
maintenance cartridge replacement appears on the touch screen, and printing is disabled. Replace the
maintenance cartridge with a new one.
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Cutter Blade

Cutter Blade

Replacing the Cutter Blade
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Cutter Blade

When purchasing, check the Model number.

This cutter blade comes with a part for securing the cutter blade during installation.

Model number: CT-07

Note
• For instructions on replacing the cutter blade, see Replacing the Cutter Blade.
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Replacing the Cutter Blade

Compatible Cutter Blade
For details on compatible cutter blade, see Cutter Blade.

How to Replace Cutter Blade

1. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

2. Tap Replace cutter blade unit.

A confirmation message appears.

3. Tap Yes.

The carriage moves and after it stops moving, instructions for the cutter blade replacement procedure
appear on the touch screen.

Note
• If you do not take action within 2 minutes, cutter blade replacement is canceled. In this case,

start over replacement from the beginning.

4. Open top cover.

5. If cutter blade is dirty, use damp cloth that you have wrung out completely to wipe it
clean.

Important
• Do not touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching these

may cause malfunction.
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6. Turn hex screw with hex wrench until loose.

7. Remove cutter blade while holding A.
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Caution
• Never touch any part other than A. This may stain your hands or cause injury. Additionally, this

may damage the printer.
• Do not disassemble the cutter blade. Touching the blade may cause injury.

Note
• Dispose of the used cutter blade in accordance with local regulations.

8. Install new cutter blade while aligning A to B and C to D.

9. Install while aligning fixing part included with replacement cutter blade with center of
cutter blade.

10. Turn hex screw until securely fixed.
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Important
• After the cutter blade is secured, check that the cutter blade does not come off. If the cutter

blade comes off, this may damage the printer.

11. Remove fixing part.

Important
• Always remove the fixing part. Operating with the part installed may damage the printer.

12. Close top cover.

A confirmation message appears.

13. Tap Yes.
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Performing Maintenance Functions from Your Computer
(Windows)

Cleaning the Print Heads

Printing a Nozzle Check Pattern
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Cleaning the Print Heads

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for print head cleaning is as follows::

 Print Head Cleaning

1. Open the printer driver setup window

2. Click Print Head Cleaning on the Maintenance tab

When the Print Head Cleaning dialog box opens, select the head cleaning to be performed from the
following:

• Cleaning

Perform Cleaning if printing is faint or a specific color fails to print, even though there is enough
ink.

• System Cleaning

System Cleaning is a more powerful cleaning function. Perform System Cleaning if there is no
improvement even after repeating Cleaning several times.

Important
• System Cleaning consumes an extremely large amount of ink.

Executing system cleaning frequently will rapidly deplete your printer's ink supply. Therefore,
execute system cleaning only when necessary.

3. Execute cleaning

Make sure that the printer is on and then click OK.

Print head cleaning starts.

Note
• After Cleaning or System Cleaning is complete, perform Print Nozzle Check Pattern and check the

cleaning results.

Related Topic
Printing a Nozzle Check Pattern
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Printing a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

 Print Nozzle Check Pattern

1. Open the printer driver setup window

2. Load paper in the printer

3. Click Print Nozzle Check Pattern on the Maintenance tab

The Print Nozzle Check Pattern dialog box opens.

4. Select feed position

Select the feed position from the displayed dialog box.

5. Print a nozzle check pattern

Make sure that the printer is on and click OK.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.

6. Check the print result

Check the print results.

(A) As long as the horizontal lines are in line, and not missing, the nozzle is working normally.
(B) Where the horizontal lines are not in line or are missing, the color nozzle is blocked.

Note
• From the nozzle check pattern printing results, if it becomes patchy or there are areas that

cannot be printed, use Print Head Cleaning to clean the print heads.
Once cleaning is complete, print the nozzle check pattern again and check the results.

Related Topic
Cleaning the Print Heads
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Cleaning the Printer

Cleaning the Printer Exterior

Cleaning Inside the Top Cover

Cleaning the Roll Unit

Cleaning the Print Head
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Cleaning the Printer Exterior

Clean the printer regularly to maintain better printing quality and help prevent problems.

To ensure a comfortable working environment, clean the printer exterior about once a month.

Important
• When the sensor of the feed slot is dirty, the printer might not perform auto feeding properly. Even if the

sensor seems clean, we recommend cleaning it because it may have paper dust on it.

1. Turn printer off.

Turning the Printer On and Off

2. Unplug power cord from outlet.

Caution
• Always turn off the printer and unplug the power cord before cleaning or maintenance.

Accidentally leaving the printer on poses a risk of injury if you touch moving parts inside the
printer.

3. Wipe away any residue and paper dust with damp cloth that you have wrung out completely
and wipe dry with dry cloth.

• Clean the printer exterior and the power cord plug.

• Open the top cover and output guide and clean parts that come in contact with paper (A, B) and
sensor (C).
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Warning
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come

into contact with electrical components inside the printer, there is a risk of fire or electrical shock.

Important
• If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend

cleaning the output guide even if it does not appear dirty, because it may actually be covered with
paper dust.

Cleaning Inside the Top Cover

4. Plug power cord into outlet.
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Cleaning Inside the Top Cover

Clean inside the top cover about once a month to maintain better printing quality and help prevent problems.

Also clean inside the top cover in the following situations to ensure optimal operation.

• If the printed surface or the underside of paper is dirty after printing
• After you have used up a roll
• After borderless printing
• After printing on small paper
• After printing on paper that generates a lot of cutting debris
• If you have replaced the roll
• After printing on paper that generates a lot of paper dust

Important
• If the platen inside the top cover becomes dirty, it may soil the underside of paper. We recommend

cleaning the platen after borderless printing or printing on small paper.
• If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend

cleaning the output guide even if it does not appear dirty, because it may actually be covered with
paper dust.

1. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

2. Tap Platen cleaning.

A confirmation message appears.

3. Tap Yes.

The carriage moves and after it stops moving, instructions appear on the touch screen.

4. Open top cover.

5. If paper dust has accumulated in vacuum holes (A) on platen or in borderless printing ink
grooves (B), use cleaning brush (C), provided with printer, to wipe it away.
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Important
• Do not touch the linear scale (D), carriage shaft (E), or ink tube stabilizer (F). Touching these may

cause malfunction.

Note
• If the cleaning brush is dirty, rinse it in water.

6. Using a damp cloth that you have wrung out completely, wipe inside the top cover to clean
it.

508



Wipe away any ink residue and paper dust (debris from cutting) on top cover roller (A), paper retainer
(B), entire platen (C), borderless printing ink grooves (D), periphery of left and right ink suction holes (E,
F), and output guide (G), and so on.

Warning
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come

into contact with electrical components inside the printer, there is a risk of fire or electrical shock.

Important
• Do not use a dry cloth to wipe inside the top cover. This may create a static charge, which may

attract dust and affect the printing quality.

7. Close top cover.

509



510



Cleaning the Roll Unit

About once a month, clean the roll unit to ensure optimal operation.

Important
• When the sensor of the feed slot is dirty, the printer might not perform auto feeding properly. Even if the

sensor seems clean, we recommend cleaning it because it may have paper dust on it.

1. Remove any roll paper loaded in roll unit.

Removing the Lower Roll from the Roll Unit (Option)

2. Turn printer off.

Turning the Printer On and Off

3. Unplug power cord from outlet.

Caution
• Always turn off the printer and unplug the power cord before cleaning or maintenance.

Accidentally leaving the printer on poses a risk of injury if you touch moving parts inside the
printer.

4. Wipe away any residue and paper dust from areas (A, B) that come in contact with paper
and sensor (C) with a thoroughly wrung out damp cloth, and wipe dry with a dry cloth.
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Warning
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come

into contact with electrical components inside the roll unit, there is a risk of fire or electrical shock.

5. Plug power cord into outlet.
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Other Maintenance

Preparing to Transfer the Printer

Reinstalling the Printer

Firmware update
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Preparing to Transfer the Printer

To protect the internal parts in transit, always follow these steps before transferring the printer to a new
location.

For details on packing the printer and installing it after transfer, see Reinstalling the Printer.

Important
• Be sure to contact your Canon dealer before transferring the printer to a new location. Ink may leak and

damage the printer if you do not prepare the printer correctly and it is tipped or stood on end in transit.

Note
• The maintenance cartridge needs to be replaced when you execute the Prepare to move menu.

Prepare the maintenance cartridge in advance while referring below. The number of maintenance
cartridge required varies depending on the amount remaining in the maintenance cartridge being used.

• If you can move the printer in a level state using casters or something similar, you do not need to
execute Prepare to move.

• Always follow the instructions of the service representative when preparing to transfer the printer.

The following lists transport restrictions by type of transport.

Move indoors on the same floor

Usage Examples: Move indoors by carrying

• Transport and storage in low temperature environments: No
• Permitted angle of inclination: All directions: within 30 °
• Required maintenance cartridges: 1-2

Move indoors to a different floor

Usage Examples: Moving the printer while temporarily tilting it such as when using the stairs

• Transport and storage in low temperature environments: No
• Permitted angle of inclination: All directions: within 90 °
• Required maintenance cartridges: 1-2

Transport outdoors

Usage Examples: Transport by vehicle

• Transport and storage in low temperature environments: Yes
• Permitted angle of inclination: All directions: within 90 °
• Required maintenance cartridges: 2

Preparing for Transportation

1. Remove the paper.

• Rolls

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)

• Sheet
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Removing Sheets

2. If touch screen indicates to replace maintenance cartridge, replace maintenance
cartridge.

Replacing the Maintenance Cartridge

3. Tap Maintenance on HOME screen.

Touch Screen

The Maintenance screen appears.

4. Tap Prepare to move.

5. Tap Move indoors on the same floor, Move indoors to a different floor, or Transport
outdoors.

A confirmation message appears.

6. Tap Yes.

The printer is now prepared for transfer.

When the preparation is finished, instructions appear on the touch screen.

Remove the ink tanks before packing the printer.

Important
• If consumables must be replaced, a message appears on the touch screen, and preparation is

disabled. If the message appears, tap OK and contact your Canon dealer for assistance.

7. Open ink tank cover to remove all ink tanks.

Replacing Ink Tanks

8. Push down release lever (A) as you gently return all ink tank lock levers to their original
positions.
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9. Close ink tank cover.

At this point, ink is drawn out from inside the tubes.

A confirmation message will appear when the process is finished.

Important
• Do not remove the maintenance cartridge except when the message indicating replacement is

displayed.

If you remove the maintenance cartridge while ink is being removed, the ink may leak out.

10. Replace maintenance cartridge currently being used with new maintenance cartridge.

Replacing the Maintenance Cartridge

11. Press ON button and turn off printer.

Packing Printer

1. Disconnect power cord and interface cable.

Important
• Turn off the printer before you unplug it. Unplugging the printer before it is off and moving it may

damage the printer. If you accidentally unplug the printer, plug it in again, reinstall the ink tanks,
and follow this procedure again.

2. Open top cover.
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3. Grasp belt and insert belt stopper into position shown.

Important
• Attach the belt stopper that was removed and stored after initial installation. Neglecting to attach

the belt stopper may damage the printer.
• Do not touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching these

may cause malfunction.
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4. Close top cover.

5. Tape down printer covers to secure them, in the reverse order of tape removal during
installation.

6. Remove basket or stacker by reversing installation procedure.

7. Remove the stand by reversing the installation procedure, when it was attached to the
printer.

8. Disassemble and repackage the stand by following the installation procedure in reverse.
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9. Repack roll holder, holder stopper, and printer in shipping materials, and then package
them in shipping box.
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Reinstalling the Printer

The basic workflow for reinstalling the printer is as follows.

For detailed instructions, see the Setup Guide.

Assemble the stand

1. Referring to the Printer Stand Setup Guide, assemble the Stand.

Caution
• The Stand must be assembled by at least two people on a flat surface. Attempting assembly by

yourself poses a risk of injury or bending the Stand.

• When assembling the Stand, lock the casters. In addition, always unlock the casters before
moving the assembled Stand. Attempting to move the stand when the casters are locked poses
a risk of injury or damage to the location site.

Install the printer

1. Mount the printer on the assembled Stand and tighten the screws firmly.

Caution
• Moving the printer requires at least six people, holding it on both sides. Be careful to avoid back

strain and other injuries.

• When carrying the printer, hold it securely by the carrying grips on the bottom left, right, and
rear. The printer may be unsteady if you hold it at other positions, which poses a risk of injury
from dropping the printer.
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2. Remove tape and packaging material attached to the printer. Also open the top cover and
remove stoppers and spacers inside the printer.

3. If using roll unit, refer to Setup Guide provided with roll unit and attach roll unit to Stand.
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4. Refer to Printer Stand Setup Guide and attach basket to Stand.

5. Connect the power cord to the power cord connector on the back of the printer.

6. Plug the power cord into the outlet.

7. Press the power button to turn the printer on.

When "Do you want to install the transported printer? Do not install the ink tanks yet." appears,
tap Yes.

8. When instructions for loading ink tank appear on touch screen, open ink tank cover and
load ink tank.
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9. Attach the Roll Holder to the Roll Media.

(See "Loading Rolls on the Roll Holder.")

10. Load the Roll Media in the printer.

(See "Loading the Upper Roll on the Printer.")

523



11. Install the software.

Note that the driver installation procedure varies depending on the type of connection.

(See "Installing the Printer Driver" (Windows).)

(See "Installing the Printer Driver" (macOS).)
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Firmware update

Select this setting item from Device settings.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

You can update the firmware of the printer, check the firmware version, or perform settings of a notification
screen, a DNS server and a proxy server.

Note
• Only Check current version is available when Disable LAN is selected for Change LAN in LAN

settings.

• Install update

Performs the firmware update of the printer. If you select Yes, the firmware update starts. Follow the on-
screen instructions to perform update.

Important
• When you use this function, make sure the printer is connected to the Internet.

Note
• If the firmware update is not complete, check the following and take an appropriate action.

• Check the network settings such as a wireless router.

• If Cannot connect to the server. is displayed on the touch screen, select OK and try again
after a while.

• Check current version

You can check the current firmware version.

• Update notification setting

When Yes is selected and the firmware update is available, the screen to inform you of the firmware
update is displayed on the touch screen.

• DNS server setup

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

• Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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Specifications

Specifications

Print Area
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Specifications

Important
• The following values may vary depending on the operating environment.

Printer

Power supply 100-240 V AC (50/60 Hz)

Power consumption When printing: 91 W max.

In Sleep mode: 3.6 W max. *1

When power is off: 0.3 W max. *1 *2

*1 Wired LAN connection

*2 The printer uses a trace amount of power even when turned off. To stop all
power consumption, turn off the printer and unplug the power cord.

Operating environment Temperature: 59 to 86 °F (15 to 30 °C)

Humidity: 10 to 80 % RH (with no condensation)

Dimensions (W x D x H) Main unit only:

Approx. 43.8 x 28.9 x 24.8 inches (1110 x 734 x 629 mm)

Main unit and Stand (when basket is not used):

Approx. 43.8 x 30.2 x 46 inches (1110 x 766 x 1168 mm)

Main unit and Stand (when using basket: Basket Position 1) *1:

Approx. 43.8 x 38.8 x 46 inches (1110 x 984 x 1168 mm)

Main unit and Stand (when using basket: Basket Position 2/4/5) *1:

Approx. 43.8 x 48.2 x 46 inches (1110 x 1222 x 1168 mm)

Main unit and Stand (when using basket: Basket Position 3) *1:

Approx. 43.8 x 56.5 x 46 inches (1110 x 1434 x 1168 mm)

Main unit and Stacker (with Stacker Position Closed) *2:

Approx. 43.8 x 44.2 x 46 inches (1110 x 1122 x 1168 mm)

Main unit and Stacker (with Stacker Position Open) *2:

Approx. 43.8 x 46.8 x 46 inches (1110 x 1188 x 1168 mm)

*1 For details on the Basket Position, see Example Basket Configurations.

*2 For details on the Stacker Position, see Example Stacker Configurations.

Weight Main unit only (does not include print head and ink tanks):

Approx. 163 lb (74 kg)

Stand and Basket: Approx. 37 lb (17 kg)

Roll unit: Approx. 35 lb (16 kg)

Stacker: Approx. 26 lb (12 kg)

Space for installation (W x D x
H)

Main unit only:

Approx. 59.5 x 56.5 x 40.2 inches (1510 x 1434 x 1020 mm)
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Main unit and Stand (when basket is not used):

Approx. 59.5 x 57.8 x 61.5 inches (1510 x 1466 x 1560 mm)

Main unit and Stand (when basket is used):

Approx. 59.5 x 66.3 x 61.5 inches (1510 x 1684 x 1560 mm)

Main unit and Stacker:

Approx. 59.5 x 74.4 x 61.5 inches (1510 x 1888 x 1560 mm)

Printing performance

Print method Bubblejet

Maximum resolution 2400 dpi (horizontally) * x 1200 dpi (vertically)

* Prints with a minimum 1/2400 inch dot pitch between ink droplets.

Print head PF-06

Number of nozzles MBK: 5120 nozzles, others: each 2560 nozzles

Memory and hard disk

Memory 128 GB (2GB physical memory)

Hard disk capacity 500 GB (encryption)

Personal mail boxes (Permanent storage area): 180 GB

Print job storage capacity Common Box: 100 jobs

Personal Boxes: 100 jobs

Interface
You can use both USB and LAN at the same time.

You cannot use wireless LAN and wired LAN at the same time.

USB Hi-Speed USB *

* To use Hi-Speed USB, your computer must support Hi-Speed USB. Addition-
ally, the Hi-Speed USB interface is completely backward compatible with USB
1.1, so the printer can be connected even if the computer interface is USB 1.1.

USB memory USB flash drive

LAN Wired LAN: IEEE802.3ab (1000BASE-T) / IEEE802.3u (100BASE-TX) /
IEEE802.3 (10BASE-T)

Wireless LAN: IEEE802.11n / IEEE802.11g / IEEE802.11b *

* A connection can be established by configuring Standard setup, WPS (Wi-Fi
Protected Setup), WCN (Windows Connect Now), Easy wireless connect.
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Network Specifications

Communication protocol SNMP (Canon-MIB compatible), HTTP, TCP/IP (IPv4/IPv6), FTP

Wired LAN specifications Compliance standards: IEEE802.3ab (1000BASE-T) / IEEE802.3u
(100BASE-TX) / IEEE802.3 (10BASE-T)

Transmission speed: 10 Mbps / 100 Mbps / 1000 Mbps (automatically selec-
ted)

Wireless LAN specifications Compliance standards: IEEE802.11n / IEEE802.11g / IEEE802.11b

Frequency range: 2.4 GHz

Channels: 1-11 or 1-13 *

* Varies by country and region.

Effective range: Indoors 164 feet/50 m *

* Varies according to environmental conditions.

Security:

WEP (64/128 bits)

WPA-PSK (TKIP/AES)

WPA2-PSK (TKIP/AES)

Setup:

WPS (push button method/PIN code method)

WCN (WCN-NET)

Easy wireless connect

Other: Admin password

Operating Conditions
If operating conditions of the operating system are high, follow those.

Windows

Compatible Operating System (Stand-
ard supplied printer driver)

32-bit version:

Windows 10

Windows 8.1

Windows 7

Use the latest Service Pack available.

64-bit version:

Windows 10

Windows 8.1

Windows 7

Windows Server 2008 R2

Windows Server 2012, Windows Server 2012 R2

Windows Server 2016
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Use the latest Service Pack available.

Windows RT (Windows 8 ARM architecture) not supported.

Recommended operating environment
*

CPU: Pentium 4 or later, or Athlon 64 or later processor

Memory: 1 GB or more

Free hard disk space: 20 GB or more

* Depending on the application software and data being used, the printer may not output correctly even
with the above environmental conditions.

macOS

Compatible Operating System (Standard sup-
plied printer driver)

OS X 10.10.5 - OS X 10.11, macOS 10.12

Recommended operating environment * CPU: Intel multi-core processor or later

Memory: 2 GB or more

Free hard disk space: 20 GB or more

* Depending on the application software and data being used, the printer may not output correctly even
with the above environmental conditions.

• An Internet connection is required to use the Online Manual.
• To install the software while using Windows, you must have a CD-ROM drive or a network

connection.
• To install the software while using macOS, you must have a network connection.

Ink
For information on the ink the printer supports, see Ink Tanks.

Paper
For details on the compatible media types, see Paper Information List.

Paper width For details on the paper widths supported by the printer, see Paper Sizes.

Minimum paper length 8.00 inches (203.2 mm)

Maximum printable length Rolls: 59 feet (18 m) *

* Varies depending on the operating system or application.

Sheets: 5.2 feet (1.6 m)

Thickness Rolls: 3-31 mil (0.07-0.8 mm)

Sheets: 3-31 mil (0.07-0.8 mm)

Roll maximum outer diameter 6.7 inches (170 mm) or shorter

Supported paper core inner diam-
eter

2 inches/3 inches (50.8 mm/76.2 mm)
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Print area For details about Print Area, see Print Area.
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Print Area

A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in
borderless printing, the actual printing area corresponds to the paper size minus the space for this margin.

Note
• Printable Area: The area that can be printed.
• For borderless printing with roll paper, the margin is 0 inch (0 mm).

However, depending on the paper size, minor margins may be available.

Prints without Edges Based on the Scenarios (Windows)
Prints without Edges Based on the Scenarios (macOS)

• Recommended Print Area: We recommend printing within this area.
• To match the document size with the actual printing area, print on oversize paper with the required

margin added.

Printing to Oversized Paper Sizes (Windows)
Printing to Oversized Paper Sizes (macOS)

Sheets

Printable Area:

A margin of 0.2 inch (3 mm) on top, 0.8 inch (20 mm) on bottom, and 0.2 inch (3 mm) on left and right
sides is required.

Recommended Print Area:

A margin of 0.8 inch (20 mm) on top, 0.8 inch (20 mm) on bottom, and 0.2 inch (3 mm) on left and right
sides is required.

A: Top Edge
B: Bottom Edge
C: Left Edge
D: Right Edge
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Rolls

Printable Area:

A margin of 0.2 inch (3 mm) on top and bottom and 0.2 inch (3 mm) on left and right sides is required. For
borderless printing, the margins on top, bottom, left, and right are 0 inch (0 mm). For paper that supports
borderless printing, see Paper Information List.

Recommended Print Area:

A margin of 0.8 inch (20 mm) on top, 0.2 inch (3 mm) on bottom, and 0.2 inch (3 mm) on left and right
sides is required.

A: Top Edge
B: Bottom Edge
C: Left Edge
D: Right Edge
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Safety

Safety Precautions

Regulatory Information

WEEE (EU&EEA)

When repairing, lending, or disposing of the printer
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Safety Precautions

Choosing a location
• Never install the printer on an unstable or vibrating surface.
• Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or close

to a heating source.
To avoid the risk of fire or electric shocks, use the printer under the operating environment specified in
the Specifications.

• Do not place the printer on a thick rug or carpet.
• Do not place the printer with its back attached to the wall.
• We recommend ensuring ample space for installation.
• Do not install the printer near sources of strong electromagnetic fields, whether equipment that

generates such fields or places where such fields occur.

Power Supply
• Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the

power cord if necessary.
• Never remove the plug by pulling on the cord.

Pulling the cord may damage the power cord, leading to possible fire or electrical shock.
• Do not use an extension lead/cord.

Working Around the Printer
• Never put your hands or fingers in the printer while it is printing.
• Moving the printer requires at least six people, holding it on both sides. Be careful to avoid back strain

and other injuries.
• When moving the printer, firmly grasp the Carrying Handles under each side. The printer may be

unsteady if you hold it at other positions, which poses a risk of injury from dropping the printer.
• When using and transferring the printer, do not tilt it, stand it on its side, or turn it upside down. There

is a risk of the ink spilling.
• When transferring the printer tilted, always perform the steps in "Preparing to Transfer the Printer" in

order to protect the internal structure.
• Do not place any object on the printer. Especially do not place metal objects (paper clips, staples,

etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the printer.

Print Heads/Ink Tanks/Maintenance Cartridges
• Keep ink tanks out of the reach of children. In case ink is accidentally licked or swallowed, rinse out

mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.

• In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

• Never touch the electrical contacts on a print head after printing.
The metal parts may be very hot and could cause burns.

• Do not throw ink tanks and maintenance cartridges into fire.
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• Do not attempt to disassemble or modify the print head, ink tanks, and maintenance cartridges.
• Avoid dropping or shaking print head, ink tanks, and maintenance cartridges.
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Regulatory Information

Lithium Battery
• Dispose of used batteries according to the local regulations.
• Risk of explosion if battery is replaced by an incorrect type.

Users in the U.S.A.
FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10473 (Contains FCC Approved WLAN Module K30357)
Optional parts: Roll Unit RU-22

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

FCC ID:AZDK30357

Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This
equipment should be installed and operated with minimum distance at least 20cm between the radiator
and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or
operated with any other antenna or transmitter.

Canon U.S.A., Inc.
One Canon Park
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Melville, New York 11747
1-800-652-2666

About Radio Waves
Do not use this product near medical equipment or electronic equipment. Radio wave interference can
affect the operation or performance of the equipment.

Users in Canada
This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the
following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment and
meets RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and
operated keeping the radiator at least 20cm or more away from person's body (excluding extremities:
hands, wrists, feet and ankles).

Pour les usagers résidant au Canada
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts
de licence. L'exploitation est autorisée aux deux conditions suivantes :

(1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage
radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un
environnement non contrôlé et respecte les règles d'exposition aux fréquences radioélectriques (RF)
CNR-102 de l'IC. Cet équipement doit être installé et utilisé en gardant une distance de 20 cm ou plus
entre le dispositif rayonnant et le corps (à l'exception des extrémités : mains, poignets, pieds et chevilles).
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WEEE (EU&EEA)

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

These symbols indicate that this product is not to be disposed of with your household waste, according to
the WEEE Directive (2012/19/EU), the Battery Directive (2006/66/EC) and/or national legislation
implementing those Directives. If a chemical symbol is printed beneath the symbol shown above, in
accordance with the Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium,
Pb = Lead) is present in this battery or accumulator at a concentration above an applicable threshold
specified in the Battery Directive. This product should be handed over to a designated collection point,
e.g., on an authorized one-for-one basis when you buy a new similar product or to an authorized
collection site for recycling waste electrical and electronic equipment (EEE) and batteries and
accumulators. Improper handling of this type of waste could have a possible impact on the environment
and human health due to potentially hazardous substances that are generally associated with EEE. Your
cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about the recycling of this product, please contact your local city office,
waste authority, approved scheme or your household waste disposal service or visit www.canon-
europe.com/weee, or www.canon-europe.com/battery.

Nur für Europäische Union und EWR (Norwegen, Island und Liechtenstein)

Diese Symbole weisen darauf hin, dass dieses Produkt gemäß WEEE-Richtlinie (2012/19/EU; Richtlinie
über Elektro- und Elektronik-Altgeräte), Batterien-Richtlinie (2006/66/EG) und nationalen Gesetzen zur
Umsetzung dieser Richtlinien nicht über den Hausmüll entsorgt werden darf. Falls sich unter dem oben
abgebildeten Symbol ein chemisches Symbol befindet, bedeutet dies gemäß der Batterien-Richtlinie,
dass in dieser Batterie oder diesem Akkumulator ein Schwermetall (Hg = Quecksilber, Cd = Cadmium, Pb
= Blei) in einer Konzentration vorhanden ist, die über einem in der Batterien-Richtlinie angegebenen
Grenzwert liegt. Dieses Produkt muss bei einer dafür vorgesehenen Sammelstelle abgegeben werden.
Dies kann z. B. durch Rückgabe beim Kauf eines neuen ähnlichen Produkts oder durch Abgabe bei einer
autorisierten Sammelstelle für die Wiederaufbereitung von Elektro- und Elektronik-Altgeräten sowie
Batterien und Akkumulatoren geschehen. Der unsachgemäße Umgang mit Altgeräten kann aufgrund
potenziell gefährlicher Stoffe, die generell mit Elektro- und Elektronik-Altgeräten in Verbindung stehen,
negative Auswirkungen auf die Umwelt und die menschliche Gesundheit haben. Durch Ihre Mitarbeit bei
der umweltgerechten Entsorgung dieses Produkts tragen Sie zu einer effektiven Nutzung natürlicher
Ressourcen bei. Um weitere Informationen über die Wiederverwertung dieses Produkts zu erhalten,
wenden Sie sich an Ihre Stadtverwaltung, den öffentlich-rechtlichen Entsorgungsträger, eine autorisierte
Stelle für die Entsorgung von Elektro- und Elektronik-Altgeräten oder Ihr örtliches
Entsorgungsunternehmen oder besuchen Sie www.canon-europe.com/weee, oder www.canon-
europe.com/battery.
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Union Européenne, Norvège, Islande et Liechtenstein uniquement.

Ces symboles indiquent que ce produit ne doit pas être mis au rebut avec les ordures ménagères, comme
le spécifient la Directive européenne DEEE (2012/19/UE), la Directive européenne relative à l'élimination
des piles et des accumulateurs usagés (2006/66/CE) et les lois en vigueur dans votre pays appliquant ces
directives. Si un symbole de toxicité chimique est imprimé sous le symbole illustré ci-dessus
conformément à la Directive relative aux piles et aux accumulateurs, il indique la présence d'un métal
lourd (Hg = mercure, Cd = cadmium, Pb = plomb) dans la pile ou l'accumulateur à une concentration
supérieure au seuil applicable spécifié par la Directive. Ce produit doit être confié au distributeur à chaque
fois que vous achetez un produit neuf similaire, ou à un point de collecte mis en place par les collectivités
locales pour le recyclage des Déchets des Équipements Électriques et Électroniques (DEEE). Le
traitement inapproprié de ce type de déchet risque d'avoir des répercussions sur l'environnement et la
santé humaine, du fait de la présence de substances potentiellement dangereuses généralement
associées aux équipements électriques et électroniques. Votre entière coopération dans le cadre de la
mise au rebut correcte de ce produit favorisera une meilleure utilisation des ressources naturelles. Pour
plus d'informations sur le recyclage de ce produit, contactez vos services municipaux, votre éco-
organisme ou les autorités locales compétentes, ou consultez le site www.canon-europe.com/weee, ou
www.canon-europe.com/battery.

Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen, IJsland en
Liechtenstein)

Met deze symbolen wordt aangegeven dat dit product in overeenstemming met de AEEA-richtlijn
(2012/19/EU), de richtlijn 2006/66/EG betreffende batterijen en accu's en/of de plaatselijk geldende
wetgeving waarin deze richtlijnen zijn geïmplementeerd, niet bij het normale huisvuil mag worden
weggegooid. Indien onder het hierboven getoonde symbool een chemisch symbool gedrukt staat, geeft dit
in overeenstemming met de richtlijn betreffende batterijen en accu's aan dat deze batterij of accu een
zwaar metaal bevat (Hg = kwik, Cd = cadmium, Pb = lood) waarvan de concentratie de toepasselijke
drempelwaarde in overeenstemming met de genoemde richtlijn overschrijdt. Dit product dient te worden
ingeleverd bij een hiervoor aangewezen inzamelpunt, bijv. door dit in te leveren bij een hiertoe erkend
verkooppunt bij aankoop van een gelijksoortig product, of bij een officiële inzameldienst voor de recycling
van elektrische en elektronische apparatuur (EEA) en batterijen en accu's. Door de potentieel gevaarlijke
stoffen die gewoonlijk gepaard gaan met EEA, kan onjuiste verwerking van dit type afval mogelijk
nadelige gevolgen hebben voor het milieu en de menselijke gezondheid. Uw medewerking bij het op juiste
wijze weggooien van dit product draagt bij tot effectief gebruik van natuurlijke hulpbronnen. Voor verdere
informatie over recycling van dit product kunt u contact opnemen met uw plaatselijke gemeente,
afvaldienst, officiële dienst voor klein chemisch afval of afvalstortplaats, of kunt u terecht op www.canon-
europe.com/weee, of www.canon-europe.com/battery.
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Sólo para la Unión Europea y el Área Económica Europea (Noruega,
Islandia y Liechtenstein)

Estos iconos indican que este producto no debe desecharse con los residuos domésticos de acuerdo con
la Directiva sobre RAEE (2012/19/UE) y la Directiva sobre Pilas y Acumuladores (2006/66/CE) y/o la
legislación nacional. Si aparece un símbolo químico bajo este icono, de acuerdo con la Directiva sobre
Pilas y Acumuladores, significa que la pila o el acumulador contiene metales pesados (Hg = Mercurio, Cd
= Cadmio, Pb = Plomo) en una concentración superior al límite especificado en dicha directiva. Este
producto deberá entregarse en un punto de recogida designado, por ejemplo, entregándolo en el lugar de
venta al adquirir un producto nuevo similar o en un centro autorizado para la recogida de residuos de
aparatos eléctricos y electrónicos (RAEE), baterías y acumuladores. La gestión incorrecta de este tipo de
residuos puede afectar al medio ambiente y a la salud humana debido a las sustancias potencialmente
nocivas que suelen contener estos aparatos. Su cooperación en la correcta eliminación de este producto
contribuirá al correcto aprovechamiento de los recursos naturales. Los usuarios tienen derecho a
devolver pilas, acumuladores o baterías usados sin coste alguno. El precio de venta de pilas,
acumuladores y baterías incluye el coste de la gestión medioambiental de su desecho, y no es necesario
mostrar la cuantía de dicho coste en la información y la factura suministradas a los usuarios finales. Si
desea más información sobre el reciclado de este producto, póngase en contacto con su municipio, el
servicio o el organismo encargado de la gestión de residuos domésticos o visite www.canon-europe.com/
weee, o www.canon-europe.com/battery.

Només per a la Unió Europea i a l’Espai Econòmic Europeu (Noruega,
Islàndia i Liechtenstein)

Aquests símbols indican que aquest producte no s’ha de llençar amb les escombraries de la llar, d’acord
amb la RAEE (2012/19/UE), la Directiva relativa a piles i acumuladors (2006/66/CE) i la legislació
nacional que implementi aquestes directives. Si al costat d’aquest símbol hi apareix imprès un símbol
químic, segons especifica la Directiva relativa a piles i acumuladors, significa que la bateria o
l’acumulador conté un metall pesant (Hg = mercuri, Cd = cadmi, Pb = plom) en una concentració superior
al límit aplicable especificat en la Directiva. Aquest producte s’hauria de lliurar en un dels punts de
recollida designats, com per exemple, intercanviant un per un en comprar un producte similar o lliurant-lo
en un lloc de recollida autoritzat per al reciclatge de residus d’aparells elèctrics i electrònics (RAEE) i piles
i acumuladors. La manipulació inadequada d’aquest tipus de residus podria tenir un impacte negatiu en
l’entorn i en la salut humana, a causa de les substàncies potencialment perilloses que normalment estan
associades a l'RAEE. La vostra cooperació a l’hora de rebutjar correctament aquest producte contribuirà
a la utilització efectiva dels recursos naturals. Els usuaris tenen dret a retornar les bateries o els
acumuladors usats sense cap càrrec. El preu de venda de les bateries i els acumuladors inclou el cost de
la gestió ambiental dels residus i no es necessari mostrar l’import d’aquest cost en aquest fullet o en la
factura que es lliuri a l’usuari final. Per a més informació sobre el reciclatge d’aquest producte, contacteu
amb l’oficina municipal, les autoritats encarregades dels residus, el pla de residus homologat o el servei
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de recollida d’escombraries domèstiques de la vostra localitat o visiteu www.canon-europe.com/weee, o
www.canon-europe.com/battery.

Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)

Questi simboli indicano che il prodotto non può essere smaltito con i rifiuti domestici, ai sensi della
Direttiva RAEE (2012/19/UE), della Direttiva sulle Batterie (2006/66/CE) e/o delle leggi nazionali che
attuano tali Direttive. Se sotto il simbolo indicato sopra è riportato un simbolo chimico, in osservanza della
Direttiva sulle batterie, tale simbolo indica la presenza di un metallo pesante (Hg = Mercurio, Cd =
Cadmio, Pb = Piombo) nella batteria o nell'accumulatore con un livello di concentrazione superiore a una
soglia applicabile specificata nella Direttiva sulle batterie. Il prodotto deve essere conferito a un punto di
raccolta designato, ad esempio il rivenditore in caso di acquisto di un nuovo prodotto simile oppure un
centro di raccolta autorizzato per il riciclaggio di rifiuti di apparecchiature elettriche ed elettroniche (RAEE)
nonché di batterie e accumulatori. Un trattamento improprio di questo tipo di rifiuti può avere
conseguenze negative sull'ambiente e sulla salute umana a causa delle sostanze potenzialmente nocive
solitamente contenute in tali rifiuti. La collaborazione dell'utente per il corretto smaltimento di questo
prodotto contribuirà a un utilizzo efficace delle risorse naturali ed eviterà di incorrere in sanzioni
amministrative ai sensi dell'art. 255 e successivi del Decreto Legislativo n. 152/06. Per ulteriori
informazioni sul riciclaggio di questo prodotto, contattare le autorità locali, l'ente responsabile della
raccolta dei rifiuti, un rivenditore autorizzato o il servizio di raccolta dei rifiuti domestici, oppure visitare il
sito www.canon-europe.com/weee, o www.canon-europe.com/battery.

Apenas para a União Europeia e AEE (Noruega, Islândia e Liechtenstein)

Estes símbolos indicam que este produto não deve ser eliminado juntamente com o seu lixo doméstico,
segundo a Diretiva REEE de 2012/19/UE, a Diretiva de Baterias (2006/66/CE) e/ou a sua legislação
nacional que transponha estas Diretivas. Se houver um símbolo químico impresso como mostrado
abaixo, de acordo com a Diretiva de Baterias, isto indica que um metal pesado (Hg = Mercúrio, Cd =
Cádmio, Pb = Chumbo) está presente nesta pilha ou acumulador, numa concentração acima de um limite
aplicável especificado na Diretiva. Este produto deve ser entregue num ponto de recolha designado, por
exemplo num local autorizado de troca quando compra um equipamento novo idêntico, ou num local de
recolha autorizado para reciclar equipamento elétrico e eletrónico (EEE) em fim de vida, bem como pilhas
e baterias. O tratamento inadequado deste tipo de resíduos pode ter um impacto negativo no ambiente e
na saúde humana, devido a substâncias potencialmente perigosas que estão associadas com
equipamentos do tipo EEE. A sua cooperação no tratamento correto deste produto irá contribuir para a
utilização mais eficaz dos recursos naturais. Para obter mais informações acerca de como reciclar este
produto, por favor contacte as suas autoridades locais responsáveis pela matéria, serviço de recolha
aprovado para pilhas e baterias ou serviço de recolha de resíduos sólidos domésticos da sua
municipalidade, ou visite www.canon-europe.com/weee, ou www.canon-europe.com/battery.
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Gælder kun i Europæiske Union og EØS (Norge, Island og Liechtenstein)

Disse symboler betyder, at produktet ikke må bortskaffes sammen med dagrenovation i henhold til
WEEE-direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller den lokale lovgivning, som disse
direktiver er gennemført i. Hvis der i overensstemmelse med batteridirektivet er trykt et kemisk symbol
under det symbol, der er vist ovenfor, betyder det, at batteriet eller akkumulatoren indeholder tungmetaller
(Hg = kviksølv, Cd = cadmium, Pb = bly) i en koncentration, som ligger over de grænseværdier, der er
beskrevet i batteridirektivet. Produktet skal afleveres på et godkendt indsamlingssted, f.eks. i
overensstemmelse med en godkendt én-til-én-procedure, når du indkøber et nyt tilsvarende produkt, eller
på et godkendt indsamlingssted for elektronikaffald samt for batterier og akkumulatorer. Forkert
håndtering af denne type affald kan medføre negative konsekvenser for miljøet og menneskers helbred
på grund af de potentielt sundhedsskadelige stoffer, der generelt kan forefindes i elektrisk og elektronisk
udstyr. Når du foretager korrekt bortskaffelse af produktet, bidrager du til effektiv brug af
naturressourcerne. Kontakt din kommune, den lokale affaldsmyndighed, det lokale affaldsanlæg, eller
besøg www.canon-europe.com/weee, eller www.canon-europe.com/battery for at få flere oplysninger om
genbrug af dette produkt.

Μόνο για την Ευρωπαϊκή Ένωση και τον ΕΟΧ (Νορβηγία, Ισλανδία και
Λιχτενστάιν)

Αυτά τα σύμβολα υποδεικνύουν ότι αυτό το προϊόν δεν πρέπει να απορρίπτεται μαζί με τα οικιακά
απορρίμματα, σύμφωνα με την Οδηγία για τα Απόβλητα Ηλεκτρικού και Ηλεκτρονικού Εξοπλισμού
(ΑΗΗΕ) (2012/19/ΕΕ), την Οδηγία για τις Ηλεκτρικές Στήλες (2006/66/ΕΚ) ή/και την εθνική νομοθεσία που
εφαρμόζει τις Οδηγίες εκείνες. Εάν κάποιο χημικό σύμβολο είναι τυπωμένο κάτω από το σύμβολο που
φαίνεται παραπάνω, σύμφωνα με την Οδηγία για τις Ηλεκτρικές Στήλες, υποδηλώνει ότι κάποιο βαρύ
μέταλλο (Hg = Υδράργυρος, Cd = Κάδμιο, Pb = Μόλυβδος) υπάρχει στην μπαταρία ή τον συσσωρευτή σε
συγκέντρωση μεγαλύτερη από το ισχύον επίπεδο που καθορίζεται στην Οδηγία για τις Ηλεκτρικές Στήλες.
Αυτό το προϊόν πρέπει να παραδίδεται σε καθορισμένο σημείο συλλογής, π.χ. σε μια εξουσιοδοτημένη
βάση ανταλλαγής όταν αγοράζετε ένα νέο παρόμοιο προϊόν ή σε μια εξουσιοδοτημένη θέση συλλογής για
την ανακύκλωση των αποβλήτων ηλεκτρικού και ηλεκτρονικού εξοπλισμού (ΗΗE) και των ηλεκτρικών
στηλών και συσσωρευτών. Ο ακατάλληλος χειρισμός αυτού του τύπου αποβλήτων μπορεί να έχει
αρνητικό αντίκτυπο στο περιβάλλον και την υγεία του ανθρώπου, λόγω δυνητικά επικίνδυνων ουσιών που
γενικά συνδέονται με τον ΗΗΕ. Η συνεργασία σας για τη σωστή απόρριψη αυτού του προϊόντος θα
συμβάλει στην αποτελεσματική χρήση των φυσικών πόρων. Για περισσότερες πληροφορίες σχετικά με
ανακύκλωση αυτού του προϊόντος, επικοινωνήστε με το τοπικό γραφείο της πόλης σας, την υπηρεσία
απορριμμάτων, το εγκεκριμένο σχήμα ή την υπηρεσία απόρριψης οικιακών αποβλήτων ή επισκεφθείτε τη
διεύθυνση www.canon-europe.com/weee ή www.canon-europe.com/battery.
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Gjelder kun den europeiske union og EØS (Norge, Island og Liechtenstein)

Disse symbolene indikerer at dette produktet ikke skal kastes sammen med husholdningsavfall, i henhold
til WEEE-direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller nasjonal lov som har
implementert disse direktivene. Hvis et kjemisk symbol vises under symbolet vist ovenfor, i samsvar med
batteridirektivet, indikerer dette at et tungmetall (Hg = kvikksølv, Cd = kadmium, Pb = bly) finnes i batteriet
eller akkumulatoren i en konsentrasjon over en gjeldende øvre grense som er spesifisert i batteridirektivet.
Produktet må leveres til et dertil egnet innsamlingspunkt, det vil si på en autorisert en-til-en-basis når en
kjøper et nytt lignende produkt, eller til et autorisert innsamlingssted for resirkulering av avfall fra elektrisk
og elektronisk utstyr (EE-utstyr) og batterier og akkumulatorer. Feil håndtering av denne typen avfall kan
være miljø- og helseskadelig på grunn av potensielt skadelige stoffer som ofte brukes i EE-utstyr. Din
innsats for korrekt avhending av produktet vil bidra til effektiv bruk av naturressurser. Du kan få mer
informasjon om resirkulering av dette produktet ved å kontakte lokale myndigheter,
avfallsadministrasjonen, et godkjent program eller husholdningens renovasjonsselskap, eller gå til
www.canon-europe.com/weee, eller www.canon-europe.com/battery.

Vain Euroopan unionin sekä ETA:n (Norja, Islanti ja Liechtenstein) alueelle.

Nämä tunnukset osoittavat, että sähkö- ja elektroniikkalaiteromua koskeva direktiivi (SER-direktiivi,
2012/19/EU), paristoista ja akuista annettu direktiivi (2006/66/EY) sekä kansallinen lainsäädäntö kieltävät
tuotteen hävittämisen talousjätteen mukana. Jos yllä olevan symbolin alapuolelle on paristodirektiivin
mukaisesti painettu kemiallisen aineen tunnus, kyseinen paristo tai akku sisältää raskasmetalleja (Hg =
elohopea, Cd = kadmium, Pb = lyijy) enemmän kuin paristodirektiivin salliman määrän. Tuote on vietävä
asianmukaiseen keräyspisteeseen, esimerkiksi kodinkoneliikkeeseen uutta vastaavaa tuotetta ostettaessa
tai viralliseen sähkö- ja elektroniikkalaiteromun tai paristojen ja akkujen keräyspisteeseen. Sähkö- ja
elektroniikkalaiteromun virheellinen käsittely voi vahingoittaa ympäristöä ja ihmisten terveyttä, koska
laitteet saattavat sisältää ympäristölle ja terveydelle haitallisia aineita. Tuotteen asianmukainen
hävittäminen säästää myös luonnonvaroja. Jos haluat lisätietoja tämän tuotteen kierrätyksestä, ota yhteys
kunnan jätehuoltoviranomaisiin tai käyttämääsi jätehuoltoyhtiöön tai käy osoitteessa www.canon-
europe.com/weee, tai www.canon-europe.com/battery.

Endast för Europeiska unionen och EES (Norge, Island och Liechtenstein)

De här symbolerna visar att produkten inte får sorteras och slängas som hushållsavfall enligt WEEE-
direktivet (2012/19/EU), batteridirektivet (2006/66/EG) och/eller nationell lagstiftning som implementerar
dessa direktiv. Om en kemisk symbol förekommer under ovanstående symbol innebär detta enligt
Batteridirektivet att en tungmetall (Hg = Kvicksilver, Cd = Kadmium, Pb = Bly) förekommer i batteriet eller
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ackumulatorn med en koncentration som överstiger tillämplig gräns som anges i Batteridirektivet.
Produkten ska lämnas in på en avsedd insamlingsplats, t.ex. på en återvinningsstation auktoriserad att
hantera elektrisk och elektronisk utrustning (EE-utrustning) samt batterier och ackumulatorer eller hos
handlare som är auktoriserade att byta in varor då nya, motsvarande köps (en mot en). Olämplig
hantering av avfall av den här typen kan ha negativ inverkan på miljön och människors hälsa på grund av
de potentiellt farliga ämnen som kan återfinnas i elektrisk och elektronisk utrustning. Din medverkan till en
korrekt avfallshantering av produkten bidrar till effektiv användning av naturresurserna. Om du vill ha mer
information om var du kan lämna in den här produkten, kontakta ditt lokala kommunkontor, berörd
myndighet eller företag för avfallshantering eller se www.canon-europe.com/weee, eller www.canon-
europe.com/battery.

Pouze Evropská unie a EHP (Norsko, Island a Lichtenštejnsko)

Tento symbol znamená, že podle směrnice OEEZ (2012/19/EU), směrnice o bateriích (2006/66/ES) a/
nebo podle vnitrostátních právních prováděcích předpisů k těmto směrnicím nemá být tento výrobek
likvidován s odpadem z domácností. Je-li v souladu s požadavky směrnice o bateriích vytištěna pod výše
uvedeným symbolem chemická značka, udává, že tato baterie nebo akumulátor obsahuje těžké kovy (Hg
= rtuť, Cd = kadmium, Pb = olovo) v koncentraci vyšší, než je příslušná hodnota předepsaná směrnicí.
Tento výrobek má být vrácen do určeného sběrného místa, např. v rámci autorizovaného systému odběru
jednoho výrobku za jeden nově prodaný podobný výrobek, nebo do autorizovaného sběrného místa pro
recyklaci odpadních elektrických a elektronických zařízení (OEEZ), baterií a akumulátorů. Nevhodné
nakládání s tímto druhem odpadu by mohlo mít negativní dopad na životní prostředí a lidské zdraví,
protože elektrická a elektronická zařízení zpravidla obsahují potenciálně nebezpečné látky. Vaše
spolupráce na správné likvidaci tohoto výrobku napomůže efektivnímu využívání přírodních zdrojů.
Chcete-li získat podrobné informace týkající se recyklace tohoto výrobku, obraťte se prosím na místní
úřad, orgán pro nakládání s odpady, schválený systém nakládání s odpady či společnost zajišťující
likvidaci domovního odpadu, nebo navštivte webové stránky www.canon-europe.com/weee nebo
www.canon-europe.com/battery.

Csak az Európai Unió és az EGT (Norvégia, Izland és Liechtenstein)
országaiban

Ezek a szimbólumok azt jelzik, hogy a termék hulladékkezelése a háztartási hulladéktól különválasztva,
az elektromos és elektronikus berendezések hulladékairól (WEEE) szóló (2012/19/EU) irányelvnek és az
elemekről és akkumulátorokról, valamint a hulladék elemekről és akkumulátorokról szóló (2006/66/EK)
irányelvnek megfelelően és/vagy ezen irányelveknek megfelelő helyi előírások szerint történik.
Amennyiben a fent feltüntetett szimbólum alatt egy vegyjel is szerepel, az elemekről és akkumulátorokról
szóló irányelvben foglaltak értelmében ez azt jelzi, hogy az elem vagy az akkumulátor az irányelvben
meghatározott határértéknél nagyobb mennyiségben tartalmaz nehézfémet (Hg = higany, Cd = kadmium,
Pb = ólom). E terméket az arra kijelölt gyűjtőhelyre kell juttatni – pl. hasonló termék vásárlásakor a régi
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becserélésére vonatkozó hivatalos program keretében, vagy az elektromos és elektronikus berendezések
(EEE) hulladékainak gyűjtésére, valamint a hulladék elemek és hulladék akkumulátorok gyűjtésére kijelölt
hivatalos gyűjtőhelyre. Az ilyen jellegű hulladékok nem előírásszerű kezelése az elektromos és
elektronikus berendezésekhez (EEE) általánosan kapcsolható potenciálisan veszélyes anyagok révén
hatással lehet a környezetre és az egészségre. E termék megfelelő leselejtezésével Ön is hozzájárul a
természeti források hatékony használatához. A termék újrahasznosítását illetően informálódjon a helyi
polgármesteri hivatalnál, a helyi közterület-fenntartó vállalatnál, a hivatalos hulladéklerakó telephelyen
vagy a háztartási hulladék begyűjtését végző szolgáltatónál, illetve látogasson el a www.canon-
europe.com/weee, vagy www.canon-europe.com/battery internetes oldalra.

Tylko dla krajów Unii Europejskiej oraz EOG (Norwegia, Islandia i
Liechtenstein)

Te symbole oznaczają, że produktu nie należy wyrzucać razem z odpadami gospodarstwa domowego,
zgodnie z dyrektywą WEEE w sprawie zużytego sprzętu elektrycznego i elektronicznego (2012/19/UE) lub
dyrektywą w sprawie baterii (2006/66/WE) bądź przepisami krajowymi wdrażającymi te dyrektywy. Jeśli
pod powyższym symbolem znajduje się symbol chemiczny, zgodnie z dyrektywą w sprawie baterii
oznacza to, że bateria lub akumulator zawiera metal ciężki (Hg = rtęć, Cd = kadm, Pb = ołów) w stężeniu
przekraczającym odpowiedni poziom określony w dyrektywie w sprawie baterii. Użytkownicy baterii i
akumulatorów mają obowiązek korzystać z dostępnego programu zwrotu, recyklingu i utylizacji baterii
oraz akumulatorów. Niewłaściwe postępowanie z tego typu odpadami może mieć wpływ na środowisko i
zdrowie ludzi ze względu na substancje potencjalnie niebezpieczne, związane ze zużytym sprzętem
elektrycznym i elektronicznym. Państwa współpraca w zakresie właściwej utylizacji tego produktu
przyczyni się do efektywnego wykorzystania zasobów naturalnych. W celu uzyskania informacji o
sposobie recyklingu tego produktu prosimy o kontakt z właściwym urzędem miejskim lub zakładem
gospodarki komunalnej bądź zapraszamy na stronę www.canon-europe.com/weee, lub www.canon-
europe.com/battery.

Platí len pre štáty Európskej únie a EHP (Nórsko, Island a Lichtenštajnsko)

Tieto symboly označujú, že podľa Smernice o odpade z elektrických a elektronických zariadení (OEEZ)
2012/19/EÚ, Smernice o batériách (2006/66/ES) a podľa platnej legislatívy Slovenskej republiky sa tento
produkt nesmie likvidovať spolu s komunálnym odpadom. Ak je chemická značka vytlačená pod vyššie
uvedeným symbolom, znamená to, že táto batéria alebo akumulátor obsahuje ťažký kov (Hg = ortuť, Cd =
kadmium, Pb = olovo) v koncentrácii vyššej, ako je príslušná povolená hodnota stanovená v Smernici o
batériách. Produkt je potrebné odovzdať do určenej zberne, napr. prostredníctvom výmeny za kúpu
nového podobného produktu, alebo na autorizované zberné miesto, ktoré spracúva odpad z elektrických
a elektronických zariadení (EEZ), batérií a akumulátorov. Nesprávna manipulácia s takýmto typom
odpadu môže mať negatívny vplyv na životné prostredie a ľudské zdravie, pretože elektrické a
elektronické zariadenia obsahujú potenciálne nebezpečné látky. Spoluprácou na správnej likvidácii tohto
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produktu prispejete k účinnému využívaniu prírodných zdrojov. Ďalšie informácie o recyklácii tohto
produktu získate od miestneho úradu, úradu životného prostredia, zo schváleného plánu OEEZ alebo od
spoločnosti, ktorá zaisťuje likvidáciu komunálneho odpadu. Viac informácií nájdete aj na webovej stránke:
www.canon-europe.com/weee, alebo www.canon-europe.com/battery.

Üksnes Euroopa Liit ja EMP (Norra, Island ja Liechtenstein)

Antud sümbolid viitavad sellele, et vastavalt elektri- ja elektroonikaseadmete jäätmeid käsitlevale
direktiivile (2012/19/EL), patareisid ja akusid ning patarei- ja akujäätmeid käsitlevale direktiivile
(2006/66/EÜ) ja/või nimetatud direktiive rakendavatele riiklikele õigusaktidele ei või seda toodet koos
olmejäätmetega ära visata. Kui keemiline sümbol on trükitud eespool toodud sümboli alla, siis tähendab
see, et antud patareis või akus leiduva raskemetalli (Hg = elavhõbe, Cd = kaadmium, Pb = plii)
kontsentratsioonitase on kõrgem kui patareisid ja akusid ning patarei- ja akujäätmeid käsitlevas direktiivis
sätestatud piirmäär. Antud tootest tekkinud jäätmed tuleb anda vastavasse kogumispunkti, nt
müügipunkti, mis on volitatud üks ühe vastu vahetama, kui ostate uue sarnase toote, või vastavasse
elektri- ja lektroonikaseadmete jäätmete ning patareide ja akude ümbertöötlemiseks mõeldud
kogumispunkti. Antud liiki jäätmete vale käitlemine võib kahjustada keskkonda ja inimeste tervist elektri- ja
elektroonikajäätmetes tavaliselt leiduvate potentsiaalselt ohtlike ainete tõttu. Antud tootest tekkinud
jäätmete nõuetekohase kõrvaldamisega aitate kasutada loodusvarasid efektiivselt. Täiendava teabe
saamiseks elektri- ja elektroonikaseadmetest tekkinud jäätmete ning patarei- ja akujäätmete tagastamise
ja ümbertöötlemise kohta võtke ühendust kohaliku omavalitsusega, asjakohase valitsusasutusega,
asjakohase tootjavastutusorganisatsiooniga või olmejäätmete käitlejaga. Lisateavet leitate ka Interneti-
leheküljelt www.canon-europe.com/weee või www.canon-europe.com/battery.

Tikai Eiropas Savienībai un EEZ (Norvēģijai, Islandei un Lihtenšteinai)

Šie simboli norāda, ka atbilstoši ES Direktīvai (2012/19/ES) par elektrisko un elektronisko iekārtu
atkritumiem (EEIA), Direktīvai (2006/66/EK) par baterijām un akumulatoriem, un akumulatoru atkritumiem,
ar ko atceļ Direktīvu 91/157/EEK, un vietējiem tiesību aktiem šo izstrādājumu nedrīkst izmest kopā ar
sadzīves atkritumiem. Ja zem iepriekš norādītā simbola ir uzdrukāts ķīmiskais simbols, saskaņā ar
direktīvu par baterijām un akumulatoriem tas nozīmē, ka šīs baterijas vai akumulatori satur smagos
metālus (Hg = dzīvsudrabs, Cd = kadmijs, Pb = svins) un to koncentrācijas līmenis pārsniedz direktīvā par
baterijām un akumulatoriem minēto piemērojamo slieksni. Šis izstrādājums ir jānodod piemērotā
savākšanas vietā, piemēram, apstiprinātā veikalā, kur iegādājaties līdzīgu jaunu produktu un atstājat
veco, vai apstiprinātā vietā izlietotu elektrisko un elektronisko iekārtu un bateriju un akumulatoru
pārstrādei. Nepareiza šāda veida atkritumu apsaimniekošana var apdraudēt vidi un cilvēka veselību tādu
iespējami bīstamu vielu dēļ, kas parasti ir elektriskajās un elektroniskajās iekārtās. Jūsu atbalsts pareizā
šāda veida atkritumu apsaimniekošanā sekmēs efektīvu dabas resursu izmantošanu. Lai saņemtu
pilnīgāku informāciju par šāda veida izstrādājumu nodošanu otrreizējai pārstrādei, sazinieties ar vietējo
pašvaldību, atkritumu savākšanas atbildīgo dienestu, pilnvaroto organizāciju vai iestādi, kas veic sadzīves
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atkritumu apsaimniekošanu, vai apmeklējiet tīmekļa vietni www.canon-europe.com/weee, vai www.canon-
europe.com/battery.

Tik Europos Sąjungai ir EEE (Norvegijai, Islandijai ir Lichtenšteinui)

Šie simboliai reiškia, kad šio gaminio negalima išmesti į buitines atliekas, kaip reikalaujama WEEE
Direktyvoje (2012/19/ES) ir Baterijų direktyvoje (2006/66/EB) ir (ar) jūsų šalies nacionaliniuose
įstatymuose, kuriais šios Direktyvos yra įgyvendinamos. Jeigu cheminio ženklo simbolis yra nurodytas
žemiau šio ženklo, tai reiškia, kad vadovaujantis Baterijų direktyvą, baterijų ar akumuliatorių sudėtyje yra
sunkiųjų metalų (Hg = gyvsidabrio, Cd = kadmio, Pb = švino), kurių koncentracija viršija Baterijų
direktyvoje nurodytas leistinas ribas. Šį gaminį reikia pristatyti į specialųjį surinkimo punktą, pavyzdžiui,
mainais, kai jūs perkate naują panašų gaminį, arba į specialiąją surinkimo vietą, kurioje perdirbamos
elektrinės ir elektroninės įrangos atliekos bei naudotos baterijos ir akumuliatoriai. Dėl netinkamo šio tipo
atliekų tvarkymo gali nukentėti aplinka ir iškilti grėsmė žmogaus sveikatai dėl galimai kenksmingų
medžiagų, iš esmės susijusių su elektrine ir elektronine įranga. Bendradarbiaudami ir teisingai
utilizuodami šiuos gaminius, jūs padėsite efektyviai naudoti gamtinius išteklius. Daugiau informacijos apie
gaminio perdirbimą jums gali suteikti vietinis biuras, atliekų tvarkymo bendrovė, sertifikuoti organai ar
buitinių atliekų surinkimo įmonės. Taip pat siūloma apsilankyti interneto svetainėje www.canon-
europe.com/weee, arba www.canon-europe.com/battery.

Samo za Evropsko unijo in EGP (Norveška, Islandija in Lihtenštajn)

Ti simboli pomenijo, da tega izdelka skladno z Direktivo OEEO (2012/19/EU), Direktivo 2006/66/ES in/ali
nacionalno zakonodajo, ki uvaja ti direktivi, ne smete odlagati z nesortiranimi gospodinjskimi odpadki. Če
je pod zgoraj prikazanim simbolom natisnjen kemijski simbol, to v skladu z Direktivo pomeni, da je v tej
bateriji ali akumulatorju prisotna težka kovina (Hg = živo srebro, Cd = kadmij, Pb = svinec), in sicer v
koncentraciji, ki je nad relevantno mejno vrednostjo, določeno v Direktivi. Ta izdelek je potrebno odnesti
na izbrano zbirno mesto, t. j. pooblaščeno trgovino, kjer ob nakupu novega (podobnega) izdelka vrnete
starega, ali na pooblaščeno zbirno mesto za ponovno uporabo odpadne električne in elektronske opreme
(EEO) ter baterij in akumulatorjev. Neustrezno ravnanje s to vrsto odpadkov lahko negativno vpliva na
okolje in človeško zdravje zaradi potencialno nevarnih snovi, ki so pogosto povezane z EEO. Vaše
sodelovanje pri pravilnem odlaganju tega izdelka predstavlja pomemben prispevek k smotrni izrabi
naravnih virov. Za več informacij o ponovni uporabi tega izdelka se obrnite na lokalen mestni urad,
pristojno službo za odpadke, predstavnika pooblaščenega programa za obdelavo odpadkov ali na lokalno
komunalo. Lahko pa tudi obiščete našo spletno stran www.canon-europe.com/weee, ali www.canon-
europe.com/battery.
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Само за Европейския съюз и ЕИП (Норвегия, Исландия и Лихтенщайн)

Тези символи показват, че този продукт не трябва да се изхвърля заедно с битовите отпадъци
съгласно Директивата за ИУЕЕО (2012/19/ЕC), Директивата за батерии (2006/66/ЕО) и/или Вашето
национално законодателство, прилагащо тези Директиви. Ако под показания горе символ е
отпечатан символ за химически елемент, съгласно разпоредбите на Директивата за батерии, този
втори символ означава наличието на тежък метал (Hg = живак, Cd = кадмий, Pb = олово) в
батерията или акумулатора в концентрация над указаната граница за съответния елемент в
Директивата. Този продукт трябва да бъде предаден в предназначен за целта пункт за събиране,
например на база размяна, когато купувате нов подобен продукт, или в одобрен събирателен пункт
за рециклиране на излязло от употреба електрическо и електронно оборудване (ИУЕЕО), батерии
и акумулатори. Неправилното третиране на този тип отпадъци може да доведе до евентуални
отрицателни последствия за околната среда и човешкото здраве поради потенциално опасните
вещества, които обикновено са свързани с ЕЕО. В същото време Вашето съдействие за
правилното изхвърляне на този продукт ще допринесе за ефективното използване на природните
ресурси. За повече информация относно това къде можете да предадете за рециклиране на този
продукт, моля свържете се с Вашите местни власти, с органа, отговорен за отпадъците, с
одобрената система за ИУЕЕО или с Вашата местна служба за битови отпадъци, или посетете
www.canon-europe.com/weee, или www.canon-europe.com/battery.

Doar pentru Uniunea Europeană şi EEA (Norvegia, Islanda şi Liechtenstein)

Aceste simboluri indică faptul că acest produs nu trebuie aruncat împreună cu deşeurile menajere, în
conformitate cu Directiva DEEE (2012/19/UE), Directiva referitoare la baterii (2006/66/CE) şi/sau legile
dvs. naţionale ce implementează aceste Directive. Dacă un simbol chimic este imprimat sub simbolul de
mai sus, în conformitate cu Directiva referitoare la baterii, acest simbol indică prezenţa în baterie sau
acumulator a unui metal greu (Hg = Mercur, Cd = Cadmiu, Pb = Plumb) într-o concentraţie mai mare
decât pragul admis specificat în Directiva referitoare la baterii. Acest produs trebuie înmânat punctului de
colectare adecvat, ex: printr-un schimb autorizat unu la unu atunci când cumpăraţi un produs nou similar
sau la un loc de colectare autorizat pentru reciclarea reziduurilor de echipament electric şi electronic
(EEE) şi baterii şi acumulatori. Administrarea neadecvată a acestui tip de deşeuri, ar putea avea un
impact asupra mediului şi asupra sănătăţii umane datorită substanţelor cu potenţial de risc care sunt în
general asociate cu EEE. Cooperarea dvs. în direcţia reciclării corecte a acestui produs va contribui la o
utilizare eficientă a resurselor naturale. Pentru mai multe informaţii despre reciclarea acestui produs, vă
rugăm să contactaţi biroul dvs. local, autorităţile responsabile cu deşeurile, schema aprobată sau serviciul
dvs. responsabil cu deşeurile menajere sau vizitaţi-ne la www.canon-europe.com/weee, sau www.canon-
europe.com/battery.
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Samo za Europsku uniju i EEA (Norveška, Island i Lihtenštajn)

Oznaka pokazuje da se ovaj proizvod ne smije odlagati s komunalnim i ostalim vrstama otpada, u skladu
s direktivom WEEE (2012/19/EC), Direktivom o baterijama (2006/66/EC) i Pravilnikom o gospodarenju
otpadnim baterijama i akumulatorima te Pravilnikom o gospodarenju otpadnim električnim i elektroničkim
uređajima i opremom. Ako je ispod prethodno prikazane oznake otisnut kemijski simbol, u skladu s
Direktivom o baterijama, to znači da se u ovoj bateriji ili akumulatoru nalazi teški metal (Hg = živa, Cd =
kadmij, Pb = olovo) i da je njegova koncentracija iznad razine propisane u Direktivi o baterijama. Ovaj bi
proizvod trebalo predati ovlašenom skupljaču EE otpada ili prodavatelju koji je dužan preuzeti otpadni
proizvod po sistemu jedan za jedan, ukoliko isti odgovara vrsti te je obavljao primarne funkcije kao i
isporučena EE oprema. Otpadne baterije i akumulatori predaju se ovlaštenom skupljaču otpadnih baterija
ili akumulatora ili prodavatelju bez naknade i obveze kupnje za krajnjeg korisnika. Neodgovarajuće
rukovanje ovom vrstom otpada može utjecati na okoliš i ljudsko zdravlje zbog potencijalno opasnih
supstanci koje se najčešće nalaze na takvim mjestima. Vaša suradnja u pravilnom zbrinjavanju ovog
proizvoda pridonijet će djelotvornom iskorištavanju prirodnih resursa. Dodatne informacije o recikliranju
ovog proizvoda zatražite od svog lokalnog gradskog ureda, službe za zbrinjavanje otpada, odobrenog
programa ili komunalne službe za uklanjanje otpada ili pak na stranicama www.canon-europe.com/weee
ili www.canon-europe.com/battery.

Korisnici u Srbiji

Ovaj simbol označava da ovaj proizvod ne sme da se odlaže sa ostalim kućnim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU), Direktivom o baterijama (2006/66/EC) i nacionalnim zakonima. Ukoliko
je ispod gore navedenog simbola odštampan hemijski simbol, u skladu sa Direktivom o baterijama, ovaj
simbol označava da su u ovoj bateriji ili akumulatoru prisutni teški metali (Hg – živa, Cd – kadmijum, Pb -
olovo) u koncentracijama koje premašuju prihvatljivi prag naveden u Direktivi o baterijama. Ovaj proizvod
treba predati određenom centru za prikupljanje, npr. po principu „jedan-za-jedan“ kada kupujete sličan
novi proizvod, ili ovlašćenom centru za prikupljanje za reciklažu istrošene električne i elektronske opreme
(EEE), baterija i akumulatora. Nepravilno rukovanje ovom vrstom otpada može imati negativne posledice
po životnu sredinu i ljudsko zdravlje usled potencijalno opasnih materijala koji se uglavnom vezuju za
EEE. Vaša saradnja na ispravnom odlaganju ovog proizvoda će doprineti efikasnom korišćenju prirodnih
resursa. Više informacija o tome kako možete da reciklirate ovaj proizvod potražite od lokalnih gradskih
vlasti, komunalne službe, odobrenog plana reciklaže ili servisa za odlaganje kućnog otpada, ili posetite
stranicu www.canon-europe.com/weee, ili www.canon-europe.com/battery.
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When repairing, lending, or disposing of the printer

Personal information or administrator password may be stored in the printer if you have registered it.

When you leave the printer to others to ask for repairing or to lend it, initialize or delete settings below
following each procedure to avoid information leakage.

• Areas on the hard disk drive

Device settings　>　Hard disk settings　>　Data deletion　>　Fast/Fast secure/Secure　>　Yes

• Initializing network settings

Device settings　>　LAN settings　>　Reset LAN settings　>　Yes

• Initializing SSL information

Device settings　>　LAN settings　>　Other settings　>　Reset SSL certificates　>　Yes

• Deleting the administrator password

Device settings　>　Administrator password setting　>　Yes　>　Enter the administrator
password　>　OK　>　Remove administrator password　>　Yes　>　OK
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Screenshots in This Manual

For Windows:
The screenshots used in this manual are the screens that appear when the operating system Windows 10
is used.

For macOS:
The screenshots used in this manual are the screens that appear when the operating system macOS
Sierra 10.12 is used.
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Basic Printing Workflow

Printing procedure

Canceling print jobs

Pausing Printing
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Printing procedure

Printing Options Using Rolls and Sheets

Turning the Printer On and Off

Loading and Printing on Rolls

Loading and Printing on Sheets

Printing in Windows

Printing from macOS
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Printing Options Using Rolls and Sheets

The printer supports both rolls and sheets.

This section introduces the main features of each, as well as the main printing methods available. Select
rolls or sheets to suit your particular printing application.

Note
• For information on the types of paper the printer supports, see "Types of Paper."

• A variety of other ways to print are available besides those introduced here. For details, see "Enhanced
Printing Options."

Roll printing
Media in spooled rolls is generally called Roll Media. Rolls are loaded on the Roll Holder, which are in turn
loaded in the printer.

Rolls can be used to print large photos or create posters or banners that cannot be printed on regular
sheets.

• Large-format printing

Easily print vertical or horizontal banners from familiar applications such as Microsoft Office
applications.

(See "Printing Hanging and Horizontal Banners (Large-Format Printing)" (Windows).)

(See "Printing Hanging and Horizontal Banners (Large-Format Printing)" (macOS).)

• Borderless printing

Print without a margin (border) around posters or photos.

(See "Prints without Edges Based on the Scenarios" (Windows).)

(See "Prints without Edges Based on the Scenarios" (macOS).)

• Banner printing

You can print multiple pages as a single continuous image, without margins between pages.

(See "Printing by Connecting Multiple Pages" (Windows).)

(See "Printing by Connecting Multiple Pages" (macOS).)

• 90-degree rotation before printing

Originals in portrait orientation are rotated 90 degrees when possible to use paper more efficiently.

(See "Saving Roll Paper by Rotating Document 90 Degrees" (Windows).)

(See "Saving Roll Paper by Rotating Document 90 Degrees" (macOS).)

• Enlarged/reduced printing

You can freely adjust the size of originals by enlarging or reducing originals before printing.

(See "Scaled Printing" (Windows).)

(See "Scaled Printing" (macOS).)

• Free Layout (Windows) and imagePROGRAF Free Layout (macOS)
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Print multiple documents from multiple applications (such as word-processing programs, spreadsheet
programs, and so on) next to each other.

(See "Lining Up and Printing Multiple Documents" (Windows).)

(See "Lining Up and Printing Multiple Documents" (macOS).)

Note
• Setting the roll unit to feed mode and loading roll paper in both the Roll 1 (Upper) and Roll 2 (Lower)

holders offers the following advantages.

• Save the time and effort of switching paper

By loading roll paper of different media types or paper sizes on the upper and lower rolls, you can
select the roll paper in Paper Source in the printer driver when printing, eliminating the effort it
takes to replace the roll.

(See "Page Setup Tab Description" (Windows).)

(See "Quality & Media" (macOS).)

• Automatic selection of the right paper for the print job

Selecting Roll Paper (Auto) in Paper Source in the printer driver enables automatic selection and
printing on the roll that suits the print job from the loaded rolls.

(See "Printing by Automatically Switching Upper-level and Lower-level Roll Papers" (Windows).)

(See "Printing by Automatically Switching Upper-level and Lower-level Roll Papers" (macOS).)

Sheet printing
Sheets refer to individual sheets of paper.

Insert the sheet between the platen and the paper retainer.

• Enlarged/reduced printing

You can freely adjust the size of originals by enlarging or reducing originals before printing.

(See "Scaled Printing" (Windows).)

(See "Scaled Printing" (macOS).)

• Free Layout (Windows) and imagePROGRAF Free Layout (macOS)

Print multiple documents from multiple applications (such as word-processing programs, spreadsheet
programs, and so on) next to each other.

(See "Lining Up and Printing Multiple Documents" (Windows).)

(See "Lining Up and Printing Multiple Documents" (macOS).)
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Turning the Printer On and Off

Turning the printer on

1. Press ON button to turn on printer.

The printer will now start up.

The Canon logo appears on the touch screen, and then "Starting the system Please wait." appears.

When startup is finished, ON button lights up, and printer enters standby mode.
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The printer will not enter standby mode in the following situations. Take action as necessary.

• The top cover is open

Close the top cover.

• The ink tank cover is open

Close the ink tank cover.

• The print head is not installed

Replacing the Print Head

• The ink tank is not installed

Replacing Ink Tanks

• Error appears on touch screen

Check the message on the touch screen and take action as necessary.

• The ON button and Status lamp never light up, and nothing appears on the touch screen

Make sure the printer is plugged in correctly. Check the connection at the plug and electrical
outlet.

• No paper is loaded

Load paper. (See "Loading and Printing on Rolls.") (See "Loading and Printing on Sheets.")

Turning the printer off

Important
• Never disconnect the printer's power supply or unplug it during a print job. This may damage the

printer.

1. Make sure no print jobs are in progress.

While the Status lamp is flashing, the printer is running. The color of the lamp indicates the following
states.
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If the Status lamp is flashing orange, check the message on the touch screen and take action as
necessary.

If the Status lamp is flashing white, the printer is receiving a print job. Turn off the printer after printing
is finished.

2. Hold down the ON button for more than a second.

"Ending Please wait a while." appears on the touch screen, and the printer turns off.
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Loading and Printing on Rolls

These are the basic steps for loading and printing on rolls.

Follow these steps to load and print on rolls.

Note
• For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information

List".

• To wait until the ink dries after printing before cutting the roll, set Drying Time in the printer driver. (See
"Specifying the Ink Drying Time for Rolls.")

• Once you have used all the paper on a roll, clean the platen. If the platen inside the top cover becomes
dirty, it may soil the underside of paper. (See "Cleaning Inside the Top Cover.")

1. Turn the printer on. (See "Turning the Printer On and Off.")

2. Load a roll on the Roll Holder. (See "Loading Rolls on the Roll Holder.")
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3. Load roll paper in printer or roll unit. (See "Loading the Upper Roll on the Printer.")  (See
"Loading the Lower Roll on the Roll Unit (Option).")

4. Select the type of paper. (See "Changing the Type of Paper.")

Note
• If no barcode has been printed on the roll paper and you have set Manage remaining roll

amount to Barcodes, specify the roll length after selecting the media type. (See "Specifying the
Paper Length.")

5. Complete settings in the printer driver for the type of paper and other details.

How to Open the Printer Driver Setup Window (Windows)

How to Open the Printer Driver Setup Window (macOS)
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6. Send the print job.

Printing in Windows

Printing from macOS

The printer now starts printing the print job.
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Loading and Printing on Sheets

These are the basic steps for loading sheets and then printing.

Follow the steps below to load and print on sheets.

Note
• For details on paper sizes and types that can be loaded, see "Paper Sizes" or "Paper Information List".

• Borderless printing is not supported on sheets. For the features and the main printing methods
available for sheet printing, see "Printing Options Using Rolls and Sheets."

1. Turn the printer on. (See "Turning the Printer On and Off.")

2. Complete settings in the printer driver for the type of paper and other details.

How to Open the Printer Driver Setup Window (Windows)

How to Open the Printer Driver Setup Window (macOS)
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3. Send the print job.

Printing in Windows

Printing from macOS

4. Load the sheet. (See "Loading Sheets in the Printer.")

Start printing.
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Printing in Windows

Print from the application menu.

Important
• We recommend exiting unnecessary applications before printing. Running several applications while

printing may interrupt the transfer of print data and affect printing quality.

1. In the source application, select Print from the File menu to display the dialog box for
printing conditions.

2. After confirming that the printer is selected in the dialog box, click Print or OK to start
printing.

Note
• The appearance of the dialog box varies depending on the software application. In most cases,

the dialog box includes basic printing options and enables you to choose the printer, specify the
range of pages, number of copies, and so on.

Example: Print dialog box displayed by the application

• If another printer is selected, select the printer you want to use under Select Printer or in the
dialog box displayed after clicking Printer.
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You can use the printer driver dialog box to configure various printing settings such as for enlarged or
reduced printing and borderless printing. You can open the printer driver dialog box from the application
software or from the operating system menu. For details, see "How to Open the Printer Driver Setup
Window" (Windows) or "How to Open the Printer Driver Setup Window" (macOS).
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Printing from macOS

Print from the application menu after registering the printer.

Important
• We recommend exiting unnecessary applications before printing. Running several applications while

printing may interrupt the transfer of print data and affect printing quality.

Registering the printer
The printer needs to be registered in Print & Scan (identified as Printers & Scanners or Print & Fax in
other versions of macOS X) in System Preferences before printing.

For instructions on registering printers, see "Sharing the Printer on a Network (macOS)."

Important
• During this setup process, the printer will not be listed among available printers if it is off or

disconnected.

Printing from the application software

1. In the application software, select Print from the File menu to display the dialog box for
printing conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify

the range of pages, number of copies, and so on.

2. Select the printer in the Printer list.

3. Click Print to start printing.
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As shown in the following illustration, you can switch to other panes in this dialog box to complete
settings for various methods of printing, including enlarged and reduced printing, borderless printing,
and so on.
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Canceling print jobs

Canceling Print Jobs from the Control Panel

Canceling Print Jobs from Windows

Canceling Print Jobs from macOS
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Canceling Print Jobs from the Control Panel

To cancel printing or reception of print jobs, press the Stop button on the operation panel.

When you press the Stop button during printing, the printer operation varies depending on the current
status.

• You press the Stop button before printing starts

Pressing the Stop button before printing starts displays a confirmation message. To cancel the print job,
select Yes.

• You press the Stop button during printing

Pressing the Stop button during printing displays a confirmation message. To cancel the print job
immediately, select Yes.
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Canceling Print Jobs from Windows

In the printer window, you can cancel jobs that are being sent to the printer.

Using Canon IJ Status Monitor, you can cancel print jobs that have already been received by the printer or
that are currently being printed.

1. Click the printer icon in the taskbar to display the printer window.

Note
• You can proceed from the folder for configuring the printer settings in the OS you are using.

For example, in Windows 7, open the Devices and Printers window from the start menu and
double-click the printer icon.

2. Right-click the job to cancel and select Cancel.

3. If job to be canceled is not shown in printer window (that is, if print data has already been
received by printer), click taskbar icon to display Canon IJ Status Monitor.

4. Click Cancel Printing.
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Note
• The screen may differ slightly depending on the model you are using.
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Canceling Print Jobs from macOS

In the printer window, you can cancel jobs that are being sent to the printer.

Note
• Print jobs are shown in the printer window while they are being sent from the computer. After

transmission, jobs are not displayed even during printing.

1. Click the printer icon in the Dock to display the printer window.

2. Either click × for the job to cancel printing or select the job to cancel printing and then click
Delete to delete the job.

Note
• If the job to be canceled is not shown in the printer window (that is, if the print data has already

been received by the printer), you can cancel printing from the operation panel on the printer or
from RemoteUI. For details, "Canceling Print Jobs from the Control Panel" or see "Changing
Settings Using Web Browser."
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Pausing Printing

Pausing Printing
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Pausing Printing

During printing, if you set Pause printing to Enable, the printer enters a state in which printing is paused,
after the completion of the printing process when this setting was made.

Printing from the job queue is not possible in this state.

To restore normal operation after pausing printing, set Pause printing to Disable.

Note
• In the following cases, the status is cleared even if you do not set Pause printing to Disable, and

printing from the job queue resumes.

• When paper is advanced

• If you changed the media type from the paper settings display area

1. Tap Job management on Home screen during printing.

Note
• If the Home screen does not appear, press the HOME button.

2. Tap Pause printing.

3. Tap Enable or Disable.
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Enhanced Printing Options

Printing from Your Computer (Windows)

Printing with Easy Setup Basics

Changing the Type of Paper

Setting the Number of Copies and Printing Order

Using Roll Unit to Use 2-Level Rolls

About 2-Level Roll Switching

Setting the Paper Rolls in the Printer According to the Intended Use

Printing by Automatically Switching Upper-level and Lower-level Roll Papers

How to Switch Paper Rolls

Reflect Roll Unit Settings in the Printer Driver

Printing Photos and Business Documents

Printing By Setting Print Purpose

Edit in PosterArtist and Print

Printing CAD Drawings

Printing By Setting Print Purpose

Printing from AutoCAD

Changing the Print Quality and Correcting Image Data

Adjusting Color Balance

Setting the Print Quality Level (Custom)

Printing a Color Document in Monochrome

Specifying Color Correction

Optimal Photo Printing of Image Data

Adjusting Colors with the Printer Driver

Printing with ICC Profiles

Adjusting Brightness

Adjusting Contrast

Printing Using Detailed Setting Mode

Scaled Printing
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Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Prints without Edges Based on the Scenarios

Printing without Margins to Match Paper Size

Printing without Margins to Match Roll Paper Width

Printing Full-Size without Margins

Printing Hanging and Horizontal Banners (Large-Format Printing)

Printing by Dividing/Joining Documents

Lining Up and Printing Multiple Documents

Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page

Dividing and Printing Posters

Printing Document in Center of Paper

Printing by Saving Roll Paper

Saving Roll Paper by Rotating Document 90 Degrees

Saving Roll Paper by Eliminating Upper and Lower Margins on Document

Switching the Paper Source to Match the Purpose

Displaying the Print Results before Printing

Other Convenient Settings

Stamp Printing

Registering a Stamp

Setting a Page Size and Orientation

Registering a Frequently Used Printing Profile

Cutting Roll Paper after Printing

Printing from Computer (macOS)

Printing with Easy Setup Basics

Changing the Type of Paper

Setting the Number of Copies and Printing Order
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Using Roll Unit to Use 2-Level Rolls

About 2-Level Roll Switching

Setting the Paper Rolls in the Printer According to the Intended Use

Printing by Automatically Switching Upper-level and Lower-level Roll Papers

How to Switch Paper Rolls

Reflect Roll Unit Settings in the Printer Driver

Changing the Print Quality and Correcting Image Data

Adjusting Color Balance

Setting the Print Quality Level (Custom)

Printing a Color Document in Monochrome

Specifying Color Correction

Optimal Photo Printing of Image Data

Adjusting Colors with the Printer Driver

Printing with ICC Profiles (Specifying an ICC Profile from the Application Software)

Printing with ICC Profiles (Specifying an ICC Profile from the Printer Driver)

Adjusting Brightness

Adjusting Contrast

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Print Area

Prints without Edges Based on the Scenarios

Printing without Margins to Match Roll Paper Width

Printing Full-Size without Margins

Printing Hanging and Horizontal Banners (Large-Format Printing)

Printing by Dividing/Joining Documents

Lining Up and Printing Multiple Documents

Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page
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Printing Document in Center of Paper

Printing by Saving Roll Paper

Saving Roll Paper by Rotating Document 90 Degrees

Saving Roll Paper by Eliminating Upper and Lower Margins on Document

Switching the Paper Source to Match the Purpose

Cutting Roll Paper after Printing

HP-GL/2 Printing

Printing from Printer

Printing from USB Flash Drive

Printing Data Saved on USB Flash Drive

Setting Items for Printing Using Operation Panel

Printing from Smartphone/Tablet

Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct
Connection)
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Printing from Your Computer (Windows)

Printing with Easy Setup Basic

Setting the Number of Copies and Printing Order

Using Roll Unit to Use 2-Level Rolls

Printing Photos and Business Documents

Printing CAD Drawings

Changing the Print Quality and Correcting Image Data

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Prints without Edges Based on the Scenarios

Printing Hanging and Horizontal Banners (Large-Format Printing)

Printing by Dividing/Joining Documents

Printing Document in Center of Paper

Printing by Saving Roll Paper

Switching the Paper Source to Match the Purpose

Displaying the Print Results before Printing

Other Convenient Settings
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Printing with Easy Setup

This section describes the simple setting procedure so that you can carry out appropriate printing on this
printer.

Printing with Easy Setup

1. Check that the printer is turned on

2. Load paper on the printer
Set roll paper or cut paper to a printer.

3. Open the printer driver setup window

4. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

Important
• See "Paper Information List" for Canon authentic paper or Canon output check paper.

Note
• Click Get Information... to display the Paper Information on Printer dialog box. The Paper

Information on Printer dialog box allows you to get the paper information from the printer and
to set the paper source and the media type on the printer driver.
If Roll Paper (Auto) is selected for the paper source, it will remain as Roll Paper (Auto) even if
you get the paper information from the printer.
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• For instructions on changing the media type from the printer's operation panel, see "Changing
the Type of Paper."

5. Select print target

From the pull-down menu, select Easy Settings, and then select the setting that matches your
purpose from the Print Target list.

6. Select the print quality

For Print Quality, select High, Standard or Fast according to your purpose.

Important
• The print quality settings that can be selected may differ depending on a printing profile.
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7. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

8. Select the paper source

For Paper Source, select the setting that matches your purpose.

Important
• The paper feed method will differ according to the lower level (roll paper 2) settings, or roll unit

option settings.

9. Select roll paper width
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If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

10. Complete the setup

Click OK.
When you execute print, the document is printed with settings that match your purpose.

Note
• If the paper settings in the printer driver differ from the paper information registered on the printer, an

error message may appear on the printer's operation panel. You can execute Print, but you may not
obtain the correct printing result.
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Checking Printer Settings and Applying Settings to Printer Driver

1. Open printer driver setup window

2. Click Get Information... on Main tab
The Paper Information on Printer dialog box appears.

3. Select the paper source

From Paper Source, check the setting or select a new paper source.
The current printer settings appear in Media Type and Roll Width.

4. Apply settings

To apply the printer settings to the printer driver, click OK.

Note
• If the media type and the output paper size are not set on the printer, OK will be grayed out and

cannot be clicked.
• If communication with the printer is disabled, the Get Information... does not appear or printer

media information from the printer cannot be obtained.
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Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Layout tab, specify the number of copies to be printed.

3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.

4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

Important
• When the application software that you used to create the document has the same function, specify the

settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.
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Using Roll Unit to Use 2-Level Rolls

About 2-Level Roll Switching

Setting the Paper Rolls in the Printer According to the Intended Use

Printing by Automatically Switching Upper-level and Lower-level Roll Papers

How to Switch Paper Rolls

Reflect Roll Unit Settings in the Printer Driver
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About 2-Level Roll Switching

This printer allows you to load roll paper in two levels, the upper level (Roll 1) and the lower level (Roll 2)
and to automatically switch between Roll 1 and Roll 2 depending on the print job.

Printing by automatically switching Roll 1 and Roll 2 in this way is called "2-level roll switching."

• For instructions on setting the paper, see "Setting the Paper Rolls in the Printer According to the
Intended Use."

• For the 2-level roll switching procedure, see "Printing by Automatically Switching Upper-level and Lower-
level Roll Papers."

• Guidelines on how to switch Roll 1 and Roll 2 for certain cases are summarized in "How to Switch Paper
Rolls."
Refer to this section if a document cannot be printed as intended or as necessary.
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Setting the Paper Rolls in the Printer According to the Intended
Use

If you want to switch the 2-level rolls, set the paper rolls on the upper and lower level of the printer in one of
the ways described below depending on the intended use.

• When automatically switching from paper roll 1 to paper roll 2 to match the paper size specified for the
print job

Set two paper rolls of the same type of paper but of different width on the upper and on the lower trays.

Example of how to set the paper

Paper-feeding tray Roll Width Media Type

Upper-level 24 in Roll (609.6mm) Plain Paper

Lower-level A1/A2 Roll (594.0mm) Plain Paper

• When automatically switching from paper roll 1 to paper roll 2 role to match the paper type specified for
the print job

Set two paper rolls of the same width but of different types of paper on the upper and on the lower trays.
Alternatively, set two paper rolls of different width and different types of paper on the upper and on the
lower trays.

Setting the paper (Example 1)

Paper-feeding tray Roll Width Media Type

Upper-level A1/A2 Roll (594.0mm) Plain Paper

Lower-level A1/A2 Roll (594.0mm) Canon Coated Paper

Setting the paper (Example 2)

Paper-feeding tray Roll Width Media Type

Upper-level 24 in Roll (609.6mm) Plain Paper

Lower-level A1/A2 Roll (594.0mm) Canon Coated Paper

Important
• 2-level roll switching is not possible when the paper rolls being fed on the platen are not compatible

with automatic cut-off. For checking which types of paper are compatible with automatic cut-off,
look up the paper you want to use on the "Paper Information List."

• If Auto (Use Printer Settings) is selected for Media Type in the Main sheet, you cannot switch
between upper and lower rolls corresponding to the media type specified by the print job. If different
types of roll paper are set for the upper and lower rolls, specify the media type, such as plain paper
or enameled paper, in Media Type.
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Note
• For information on how to set the paper rolls in the printer, see "Handling rolls."
• When rolls of different types of paper and of different width are set in the upper and lower trays, the

paper roll matching the type of paper specified for the print job will be used.
Depending on the settings, an error may occur causing the wrong paper roll to be used; in such
cases, it is recommended that, instead of using 2-level roll switching, you specify which one is best
between paper roll 1 and paper roll 2 and print.

Document
Size: A3

Media Type: Plain Paper

Roll 1:
ISO A1/A2
Plain Paper

Roll 2:
ISO A3/A4

Glossy Paper

• To learn how to switch paper- feeding trays, see "How to switch paper rolls."
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Printing by Automatically Switching Upper-level and Lower-level
Roll Papers

You can print by automatically switching Roll 1 and Roll 2 depending on the media type or your purpose.

The procedure for printing by switching the roll papers is as follows:

1. Load roll papers in upper and lower levels of printer

2. Open the printer driver setup window

3. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

Note
• If Automatically switch paper sources (paper size priority) is grayed out, refer to "Reflect

Roll Unit Settings in the Printer Driver" and set Roll Unit in the Device Information dialog box
to Yes.

4. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

5. For Paper Source, select Roll Paper (Auto)
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6. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

7. Selecting the printing method for the roll paper

When performing enlarged/reduced printing in accordance with the roll width, place a checkmark next
to Enlarged/Reduced Printing and select the Fit Roll Paper Width.

8. Set the other items

To rotate the document 90 degrees and print it, select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

Note
• If you rotate a portrait document 90 degrees and print it at that horizontally, you may be able to

save paper depending on the paper size.

Important
• When you select the Rotate Page 90 degrees check box and print the document, the

document will be rotated 90 degrees only if the vertical length of the document fits in the width
set in Roll Width.
Therefore to use this function, correctly set Roll Width to the width of one of the roll papers
loaded in the printer.

Document  
Roll Width:

ISO A1/A2 Roll (594.0 mm)
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• If the roll papers loaded in the upper and lower levels are different media types, the document is
printed on the roll paper that matches the media type specified in the print job.
If the document is being rotated 90 degrees for printing and the roll papers loaded in the upper
and lower levels have different widths and different media types, set the correct combination of
width and media type so that they match one of the roll papers loaded in the printer.

9. Complete the setup

Click OK.
When you print, the paper source is switched automatically to roll paper.

Important
• On the operation panel, if Device settings -> Paper-related settings -> Roll paper auto switching

is set to Do not identify size, the document may be printed on the unintended roll paper. Canon
recommends that you set this setting to Identify size before you print.

• 2-level roll switching is not possible when the paper rolls being fed on the platen are not compatible
with automatic cut-off. For checking which types of paper are compatible with automatic cut-off, look
up the paper you want to use on the "Paper Information List."

Note
• For details about how to switch the source levels depending on the print job, see "How to Switch

Paper Rolls."

Printing by Saving Paper
Depending on the paper size that was specified in the print job, the printer automatically identifies the roll
paper that will produce the smaller margins.

Whether or not the page is rotated 90 degrees, the printer prints using conditions that produce the
smallest paper margins from among the Roll1 and Roll2 combinations.

Document  
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Roll 1: ISO A1/A2 Roll 2: ISO A3/A4

1. Select as described below:

• If you are using Windows 10 or Windows Server 2016, select the Start menu -> Windows
System -> Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 8.1, Windows Server 2012 R2, or Windows Server 2012, from the
Desktop charms, select Settings -> Control Panel -> Hardware and Sound (Hardware) ->
Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control
Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Set automatic paper source switching

On the Device Settings tab, select the Automatically switch paper sources (paper size priority)
check box.
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4. Click Get Information...

When the confirmation message appears, click Yes.
Your computer gets the paper size information from the printer and displays the width of the roll
paper that is actually loaded in the printer.

Important
• When you replace the roll paper loaded in the printer, always click Get Information... to

obtain the roll paper width information. If the roll paper width is not set correctly, you may not
be able to print the document as intended.

5. Open the printer driver setup window

6. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

7. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that
was created with the application software.

8. For Paper Source, select Roll Paper (Auto)

9. Set the other items

To rotate the document 90 degrees and print it, select the Rotate Page 90 degrees check box.

10. Complete the setup
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Click OK.
When you print, the paper source is switched automatically to roll paper.

Important
• This method switches the upper and lower levels depending on the paper size specified in the print

job. Always load the same media type for the roll papers in the upper and lower levels of the
printer.
If different types of paper are loaded, an error could occur and you may not be able to print the
document as intended.

• If roll papers of the same width and type are loaded in the upper and lower levels and you want to
automatically switch the roll papers, clear the Automatically switch paper sources (paper size
priority) check box.

Note
• If Roll 1 and Roll 2 produce the same margins, Roll 1 is used for printing.
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How to Switch Paper Rolls

Here we will explain how, in certain situations, paper roll 1 and paper roll 2 are switched. Refer to this
information when necessary, for example, when documents will not print as expected, etc.

If you select Roll Paper (Auto) under Paper Source in the Page Setup tab, of the two paper rolls loaded in
the lower and upper trays of the printer, the one best suited for the print job will be automatically selected.

Whether paper roll 1 or paper roll 2 will be used, is determined through a sequence of judgment based on
the 7 conditions in the table below.

At such times, the Device settings -> Paper-related settings -> Detect paper setting mismatch in the
Printer unit's Control panel will switch to the result of the judgment based on the process described below.

• If the Detect paper setting mismatch setting is set on Pause or Hold job

• If the Detect paper setting mismatch setting is Display warning or Do not detect

Important
• If the lower roll unit is not loaded or if the roll unit that was set as the take-up unit is loaded, the roll

paper cannot be switched automatically.

Note
• If Error or On hold are displayed, replace the paper to match the requirements of the print job.
• In order to minimize paper waste, it is recommended that you configure the control panel on the

Printer unit as indicated below.
• In Device settings -> Paper-related settings, set Roll paper auto switching to Identify size
• In Paper settings display area -> (Each paper type) -> Paper settings -> Advanced, set

Detect paper width to Enable

• If, on the Device Settings tab, a checkmark appears next to Automatically switch paper sources
(paper size priority), do not follow the table below.

If the Detect paper setting mismatch setting is set on Pause or Hold job

Condition Situation Judgment result

Condi-
tion 1

Whether the paper roll loaded on the printer is
long enough to print the paper size specified for
the print job.

Only one of either paper roll 1 or
paper roll 2 is long enough

Select the paper
roll of sufficient
length

Neither paper roll 1 nor paper roll
2 are long enough

Error

Both paper roll 1 and paper roll 2
are long enough

To Condition 2On the Printer's menu, Manage
remaining roll amount is set on
Disable (length of the paper roll
cannot be determined)
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Condi-
tion 2

Whether the paper roll loaded on the printer
matches the paper type specified for the print
job. *1

Only one of either paper roll 1 or
paper roll 2 matches the paper
type

Select the paper
roll matching the
paper type

Neither roll 1 nor roll 2 match the
paper type

Error / On hold

Both paper roll 1 and paper roll 2
match the paper type

To Condition 3

Condi-
tion 3

In the Printer menu, how has the Roll paper
auto switching setting changed?

It has changed to Do not identify
size

Select the paper
roll currently being
fed into the platen
*2

It has changed to Identify size To Condition 4

Condi-
tion 4

If borderless printing has been indicated for the
print job (if it has not, on to condition 5)

Only one of either paper roll 1 or
paper roll 2 is compatible with
borderless printing

Select the paper
roll compatible
with borderless
printing

Neither paper roll 1 nor paper roll
2 are compatible with borderless
printing

Error

Both paper roll 1 and paper roll 2
are compatible with borderless
printing

To Condition 5

Condi-
tion 5

Whether the width of the paper roll loaded on
the printer matches the paper width specified for
the print job (only when printing borderless or
enlarging/reducing)

Only one of either paper roll 1 or
paper roll 2 has the width speci-
fied for the print job

Select the paper
roll of the match-
ing width

Neither paper roll 1 nor paper roll
2 have a width matching the one
specified for the print job

Error / On hold

Both paper roll 1 and paper roll 2
have a width matching the one
specified for the print job To Condition 6

Paper roll width has not been
specified for the print job

Condi-
tion 6

Whether the width of the paper size specified
for the print job fits within the width of the paper
roll loaded on the printer.

The width of the paper size speci-
fied for the print job only fits within
the width of paper roll 1 or paper
roll 2

Select the paper
roll in which the
width of the paper
size fits comforta-
bly

The width of the paper size speci-
fied for the print job does not fit

Error
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within the width of either paper
roll 1 or paper roll 2

The width of the paper size speci-
fied for the print job fits within the
width of both paper roll 1 and pa-
per roll 2

To Condition 7

Condi-
tion 7

Is the width of paper roll 1 different from the
width of paper roll 2?

Roll width is different

Select the paper
roll whose width is
closer to the width
specified for the
print job

Roll width is the same

Select the paper
roll currently being
fed into the platen
*2

*1 If Auto (Use Printer Settings) is selected for Media Type in the Main sheet, the media type set in the
printer is recognized as being consistent with the media type specified in the print job.

*2 In the following cases, neither roll 1 nor roll 2 are being fed onto the platen. In such cases, paper roll 1 is
selected.

• When the printer has switched to sleep mode and has returned to the initial position
• When the printer has been turned on
• When cut paper has been fed into the printer and has exited it

If the Detect paper setting mismatch setting is set on Display warning or Do not detect

Condition Situation Judgment result

Condi-
tion 1

Whether the paper roll loaded on the printer is
long enough to print the paper size specified for
the print job.

Only one of either paper roll 1 or
paper roll 2 is long enough

Select the paper
roll of sufficient
length

Neither paper roll 1 nor paper roll
2 are long enough

Error

Both paper roll 1 and paper roll 2
are long enough

To Condition 2On the Printer's menu, Manage
remaining roll amount is set on
Disable (length of the paper roll
cannot be determined)

Condi-
tion 2

Whether the paper roll loaded on the printer
matches the paper type specified for the print
job. *1

Only one of either paper roll 1 or
paper roll 2 matches the paper
type

Select the paper
roll matching the
paper type
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Neither roll 1 nor roll 2 match the
paper type

To Condition 3
Both paper roll 1 and paper roll 2
match the paper type

Condi-
tion 3

In the Printer menu, how has the Roll paper
auto switching setting changed?

It has changed to Do not identify
size

Select the paper
roll currently being
fed into the platen
*2

It has changed to Identify size To Condition 4

Condi-
tion 4

If borderless printing has been indicated for the
print job (if it has not, on to condition 5)

Only one of either paper roll 1 or
paper roll 2 is compatible with
borderless printing

Select the paper
roll compatible
with borderless
printing

Neither paper roll 1 nor paper roll
2 are compatible with borderless
printing

Error

Both paper roll 1 and paper roll 2
are compatible with borderless
printing

To Condition 5

Condi-
tion 5

Whether the width of the paper roll loaded on
the printer matches the paper width specified
for the print job (only when printing borderless
or enlarging/reducing)

Only one of either paper roll 1 or
paper roll 2 has the width speci-
fied for the print job

Select the paper
roll of the match-
ing width

Neither paper roll 1 nor paper roll
2 have a width matching the one
specified for the print job

To Condition 6
Both paper roll 1 and paper roll 2
have a width matching the one
specified for the print job

Paper roll width has not been
specified for the print job

Condi-
tion 6

Whether the width of the paper size specified
for the print job fits within the width of the paper
roll loaded on the printer.

The width of the paper size speci-
fied for the print job only fits with-
in the width of paper roll 1 or pa-
per roll 2

Select the paper
roll in which the
width of the paper
size fits comforta-
bly

The width of the paper size speci-
fied for the print job does not fit
within the width of either paper
roll 1 or paper roll 2 To Condition 7

The width of the paper size speci-
fied for the print job fits within the
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width of both paper roll 1 and pa-
per roll 2

Condi-
tion 7

Is the width of paper roll 1 different from the
width of paper roll 2?

Roll width is different

Select the paper
roll whose width is
closer to the width
specified for the
print job

Roll width is the same

Select the paper
roll currently being
fed into the platen
*2

*1 If Auto (Use Printer Settings) is selected for Media Type in the Main sheet, the media type set in the
printer is recognized as being consistent with the media type specified in the print job.

*2 In the following cases, neither roll 1 nor roll 2 are being fed onto the platen. In such cases, paper roll 1 is
selected.

• When the printer has switched to sleep mode and has returned to the initial position
• When the printer has been turned on
• When cut paper has been fed into the printer and has exited it
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Reflect Roll Unit Settings in the Printer Driver

Reflect printer unit's Roll Unit settings in the printer driver.

If the printer unit settings are reflected in the printer driver, the paper that can be set in the printer driver
settings will change to a status suitable to the printer unit status.

The following explains the procedure to reflect Roll Unit settings in the printer driver.

1. Select as described below:

• If you are using Windows 10 or Windows Server 2016, select the Start menu -> Windows
System -> Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 8.1, Windows Server 2012 R2, or Windows Server 2012, from the
Desktop charms, select Settings -> Control Panel -> Hardware and Sound (Hardware) ->
Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control
Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Click the Device Settings tab's Device Information

Click Acquire Status in the displayed Device Information dialog box, and then click Yes.
Printer unit settings will be reflected in the printer driver.

Important
• In the event the lower roll unit is not set or the roll unit is being used as a wrapping device, the value

of Roll Unit will be set to No. In this case, Automatically switch paper sources (paper size
priority) will be grayed out and cannot be selected. Also, the Paper Source items that can be
selected in the Page Setup tab will change.
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Printing Photos and Business Documents

Printing By Setting Print Purpose

Edit in PosterArtist and Print
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Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select print setting mode

From the pull-down menu, select Easy Settings.
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4. Select print purpose

For Print Target, select the setting that matches the document.

• Default Settings

Select this setting to print a general document such as an business documents.
• Photo (Color)

Select this setting to print a color illustration or a photo.
• Poster

Select this setting to print a poster.
• CAD (Color Line Drawing)

Select when printing data such as drawings.
• CAD Monochrome

Select when printing data such as drawings in monochrome.
• Perspective, GIS

Select when printing data such as perspectives and GIS.

Note
• To check the settings of the items that are set by Print Target, click View Settings.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed to match the specified print purpose.
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Edit in PosterArtist and Print

Word processing and spreadsheet software documents and web browser screens, etc. can be edited a print
from PosterArtist Lite.

The following explains the procedure for editing original documents made in multiple application software in
PosterArtist Lite and printing in a poster layout.

1. Open Printer Driver Settings Screen

2. Select edit in PosterArtist

Check Page Layout in the Layout tab and select Edit Using PosterArtist from the pull-down menu.

Note
• Edit Using PosterArtist may not be available for use depending on the usage environment.

3. Start up PosterArtist Lite

Click OK.
When printing is executed, PosterArtist Lite starts up and PageCapture window opens.

4. Select page to get in PosterArtist Lite

5. Edit page in PosterArtist Lite

Image editing and sorting is implemented in PosterArtist Lite.
By repeating steps 1 through 4 without closing the PosterArtist Lite window, documents made in
multiple application software can be arranged on one page.
After editing is complete, please print from PosterArtist Lite menu.

607



Note
• For instructions on how to edit and rearrange images, refer to the PosterArtist Lite manual.
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Printing CAD Drawings

Printing By Setting Print Purpose

Printing from AutoCAD
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Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select print setting mode

From the pull-down menu, select Easy Settings.
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4. Select print purpose

For Print Target, select the setting that matches the document.

• Default Settings

Select this setting to print a general document such as an business documents.
• Photo (Color)

Select this setting to print a color illustration or a photo.
• Poster

Select this setting to print a poster.
• CAD (Color Line Drawing)

Select when printing data such as drawings.
• CAD Monochrome

Select when printing data such as drawings in monochrome.
• Perspective, GIS

Select when printing data such as perspectives and GIS.

Note
• To check the settings of the items that are set by Print Target, click View Settings.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed to match the specified print purpose.
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Printing from AutoCAD

Printer Driver Optimization Module for AutoCAD is software for printing optimally from AutoCAD with the
printer driver.

By optimally controlling the processing resolution of raster data and the memory to be used in image
processing of AutoCAD, printing superior in reliability and productivity is realized.

If you install Printer Driver Optimization Module for AutoCAD on a computer on which supported AutoCAD is
installed, it will be installed automatically.

Note
• Printer Driver Optimization Module for AutoCAD is applied automatically when you print from AutoCAD,

and optimal printing is performed.

Confirming the Installation of Printer Driver Optimization Module for
AutoCAD
You can confirm whether Printer Driver Optimization Module for AutoCAD is installed by the following
method.

1. From the File menu of AutoCAD, select Print

The Plot dialog box is displayed.

2. Confirm if the device name in use is displayed

Printer Driver Optimization Module for AutoCAD is installed if "XXX - Optimized driver - by Canon Inc."
(where "XXX" is your model name) is displayed in Plotter of Printer/plotter.
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Changing the Print Quality and Correcting Image Data

Adjusting Color Balance

Setting the Print Quality Level (Custom)

Printing a Color Document in Monochrome

Specifying Color Correction

Adjusting Brightness

Adjusting Contrast

Printing Using Detailed Setting Mode
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Adjusting Color Balance

You can adjust the color tints when printing.
Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.
The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment Adjust color balance

The procedure for adjusting color balance is as follows:

1. Open the printer driver setup window

2. Select the advanced settings

Select Advanced Settings from the pull-down menu on the Main tab.

3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.
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4. Adjust color balance

The Color Adjustment tab has individual sliders for Cyan, Magenta, and Yellow. Each color becomes
stronger when the corresponding slider is moved to the right, and becomes weaker when the
corresponding slider is moved to the left. For example, when cyan becomes weaker, the color red
becomes stronger.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Brightness
Adjusting Contrast
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Setting the Print Quality Level (Custom)

Custom on the Print Quality tab allows you to set detailed print quality levels.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

3. Select the print quality

For Print Quality, select Custom.
The Custom dialog box opens.

Important
• If Auto (Use Printer Settings) is selected for Media Type, Custom cannot be selected.

4. Setting the print quality level

Drag the slider bar to select the print quality level and click OK.
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Important
• Certain print quality levels cannot be selected depending on the settings of Media Type.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

Related Topics
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Contrast
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode

For Color Mode, select Monochrome or Monochrome Bitmap.

Note
• The selectable Color Mode depends on the media type selected for Media Type on the Main tab.
• You can select Monochrome Bitmap for Color Mode only if Line Drawing/Text is selected in

Print Priority.

4. Complete the setup
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Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.

Important
• When Monochrome or Monochrome Bitmap are selected, the printer driver processes image data as

sRGB data. In this case, actual colors printed may differ from those in the original image data.
When using the grayscale printing function to print Adobe RGB data, convert the data to sRGB data
using an application software.

Note
• With Monochrome or Monochrome Bitmap inks other than black ink may be used as well.
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, when data is printed, the printer driver automatically adjusts the colors.

When you want to print by using the color space of the image data effectively, select ICM or, ICC Profile
Matching. When you want to use an application software to specify a printing ICC profile, select None.

The procedure for specifying color correction is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
Print with the optimal color using the driver's original color profile. Normally, you should choose this
mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching
method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or
the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing
from an ICM function-compatible application.

None
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing a color chart using a profile
creation tool.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

Important
• When ICM is disabled in the application software, ICM is unavailable for Color Correction and the

printer may not be able to print the image data properly.
• If Auto (Use Printer Settings) is selected for Media Type, the Matching sheet is not displayed, and

color correction occurs according to printer settings.

Related Topics
Optimal Photo Printing of Image Data
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Adjusting Colors with the Printer Driver
Printing with ICC Profiles
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Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.
To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

Color Management
Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

Note
• Normally, image files are saved in JPEG format. Some digital cameras allow you to save images in a

format called RAW. RAW data refers to an image saving format that requires a computer to develop
the image. You can embed an input ICC profile tag into a RAW file by using special application
software.

Selecting a Printing Method Suited to the Image Data
The recommended printing method depends on the color space of the image data or the application
software to be used.

There are two typical printing methods.
Check the color space of the image data and the application software to be used, and then select the
printing method suited to your purpose.

Adjusting Colors with the Printer Driver
This section describes the procedure for printing data by using the color correction function of the
printer driver.
Select this function when you want to print impressions that are close to those displayed on the
monitor, for example, if you corrected the colors while checking the print image on the monitor.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of the image data effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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Adjusting Colors with the Printer Driver

To use driver matching when printing, turn on the printer driver's color correction function. Driver matching
accurately applies the characteristics of data displayed on the monitor and allows you to obtain print results
of impressions that are close to those displayed on the monitor.

Important
• When printing using driver matching, Canon recommends that you set the monitor and the environment

light as follows:
• Monitor

Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

• Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 lx ± 125 lx

Note
• When printing from an application software that can identify ICC profiles and allows you to specify them,

use a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.

5. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Perceptual (Photo)
Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting
this setting allows you to adjust colors easily using an application software.

Saturation (Poster/CAD)
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable
for line drawing.

6. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

7. Complete the setup

Click OK on the Main tab.
When you execute print, the printer driver adjusts the colors when printing the data.
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Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Contrast
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Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space of the data
effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data
When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.
Even if you print using a printing ICC profile that you created yourself or one for special Canon paper, be
sure to select color management items from your application software.
For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select None for Color Correction.
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5. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Specify an ICC Profile with the Printer Driver, and then Print
When you print from application software that cannot identity input ICC profiles or does not allow you to
specify one, the data color space is printed as sRGB.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select ICC Profile Matching for Color Correction.

5. Select For Input Profile

Select the input profile you want to use.
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Important
• When the application software specifies an input profile, the input profile setting of the printer

driver becomes invalid.

6. Select the printer profile

Select Printer Profile as follows:

• To set the printer profile automatically:

Select Auto Settings.
• To set the printer profile manually:

Select a printer profile that matches the media type to be used.

7. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

Important
• When you select Perceptual to print images, Canon recommends that you set the monitor

and the environment light as follows:
• Monitor

Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

• Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 lx ± 125 lx

Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable
for line drawing.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.

Absolute Colorimetric
When Relative Colorimetric is selected, white spots are reproduced as white spots of the paper
(background color). However, when Absolute Colorimetric is selected, how the white spots are
reproduced depends on the image data.

Important
• Depending on the media type, you may obtain the same print results even when you change

the Rendering Intent setting.

631



8. Set the other items

If necessary, click Color Adjustment tab, and adjust Cyan, Magenta, Yellow, Brightness, and
Contrast settings, and then click OK.

9. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Contrast
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Adjusting Brightness

You can brighten or darken the colors of the overall image data during printing.
The following sample shows the case when light colors are darkened when the image data is printed.

No adjustment Darken light colors

The procedure for adjusting brightness is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings dialog box appears.

4. Adjust brightness

On the Color Adjustment tab, moving the Brightness slider to the right brightens (dilutes) the colors,
and moving the slider to the left darkens (intensifies) the colors.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the adjusted brightness.

Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Contrast
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Adjusting Contrast

You can adjust the image contrast during printing.
To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode

For Color Mode, select Color, and then click Color Settings.
The Color Settings... dialog box appears.

4. Adjust the contrast

On the Color Adjustment tab, moving the Contrast slider to the right increases the contrast, and
moving the slider to the left decreases the contrast.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
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Printing Using Detailed Setting Mode

You can print by using your own settings instead of the pre-registered Print Target settings.

The procedure for using the detailed setting mode and printing is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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4. Set print conditions

Set the following items as necessary.

Print Priority
Select elements to prioritize for print results.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Color Mode
Selects color adjustment method.

Thicken Fine Lines
Prints thin lines thicker for easy viewing.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.

638



6. Select the paper source

For Paper Source, select the setting that matches your purpose.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed with the print conditions you set.

Related Topics
Adjusting Color Balance
Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Brightness
Adjusting Contrast
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Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Select the paper size of the document

Using Page Size on the Page Setup tab, select the page size that is set with your application software.

3. Select the paper source

For Paper Source, select the setting that matches your purpose.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

4. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

5. Select scaled printing

Check the Enlarged/Reduced Printing check box.

6. Set one of scaling methods described below

From the items listed below, select the setting that matches your purpose and select the corresponding
check box.
The current settings are displayed in the settings preview on the left side of the window.
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• Fit Paper Size

Scales the document to match the paper size.
• Fit Roll Paper Width

Scales the document to match the roll paper width.
• Scaling

Allows you to specify the scaling by entering a number directly or by selecting the paper size you
want from the Printer Paper Size list.
The document is reduced when a size smaller than the Page Size setting is selected from the
Printer Paper Size list, and enlarged when a size larger is selected.

7. Complete the setup

Click OK.
When you execute print, the document will be printed with the specified scale.

Important
• When the application software which you used to create the original has the scaled printing function,

configure the settings on your application software. You do not need to configure the same setting in
the printer driver.

• If you are performing enlarged/reduced printing when Automatically switch paper sources (paper
size priority) is enabled, Fit Roll Paper Width is selected for Enlarged/Reduced Printing on the
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Page Setup tab, and Roll Paper (Auto) is selected for Paper Source, Roll 1 (upper level roll paper) is
always used for printing.

Note
• Selecting Enlarged/Reduced Printing changes the printable area of the document.
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Printing to Oversized Paper Sizes

When printing a created document so that it fills the entire paper width, select a paper size from the
Oversize list (sizes resulting from adding margins necessary for printer operation to the document sizes) so
that all areas of the document are printed at their actual size.

A printout that has the same area as the document can be obtained by trimming the outer margins after
printing.

The procedure for printing with oversize is as follows:

1. Open the printer driver setup window

2. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

3. Click Size Options...

The Paper Size Options dialog box opens.

4. Select oversize

Select the Oversize check box, and click OK.
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The current settings are displayed in the settings preview on the left side of the Page Setup tab.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

6. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed using oversize.

Important
• When printing to oversized paper sizes, use paper that has the following necessary margins added to

the document size.
• Cut sheet: 6 mm or more added to width and 23 mm or more added to height of document size
• Roll paper: 6 mm or more added to width and 6 mm or more added to height of document size

Note
• An oversized paper size cannot be used for the largest paper size that can be loaded in the printer.
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• To set an oversized paper size for a non-standard paper size, register the paper size in the Paper
Size Options dialog box. An oversized paper size cannot be set for paper sizes that were set in the
Custom Size Settings dialog box.

645



Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

There are two ways of setting a user-defined paper, setting the paper from Size Options... on the Page
Setup tab and setting the paper from Custom Size of Page Size.

If you will be using a user-defined paper repeatedly, setting it from Size Options... is convenient because it
becomes registered to Page Size and can be selected any time after that.

If you want to use a user-defined paper temporarily, setting it from Custom Size is suitable.

The procedure for specifying a custom size is as follows:

Setting from Paper Size Options

1. Open the printer driver setup window

2. Click Size Options... on the Page Setup tab

The Paper Size Options dialog box opens.

3. Set user-defined paper

Set Custom Paper Size Name, Units, and Size, and then click Add.
For Size, specify an size or select the paper size to be used from Paper Size List.
To narrow down the paper sizes displayed in Paper Size List, select the Display Series check box.
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Note
• By selecting the Borderless Printing Size check box for Size, you can select a size from the

paper sizes that support Borderless Printing. By selecting the Fix the Ratio of the Width to
Height check box, you can change the size while keeping the Width and Height ratio.

4. Set user-defined paper

Click OK, then it returns to Page Setup tab.
The paper size registered by using Custom Paper Size Name is registered to Custom Paper Size of
Page Size and can be selected at any time.

Setting from Custom Size

1. Open the printer driver setup window

2. Select the paper size

For Page Size on the Page Setup tab, select Custom Size from the Custom Paper Size list.
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The Custom Size Settings dialog box opens.

3. Set the custom paper size

Enter the Width and Height values of the paper to be used, specify the Units, and then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.

Important
• If the application software that created the document has a function for specifying height and width

values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

• Printing may be disabled depending on the size of the specified user-defined media.
For information about printable sizes for user-defined media, see "Paper Sizes."

• Any paper size that was set by using Custom Size can no longer be used after the application software
is closed.
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Note
• If the paper settings in the printer driver differ from the paper information registered on the printer, an

error message may appear on the printer's operation panel. You can still print but you may not be able
to obtain correct print results.

• The maximum configurable size with Custom Size is 3.2m.
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Prints without Edges Based on the Scenarios

Printing without Margins to Match Paper Size

Printing without Margins to Match Roll Paper Width

Printing Full-Size without Margins
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Printing without Margins to Match Paper Size

Procedure for printing borderless (without white margins around the edges) by enlarging/reducing
documents to match paper size.

1. In the printer driver, open the settings screen

2. Select a feeding method

In Paper Source, choose the best option for your purposes between Roll Paper (Auto), Roll 1 and Roll
2.

Important
• The feeding methods you can choose from vary depending on paper and lower tray (paper roll 2)

settings, or on roll unit option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Width, select the same paper width as that of the
paper roll loaded in the printer and click OK.

5. Determine by how much you want the image to exceed the size of the paper

Adjust Amount of Extension as needed.
When clicking on Borderless Setting, the Borderless Setting dialog box will appear.
Dragging the slide bar to the right will increase overflow, while dragging it to the left will reduce it.
The second position from the right is recommended for most cases.

Important
• If the Amount of Extension slide bar is set to the far right position, the back of the paper may

come out stained.

6. Select a method for printing borderless

In the Borderless Printing Method tab, place a checkmark next to the Fit Paper Size option.
If the size of the document is different from the size of the paper you want to print on, select the paper
size you want to print on from Printer Paper Size.

7. Complete the setting process

Click OK.
If you print now, the document will be printed without margins to fit the paper size.

Important
• If you choose a paper size not compatible with borderless printing, it will be replaced with a size

compatible with whole-surface borderless printing.
• If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered

options in the Layout tab will be displayed in gray out and you will not be able to configure them.
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• Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.
When this happens, crop the image with the application software to match paper size.

• When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Auto Cut... list. When you do so, the document will be printed
without the left and right margins. After the printed material has exited the printer and has been cut, cut
the upper and lower edges with a pair of scissors.

• When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.
You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

• If you print borderless while Automatically switch paper sources (paper size priority) is on, in the
Page Setup tab, under Borderless Printing Method, you will only be able to select Scale to fit Roll
Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray) will be normally used for
printing. If the size, or the type, of the paper set in roll 1 is not compatible with borderless printing, you
will not be able to print borderless.

• If the following paper is selected for Roll Width, margins may be formed on the left and right of the
document even when borderless printing is set.

• 600mm Roll (600.0mm)
• 20 in Roll (508.0mm)
• 500mm Roll (500.0mm)
• A2/A3 Roll (420.0mm)
• 16 in Roll (406.4mm)
• A3+ Roll (329.0mm)
• 12 in Roll (304.8mm)
• 300mm Roll (300.0mm)
• A3/A4 Roll (297.0mm)
• B4 Roll (257.0mm)
• 8 in Roll (203.2mm)

Also, stains may appear on the back of the paper.

Note
• When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Printing without Margins to Match Roll Paper Width

Procedure for printing borderless (without white margins around the edges) by enlarging/reducing
documents to match roll paper width.

1. In the printer driver, open the settings screen

2. Select a feeding method

In Paper Source, choose the best option for your purposes between Roll Paper (Auto), Roll 1 and Roll
2.

Important
• The feeding methods you can choose from vary depending on paper and lower tray (paper roll 2)

settings, or on roll unit option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Width, select the same paper width as that of the
paper roll loaded in the printer and click OK.

5. Determine by how much you want the image to exceed the size of the paper

Adjust Amount of Extension as needed.
When clicking on Borderless Setting, the Borderless Setting dialog box will appear.
Dragging the slide bar to the right will increase overflow, while dragging it to the left will reduce it.
The second position from the right is recommended for most cases.

Important
• If the Amount of Extension slide bar is set to the far right position, the back of the paper may

come out stained.

6. Select a method for printing borderless

Place a checkmark next to Scale to fit Roll Paper Width in Borderless Printing Method.

7. Complete the setting process

Click OK.
Job will print to the entire roll width without a white border.

Important
• If you choose a paper size not compatible with borderless printing, it will be replaced with a size

compatible with whole-surface borderless printing.
• If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered

options in the Layout tab will be displayed in gray out and you will not be able to configure them.
• Depending on paper size, the length/width ratio of the paper may be different from that of the image,

making it impossible for the whole image to fit on the paper.
When this happens, crop the image with the application software to match paper size.
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• When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Auto Cut... list. When you do so, the document will be printed
without the left and right margins. After the printed material has exited the printer and has been cut, cut
the upper and lower edges with a pair of scissors.

• When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.
You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

• If you print borderless while Automatically switch paper sources (paper size priority) is on, in the
Page Setup tab, under Borderless Printing Method, you will only be able to select Scale to fit Roll
Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray) will be normally used for
printing. If the size, or the type, of the paper set in roll 1 is not compatible with borderless printing, you
will not be able to print borderless.

• If the following paper is selected for Roll Width, margins may be formed on the left and right of the
document even when borderless printing is set.

• 600mm Roll (600.0mm)
• 20 in Roll (508.0mm)
• 500mm Roll (500.0mm)
• A2/A3 Roll (420.0mm)
• 16 in Roll (406.4mm)
• A3+ Roll (329.0mm)
• 12 in Roll (304.8mm)
• 300mm Roll (300.0mm)
• A3/A4 Roll (297.0mm)
• B4 Roll (257.0mm)
• 8 in Roll (203.2mm)

Also, stains may appear on the back of the paper.

Note
• When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Printing Full-Size without Margins

Procedure for printing borderless (without white margins around the edges) images in the same size as the
original document without enlarging/reducing them. Recommended if you prize quality.

1. In the printer driver, open the settings screen

2. Select a feeding method

In Paper Source, choose the best option for your purposes between Roll Paper (Auto), Roll 1 and Roll
2.

Important
• The feeding methods you can choose from vary depending on paper and lower tray (paper roll 2)

settings, or on roll unit option settings.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Width, select the same paper width as that of the
paper roll loaded in the printer and click OK.

5. Determine by how much you want the image to exceed the size of the paper

Adjust Amount of Extension as needed.
When clicking on Borderless Setting, the Borderless Setting dialog box will appear.
Dragging the slide bar to the right will increase overflow, while dragging it to the left will reduce it.
The second position from the right is recommended for most cases.

Important
• If the Amount of Extension slide bar is set to the far right position, the back of the paper may

come out stained.

6. Select a method for printing borderless

Place a checkmark next to Print Image with Actual Size in Borderless Printing Method.

7. Complete the setting process

Click OK.
Job will print to original size without white border.

Important
• If Amount of Extension is set to the second from the right, create the source document with a

size 2mm larger on each of the top, bottom, left and right sides than the size of the paper you wish
to print.

Important
• If you choose a paper size not compatible with borderless printing, it will be replaced with a size

compatible with whole-surface borderless printing.
• If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered

options in the Layout tab will be displayed in gray out and you will not be able to configure them.
• Depending on paper size, the length/width ratio of the paper may be different from that of the image,

making it impossible for the whole image to fit on the paper.
When this happens, crop the image with the application software to match paper size.

• When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Auto Cut... list. When you do so, the document will be printed
without the left and right margins. After the printed material has exited the printer and has been cut, cut
the upper and lower edges with a pair of scissors.

• When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.
You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

• If you print borderless while Automatically switch paper sources (paper size priority) is on, in the
Page Setup tab, under Borderless Printing Method, you will only be able to select Scale to fit Roll
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Paper Width. In such cases, paper roll 1 (the paper roll in the upper tray) will be normally used for
printing. If the size, or the type, of the paper set in roll 1 is not compatible with borderless printing, you
will not be able to print borderless.

• If the following paper is selected for Roll Width, margins may be formed on the left and right of the
document even when borderless printing is set.

• 600mm Roll (600.0mm)
• 20 in Roll (508.0mm)
• 500mm Roll (500.0mm)
• A2/A3 Roll (420.0mm)
• 16 in Roll (406.4mm)
• A3+ Roll (329.0mm)
• 12 in Roll (304.8mm)
• 300mm Roll (300.0mm)
• A3/A4 Roll (297.0mm)
• B4 Roll (257.0mm)
• 8 in Roll (203.2mm)

Also, stains may appear on the back of the paper.

Note
• When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Printing Hanging and Horizontal Banners (Large-Format Printing)

A drapery or banner up to 18.0m can be made by enlarging or reducing original documents made on
application software.
However, there are cases in which an 18.0 meter banner cannot be printed because the application
software used has limits on the document size that can be set.

The procedure for printing hanging and horizontal banners is as follows:

Print for width of roll

1. Create document by using application software

2. Open the printer driver setup window

3. Select the paper size

Select the same original paper size created in the application soft in the Page Setup tab's Page Size.
In the event an optional size is set in the application software, select Custom Size from Custom
Paper Size in Page Size and designate size in the dialog box that appears.

4. Select roll width

Select the equivalent to the paper width of the roll set in the printer under Roll Width.

5. Set Enlarged/Reduced Printing

Check Enlarged/Reduced Printing and select Fit Roll Paper Width.
When the Information dialog box appears, select the equivalent to the paper width of the roll set in
the printer.
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6. Complete the setup

Click OK.
When printing is executed, a drapery or banner can be printed according to the roll.

Enlarge and print

1. Register user-defined paper

Register both the actual desired print size (user-defined paper 1) and original document size created
in application (user-defined document size 2) in the Size Options... under the Page Setup tab.

Note
• Please set user-defined paper 2 to the same aspect ratio as user-defined paper 1. If the aspect

ratio differs, the enlarged image may not turn out to be the expected size.
After creating user-defined paper 1, if user-defined paper 2 is created after checking Fix the
Ratio of the Width to Height, settings can be set to the same aspect ratio.
Also set user-defined paper 2 to a size that doesn't exceed the maximum size supported by the
application.
For example, when printing on paper 600mm wide and 3,000mm long, use the following
settings.
(when setting length to 1/6 the user-defined paper)

• User-defined paper 1: Width600mm, Height3,000mm
• User-defined paper 2: Width100mm, Height500mm

2. Create original document in application software

Use registered user-defined paper 2 to create original document in application software.

3. Open printer driver settings screen

4. Select Paper Size

Select registered user-defined paper 1 from Custom Paper Size in Page Setup tab's Page Size.

5. Complete the setup

Click OK.
When you print, the hanging or horizontal banner is printed by using the user-defined size.

Note
• Maximum printable length is 18.0m. In the event the enlarged length exceeds 18.0m, the part of the

image exceeding the length will not be printed.
• If printing cannot be performed correctly, you may be able to improve printing by using Special

Settings on the Layout tab to change FineZoom Settings to Yes.
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Printing by Dividing/Joining Documents

Lining Up and Printing Multiple Documents

Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page

Dividing and Printing Posters
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Lining Up and Printing Multiple Documents

You can line up multiple documents that were created separately and print them together on one page.

The procedure for lining up and printing multiple documents is as follows:

1. Open the printer driver setup window

2. Select Free Layout

On the Layout tab, select the Page Layout check box, and then from the pull-down menu, select Free
Layout.

3. Complete the setup

Click OK.
When you print, Canon imagePROGRAF Free Layout starts. Canon imagePROGRAF Free Layout
allows you to edit and rearrange images.

Note
• To lay out multiple application software documents onto one page, repeat steps 1 to 3 without

closing the Canon imagePROGRAF Free Layout window.
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Printing by Connecting Multiple Pages

You can eliminate the blank spaces between pages in a document that extends over multiple pages and
print the document as one continuous document.

The procedure for printing by connecting multiple pages is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

3. Set roll paper options

Click Roll Paper Options to display the Roll Paper Options dialog box.
Select the Banner Printing check box, and then click OK.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Complete the setup
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Click OK on the Page Setup tab.
When you print, the document is printed with the print conditions you set.
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Printing Multiple Pages All on One Page

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for printing multiple pages all on one page is as follows:

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.

3. Set number of pages to be printed per sheet

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select 2 Pages/
Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet.
The current settings are displayed in the settings preview on the left side of the window.
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4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Set..., specify the following settings in the Page Layout Printing dialog box, and click
OK.

Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, check this check box.

5. Complete the setup

Click OK on the Layout tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.

Important
• When there is a checkmark attached to Banner Printing on the Page Setup tab, Page Layout is

grayed out and cannot be set.
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Dividing and Printing Posters

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for dividing and printing posters is as follows:

Setting for Dividing and Printing Posters

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.

3. Set number of divisions

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select Poster (1
x 2) or Poster (2 x 2).
The current settings are displayed in the settings preview on the left side of the window.
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4. Complete the setup

Click OK on the Layout tab.
When you execute print, the document will be divided into several pages during printing.

Important
• When there is a checkmark attached to Banner Printing on the Page Setup tab, Page Layout

is grayed out and cannot be set.

Printing Only Specific Pages
If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Display Pages to Print dialog box

For Page Layout, click Set... to display the Pages to Print dialog box.

2. Set print range

Clear the check boxes of the pages you do not want to print.
In the setting view, the pages that you cleared are deleted and only the pages to be printed are
displayed.
Check the pages to be printed, and then click OK.
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Note
• In the setting view on the left side of the Pages to Print dialog box, you can also clear the

display by clicking the pages you do not want to print.
To redisplay a cleared page, click that page again.

• To switch the pages to display/hide, click Invert in the Pages to Print dialog box.

3. Complete the setup

Click OK on the Layout tab.
When you print, only the specified pages are printed.

Important
• If you partition and print as a poster, the source document will be printed in enlarged form, so the

print results may become rough.
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Printing Document in Center of Paper

When you want to position the source document in the middle of the cut paper and print, or print with even
margins on the right and left in relation to the width of the roll paper, use the Print Centered function.
The print results when setting with Print Centered are as follows. Normally, if Print Centered is set when
printed as in (A), it will be printed as in (B) for cut paper and (C) for roll paper.

Note
• When setting the magnification using Scaling from Enlarged/Reduced Printing on the Page Setup

tab and printing, the start point for enlarge/reduce will always be fixed based on the top left corner of
that page. For that reason, for reduced printing, the bottom and right margins of the paper will increase.
At this time, if you place a checkmark next to Print Centered on the Layout tab, the top, bottom, left
and right margins can all be printed evenly.

The procedure for printing in the center of the paper is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.
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3. Select the paper size

Select the size of the paper you want to print from Page Size on the Page Setup tab.

4. Set magnification as necessary

Where necessary, attach a checkmark next to Enlarged/Reduced Printing, and set according to the
objective.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.
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Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

6. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

7. Print document in the center of paper

Select the Print Centered check box on the Layout tab.

8. Complete the setup

Click OK.
When you print, the document is printed in the center of the paper.
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Printing by Saving Roll Paper

Saving Roll Paper by Rotating Document 90 Degrees

Saving Roll Paper by Eliminating Upper and Lower Margins on Document
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Saving Roll Paper by Rotating Document 90 Degrees

When printing a portrait document on roll paper, you can save paper by rotating the document 90 degrees
and printing the document so that it is oriented horizontally relative to the paper.

The procedure for saving paper by rotating the document 90 degrees is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

4. Select the paper source

For Paper Source, select the setting that matches your purpose from Roll Paper (Auto), Roll 1, and
Roll 2.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

5. Selecting Paper Saving

Select the Rotate Page 90 degrees check box.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

7. Complete the setup

Click OK.
When you print, you can rotate a portrait document 90 degrees to save paper.

Important
• When there is a checkmark attached to Banner Printing on the Page Setup tab, Rotate Page 90

degrees is grayed out and cannot be set.
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• When selecting paper in portrait format as the Page Size from the Page Setup tab, if the length in
the vertical direction is longer than the width selected in Roll Width, even if a checkmark is placed
next to Rotate Page 90 degrees, the page will not be rotated.
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Saving Roll Paper by Eliminating Upper and Lower Margins on
Document

When printing on roll paper, you can save paper by reducing the upper and lower margins when printing.

The procedure for saving paper by reducing the upper and lower margins is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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4. Select the paper source

For Paper Source, select the setting that matches your purpose from Roll Paper (Auto), Roll 1, and
Roll 2.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

5. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

6. Selecting Paper Saving

On the Layout tab, select the No Spaces at Top or Bottom check box.
The current settings are displayed in the settings preview on the left side of the window.
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7. Complete the setup

Click OK.
When you print, the upper and lower margins are reduced so that you can save paper.
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Switching the Paper Source to Match the Purpose

This printer has three paper sources: Roll 1, Roll 2, and Cut Sheet.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select the paper source

From the Paper Source list on the Page Setup tab, select the paper source that matches your purpose.

Roll Paper (Auto)
Feeds paper by automatically switching between Roll 1 and Roll 2 according to the print job.

Roll 1
Feeds paper from Roll 1.

Roll 2
Feeds paper from Roll 2.

Cut Sheet
Feeds paper using the cut paper.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.
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4. Complete the setup

Click OK.
When you execute print, the printer uses the specified paper source to print the data.

Note
• If the paper settings in the printer driver differ from the paper information registered on the printer,

an error message may appear on the printer's operation panel. You can still print but you may not
be able to obtain correct print results.
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Displaying the Print Results before Printing

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

3. Complete the setup

Click OK.
When you execute print, the Canon imagePROGRAF Preview opens and displays the print results.

Related Topic
Canon imagePROGRAF Preview
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Other Convenient Settings

Stamp Printing

Setting a Page Size and Orientation

Registering a Frequently Used Printing Profile

Cutting Roll Paper after Printing
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Stamp Printing

This feature may be unavailable when certain printer drivers or operating environments are used.

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name.
"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

The procedure for printing with a stamp is as follows:

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and then select the stamp to use from the list.
The current settings are displayed in the settings preview on the left side of the Layout tab.

3. Complete the setup

Click OK.
When you execute print, the data is printed with the specified stamp.
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Registering a Stamp

This feature may be unavailable when certain printer drivers or operating environments are used.

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

Registering a New Stamp

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....

The Define Stamp dialog box opens.

686



3. Set stamp details

Click Add to add a new stamp (Untitled) to the list.
In Name, enter the name of the stamp to register, and in Text, enter the character string you want as
the stamp.
Change the Font, Size, and Color settings as necessary.

4. Set the other items

Set the following items as necessary.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp print method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print it
on the front.

Position
Specifies the stamp position on the page.
Enter numbers in X and Y to set the coordinates, or drag the horizontal and vertical slide bars to
the left/right or up/down to change the settings.

Angle
Set the stamp placement angle.
Enter a number in Set Angle to set the angle, or drag the slide bar to the left/right to change the
setting.
Set the angle by entering a number in range of -180 to 180.

Stamp first page only
To print the stamp on the first page only, select this check box.
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5. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

Changing and Registering Some of Stamp Settings

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp for which the settings are to be changed

From Watermark List, select the title of the stamp you want to change the settings for.

3. Configure each setting while viewing the preview

4. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

Note
• The stamp registered as the default setting cannot be changed.

Deleting an Unnecessary Stamp

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp to be deleted

Select the title that you wish to delete from the Watermark List and click Delete.
Click Yes when the confirmation message appears.

3. Complete the setup

Click OK to return to the Layout tab.

Note
• The stamp registered as the default setting cannot be deleted.
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Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.

3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate Page 90 degrees check box when you
want to perform printing with the original being rotated 90 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.
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Registering a Frequently Used Printing Profile

You can register the frequently used printing settings to Favorites. Unnecessary printing profiles can be
deleted at any time.

The procedure for registering a printing profile is as follows:

Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

On the Main tab, the Page Setup tab, and the Layout tab, specify the print settings you want to
register.

3. Display Add dialog box

On the Favorites tab, click Add....

The Add dialog box opens.

4. Register favorite setting
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In Name, enter the name of the favorite. Set the Icon and Comment fields as necessary, and then
click OK.
The name and the icon appear in the Favorites list.
To check the settings of the registered favorite, click Settings Details.

Note
• To save the settings of the favorite to a file, click Export... on the Favorites tab.

Printing Using Favorite Settings

1. Open the printer driver setup window

2. Apply favorite

From the Favorites list on the Favorites tab, select the favorite you want to use.
Click Apply Favorite to replace the registered print settings.

3. Complete the setup

Click OK.
When you print, the document is printed with the settings of the registered favorite.

Deleting Unnecessary Printing Profile

1. Select favorite to be deleted

Select the favorite you want to delete from the Favorites list on the Favorites tab.

2. Delete setting

Click Delete. When the confirmation message appears, click OK.
The selected favorite is deleted from the Favorites list.

Note
• Printing profiles that are registered in the initial settings cannot be deleted.
• The settings of the favorite being applied to the current print settings cannot be deleted. To delete

that favorite, select another favorite from the Favorites list, click Apply Favorite to apply the settings
of that other favorite, and then delete the target favorite.
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Cutting Roll Paper after Printing

The procedure for cutting roll paper automatically and printing cut guidelines is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select the setting that matches your purpose from Roll Paper
(Auto), Roll 1, and Roll 2.

Important
• The paper feed method will differ according to the paper or lower level (roll paper 2) settings, or

roll unit option settings.

3. Display Roll Paper Options dialog box

Click Roll Paper Options to display the Roll Paper Options dialog box.

4. Set auto cut

From Automatic Cutting, select the item that matches your purpose.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

• Yes

The roll paper is cut automatically after printing.
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• No

The roll paper is not cut after printing.
• Print Cut Guideline

Cut guidelines are printed for cutting the roll paper manually after printing.

Note
• The default setting for automatic cutting is Yes.

After completing the setting, click OK to return to the Page Setup tab.

5. Complete the setup

Click OK on the Page Setup tab.
When you print, the roll paper is cut automatically after printing or cut guidelines are printed.
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Printing from Computer (macOS)

Printing with Easy Setup Basics

Changing the Type of Paper

Setting the Number of Copies and Printing Order

Using Roll Unit to Use 2-Level Rolls

About 2-Level Roll Switching

Setting the Paper Rolls in the Printer According to the Intended Use

Printing by Automatically Switching Upper-level and Lower-level Roll Papers

How to Switch Paper Rolls

Reflect Roll Unit Settings in the Printer Driver

Changing the Print Quality and Correcting Image Data

Adjusting Color Balance

Setting the Print Quality Level (Custom)

Printing a Color Document in Monochrome

Specifying Color Correction

Adjusting Brightness

Adjusting Contrast

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Print Area

Prints without Edges Based on the Scenarios

Printing without Margins to Match Roll Paper Width

Printing Full-Size without Margins

Printing Hanging and Horizontal Banners (Large-Format Printing)

Printing by Dividing/Joining Documents

Lining Up and Printing Multiple Documents
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Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page

Printing Document in Center of Paper

Printing by Saving Roll Paper

Saving Roll Paper by Rotating Document 90 Degrees

Saving Roll Paper by Eliminating Upper and Lower Margins on Document

Switching the Paper Source to Match the Purpose

Cutting Roll Paper after Printing
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HP-GL/2 Printing

This printer supports printing using the original Canon SG Raster printer control language and printing using
HP-GL/2 and HP RTL.

The printer automatically switches to the corresponding processing depending on whether SG Raster and
HP-GL/2 or HP RTL job is received.

Note
• SG Raster is an abbreviation of Swift Graphic Raster.
• HP-GL/2 is an abbreviation of Hewlett-Packard Graphics Language/2, and HP RTL is an abbreviation of

Hewlett-Packard Raster Transfer Language.
• Emulation is good for obtaining results similar to printing on other printers.

When printing from applications that support HP-GL/2 or HP RTL output, specify HP-GL/2 or HP RTL in the
plotter output printer language settings.

HP-GL/2 and HP RTL emulation related settings are configured from the printer operation panel. For further
details, refer to "HP-GL/2 Settings."

Note
• For instructions on configuring these settings, refer to the software documentation.

It may not be possible to print jobs with excessively large amounts of data correctly.
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Printing from Printer

Printing from USB Flash Drive
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Printing from USB Flash Drive

Printing Data Saved on USB Flash Drive

Setting Items for Printing Using Operation Panel
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Printing Data Saved on USB Flash Drive

You can print photo data (JPEG file) or document data (PDF file) saved on the USB flash drive easily.

Note
• Restrictions on printable PDF/JPEG files

• PDF file:

Files which conforms to V 1.7

-Does not support overprint or some of transparent processing.

-Font embedding is recommended. If a font is not embedded, it is replaced with one of the built-in
fonts below.

Times-Roman, Helvetica, Courier, Symbol, Times-Bold, Helvetica-Bold, Courier-Bold,
ZapfDingbats, Times-Italic, Helvetica-Oblique, Courier-Oblique, Times-BoldItalic, Helvetica-
BoldOblique, Courier-BoldOblique

• JPEG file:

Files which conforms to JFIF 1.02

Supports the files with the following conditions.

-Processing method: Basic DCT

-Color mode: RGB/GrayScale

-Number of colors: 24bit/8bit

-Number of pixels: 19200 or less vertically and horizontally

Does not support some samplings

1. Make sure printer is turned on.

2. Load paper.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading Sheets in the Printer

3. Insert USB flash drive into USB flash drive port.

4. Flick HOME screen and tap  Print from USB flash drive.

Menu Operations

Note
• When the message informing you that the operation restriction is enabled, ask the administrator of

the printer you are using.
• If no printable data is saved on the USB flash drive, There are no files that can be printed. is

displayed on the touch screen.
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5. Tap folder or data to print on displayed screen.

Tapping a folder displays the data list. Tap the data to print.

Note
• If no printable data is saved on the folder you tapped, There are no files that can be printed. is

displayed on the touch screen.

The screen below appears.

A. Number of copies

Tap to display the screen below and specify the number of copies.

B. Preview

Tap to preview an image of the printout on the preview screen.

C. Settings

Tap to display the Settings screen.

You can change the print settings.
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For more on the setting items:

Setting Items for Printing Using Operation Panel

6. Tap Start print.

The printer starts printing.

Note
• Tapping Yes on the displayed screen returns to step 5. Tap a folder or data to print.

• Tapping No returns to HOME screen.
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Setting Items for Printing Using Operation Panel

You can specify the print settings to print data saved on the USB flash drive.

Flick vertically or tap   to display setting items and tap the setting item to display the settings.
Tap to specify the setting.

1. Color

Select color or black and white printing.

2. Print qlty (Print quality)

Select print quality according to the photo.

3. Target

Select print usage.

4. Paper src (Paper source)

Select where to feed paper.

5. Margin

Select margin for printed image.

6. Border

Select bordered/borderless print.

7. Rotate

The image is printed rotated by 90 degrees if you select 90 degrees.

8. Enl./Red.

Select a method to enlarge/reduce image size.

9. Tap to specify the print settings.
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Printing from Smartphone/Tablet

For more on printing from a device via wireless LAN, refer to the device's or application's instruction manual.

Connecting Smartphone/Tablet to Printer Directly via Wireless LAN (Direct
Connection)
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Connecting Smartphone/Tablet to Printer Directly via Wireless LAN
(Direct Connection)

You can connect devices (e.g. smartphone, or tablet) to the printer by two methods below.

• Wireless connection (connecting devices via a wireless router)
• Direct wireless connection (connecting devices using wireless direct)

This section describes wireless direct, which allows you to print by connecting the devices to the printer
directly.

Follow the procedure below to use wireless direct.

1. Enable wireless direct.

2. Connect devices to printer.

This section also describes changing wireless direct to wireless LAN.

Changing Printer Setting to Use Wireless LAN

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.
• If a device has already been connected to the printer via wireless LAN and you want to add a device to

connect, connect it to the printer directly. You can connect up to 5 devices to the printer at the same
time.

• Check the usage restrictions and switch the printer to the wireless direct.

Restrictions

Preparing for Connection
Change settings below to prepare for wireless direct.

• Printer's LAN settings

Changing Printer Setting

• Settings of a device to connect

Connecting Smartphone/Tablet to Printer

Changing Printer Setting

1. Make sure printer is turned on.

2. Flick HOME screen and tap  LAN settings.

Menu Operations

3. Tap Change LAN.

4. Tap Activate direct connect..
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5. Tap Yes.

The identifier (SSID) for wireless direct appears.

The device detects the printer by the identifier (SSID).

Note
• If you tap Details and tap Yes, the following items appear.

• Security setting
• Password
• Printer's name which appears on a Wi-Fi Direct compatible device

The password is required when connecting a device to the printer. Depending on the device
you are using, no password is required.

When you connect a Wi-Fi Direct compatible device to the printer, select the device name
displayed on the touch screen from your device.

• The identifier (SSID) and the security setting are specified automatically. To update them, see
below.

Changing Direct Connection Setting

6. Tap OK.

The wireless direct is enabled and a device can be connected to the printer wirelessly.

Connecting Smartphone/Tablet to Printer

1. Turn on wireless communication on your device.

Enable "Wi-Fi" on your device's "Setting" menu.

For more on turning on wireless communication, see your device's instruction manual.

2. Select "DIRECT-XXXX-TX-2000" ("X" represents alphanumeric characters) from list
displayed on device.

Note
• If "DIRECT-XXXX-TX-2000" does not appear on the list, wireless direct is not enabled.

See Changing Printer Setting to enable wireless direct.

3. Enter password.

Your device is connected to the printer.

Note
• Check the password for the wireless direct.

Check by one of the following methods.

• Display on the touch screen.
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LAN settings

• Print the network settings.
Printing Network Settings

• Depending on the device you are using, entering the password is required to connect a
device to the printer via wireless LAN. Enter the password specified for the printer.

• If your Wi-Fi Direct compatible device is set to prioritize using Wi-Fi Direct and it is connecting
to the printer, the printer displays a confirmation screen asking if you allow the device to
connect to the printer.

Make sure the name on the touch screen is the same as that of your wireless communication
device and tap Yes.

Changing Printer Setting to Use Wireless LAN
Follow the procedure below to change the printer setting to use wireless LAN.

1. Flick HOME screen and tap  LAN settings.

Menu Operations

2. Tap Change LAN.

3. Tap Activate wireless LAN.

If you do not use the printer over wireless LAN, select Activate wired LAN or Disable LAN.

Changing Direct Connection Setting
Change the settings for the wireless direct following the procedure below.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  LAN settings.

Menu Operations

3. Tap LAN settings.

4. Tap Other settings.

5. Tap Wireless Direct settings.

6. Change settings as necessary.
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• To update the identifier (SSID) and the password for wireless direct

Tap A to display the confirmation screen. To update the identifier (SSID) and the password, tap
Yes.

To check the security setting and the updated password, tap Details and tap Yes on the screen
displayed next.

• To change the printer's name displayed on the Wi-Fi Direct compatible device

Tap B to display the printer's name (device name) displayed on a Wi-Fi Direct compatible
device.

Follow the procedure below to change the name.

1. Tap touch screen.

2. Enter device name (up to 32 characters).

3. Tap OK to finish entering device name.

4. Tap OK to finish specifying device name.

• To change the confirmation screen setting when a Wi-Fi Direct compatible device is connecting
to the printer

Tap C to display the confirmation screen. If you want the printer to display the screen to inform
you a Wi-Fi direct compatible device is connecting to the printer, tap Yes.

Important
• To prevent an unauthorized access, we recommend you should not change the setting from

the default.

When you finished performing the settings, the printer returns to the Wireless Direct settings screen.

7. Touch HOME button.

The HOME screen appears.

Note
• If you change the wireless direct setting of the printer, also change the wireless router setting of the

device.
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Canon IJ Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

Installing the Printer Driver
Load the Setup CD-ROM that comes with the printer, and then install the driver from Start Setup Again.

Specifying the Printer Driver
To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name).

Displaying the Manual from the Printer Driver
To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

Related Topic
How to Open the Printer Driver Setup Window
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Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Special Settings... on the Layout tab

The Special Settings dialog box opens.

3. Change the individual settings

If necessary, change the setting of each item, and then click OK.

The Layout tab is displayed again.
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Canon imagePROGRAF Preview

This feature may be unavailable when certain printer drivers or operating environments are used.

The Canon imagePROGRAF Preview is an application software that displays what the print result will look
like before a document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

Related Topic
Displaying the Print Results before Printing
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How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software
Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

Note
• Depending on application software you use, command names or menu names may vary and

there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon
Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Select as described below:

• If you are using Windows 10 or Windows Server 2016, select the Start menu -> Windows
System -> Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.

• If you are using Windows 8.1, from the Desktop charms, select Settings -> Control Panel ->
Hardware and Sound -> Devices and Printers.

• If you are using Windows 7, select the Start menu -> Devices and Printers.

2. Right-click your model name icon, and then select Printing preferences from the
displayed menu

The printer driver setup window appears.

Important
• Opening the printer driver setup window through Printer properties displays such tabs

regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not appear
when opening through Printing preferences or application software. For tabs regarding
Windows functions, refer to the user's manual for the Windows.
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Updating Media Information in Printer Driver

This function gets the latest media information from the printer and updates the media information in the
printer driver.
When the media information is updated, the media displayed for Media Type on the Main tab is updated to
the latest information.

The procedure for updating media information is described below.

1. Select as described below:

• If you are using Windows 10 or Windows Server 2016, select the Start menu -> Windows
System -> Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 8.1, Windows Server 2012 R2, or Windows Server 2012, from the
Desktop charms, select Settings -> Control Panel -> Hardware and Sound (Hardware) ->
Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control
Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's Properties window appears.

3. Update media information

Click Update Media Information the Device Settings tab.
When a confirmation message appears, click Execute.
If the paper information on the driver cannot be updated, click Initial Check Items Items and check
the displayed information.
The printer driver media information will update.

Important
• It may take some time to update the media information.

4. Finish updating media information

When a confirmation message appears, click OK.
The media information will be updated.

Important
• Restart the printer driver after updating media information.
• Do not change media information on the printer while you are updating media information on

the driver.
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Important
• Ensure that a user with administrative privileges carries out the media information update.

Users other than administrators can check if a media information update is required, but cannot carry
out the update itself.

• When you have added, deleted, or edited media using administrative tools (the Media Configuration
Tool) but have not updated the media information, issues may arise such as the inability to print.
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Setting Accounting Information

By setting accounting information, you add IDs to print jobs, and use the printer and cost management tool
to tabulate print history information for any ID.

The procedure for setting accounting information is described below.

1. Select as described below:

• If you are using Windows 10 or Windows Server 2016, select the Start menu -> Windows
System -> Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 8.1, Windows Server 2012 R2, or Windows Server 2012, from the
Desktop charms, select Settings -> Control Panel -> Hardware and Sound (Hardware) ->
Devices and Printers.
The Devices and Printers window is displayed.

• If you are using Windows 7 or Windows Server 2008 R2, select the Start menu -> Control
Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

2. Display setup window

Right-click the "Your model name" icon, and select Printer properties.
The printer's properties window appears.

3. Click Accounting on the Device Settings tab

The Accounting dialog box opens.
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4. If necessary, complete the following settings:

Account ID/Account ID2
Enter the account ID to be set. Enter the ID by using up to 20 alphanumeric characters (0 to 9, a
to z, and A to Z).

Prohibits Account ID changes
Prohibits changes to account IDs that have already been set.
Check this check box to prevent other users from changing IDs.

5. Apply the settings

Click OK.
The Device Settings tab is displayed again.
The settings are enabled hereafter.

Note
• Prohibits Account ID changes can be set only by users with Administrator rights.

If this is set, users without Administrator rights may not be able to set Account ID and Account ID2.
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Deleting the Undesired Print Job

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Open the printer driver setup window

2. Display the Canon IJ Status Monitor

Click Status Monitor... on the Main tab.
The Canon IJ Status Monitor appears.

3. Display the print jobs

Click Display Send Queue.
The print queue window opens.

4. Delete the print jobs

Select the print jobs you want to delete, and select Cancel from the Document menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

Important
• Users who have not been granted access permission for printer management cannot delete the print

job of another user.
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Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

Launching the Canon IJ Status Monitor
The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon IJ Status Monitor appears as a button on the task bar.

Click the button of the status monitor displayed on the task bar. The Canon IJ Status Monitor appears.

Note
• To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup

window and click Status Monitor... on the Main tab.
• The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.

When Errors Occur
If an error occurs (e.g., if the printer runs out of paper or if the ink is low), the Canon IJ Status Monitor
displays an error information dialog box.

In such cases, take the appropriate action as described.
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Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Main tab, click Status Monitor....
The Canon IJ Status Monitor opens.

3. Display Estimated ink levels

Ink status is displayed as an illustration.

Note
• The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

Restrictions on the Printer Driver
• Before installing, log on to Windows as user with administrator rights.
• Always check the following before installing the software.

1. Quit the application software while it is running.
2. If you are printing a document, abort printing or wait for it to finish.
3. Close all the printer driver's dialog boxes.

• If you can set the number of copies with the application software, set them either with the printer
driver or the application software.

• If you can configure enlarging/reducing settings with the application software, set the normal size
(100%) in the printer driver, and then configure the magnification factor with the application software.

• Depending on the application software used, it may be possible to print collated copies; however,
please do not use this feature when configuring layout printing with the Page Layout option in the
Layout tab.
This may cause incorrect layout.

• When printing enlarged/reduced documents, printed results may come out different due to a
discrepancy between the image data resolution and the enlarging/reducing ratio.

• When printing reduced color images, 1-dot wide lines or points may disappear from the color images.
• Depending on the application software, lines drawn at almost horizontal angles may not print

correctly.
If that should happen, re-draw the line horizontally and print one more time.

• Immediately after installing (or updating) the printer driver, you might not be able to visualize new
features in some of the application software.
In all application software provided with printing features, choose Print from the File menu and, after
selecting the printer you are using, click the Properties.
After the Properties dialog box has opened, immediately close it by clicking OK.

• If characters strings specified as stamps have a large number of characters, or if the characters have
a large point size, you may not be able to print stamp strings.

• If characters strings specified as stamps contain external characters after F040, you will not be able to
print the stamp strings.

• If you update the model name of your printer through the General tab in the printer's Properties, the
Favorites settings registered in the printer driver will be disabled.
In such cases, save the Favorites settings as a file before changing the name of the printer and reload
the saved file after you have updated the printer's name.

• Printing at high resolution requires a large amount of memory on your computer.
When your computer is low on memory or you are using a large number of application software, the
application software may not work correctly.
In such cases, re-start Windows and, before resuming printing, close all the applications you are not
using. Also, when the printer is not printing correctly, switch the Print Quality setting in the Main tab
to a lower resolution.
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• When using a local connection, if you do not see a check mark next to the Enable bidirectional
support option in the Ports tab in the printer's Properties, it will not be possible to acquire printer and
device information correctly.

• If you are you are using your printer with a USB connection, refrain from using standby mode. You
can set standby mode through the Power Options on the Control Panel.

• In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.
In such cases, in the Advanced tab in the printer's Properties, choose Spool print documents so
program finishes printing faster and place a check mark next to Start printing after last page is
spooled.

• Fine lines and gradients may not print correctly.
In such cases, choose Print from the File menu of application software and, after opening from there
the property dialog box of the printer driver, follow the procedure below and then run printing.

1. In the Main tab, uncheck Preview before printing.
2. In the Layout tab, uncheck Page Layout.
3. If you are using a 32-bit driver, in the Layout tab, click on Special Settings to open the Special

Settings dialog box and turn off Fast Graphic Process.

• In case of a large amount of print data, the printer may time-out during printing and you may no longer
be able to print.
In such cases, you may be able to print by increasing the time set in Job timeout in the printer's
control panel.

• Depending on the application used, if you print using features like enlarging/reducing, layout printing,
page borders and so on, some of the data in the resulting printed document, for example graphics,
may differ from the source document.

• If you print very large images from your computer when it's running low on memory, you may not be
able to print correctly; for example, it may take a very long time to print or parts of the image may end
up missing.
In such cases, try printing after following the procedure indicated below.

◦ If you are using a 32-bit driver, open the Layout tab and click Special Settings.
Turn off Fast Graphic Process.

◦ Increase your computer memory.
◦ Increase the virtual memory of your operating system.

• Do not change the Print Processor... settings in the Advanced tab in the printer Properties.
If you change them, you will not be able to use the following features correctly.

◦ The Free Layout and the Edit Using PosterArtist features of Page Layout in the Layout tab
◦ The Canon imagePROGRAF Preview feature

• In the cases described below, you will not be able to use the Free Layout and the Edit Using
PosterArtist features of Page Layout in the Layout tab as well as the Canon imagePROGRAF
Preview feature.

◦ When right-clicking on the printer icon and choosing from See what's printing: Printer -> Pause
Printing, or when right-clicking on the printer icon and choosing Pause Printing

◦ When right-clicking on the printer icon and choosing from See what's printing: Printer -> Use
Printer Offline, or when right-clicking on the printer icon and choosing Use Printer Offline

◦ When printing during hours other than those set in Available from and To in the Advanced tab in
the printer's Properties

723



◦ When printing with the Enable advanced printing features turned off in the Advanced tab in the
printer's Properties

◦ When printing with Print directly to the printer enabled in the Advanced tab in printer's
Properties

◦ When printing after the printing port in the Ports tab in the printer's Properties has changed to
FILE:

◦ When printing after choosing Output to file in the Print dialog box in the application software

• If you perform a point-and-print installation, you will not be able to use the Free Layout and the Edit
Using PosterArtist features of Page Layout in the Layout tab as well as the Canon
imagePROGRAF Preview feature.

• If you print after setting Free Layout and Edit Using PosterArtist, refrain from printing from other
drivers.

• If you combine specific Print Quality with large paper sizes, you may not be able to correctly print
stamps and borders.

• In the Canon imagePROGRAF Preview, characters and fine lines visualized in the View screen may
look differ from printed results. In such cases, try choosing the Layout tab, opening the Special
Settings dialog and turning on Preview Switching.

• If you are using a model supporting Automatically switch paper sources (paper size priority) in
the Device Settings tab, or if you have chosen Automatically switch paper sources (paper size
priority), you may not be able to get the desired printing results.
In such cases, uncheck Automatically switch paper sources (paper size priority).

Points to Note About Applications with Restrictions
• If, in Microsoft Excel, you tick Collate and then you print more than one copy, or if you do Entire

workbook after configuring different settings in each tab, you may not be able to perform layout
printing nor to get the intended printing results.

• If you try to print data on a very large-size paper through applications like Adobe Illustrator, you may
not be able to print.
In such cases, try printing after following the procedure indicated below.

◦ Open the Main tab and uncheck Preview before printing.
◦ If you are using a 32-bit driver, open the Layout tab and click Special Settings.

Turn off Fast Graphic Process.
◦ Increase the virtual memory of your operating system.
◦ If you are using Adobe Illustrator, turn off/on Bitmap printing in the Print dialog box.

• In the cases described below, you will not be able to use the Free Layout and the Edit Using
PosterArtist features of Page Layout in the Layout tab.

◦ When printing from application software which do not allow EMF spooling, like Adobe Photoshop
LE, MS Photo Editor, Ace Draw and others.

• When printing from Adobe Photoshop, tone jumps may occur in the gradation of black and white
photographs.

• When printing data created with Microsoft Word using Enlarged/Reduced Printing or Borderless
Printing, you may not be able to print correctly.
In such cases, try printing after following the procedure indicated below.

724



◦ Open the printer folder from the start menu, right click on the printer icon and select Printing
preferences. Launch the application after setting, in the Page Setup tab, Page Size, Enlarged/
Reduced Printing and Borderless Printing.

◦ Open Microsoft Word's Page setup dialog box and close it by clicking OK.
◦ After configuring the printer driver, close momentarily the Print dialog box without printing. Then,

open the printer driver's set up screen once again, close it by clicking OK, and run printing.
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Printer Driver Description

Main Tab Description

Page Setup Tab Description

Layout Tab Description

Favorites Tab Description

Maintenance Tab Description

Device Settings Tab Description

Canon IJ Status Monitor Description
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Main Tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Get Information...
Opens the Paper Information on Printer dialog box.
You can check the settings on the printer and apply the checked settings to the printer driver.

Specify...
Open the Paper Detailed Settings dialog box, and specify detailed print settings that match the media
type loaded in the printer.

Pull-down menu
Switches the Easy Settings and Advanced Settings.
Easy Settings

This mode allows you to print by using pre-registered print settings.
Print Target

Print settings that are generally used frequently are pre-registered as print purposes. By using
a print purpose to print, you can print by using settings that match the document.
Default Settings

Select this setting to print a general document such as an business documents.
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Photo (Color)
Select this when printing a color illustration or a photograph.

Poster
Select this when printing a poster.

CAD (Color Line Drawing)
Select when printing data such as drawings.

CAD Monochrome
Select when printing data such as drawings in monochrome.

Perspective, GIS
Select when printing data such as perspectives and GIS.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Important
• Depending on the Media Type settings, the same print results may be produced even if

the Print Quality is changed.

High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality. Resolution settings depend on media type.

Fast
Gives priority to printing speed over print quality.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

View Settings
Opens the View Settings dialog box.

Advanced Settings
This mode allows you to print by specifying detailed settings that match your purpose.
Print Priority

Select elements to prioritize for print results.
Image

Prioritize image results when printing.

Line Drawing/Text
Prioritize detailed lines and text when printing.

Auto (Use Printer Settings)
Use printer settings when printing.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
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Important
• Depending on the Media Type settings, the same print results may be produced even if

the Print Quality is changed.

High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality. Resolution settings depend on media type.

Fast
Gives priority to printing speed over print quality.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

Color Mode
Select the color to print.
Color

Prints with the number of colors in the document.

Monochrome
Print in grayscale.

Monochrome Bitmap
Print all non-white parts in black.

Color Settings
Opens the Color Settings dialog box.
You can adjust individual color settings such as Cyan, Magenta, Yellow, Brightness,
and Contrast on the Color Adjustment tab, and select the Color Correction method on
the Matching tab.

Thicken Fine Lines
Prints thin lines thicker for easier viewing.

Preview before printing
You can start up the Canon imagePROGRAF Preview, and check what the printing results will be
before executing the print.
Check this check box to display a preview before printing.

Status Monitor...
Displays the status monitor.

About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory
settings).
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Paper Detailed Settings dialog box
Drying Time

Wait time can be set to allow ink to dry. Between Pages settings are only enabled for roll paper.
Between Pages

The wait time until outputting paper can be set after printing one page. Time is taken before
cutting roll paper to allow the ink to dry, so even when Automatic Cutting in the Roll Paper
Options of the Page Setup tab is set to Yes, page may be dropped into the basket with dried
ink.

Setting Items Content

Printer Default Settings in printer unit control panel are applied.

None Page will be output immediately after printing

30sec. / 1min. / 3min. / 5min. /
10min. / 30min. / 60min.

Page will be output after set amount of time has passed after
printing.

Between Scans
The wait time until printing next scan can be set after printing one scan in page. Set in the event
smudging occurs in the page, unevenness occurs in borderless printing, etc., and you would like
to avoid this smudging and unevenness.

Setting Items Content

Printer Default Settings in printer unit control panel are applied.

None Next scan will be print immediately after first scan is print.

0.5sec. / 1sec. / 3sec. /
5sec. / 7sec. / 9sec.

Next scan will be print after the set amount of time has passed after
printing one scan.
* If smudges and/or unevenness occur, please increase time.

Roll Paper Safety Margin
In order for heavily curling paper to absorb well in platen, length of margin established on edge of
paper can be selected.
Leading Edge Margin

Roll Leading Edge Margin length can be set.

Setting Items Content

Printer Default Settings in printer unit control panel are applied.

3mm
Will be print in standard size.
* Please select when there are no particular problems with printing.

20mm
Please select when rubbing of the print heads occurs, such as when heavily curling
paper is being used.
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Cut Speed
Select auto-cut speed. This can be adjusted when paper cannot be cut precisely with auto-cut.

Setting Items Content

Printer Default Settings in printer unit control panel are applied.

Fast Select when cut is not smooth with Standard settings.

Standard Select when there are no particular problems with auto-cut.

Slow
If this is selected for paper with adhesive, the cutter will not stick to the adhesive easily and
it will slow deterioration of the cutter's capabilities.

Unidirectional Printing
Controls color unevenness and unaligned ruled lines.
Please check when printing in one direction.

Mirror
Select whether to print reflected image or not. When box is checked and turned on, text and images
will be printed as if reflected in a mirror.

Custom dialog box
Set the quality level, and select the desired print quality.

Quality
You can use the slider bar to adjust the print quality level.

Important
• Certain print quality levels cannot be selected depending on the settings of Media Type.

Note
• The High, Standard, or Fast print quality modes are linked with the slider bar. Therefore when

the slider bar is moved, the corresponding quality and value are displayed on the left. This is the
same as when the corresponding radio button is selected for Print Quality on the Main tab.

View Settings dialog box
Print Target

Select the print purpose. The settings of the selected print purpose are displayed in Details.

Name
Displays the name of the selected print purpose.

Details
Displays the settings of the print purpose that was selected for Print Target.
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Color Settings dialog box
Color Adjustment Tab
This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Tone, Brightness, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total color
balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

Brightness
Adjusts the brightness of your print. You cannot change the levels of pure white and black. However,
the brightness of the colors between white and black can be changed. Colors become darker as you
drag the slider toward the right and brighter as you drag the slider toward the left. You can also
directly enter brightness values that are linked to the slider bar. Enter a value in the range from -50 to
50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Matching Tab
This is displayed when Color is selected for Color Mode.

Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICM, ICC Profile Matching, or None to match the purpose of
the print operation.
Driver Matching

Print with the optimal color using the driver's original color profile. Normally, you should choose
this mode.
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ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and
matching method in detail, and select when printing. You can use the digital camera or scanner
ICC profile, or the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when
printing from an ICM function-compatible application.

None
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing using a profile creation tool or
color chart.

Important
• When setting not to use ICM in the application software, ICM and ICC Profile Matching of

Color Correction do not function. There are also times when it does not print correctly.

Input Profile
Specifies the input profile to be used when you select ICC Profile Matching for Color Correction.

Printer Profile
Specifies the printer profile to be used when ICC Profile Matching is selected for Color Correction.
Normally Auto is selected but you can also select a printer profile manually.

Rendering Intent
Specifies the matching method to be used when you select Driver Matching, ICM, or ICC Profile
Matching for Color Correction.
Perceptual (Photo) / Perceptual

Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

Saturation (Poster/CAD) / Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors
suitable for line drawing.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.
The white spots are reproduced as white spots (background color) on the paper.

Absolute Colorimetric
This method uses the white spot definitions in the input and output ICC profiles to convert the
image data.
Although the color and color balance of the white spots change, you may not be able to get the
desired output results because of the profile combination.

Important
• Depending on the media type, you may obtain the same print results even when you change the

Rendering Intent setting.
• If Driver Matching is selected for Color Correction, then Relative Colorimetric and Absolute

Colorimetric are not displayed.
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Page Setup Tab Description

The Page Setup tab allows you to set borderless printing for a document and specify the scaling.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
When you select Custom Size from Custom Paper Size, the Custom Size Settings dialog box
appears, and you can specify any vertical and horizontal dimensions for the paper.

Borderless Printing
Chooses whether you are printing on a full page without any page margins or printing with page
margins.
In borderless printing, originals are enlarged to extend slightly off the paper. Thus, printing can be
performed without any margins (border).

Important
• When Cut Sheet is selected for Paper Source, Borderless Printing is grayed out and cannot be

set.

Borderless Setting
Select Borderless Printing to enable it for clicking.
Open the Borderless Setting dialog box, so that you can adjust Amount of Extension.

Borderless Printing Method
This appears when you select Borderless Printing.
Set the borderless printing method.

734



Fit Paper Size
Enlarge or reduce the document to match the size of the paper to be printed, and then print the
document.

Scale to fit Roll Paper Width
You can enlarge or reduce the document to match the roll paper width and then print the
document.

Print Image with Actual Size
Prints the document at its actual size.
When you select this check box, the Information dialog box appears, and you can select Roll
Width.

Fit Paper Size
When you select the Fit Paper Size check box, you can specify the setting.
Select the size of the paper to be printed.
The list displays the paper sizes that support borderless printing.

Enlarged/Reduced Printing
You can enlarge or reduce a document and then print it.
When you select Enlarged/Reduced Printing, you can then set Fit Paper Size, Scale to fit Roll
Paper Width, or Print Image with Actual Size.
Fit Paper Size

Enlarge/reduce the document to match the size of the paper to be printed, and then print the
document.

Scale to fit Roll Paper Width
You can enlarge/reduce the document to match the roll paper width and then print the document.

Print Image with Actual Size
Prints the document at its actual size.
When you select this check box, the Information dialog box appears, and you can select Roll
Width.

Fit Paper Size
When you select the Fit Paper Size check box, you can specify the setting.
Select the size of the paper to be printed.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait

Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.

Rotate Page 90 degrees
Rotate the long edge of the document 90 degrees, match it to the width of the roll paper, and then print
the document.
When you print a portrait document onto roll paper, you can save paper by rotating the document 90
degrees and print the document horizontally relative to the paper.
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Paper Source
Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.
Roll Paper (Auto)

Depending on the paper settings on the printer driver and the paper information registered to the
printer, the printer automatically determines which roll paper to use and then feeds that paper.

Roll 1
Paper is fed from Roll 1.

Roll 2
Paper is fed from Roll 2.

Cut Sheet
Feeds paper using the cut paper.

Important
• Depending on the media type and size, the Paper Source settings that can be selected may differ.

Roll Width
Select the roll paper width.
Select the width that matches the width of the roll paper loaded in the printer.

Roll Paper Options
Displays the Roll Paper Options dialog box.
You can specify auto cut, banner printing, and other settings for printing on roll paper.

Output Method...
Displays the Output Method dialog box.
You can select Output Method and specify save settings for saving documents to a box.

Size Options...
Displays the Paper Size Options dialog box.
The Paper Size Options dialog box allows you to create and register any user-defined paper.

Custom Size Settings dialog box
This dialog box allows you to specify the size (width and height) of the custom paper.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Units
Select the unit for entering a user-defined paper size.

Borderless Setting dialog box
Use Amount of Extension to adjust how much of the document extends off the paper during borderless
printing.

Amount of Extension
Adjusts how much of the document extends off the paper during borderless printing.
Moving the slider to the right increases the amount of extension and allows you to perform borderless
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printing with no problems.
Moving the slider to the left reduces the amount of extension and expands the range of the document
to print.

Roll Paper Options dialog box
You can specify settings for printing on roll paper.

Automatic Cutting
You can print cut guidelines for cutting the roll paper automatically or manually after printing.
Yes

Cut the roll paper automatically after printing.

No
Do not cut the roll paper automatically after printing.

Print Cut Guideline
Prints cut guidelines for cutting the roll paper manual after printing.

Banner Printing
Select this check box to print documents extending over several pages as one continuous document
without any spaces between the pages.

Output Method dialog box
You can select Output Method and specify save settings for saving documents to a box.

Output Method
Print

After print ends, the print job is saved to the printer's hard disk drive.

Save in Job Box
The print job is saved to the printer's hard disk drive. If you selected Save in Job Box, select an
individual box number as the save destination from the Job Box list.

Print after reception is complete
If you selected Print, you can specify this setting.
By selecting this check box, you can prevent the print quality from dropping if the print job
reception is cut off or if printing is interrupted.

Name of data to be saved
Use file name

The file name is used as-is.

Enter name
You can set a new name. Enter the save name in Name.

Job Box
The box list appears. If you selected Save in Job Box, select an individual box number as the save
destination from the list.
Acquire Job Box Name

When you click this, Job Box displays the box name that was obtained from the printer.
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Paper Size Options dialog box
You can create and register any user-defined paper. You can then select the defined paper size from
Custom Paper Size of Page Size.

Paper Size List
The names and sizes of the paper sizes that the printer driver can use are displayed.

Delete
From Paper Size List, you can delete a user-defined paper that a user created.

Note
• Paper deletion is not possible in the following case:

• When a standard paper size of the printer driver is selected
• When an oversized paper size is selected
• When a paper size with a red circle is selected

Custom Paper Size Name
You can specify the name of a user-defined paper.

Units
You can specify the units for the height and width dimensions of the user-defined paper.

Page Size
You can specify the Width and Height settings of the paper.
Borderless Printing Size

When you select this check box, you can select a size from the paper sizes that support
Borderless Printing.

Fix the Ratio of the Width to Height
When you select this check box, you can change the size while keeping the Width and Height
ratio.

Width
Specify the paper width.

Height
Specify the paper height.

Register with the OS
Register the set user-defined paper in the OS.
By registering in the OS, any user sharing the use of the printer or PC can use the set user -defined
paper.

Add
You can register a user-defined paper that was set and overwrite the existing user-defined paper.

Display Series
You can narrow down the paper sizes to be displayed in Paper Size List.

Oversize
Add appropriate margins so that the document contents will not get cut off, and then print the
document.

738



Layout Tab Description

The Layout tab allows you to specify how to arrange the document onto the paper. You can also set the
number of copies to be printed and the print sequence. If the application software that you used to create
the document features the same functions, specify the settings from the application software.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Page Layout
Selects the size of the document you want to print and the type of printing.

Poster (1 x 2) / Poster (2 x 2)
Poster printing is performed.
The value in parentheses represents the ratio of the vertical x horizontal lengths. As the number of
divisions increases, the number of sheets used for printing increases. If you are pasting pages together
to create a poster, increasing the number of divisions allows you to create a larger poster.
Set...

Opens the Pages to Print dialog box.
Specify this setting when you want to print only specific pages

Free Layout
You can freely position and print any document created with an application software.
Set...

Opens the Free Layout Settings dialog box.
You can freely specify detailed settings for free layout.

2 Pages/Sheet / 4 Pages/Sheet / 6 Pages/Sheet / 8 Pages/Sheet / 9 Pages/Sheet / 16 Pages/Sheet
Multiple pages are assigned to one sheet of paper and printed. The number presents the number of
pages assigned to one sheet.
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Set...
Opens the Page Layout Printing dialog box.
You can freely specify detailed settings for assigned printing.

Stamp
The Stamp function prints a specific character string over the document pages. You can select the
characters to be printed from a list or use the Define Stamp dialog box to set any characters.
Define Stamp...

Opens the Define Stamp dialog box.
You can specify detailed stamp settings or register any stamp.

Print Centered
Prints document in center of paper.

Rotate 180 degrees
Rotates document 180 degrees and prints it.

No Spaces at Top or Bottom
When printing on roll paper, you can save paper by reducing the upper and lower margins when
printing.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

Important
• If the application used to create your document has a similar function, specify the number of copies

with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not
need to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Page Options
Opens the Page Options dialog box.
You specify settings for printing information such as date, user name, and page number.

Special Settings
Opens the Special Settings dialog box.
If you are unable to obtained the desired print results, you can change the print processing method.

Pages to Print dialog box
When printing a poster that has been divided into several pages, you can specify which pages to print and
just print those pages.
Simply clear the check boxes of the pages you do not want to print.
In the setting view, the pages that were unchecked are hidden, and only the pages to be printed are
displayed.

Invert
Switches the pages to be displayed or hidden.
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Note
• The Pages to Print dialog box appears only when Poster (1 x 2) or Poster (2 x 2) is selected

for Page Layout.

Free Layout Settings dialog box
You can specify detailed settings for free layout.

Paper Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait

Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.

Roll Paper Length
Sets the roll paper length.
Auto

Automatically determines the roll paper length and prints.

Manual Settings
Determines and specifies the roll paper length.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Note
• The Free Layout Settings dialog box appears only when Free Layout is selected for Page

Layout.

Page Layout Printing dialog box
This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.
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Note
• The Page Layout Printing dialog box appears only when 2 Pages/Sheet, 4 Pages/Sheet, 6

Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet is selected for Page Layout.

Define Stamp dialog box
The Define Stamp dialog box allows you to specify settings for printing a stamp over the document
pages. In addition to the pre-registered ones, you can register and use your original stamp.

Watermark List
This is a list of the pre-registered stamps.

Add
Creates an original stamp.
Click this item to set Name, Text, Font, Style, Size, and Color.
Name

Enter the stamp name to be registered.

Text
Enter the characters to be used in the stamp.

Font
Selects the font for the stamp text string.

Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Color
Select the color of the stamp text string.

Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Watermark List, and click this button.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp printing method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print the
stamp on the front.

Position
Specifies the stamp position on the page.
You can specify values in X and Y to set the coordinates, or you can drag the horizontal and vertical
slide bars to the left/right or up/down to change the coordinates.
Move to Center

Moves the stamp to the center of the paper.
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Angle
Set the stamp positioning angle.
You can specify a value in Set Angle to set the angle, or you can drag the slide bar left/right to
change the angle.
When specifying an angle value, set a value in the range of -180 to 180.

Stamp first page only
Select this check box if you want to print a stamp only on the first page.

Page Options dialog box
Specify the print settings, such as date, user name, and page number.

Print Date
Select the position for printing the date.

Print Time Also
Prints the time along with the date.

Print User Name
Select the position for printing the user name.

Print Page Number
Select the position for printing the page number.

Format Settings
The Format Settings dialog box opens, and you can set the format.

Format Settings dialog box
Set the format to be used when printing the contents set in the Page Options dialog box.

Font
Select the font type.

Style
Select the font style.

Size
Select the font size.

Color
Select the font color.

Special Settings dialog box
The Special Settings dialog box allows you to change the print processing method if you do not get the
print results you want.

Settings Summaries
This is a list of items that you can set in the Special Settings dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.
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Spooling at Printer Driver
Set whether print jobs are to be spooled in the print driver or whether PageComposer processing
is to be performed.
Setting Do Not Print or No (EMF Spooling) may improve the print results.
FineZoom Settings

Use this function to print on long paper.
Yes

The print problem may be corrected.
Select this in usual cases.

No
Image distortions may be corrected (for example, small lines may be eliminated).

Preview Switching
If you check the Preview before printing check box on the Main tab and then print,
PageComposer starts.

Application Color Matching Priority
You can assign higher priority to color management by the application software.

Fast Graphic Process
If image colors or line thicknesses are printed incorrectly, you may be able to get the print results
you want by setting this function to off.

Disable the color profile setting of the application software
If the color profile information set in the application software is output to the printer driver, the
printing results may include an unexpected tint. You can resolve the problem in this case by
setting Disable the color profile setting of the application software to On.

Important
• Even if this is set to On, it will only disable some of the color profile information, and it is still

possible to print using the color profile.
This should normally be set to Off when using.

Adjust Faint Lines
This function prevents thin lines from fading when printing by darkening light colored lines.

Sharpen Text
Set this to print fine text clearly.

744



Favorites Tab Description

The Favorites tab allows you to register frequently used print settings as favorites.

Favorites
A list of the registered favorite settings appears. The Default Settings are registered in the initial
settings.

Details
The settings of the favorite that you selected from Favorites appear.

Comment
The comment registered to the favorite appears.

Apply Favorite
You can change the print settings to the settings of the favorite that you selected from the Favorites
list.

Delete
You can delete favorites that have become unnecessary.

Edit...
The Edit dialog box opens.
You can change the name and icon settings of the favorite that you selected from the Favorites list.

Add...
The Add dialog box opens.
You can register the current settings as a favorite.

Application Settings Priority
The setting in the application software will take priority over the favorites setting set on the printer driver.
The setting in the application software is only prioritized for Page Size, Orientation and Copies.
Place a checkmark to prioritize the settings for the application software.

Import...
You can read the settings of the favorite that was saved to a file.
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Export...
You can save the settings of a favorite to a file.

Edit dialog box
You can change the name and icon of the favorite that you selected from the Favorites list.

Name
Changes name to be displayed in Favorites list.

Icon
Changes icon to be displayed in Favorites list.

Comment
Changes information to be displayed in Comment.

Add dialog box
You can save the current print settings as the settings of a favorite.

Name
Set the name to be displayed in Favorites list.

Icon
Set the icon to be displayed in Favorites list.

Comment
Enter information to be displayed in Comment.
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Maintenance Tab Description

The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.

 Print Nozzle Check Pattern
Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, use Print Head
Cleaning to clean the print head.
Paper Source

Displayed using the Media Type, Page Size and Roll Width for each currently set paper feed
position.

 Print Head Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.
There are two head cleaning functions, which are described below.
Cleaning

Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink
levels are sufficiently high.

System Cleaning
System Cleaning is a more powerful cleaning function. Execute this function if the condition does
not improve even after you repeat Cleaning several times.
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Important
• System Cleaning consumes an extremely large amount of ink.

Executing system cleaning frequently will rapidly deplete your printer's ink supply. Therefore,
execute system cleaning only when necessary.

 Paper Feed Amount Adjustment
This function adjusts the paper feed amount if the print result is faint or contains streaks.

 View Status
This function displays printer information and setting values.

Related Topics
Cleaning the Print Heads
Printing a Nozzle Check Pattern
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Device Settings Tab Description

Many of the tabs in the Properties windows of the printer are controlled by Windows. However, the Device
Settings tab is for specifying printer configuration-related settings and is part of the printer driver.
The Device Settings tab allows you to specify settings related to the printer unit.

Automatically switch paper sources (paper size priority)
Prints after automatically switching between roll paper 1 and roll paper 2 depending on the size of the
paper to be printed.
This will save paper as the roll paper that will give the smallest margin when printing is automatically
selected.

Important
• Make sure that the same type of paper is used in the upper level and lower level of the printer.

Printing is not possible when different types of paper are used.
• Be sure to click Get Information... from the Device Settings tab to get information on the roll

paper width. You may not be able to print correctly if the roll paper width is not correctly set.
• Be sure to select Roll Paper (Auto) as Paper Source from Page Setup. This function cannot be

used unless Roll Paper (Auto) is selected.

Roll Paper Width 1
Sets the width of the roll paper loaded in the upper level (Roll 1).

Roll Paper Width 2
Sets the width of the roll paper loaded in the lower level (Roll 2).

Get Information...
Acquire information on the attachment of the roll unit or roll paper 1 or roll paper 2 paper width from
the printer.
Based on this information, the Roll Unit and Automatically switch paper sources (paper size
priority), and roll width settings are automatically switched.
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Update Media Information
Opens the Update Media Information dialog box.
Gets the latest media information from the printer and updates the media information in the printer
driver.

Accounting
Opens the Accounting dialog box.
By setting Accounting information, you add IDs to print jobs, and use the printer and cost management
tool to tabulate print history information for any ID.

Note
• Accounting can be set only by users with Administrator rights.

Users without Administrator rights may not be able to set Accounting information.

Device Information
Opens the Device Information dialog box. You can obtain and change the device information of the
connected printer.

About
Allows you to check the version of the printer unit.

Accounting dialog box
Click Accounting to display the Accounting dialog box.
The Accounting dialog box allows you to add IDs to print jobs. You can then use the IDs, along with the
printer and cost management tool, to tabulate print history information.

Account ID/Account ID2
Enter the account ID to be set. Enter the ID by using up to 20 alphanumeric characters (0 to 9, a to z,
and A to Z).

Prohibits Account ID changes
Prohibits changes to account IDs that have already been set.
Check this check box to prevent other users from changing IDs.

Device Information dialog box
The Device Information dialog box allows you to obtain and change the device information of the
connected printer.

Settings Summary
This is a list of items that you can set in the Device Information dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.
Roll Unit

If the lower roll unit is equipped, it is set to Yes.

Note
• If a roll unit set as a wrapping device is equipped, it is set to No.

Acquire Status
Obtain device type, roll unit, and hard disk information from the printer.
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Canon IJ Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.

Canon IJ Status Monitor Features
The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the ink tank type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

Canon IJ Status Monitor Overview
Canon IJ Status Monitor allows you to check the status of the printer and ink with graphics and messages.
You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon IJ Status Monitor shows an icon when a warning or error occurs to the printer.

 : A warning is being displayed.

 : An operation error has occurred.

 : You are being informed of remaining ink levels, etc.

 : There has been an error which requires a service.

Document Name
Shows the name of the document to be printed.
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Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.

Remaining Printing Time of Current Page
Displays the remaining print time of the pages being printed.

Display Send Queue
Shows the print window used to manage the print job that is being printed or being in the print
queue.

Cancel Printing
Cancels the current print job.

Estimated ink levels
Displays icons to report a remaining ink level warning and an ink depletion error.

Click  (the disclosure triangle) to display a pictorial representation of the estimated ink level in
the ink tank.
Purchase Ink

A screen for purchasing ink appears. You can use this screen to purchase ink.

Ink Model Number
You can look up the correct ink tank for your printer.

Estimated Maintenance Cartridge Usage
Displays icons to report that the available space in the maintenance cartridge is low or the
cartridge is full.

Click  (the disclosure triangle) to display a pictorial representation of the estimated space
available in the maintenance cartridge.

Paper Feed
Displays the size and type of paper loaded in each feeder. It also allows you to check the
remaining amount of paper.

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon IJ
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job

Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Warning Automatically
When a Low Ink Warning Occurs

Starts the Canon IJ Status Monitor window automatically and displays it in front of the
other windows when a low ink warning occurs.

When a Maintenance Cartridge Warning Occurs
When a maintenance cartridge remaining space warning occurs, the Canon IJ status
monitor starts automatically and appears in front of all other windows.
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Other Warnings
When any other warning occurs, the Canon IJ Status Monitor will open automatically
and be displayed in front of other windows.

Start when Windows is Started
Starts the Canon IJ Status Monitor automatically when you start Windows.

Remote UI menu
You are able to open the printer's Remote User Interface.
You are able to check the printer status and run maintenance functions on the printer when
connected to and using it through a network.

Note
• When the printer is being used via USB connection Remote UI will not display.

Printer Information
Allows you check detailed information, such as the printer status, the print progress, and
remaining ink levels.

Maintenance
Allows you to run printer maintenance and change printer settings.

Job Log
Displays the Job history window.

Job List
Displays the Print job window.

HDD Information
Displays the Saved job window.
This window allows you to check each box of the information saved on the printer's hard
disk.

Ink Supplier Display Settings
Displays the Ink supplier information window.

Download Security Certificate
Displays the For secure communication window.
This window allows you to download the root certificate, register it to the browser, and
disable warning displays.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and
you can check the version and copyright information.
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Updating the Printer Driver

Obtaining the Latest Printer Driver

Deleting the Unnecessary Printer Driver

Before Installing the Printer Driver

Installing the Printer Driver
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Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved.

You can check the version of the printer driver by clicking the About button on the Main tab.

You can access our website and download the latest printer driver for your model.

Important
• You can download the printer driver for free, but any Internet access charges incurred are your

responsibility.
• Before installing the latest printer driver, delete the previously installed version.

Related Topics
Before Installing the Printer Driver
Installing the Printer Driver
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Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller

• If you are using Windows 10 or Windows Server 2016, select the Start menu -> Windows System
-> Control Panel -> Programs -> Uninstall a program.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

• If you are using Windows 8.1, from the Desktop charms, select Settings -> Control Panel ->
Programs -> Programs and Features.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

• If you are using Windows 7, select Start menu -> Control Panel -> Programs -> Programs and
Features.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

The confirmation window for uninstalling the model appears.

Important
• A confirmation/warning dialog box may appear when starting, installing or uninstalling software.

This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Execute. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the printer driver is complete.
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Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also
refer to this section if the printer driver cannot be installed.

Checking the Printer Status
• Turn off the printer.

Checking the Personal Computer Settings
• Terminate all running applications.
• Log on as a user who has the administrator account.

Important
• Before installing the latest printer driver, delete the previously installed version.

Related Topics
Obtaining the Latest Printer Driver
Installing the Printer Driver
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Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver for your model.

The procedure for installing the downloaded printer driver is as follows:

1. Turn off the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

Important
• A confirmation/warning dialog box may appear when starting, installing or uninstalling software.

This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the printer driver

Take the appropriate action as described on the screen.

4. Complete the installation

Click Complete.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

Important
• You can download the printer driver for free, but any Internet access charges incurred are your

responsibility.
• Before installing the latest printer driver, delete the previously installed version.

Related Topics
Obtaining the Latest Printer Driver
Deleting the Unnecessary Printer Driver
Before Installing the Printer Driver
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Printing Using Canon Application Software

Preview Guide

Free Layout Guide

Print Plug-In for Office Guide

Direct Print & Share Guide

Quick Utility Toolbox Guide

IJ Network Device Setup Utility Guide

Media Configuration Tool Guide

Device Management Console Guide

Accounting Manager Guide
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macOS Software

Printer Driver

Overview of the Printer Driver

Description of Print Dialog

Updating the Printer Driver

Printing Using Canon Application Software

Preview Guide

Free Layout Guide

Quick Utility Toolbox Guide

IJ Network Device Setup Utility Guide

Media Configuration Tool Guide

Device Management Console Guide

Accounting Manager Guide
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Printing Using Canon Application Software

Preview Guide

Free Layout Guide

Quick Utility Toolbox Guide

IJ Network Device Setup Utility Guide

Media Configuration Tool Guide

Device Management Console Guide

Accounting Manager Guide
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Managing Print Jobs

Checking Print Job Information

Accounting Manager Guide

Basic Print Job Operations

Using Printer Hard Disk

Saving Print Jobs on Printer Hard Disk

Managing Job Queue (Deleting or Preempting Other Jobs)

Managing Pending Jobs (Printing or Deleting Jobs on Hold)

Printing Saved Jobs

Deleting Saved Jobs

Moving Saved Jobs

Advanced Print Job Operations

Saving Print Jobs Sent from Sources Other than Printer Driver

Printing without Saving Jobs in Common Box

Setting Passwords for Personal Boxes

Naming Personal Boxes

Displaying List of Saved Jobs

Printing List of Saved Jobs

Displaying Details of Saved Jobs

Renaming Saved Jobs

Printer Hard Disk Operations

Checking Free Hard Disk Space
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Checking Print Job Information

Check print job details or print a specified job on the printer's hard disk using a web browser or operation
panel.

• Using web browser:

Log in to the printer using web browser.

Configuration changes using the Web Browser

After logging on to the printer, select Job management and perform operations.

• Using operation panel:

Select Job management on the HOME screen and perform operations.
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Basic Print Job Operations

Using Printer Hard Disk

Saving Print Jobs on Printer Hard Disk

Managing Job Queue (Deleting or Preempting Other Jobs)

Managing Pending Jobs (Printing or Deleting Jobs on Hold)

Printing Saved Jobs

Deleting Saved Jobs

Moving Saved Jobs
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Using Printer Hard Disk

The printer can save print jobs on the built-in hard disk.

Using print jobs stored on the printer enables you to print the jobs again as needed without using a
computer.

Saving print jobs offers the following benefits.

• Save the time spent using a computer

When you send a print job to the printer, you can save it on the printer after printing or simply save it on
the printer without printing it yet. Saved print jobs can be printed in the required quantity later without the
need to use a computer again.

• Simplify reprinting, if any errors occur

If errors occur in the middle of printing (as when paper runs out), you can resume printing after clearing
the error without resending the print job from a computer.

• Streamline printing work

Without using a computer, you can select print jobs and print in the desired quantity. You can also select
multiple print jobs to print during the same period. This enables unattended operation at night, for
example.

Output Method
To save print jobs on the printer's hard disk, configure the printer driver.

In Windows, this is set using the Output Method dialog box.

In macOS, this is set by selecting Additional Settings in the pop-up menu of the printer properties dialog.

Print
Perform printing while saving the print job on the temporary storage area of the printer's hard disk.

Save in Job Box
Save print jobs on the permanent storage area of the printer's hard disk. Selecting this does not start
printing.

Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that
occurs when receiving a print job is interrupted and printing is aborted in the middle.
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Storage Destination
The storage area on the printer's hard disk is divided into a temporary storage area and a permanent
storage area. The temporary storage area stores print jobs in the job queue or shared mailbox. The
permanent storage area stores jobs in personal boxes.

Job queue
The job queue refers to print jobs that are being processed by the printer (saved, received, prepared
for processing, printed, deleted, or held). Up to 100 jobs can be stored in the temporary storage area.

However, the number of jobs available as queued jobs is up to 64.

Shared mailbox
Jobs for which you have specified Print in Output Method are saved in the shared mailbox and
classified as saved jobs.

There is one shared mailbox, numbered "00". A password cannot be set for the shared mailbox.

Up to 100 print jobs can be saved here. However, they will be deleted one after another starting with
the oldest job in the following situations.

• If there are over 101 jobs queued and saved in the shared mailbox combined
• If no more temporary storage space is available when jobs for which you have selected Print in

Output Method are received
• If there is not enough space in the temporary or permanent storage area when jobs for which you

have selected Save in Job Box in Output Method are received.

Personal boxes
Jobs are classified as saved jobs and saved in personal boxes in the following situations.

• When a saved job stored in the shared mailbox is moved to a personal box
• When you have selected Save in mail box as the option in Output Method

There are 29 personal boxes, numbered "01" to "29". You can specify a name and password for each
personal box.

Up to 100 print jobs can be saved in all personal boxes combined.
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Saving Print Jobs on Printer Hard Disk

To save print jobs on the printer's hard disk, configure the printer driver.

Configuring Printer Driver (Windows)

1. Open printer properties dialog box.

How to Open the Printer Driver Setup Window

2. Access Page Setup sheet.

3. Click Output Method to display Output Method dialog box.
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4. Make your selection in Output Method.

Print
Perform printing while saving the print job on the temporary storage area of the printer's hard disk.

Save in Job Box
Save print jobs on the permanent storage area of the printer's hard disk. Selecting this does not
start printing.

If you choose Save in Job Box, also specify the destination personal box in the Job Box list.

Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that
occurs when receiving a print job is interrupted and printing is aborted in the middle.

Note
• Click Acquire Job Box Name to display personal box names in the Job Box list, as acquired

from the printer.

5. In Name of data to be saved, specify how to name saved print jobs.

To use the file name, select Use file name.

Otherwise select Enter name and enter a name in Name.

6. Click OK to close Output Method dialog box.

Configuring Printer Driver (macOS)

1. Open printer properties dialog.

How to Open the Printer Driver Setup Window
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2. Select Additional Settings in pop-up menu.

3. Make your selection in Output Method.

Print
Perform printing while saving the print job on the temporary storage area of the printer's hard disk.

Save in Job Box
Save print jobs on the permanent storage area of the printer's hard disk. Selecting this does not
start printing.

If you select Save in Job Box, select the personal box number from Job Box No..

Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that
occurs when receiving a print job is interrupted and printing is aborted in the middle.
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Managing Job Queue (Deleting or Preempting Other Jobs)

Print jobs being processed by the printer are collectively called the job queue. You can delete or preempt
jobs in the job queue as needed.

This operation is available using the operation panel or Remote UI.

Using Operation Panel
Using Remote UI

• Delete

Note that only jobs that are not currently being deleted can be deleted from the job queue.

• Preempting other jobs

You can preempt other jobs by printing jobs that are currently being received for processing first.

Note
• For information on managing jobs being held, see Managing Pending Jobs (Printing or Deleting Jobs on

Hold).
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Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Job management.

Menu Operations

3. Tap Print job.

4. Tap data to delete or perform preempt printing.

The screen below appears.

A. Tap to delete data.

B. Tap to perform preempt printing.

5. Check message that is displayed and tap Yes.

Note
• Select Delete all print jobs on Job management to delete all jobs in the job queue

Job management

Using Remote UI

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Print job.

The print job list appears.

4. Select print job and select Delete or Prioritize.
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Managing Pending Jobs (Printing or Deleting Jobs on Hold)

If the type or size of paper loaded does not match the settings in the print job received when you have set
Detect paper setting mismatch to Hold job in the operation panel, the print job is held on the printer as a
pending job in the job queue.

Manage held jobs such as these as follows.

This operation is available using the operation panel or Remote UI.

Note
• As long as you do not manage held jobs from the operation panel, they will remain in the job queue. In

this case, the printer processes the next job in the queue without pausing.
• To print held jobs, replace the loaded paper with the paper specified in the print job.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Using Operation Panel
Using Remote UI

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Job management.

Menu Operations

3. Tap Print job.

The print job list appears.

4. Tap print job with  icon on left.

The screen below appears.

A. Tap to delete data.
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B. Tap to release hold.

5. Check message that is displayed and tap Yes.

Note
• Select Delete all print jobs on Job management to delete all jobs in the job queue

Job management

Using Remote UI

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Print job.

The print job list appears.

4. Select print job with  icon on left and select Delete or Release.
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Printing Saved Jobs

Print saved print jobs stored on the printer's hard disk as follows.

This operation is available using the operation panel or Remote UI.

Using Operation Panel
Using Remote UI

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Job management.

Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.

Note
• Enter the password if it is enabled.

5. Tap Job list.

6. Tap job to print.

7. Tap Start print on displayed screen.

The screen below appears.
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A. Tap to display the screen below. Specify the number of copies.

8. Tap Start print.

Using Remote UI

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.
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Note
• Enter the password if it is enabled for a saving box.

5. Select saved job and select Print.
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6. Enter quantity to print in Copies and select Yes.
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Deleting Saved Jobs

Delete saved print jobs stored on the printer's hard disk as follows.

This operation is available using the operation panel or Remote UI.

Using Operation Panel
Using Remote UI

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Job management.

Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.

Note
• Enter the password if it is enabled.

5. Tap Job list.

6. Tap job to delete.

7. Tap Delete.

8. Tap Yes on displayed screen.

Using Remote UI

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.
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Note
• Enter the password if it is enabled for a saving box.

5. Select saved job and select Edit.
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6. Select Delete on displayed screen.
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Moving Saved Jobs

Print jobs stored on the printer's hard disk (saved jobs) can be moved from the current box to another box as
follows.

However, jobs saved in personal boxes cannot be moved to the shared mailbox.

This operation is available using Remote UI.

Important
• Jobs stored in the shared mailbox may be automatically deleted under some conditions. To prevent

jobs from being deleted, move them from the shared mailbox to personal boxes.

Using Printer Hard Disk

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.

Note
• Enter the password if it is enabled for a saving box.
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5. Select saved job and select Edit.

6. Select Move on displayed screen.

7. On Move job page, select Destination job box.
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8. Select name or number of destination personal box in Destination job box list and select
OK on displayed screen.
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Advanced Print Job Operations

Saving Print Jobs Sent from Sources Other than Printer Driver

Printing without Saving Jobs in Common Box

Setting Passwords for Personal Boxes

Naming Personal Boxes

Displaying List of Saved Jobs

Printing List of Saved Jobs

Displaying Details of Saved Jobs

Renaming Saved Jobs

Printer Hard Disk Operations

Checking Free Hard Disk Space
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Saving Print Jobs Sent from Sources Other than Printer Driver

To save print jobs sent from software or systems other than the printer driver or applications provided with
the printer, specify the output method and select the setting to perform printing after saving printing data
using the operation panel.

Note
• Contact the software or system developer for information about support for this printer function.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

Specifying Output Method
Printing after Saving Printing Data

Specifying Output Method
Perform settings for printing or saving print job.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Device settings.

Menu Operations

3. Tap Hard disk settings.

4. Enter administrator password if it is enabled.

5. Tap Output method.

Select the method below.

Print
Save print jobs automatically at the same time they are printed. (This is the default format.)

Print (auto delete)
Save print jobs temporarily at the same time they are printed and delete them after printing.
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Save to job box
Save print jobs on the printer.

Printing after Saving Printing Data
To save print jobs on the hard disk before printing, select ON for Save first and print.

Printing will start when Save first and print is set to ON, even if you have selected Save to job box for
Output method.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Device settings.

Menu Operations

3. Tap Hard disk settings.

4. Enter administrator password if it is enabled.

5. Tap Save first and print.

6. Tap ON.
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Printing without Saving Jobs in Common Box

Jobs sent from a computer for which you have selected Print in Output Method in the printer driver are
saved in the shared mailbox.

Using Printer Hard Disk

When Common job box setting is set to Print (auto delete) in the operation panel menu, print jobs for
which you have selected Print in Output Method in the printer driver are deleted from the shared mailbox
after printing.

Use this function when printing highly confidential documents.

Important
• The administrator password is required to change settings if it is enabled for changing settings using

the operation panel.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Device settings.

Menu Operations

3. Tap Hard disk settings.

4. Enter administrator password if it is enabled.

5. Tap Common job box setting.

6. Tap Print (auto delete).
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Setting Passwords for Personal Boxes

For greater security, you can specify a password for personal boxes. After you set a password, it will be
required to modify the personal box settings, as well as to display, print, delete, move, and modify jobs
saved in the personal box.

This operation is available using Remote UI.

Note
• By default, no passwords are set for personal boxes.
• A password cannot be set for the shared mailbox.
• Enter a seven-digit number as the password, in the range 0000001 to 9999999.
• Even if you have set passwords, they are not required to access personal boxes in Administrator Mode

in Remote UI.

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.

5. Select Edit.
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6. In Edit job box dialog box, specify password.

7. Select Set/change password check box and enter password. (This field is limited to seven
digits in the range 0000001 to 9999999.)

8. Select OK.
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Naming Personal Boxes

For easier identification, you can assign names to personal boxes.

This operation is available using Remote UI.

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.

Note
• Enter the password if it is enabled for a saving box.
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5. Select Edit.

6. In Edit job box dialog box, enter name in Job box name and select OK.
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Displaying List of Saved Jobs

Print jobs stored on the printer's hard disk (saved jobs) can be listed by box as follows.

This operation is available using the operation panel or Remote UI.

Using Operation Panel
Using Remote UI

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Job management.

Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.

Note
• Enter the password if it is enabled.

5. Tap Job list.

Saved job list for each box appears.

Using Remote UI

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.
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Note
• Enter the password if it is enabled for a saving box.

Jobs saved in the box are listed.
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Printing List of Saved Jobs

The list of print jobs stored on the printer's hard disk (saved jobs) can be printed by box as follows.

This operation is available using the operation panel.

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Job management.

Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.

Note
• Enter the password if it is enabled.

5. Tap Job list.

6. Tap Print the job list.

Saved job list for each box appears.
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Displaying Details of Saved Jobs

Details of print jobs stored on the printer's hard disk (saved jobs) can be displayed as follows.

This operation is available using the operation panel or Remote UI.

Using Operation Panel
Using Remote UI

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Job management.

Menu Operations

3. Tap Saved job.

The Job box list screen appears.

4. Tap box.

Note
• Enter the password if it is enabled.

5. Tap Job list.

Saved job list for each box appears.

6. Tap print job.

The print job details appears.

Using Remote UI

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.
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Note
• Enter the password if it is enabled for a saving box.

5. Select print job.
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The details of the saved document appears.
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Renaming Saved Jobs

Print jobs stored on the printer's hard disk (saved jobs) can be renamed as follows.

This operation is available using Remote UI.

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Saved job.

The saved job list appears.

4. On Saved job page, select box.

Note
• Enter the password if it is enabled for a saving box.
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5. Select saved job and select Edit.

6. Select Change.
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7. Enter name and select OK.
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Printer Hard Disk Operations

Printer hard disk operations are available from the following programs and interfaces.

• Printer driver

• Remote UI

• Operation panel

The hard disk operations available through each interface are as follows.

Operation Printer driver Remote UI Operation
panel

Saving print jobs Save in mail box ✓ - -

Do not save print jobs in the common box - - ✓

Save print jobs sent from sources other than
the printer driver

- - ✓

Operations with saved jobs Print saved jobs - ✓ ✓

Delete saved jobs - ✓ ✓

Job queue management Display job queue - ✓ ✓

Delete - ✓ ✓

Preempt jobs - ✓ ✓

Operations with held jobs - ✓ ✓

Mail box management Move saved jobs - ✓ -

Modify saved jobs - ✓ -

Modify mail boxes - ✓ -

Print a list of saved jobs - - ✓

Display a list of saved jobs - ✓ ✓

Other operations Display free hard disk space - ✓ ✓

Initialize hard disk - - ✓

Display the time of printing - ✓ ✓

Display error messages - ✓ ✓
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Checking Free Hard Disk Space

Check the space available on the printer's hard disk as follows.

This operation is available using the operation panel or Remote UI.

Using Operation Panel
Using Remote UI

Using Operation Panel

1. Make sure printer is turned on.

2. Flick HOME screen and tap  Printer information.

Menu Operations

3. Tap Hard disk information.

The free hard disk space appears.

Using Remote UI

1. Display printer status on web browser.

2. On Menu page, select Job management.

3. Select Hard disk information.

The free hard disk space is shown in the upper-right corner.
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Troubleshooting

Frequently Asked Questions
I want to easily create vertical or horizontal banners.
Does this printer support sub-ink tank system?
I want to know how to configure roll cutting.
I want to configure so that the roll is cut automatically after waiting for the ink to dry.
How do I print without borders?
I want to know the paper types that can be used in this printer.
The paper type that I want to print is not displayed on the Touch Screen.
Can I perform duplex printing?
I want to perform enlargement printing.
Printer Connection Methods

Examples of Problems

Problems Regarding Paper

Clearing Jammed Roll Paper
Clearing a Jammed Sheet
Roll paper cannot be inserted into the Paper Feed Slot
Paper is not fed automatically
Roll Paper Is not Switched Automatically
Roll Pater Is not Fed Automatically
Paper Source Does Not Switch When Roll Paper Is Used Up
Roll Paper Remains/Lacks under Quantity Management
Cannot load sheets
Paper is not cut straight
Paper is not cut
Cutter Blade Does Not Work While Cutting Is in Progress
The size of clear film cannot be detected
Margins are wide
When printing on roll paper, the printed surface becomes scratched

Printing Does Not Start

Printer Suddenly Stopped Working for Some Reason
The Data lamp on the Operation Panel does not light up
The printer does not respond even if print jobs are sent
"Preparing the ink system." is displayed
"Agitating the ink" is displayed

The Printer Stops During a Print Job

Printing stops and an error message is displayed
The printer ejects blank, unprinted paper
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Problems with the Printing Quality

Printing is faint
Paper rubs against the Print Head
The edges of the paper are dirty
The surface of the paper is dirty
The back side of the paper is dirty
Immediately after borderless printing, the trailing edge margin is soiled during regular printing
Printed colors are inaccurate
Banding in different colors occurs
Colors in printed images are uneven
Image edges are blurred or white banding occurs
The contrast becomes uneven during printing
The length of printed images is inaccurate in the feeding direction
Images are printed crooked
Documents are printed in monochrome
Line thickness is not uniform
Lines or colors are misaligned
Borders appear in borderless printing

Cannot Print over Network

Cannot Connect Printer to Network
Cannot Print over TCP/IP Network
Cannot Print over Bonjour networks (macOS)

Cannot Find Printer on Network

Cannot Find Printer on Check Printer Settings Screen (Windows)
Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen
Searching Printer by IP Address or Host Name During Setup

Installation Problems

Removing Printer Software
Setup Processing Is Slow (Windows)
Cannot Install Printer Driver (Windows)

HP-GL/2 problems

With HP-GL/2, printing is misaligned
Lines or images are missing in printed HP-GL/2 jobs.
Lines are printed too thick or thin in HP-GL/2 print jobs
HP-GL/2 jobs are printed in monochrome (or color)
Printed colors of lines are inaccurate during HP-GL/2 printing
HP-GL/2 jobs are printed 6 mm larger than specified
HP-GL/2 jobs are printed at maximum size, even if a standard size is specified
HP-GL/2 printing takes a long time
The printer stops when printing a HP-GL/2 job (the carriage stops moving)

Other Problems

The printer does not turn on
The printer takes time to start up
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If the Printer Makes a Strange Sound
Messages advising to check the maintenance cartridge are not cleared
The printer consumes a lot of ink
Printed pages are not collected cleanly in the basket
Printed pages are not collected cleanly in the stacker
Basket Lurches
When Trim edge first is set, the trimmed paper is drawn into the roll unit
Ink Level Detection
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I want to easily create vertical or horizontal banners.

You can print originals that are in landscape (or portrait) orientation automatically enlarged to fit the roll
width. This is an easy way to create vertical or horizontal banners.

Printing Hanging and Horizontal Banners (Large-Format Printing) (Windows)
Printing Hanging and Horizontal Banners (Large-Format Printing) (macOS)
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Does this printer support sub-ink tank system?

This printer supports hot-swap ink tank replacement.

Even if an ink tank becomes empty during printing, since a certain amount of ink always is stored in a sub-
ink tank, you can replace the ink tank while printing.

Replacing Ink Tanks
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I want to know how to configure roll cutting.

Cutting methods can be selected in the printer settings and printer driver settings.

To automatically cut roll paper after printing, open the Cutting mode settings on the printer, and then under
Automatic cut set Automatic Cutting in the printer driver to Yes.

When using paper that is easily scratched, or paper where the ink requires extra time to fix, we recommend
setting Cutting mode on the printer to Eject cut.

Specifying the Cutting Method for Rolls
Cutting Roll Paper after Printing (Windows)
Cutting Roll Paper after Printing (macOS)

If using the Media Take-up Unit, see the pages below for cutting settings and rolling settings after cutting.

Switching Roll Unit Modes
Removing Printed Paper from the Roll Unit
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I want to configure so that the roll is cut automatically after waiting
for the ink to dry.

You can set an ink drying time in the printer driver.

You can also configure the same settings on the printer itself.

Main Tab Description (Windows)
Paper Detailed Settings (macOS)
Specifying the Ink Drying Time for Rolls
Menu Structure
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How do I print without borders?

If printing on roll paper, you can set borderless printing in the printer driver settings. (If printing on sheets,
borderless printing is not possible)

Prints without Edges Based on the Scenarios (Windows)
Prints without Edges Based on the Scenarios (macOS)
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I want to know the paper types that can be used in this printer.

For information about paper that can be used with this printer, see the imagePROGRAF home page or refer
to the media information list.

Paper Information List
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The paper type that I want to print is not displayed on the Touch
Screen.

If using a new paper type, start the Media Configuration Tool to get the latest media information.

Updating paper information
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Can I perform duplex printing?

This printer cannot print double-sided.

An alternative to double-sided printing is to use the Folded Duplex function of the Windows software
Canon imagePROGRAF Free Layout, which prints two pages on one side, folds the sheet back from the
center, and hangs it.
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I want to perform enlargement printing.

Use the printer driver to adjust the original to the paper size and width, or print enlarged or reduced by
specifying a magnification factor.

Scaled Printing (Windows)
Scaled Printing (macOS)
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Network Settings and Common Problems

Here are frequently asked questions on network.

Cannot Find Printer

Cannot Find Printer on Check Printer Settings Screen (Windows)
Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen
Searching Printer by IP Address or Host Name During Setup
Cannot Find Printer while Using Wireless LAN
Cannot Find Printer while Using Wired LAN

Cannot Print or Connect

Cannot Connect Printer to Network
Cannot Print over TCP/IP Network
Cannot Print over Bonjour networks (macOS)
Printer Suddenly Stopped Working for Some Reason

LAN Setting Tips/Changing LAN Settings

Printer Connection Methods
Default Network Settings
Another Printer Found with Same Name
Connecting to Another Computer via LAN/Changing from USB to LAN Connection
Printing Network Settings
Reconfiguration Method of LAN Connection/Reconfiguration Method of Wireless LAN Connection
Reconfiguration of Network Settings using the Remote UI
Network Status and Troubleshooting
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Problems Regarding Paper

Clearing Jammed Roll Paper

Clearing a Jammed Sheet

Roll paper cannot be inserted into the Paper Feed Slot

Paper is not fed automatically

Roll Paper Is not Switched Automatically

Roll Pater Is not Fed Automatically

Paper Source Does Not Switch When Roll Paper Is Used Up

Roll Paper Remains/Lacks under Quantity Management

Cannot load sheets

Paper is not cut straight

Paper is not cut

Cutter Blade Does Not Work While Cutting Is in Progress

The size of clear film cannot be detected

Margins are wide

When printing on roll paper, the printed surface becomes scratched
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Clearing Jammed Roll Paper

If roll paper jams, follow the steps below to remove jams.

Note
• If "The paper is jammed. Lift the release lever and remove the paper." appears on the touch screen,

Step 1 and Step 9 can be skipped.

1. Turn off the power to the printer.

Turning the Printer On and Off

2. Open the top cover.

Note
• If the roll paper is very curled or the leading edge of the roll paper blocks the Carriage, setting the

cutting method for the roll paper to User cut and leading edge detection to Do not detect may
stop the paper from blocking the carriage.

Specifying the Cutting Method for Rolls

3. If the Carriage is out, move the Carriage out of the way, away from the paper.
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Important
• Do not touch the linear scale (A), carriage shaft (B), or ink tube stabilizer (C). Touching these may

cause malfunction.

4. Lift up the release lever.
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5. Holding the paper on both sides, pull the jammed portion out toward the front. Use scissors
or a cutting tool to cut away the printed or wrinkled portion.
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Caution
• Be careful not to injure yourself or scratch the printer when cutting.

6. If the Carriage is on the left, move the Carriage to the right until it stops.
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Important
• Always move the Carriage to the right side. If the Carriage is on the left, a Carriage error may

occur when you turn on the printer.

7. While holding the leading edge of the roll paper in the middle and gently and evenly pulling
until it reaches the output guide (A) position, align the right edge of the roll paper parallel to
the paper alignment line (B), and lower the release lever.
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Important
• Do not pull the roll paper forcefully to make it line up with the paper alignment line (B). This might

cause the roll paper to feed at an angle.

8. Close the top cover.
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9. Turn on the power to the printer.

Turning the Printer On and Off

The roll is advanced and the printer is ready to print.

Note
• To trim the leading edge cleanly, select the paper being fed on the touch screen, and then cut the

leading edge by tapping Cut paper in Feed/cut.

Specifying the Cutting Method for Rolls
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Clearing a Jammed Sheet

If a sheet jams, follow the steps below to remove it.

1. Turn off the power to the printer.

Turning the Printer On and Off

2. Open the top cover.

3. If the Carriage is out, move the Carriage out of the way, away from the paper.
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Important
• Do not touch the linear scale (A), carriage shaft (B), or ink tube Stabilizer (C). Touching these may

cause malfunction.

4. Lift up the release lever.
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5. Hold the paper and pull it out toward the front.
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After removing the paper, inspect the interior to ensure paper fragments or other objects do not remain.

6. If the Carriage is on the left, move the Carriage to the right until it stops.

Important
• Always move the Carriage to the right side. If the Carriage is on the left, a Carriage error may

occur when you turn on the printer.

7. Lower the release lever and close the top cover.
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8. Turn on the power to the printer.

Turning the Printer On and Off
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Roll paper cannot be inserted into the Paper Feed Slot

Check 1  Is the roll paper curled?

Straighten out curls and reload the roll.

Check 2  Is paper jammed in the feed slot?

Remove the jammed paper.

Clearing Jammed Roll Paper
Clearing a Jammed Sheet

Check 3  Check that the correct paper source has been selected

Select Paper settings in the touch screen menu, and then select the paper source.

Check 4  Is the roll unit in Take-up mode when feeding from the roll unit?

Select Roll unit use setting in the touch screen menu, and set it to paper feed mode.

Loading the Lower Roll on the Roll Unit (Option)
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Paper is not fed automatically

This paper cannot be fed automatically.

Set Paper retention setting to Release in the touch screen menu and feed the paper manually.

Menu Structure
Loading the Upper Roll on the Printer

Note
• While this setting is selected, you cannot use automatic roll paper switching.
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Roll Paper Is not Switched Automatically

When using certain paper types and widths under certain temperature and humidity conditions, roll paper
auto switching may not be possible.

Set Paper retention setting to Release in the touch screen menu and feed the paper manually.

Menu Structure
Loading the Upper Roll on the Printer

Note
• Roll paper cannot not be fed or switched automatically until you change this setting.

If the roll cannot be switched at the end, make sure Switch roll paper when low is set to Enable.

Paper Source Does Not Switch When Roll Paper Is Used Up
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Roll Pater Is not Fed Automatically

Check 1  Check the paper settings.

Select Enable for Roll paper auto feed on Paper-related settings.

Paper-related settings

Check 2  Check the setting for Paper retention setting.

Select Retain for Paper retention setting on Paper-related settings.

Check 3  Make sure automatic paper feed can be used for the roll you are using.

Refer to "Paper Setting List(Roll Paper)" to make sure automatic paper feed can be used for the roll you are
using.

Paper Information List

Check 4  Make sure the roll is being fed.

If not, feed the roll manually.

Loading the Upper Roll on the Printer

If none of the above solves the problem, select Disable for Roll paper auto feed and feed paper manually.
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Paper Source Does Not Switch When Roll Paper Is Used Up

Check  Check the paper settings.

Check the following setting items on Paper-related settings and perform settings.

• Select Enable for Switch roll paper when low.
• Select Barcodes for Manage remaining roll amount.
• Select Retain for Paper retention setting.

Paper-related settings
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Roll Paper Remains/Lacks under Quantity Management

Check 1  Make sure Enable is selected for Roll paper auto feed.

When you load a roll paper, specify the remaining amount of roll within five seconds.

If you do not, the roll length specified on Advanced paper settings is regarded as the default value.

The difference between the value and actual length of loaded roll paper makes the remaining amount large or
small.

Check 2  Check the setting of Manage remaining roll amount.

• If Barcodes is selected for Manage remaining roll amount:

1. Enter Length of roll paper 1 and Length of roll paper 2, and then tap OK.

2. Select 0 (default) for Roll amount warning setting.

• If Warning message is selected for Manage remaining roll amount:

Select 0 (default) for Roll amount warning setting.

Paper-related settings
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Cannot load sheets

Check  Check that the correct paper source has been selected

Select Paper settings in the touch screen menu, and then select the paper source.

Tap Load paper and load the paper.

Loading Sheets in the Printer
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Paper is not cut straight

Check 1  Is the edge of the paper cutting position creased?

Straighten out any curling by the edges of the paper.

Check 2  Is the edge of the paper cutting position lifting up when cutting?

Reload the paper correctly.

Check 3  Is the paper a type that can be cut with the cutter blade?

Set Cutting mode in the touch screen menu to User cut, then and cut the roll paper with a cutting implement
such as scissors.

Specifying the Cutting Method for Rolls

Check 4  Are you using the basket or stacker properly?

Make sure that you are using the basket or stacker properly.

Example Basket Configurations
Example Stacker Configurations

Check 5  Check that the Cut speed setting is correct

Change the Cut speed setting in the touch screen menu.

If the paper edge cannot be cut straight at the cut starting position, it may be improved by selecting slower cut
speed than that selected currently.

If the paper edge cannot be cut straight at the cut ending position, it may be improved by selecting faster cut
speed than that selected currently.

Menu Structure

Check 6  Did the printing material slip diagonally while being cut?

Set the Cutting mode in the touch screen menu to Eject cut, and then hold and cut the material after it has
printed.

Specifying the Cutting Method for Rolls

Check 7  Is the cutter blade attached properly?

Attach the cutter blade properly.

Replacing the Cutter Blade

Check 8  Is the edge of the cutter blade blunt?
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Replace the cutter blade.

Replacing the Cutter Blade
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Paper is not cut

Check 1  Is Automatic Cutting in the printer driver set to No or Print Cut Guideline?

Set the printer driver Automatic Cutting setting to Yes.

Page Setup Tab Description (Windows)
Paper Detailed Settings (macOS)

Check 2  Is Cutting mode in the touch screen menu set to Eject cut or User cut?

If Cutting mode is set to Eject cut, select Feed/cut in the touch screen menu and cut the paper.

If Cutting mode is set to User cut, cut the roll paper with a cutting implement such as scissors.

Specifying the Cutting Method for Rolls

Check 3  Is the cutter blade attached?

Attach the cutter blade.

Replacing the Cutter Blade

Check 4  Is the cutting method for paper ejected after printing set to Do not cut when
the roll unit is set to Take-up mode?

Follow the steps below to change the settings.

1. Select the roll unit on the touch screen.

2. Tap Use in take-up mode, and then select Use the cutting mode setting.

3. Set the Cutting mode for Roll paper 1 on the touch screen to Automatic cut.
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Cutter Blade Does Not Work While Cutting Is in Progress

Check 1  Make sure the cutter blade can cut paper used currently.

Select User cut for Cutting mode in the touch screen menu and cut the roll paper with a cutting implement such
as scissors.

Specifying the Cutting Method for Rolls

Check 2  Check the setting value for Cut speed.

Change the value for Cut speed in the touch screen menu.

Menu Structure

Selecting slower value may enable the cutter blade to cut paper

Paper-related settings

Check 3  Is the edge of the cutter blade blunt?

Replace the cutter blade.

Replacing the Cutter Blade
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The size of clear film cannot be detected

Check  Is the platen dirty with ink?

Open the top cover and clean the entire platen area.

Cleaning Inside the Top Cover
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Margins are wide

Check 1  Is auto cut being used on printed material with a wide margin on the trailing
edge only?

Rolls are advanced a specific amount before cutting to prevent problems with cutting and paper ejection.

This operation is normal.

Check 2  Is leading edge detection set to Do not detect?

Do not detect may have been set by responding to the message Do you want to set to detect the leading
edge of the paper? when Cutting mode was set to User cut in the touch screen menu.

If the message Do you want to set to detect the leading edge of the paper? appears when setting Cutting
mode to User cut, select Detect (recommended).

Please note that if Detect (recommended) is selected and the paper has a strong curl, the print head may rub
against the edge of the paper when printing starts.

Specifying the Cutting Method for Rolls
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When printing on roll paper, the printed surface becomes
scratched

Check 1  Depending on the paper, the printed surface may become scratched when the
paper is fed.

In this case, you must set Paper retention setting to Release on the touch screen, and then manually feed the
paper. Lift the release lever, feed the roll paper until the leading edge is visible on the platen, lower the release
lever, and then proceed to the next step.

If Paper retention setting is set to Release, you will no longer be able to automatically switch between the
upper and lower roll paper.

Check 2  Has the roll paper lost tension during printing?

If the roll paper loses tension, the paper surface could be damaged and the paper could wrinkle or fold.

Set Roll paper tension (printing) in the touch screen menu to High.

Menu Structure

Note
• Carrying out Adjust print quality is recommended when changing Roll paper tension (printing)

settings.
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Printing Does Not Start

The Data lamp on the Operation Panel does not light up

The printer does not respond even if print jobs are sent

"Preparing the ink system." is displayed

"Agitating the ink" is displayed
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Printer Suddenly Stopped Working for Some Reason

Cannot Communicate with Printer Following Network Settings Change
Cannot Communicate with Printer via Wireless LAN
Cannot Connect to Printer through Wireless Direct
Cannot Communicate with Printer via Wired LAN
Cannot Print through Network

Cannot Communicate with Printer Following Network Settings Change

It may take a while for the computer to obtain an IP address, or you may need to restart your computer.

Make sure the computer has obtained a valid IP address, and try again to find the printer.

Cannot Communicate with Printer via Wireless LAN

Check1  Check the power status of printer and devices (e.g. wireless router or
computer) connected to the network.

Turn on the printer or devices.

If the power is already turned on, turn it off and on again.

It may be necessary to resolve wireless router problems (e.g. update interval of a key, problems of DHCP
update interval, energy saving mode, etc.) or to update the wireless router firmware.

For details, contact the manufacturer of your wireless router.

Check2  Can you view any web pages on your computer?

Make sure your computer is connected to the wireless router properly.

For more on checking computer settings or connection status, see the instruction manual supplied with the
wireless router or contact the manufacturer.

Check3  Is the printer connected to the wireless router?

Use the icon on the touch screen to check the connection status between the printer and wireless router. If the

 icon is not displayed, wireless LAN is disabled. Turn on wireless communication on the printer.

Check4  Make sure the printer and wireless router network settings match.

Make sure the network settings of the printer (e.g. wireless router name, SSID, network key, etc.) are identical
with those of the wireless router.
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To check the settings of the wireless router, refer to the instruction manual provided with it or contact its
manufacturer.

To check the current network settings of the printer, print out the network setting information.

Printing Network Settings

Note
• IJ Network Device Setup Utility allows you to diagnose and repair the network status.

Select the link below to download IJ Network Device Setup Utility and install it.

Checking Printer Connection Status Using IJ Network Device Setup Utility

See below for starting up IJ Network Device Setup Utility.

• For Windows:

Starting Up IJ Network Device Setup Utility

• For Mac OS:

Starting Up IJ Network Device Setup Utility

Check5  Make sure the printer is not placed too far away from the wireless router.

If the distance between the printer and wireless router is too far, wireless communication becomes poor. Place
the printer and wireless router close to each other.

Note
• Though an antenna is attached to most wireless routers, note that some of them have it inside.

Check6  Make sure wireless signal is strong. Monitor signal status and move printer
and wireless router as necessary.

Place the wireless router and printer where there are no obstacles between them. Wireless communication
between different rooms or floors is generally poor. Wireless communication can be impeded by building
materials containing metal or concrete. If the printer cannot communicate with the computer over a wireless
LAN due to a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a
wireless router is nearby, it may cause interference. Place the wireless router as far away from interference
sources as possible.

Note
• IJ Network Device Setup Utility allows you to diagnose and repair the network status.

Select the link below to download IJ Network Device Setup Utility and install it.

Checking Printer Connection Status Using IJ Network Device Setup Utility

See below for starting up IJ Network Device Setup Utility.

• For Windows:

Starting Up IJ Network Device Setup Utility

• For Mac OS:

Starting Up IJ Network Device Setup Utility
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Check7  Make sure you are using a valid channel.

Usable wireless channels may be limited depending on wireless network device used by your computer. See
the instruction manual provided with your computer or wireless network device to check usable wireless
channels.

Check8  Make sure channel set on wireless router is a usable channel as confirmed in
Check 7.

If it is not, change the channel set on the wireless router.

Check9  Make sure security software's firewall is off.

If your security software's firewall is on, a message may appear warning you that Canon software is attempting
to access the network. If this warning message appears, set security software to always allow access.

If you are using any programs that switch between network environments, check their settings. Some
programs use a firewall by default.

Check10  If printer is connected to an AirPort Base Station via LAN, make sure you
use alphanumeric characters for network identifier (SSID). (Mac OS)

 

If the problem is not resolved, redo setup.

• For Windows:

Perform setup using the Setup CD-ROM or from the web page.

• For Mac OS:

Perform setup from the web page.

• Positioning:

Make sure there are no obstacles between the wireless router and the printer.

Cannot Connect to Printer through Wireless Direct

Check1  Check the power status of printer and other devices (smartphone or tablet).

Turn on the printer or devices.

If the power is already turned on, turn it off and on again.

Check2  Is the  icon displayed on the touch screen?

If not, Wireless Direct is disabled. Turn on Wireless Direct.

Check3  Check the settings of your device (smartphone/tablet).
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Make sure wireless LAN is enabled on your device.

For details, refer to your device's instruction manual.

Check4  Make sure printer is selected as connection for device (e.g. smartphone or
tablet).

Select the identifier for Wireless Direct (SSID) specified for the printer as the connection destination for
devices.

Check the destination on your device.

For details, refer to your device's instruction manual or visit the manufacturer's website.

To check the identifier for wireless direct (SSID) specified for the printer, display it using the operation panel of
the printer or print out the network setting information of the printer.

• Display on the touch screen.

LAN settings

• Print the network settings.

Printing Network Settings

Check5  Have you entered the proper password specified for the Wireless Direct?

To check the password specified for the printer, display it using the operation panel of the printer or print out
the network setting information of the printer.

• Display on the touch screen.

LAN settings

• Print the network settings.

Printing Network Settings

Check6  Make sure the printer is not placed too far away from the device.

If the distance between the printer and device is too far, wireless communication becomes poor. Place the
printer and device close to each other.

Check7  Make sure 5 devices are already connected.

Wireless Direct does not allow more than 5 devices to be connected.

Cannot Communicate with Printer via Wired LAN

Check1  Make sure the printer is turned on.

Check2  Make sure the LAN cable is connected properly.

Make sure the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the
cable properly.
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If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.

 

If the problem is not resolved, redo setup.

• For Windows:

Perform setup using the Setup CD-ROM or from the web page.

• For Mac OS:

Perform setup from the web page.

Cannot Print through Network

Check1  Make sure the computer is connected to the wireless router.

For more on how to check the computer settings or connection status, see your computer instruction manual
or contact its manufacturer.

Check2  If the printer driver is not installed, install it. (Windows)

Install the printer driver using the Setup CD-ROM or install it from the Canon website.

Check3  When using wireless LAN, make sure wireless router does not restrict which
computers can access it.

For more on connecting to and setting up your wireless router, see the wireless router instruction manual or
contact its manufacturer.
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The Data lamp on the Operation Panel does not light up

Check 1  Does the printer have power?

Check that the power cord is firmly plugged all the way in. Push the ON button to turn on the power to the printer.

Check 2  Was the correct printer selected?

In Windows, select the printer by clicking Select Printer or Printer in the printing dialog box and try printing
again.

In macOS, open the dialog box of the printer driver, select the printer from the list of Printer, and try printing
again.

Check 3  Is the print job paused?

In Windows, restart the print job as follows.

1. Select the printer icon in the Printers and Faxes (or Printers ) window.

2. Clear Pause Printing in the File menu to restart the print job.

In macOS, restart the print job as follows.

1. Click Print & Scan (or Print & Fax).

2. Select the printer, and then Resume Printer (or Start Jobs ) in the Printers menu to restart the print job.
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The printer does not respond even if print jobs are sent

Check 1  Is Pause printing set to Enable?

Set Pause printing on the touch screen menu to Disable.

Pausing Printing

Check 2  Is Save to job box selected as the printer Output method?

Print the job saved on the printer's hard disk.

Printing Saved Jobs

Check 3  Is the print job pending?

Manage the jobs on hold and print as needed.

Managing Pending Jobs (Printing or Deleting Jobs on Hold)
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"Preparing the ink system." is displayed

The print head and sub-ink tank are being filled with ink.

Wait until the system has been filled with ink.

Note
• This message might appear if you force the power off while the printer is operating.

Always follow the correct procedure when turning off the power.

Turning the Printer On and Off
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"Agitating the ink" is displayed

Ink agitation is in progress.

Please wait until ink agitation is finished.

Agitation time varies depending on time elapsed since powering off (approximately 1 minute to 20 minutes).
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The Printer Stops During a Print Job

Printing stops and an error message is displayed

The printer ejects blank, unprinted paper
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Printing stops and an error message is displayed

The last portion of roll paper was used during a print job, and paper could not be advanced because the
trailing edge is taped to the roll.

Remove the used roll and insert a new roll.

Removing the Upper Roll from the Printer
Removing Rolls From the Roll Holder
Loading and Printing on Rolls
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The printer ejects blank, unprinted paper

Check 1  The leading edge of the roll paper may have been trimmed

The leading edge of the roll paper may be trimmed if Trim edge first is not set to OFF in the touch screen menu.

Cutting the Leading Edge of Roll Paper Automatically

Check 2  Is the print head nozzle blocked?

Print a nozzle check pattern to check the print head status.

Checking for Nozzle Clogging

Check 3  Is the correct printer driver selected?

Print again using the correct printer driver for your printer.

If none of the above apply, there may be a printer malfunction.

Contact your Canon dealer for assistance.
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Problems with the Printing Quality

Printing is faint

Paper rubs against the Print Head

The edges of the paper are dirty

The surface of the paper is dirty

The back side of the paper is dirty

Immediately after borderless printing, the trailing edge margin is soiled during
regular printing

Printed colors are inaccurate

Banding in different colors occurs

Colors in printed images are uneven

Image edges are blurred or white banding occurs

The contrast becomes uneven during printing

The length of printed images is inaccurate in the feeding direction

Images are printed crooked

Documents are printed in monochrome

Line thickness is not uniform

Lines or colors are misaligned

Borders appear in borderless printing
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Printing is faint

Check 1  Is the reverse side of the paper being used for printing?

Print on the printing surface.

Check 2  Is the print head nozzle blocked?

Print a test pattern to check the nozzles and see if they are clogged.

Checking for Nozzle Clogging

Note
• To automatically check for nozzle blockages after printing, set Auto nozzle check in the touch screen

menu to a setting other than Disable.

To show warnings based on nozzle check results, set Nozzle check error display in the touch screen
menu to Enable.

However, printing may be stopped by warnings if this setting is set to Enable.

Menu Structure

Check 3  Was the printer left with the ink tank out?

The ink supply may become blocked by ink if the ink tank is left out.

If this happens, leave the printer for at least 24 hours with the ink tank in, and then carry out Print head
cleaning.

Cleaning the Print Head

Check 4  Are paper scraps stuck in the top cover?

Follow the steps below to remove paper scraps left inside the top cover.

1. Open the top cover and make sure that the carriage is not over the platen.

2. Remove any paper scraps left inside the top cover.

Clearing Jammed Roll Paper
Clearing a Jammed Sheet

3. Close the top cover.

Check 5  Was the paper cut before the ink dried?

Set a longer Ink drying wait time in Advanced paper settings in the touch screen menu.

Menu Structure

Check 6  Is the printer driver Print Quality set to Fast?
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Follow the steps below to set Print Quality to a setting other than Fast, and then print.

• Windows

Change the Print Quality settings in the printer driver Advanced Settings.

Changing the Print Quality and Correcting Image Data (Windows)

• macOS

Change the Print Quality in the printer driver Quality & Media settings.

Changing the Print Quality and Correcting Image Data (macOS)

When Fast or Standard is selected, the printing time is shorter and less ink is used than with Highest or High,
but the print quality is reduced.

Check 7  Does the paper used for printing create a lot of cutting dust?

Set Cut-dust reduction in the touch screen menu Advanced paper settings to ON.

Reducing Dust from Cutting Rolls
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Paper rubs against the Print Head

Check 1  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

Load paper of the same type as you have specified in the printer driver.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.

2. Change the paper type in the printer driver and try printing again.

Check 2  Is the paper loaded properly?

If not loaded properly, paper can buckle and rub against the print head.

Reload the paper.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Check 3  Is the print head height set too low?

Set Paper Thickness (Head Height) in the touch screen menu to Auto.

Troubleshooting Paper Abrasion and Blurry Images

Check 4  Is the paper thick, or a type that curls easily or is prone to buckling after
absorbing ink?

If using paper-based printing material such as Heavyweight Coated Paper, set Transport unit vacuum
strength in the touch screen menu to Medium-strong or Strong.

If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the touch screen
menu.

Adjusting Vacuum Strength
Troubleshooting Paper Abrasion and Blurry Images

If using film-based printing material such as CAD Tracing Paper, set the Transport unit vacuum strength in the
touch screen menu to Standard, Medium-strong, or Strong.

If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the touch screen
menu.

Adjusting Vacuum Strength
Troubleshooting Paper Abrasion and Blurry Images
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If using paper thinner than 0.004 inches (0.1 mm), set Transport unit vacuum strength in the touch screen
menu to Weak.

If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the touch screen
menu.

Adjusting Vacuum Strength
Troubleshooting Paper Abrasion and Blurry Images

Check 5  When loading paper in the printer, is the media loaded the same as the media
type selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Check 6  Does the paper have a strong curl at the front edge or is it buckled?

Set Cutting mode in the touch screen menu to User cut, and set leading edge detection to Do not detect.

To keep track of the amount of roll paper remaining in this situation, set Manage remaining roll amount to OFF
before loading the roll paper, and then set Manage remaining roll amount back to ON after the roll paper is
loaded.

Specifying the Cutting Method for Rolls
Keeping Track of the Amount of Roll Paper Left
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The edges of the paper are dirty

Check 1  Was printing borderless or on small paper?

The platen may become dirtied by printing borderless or on small paper sizes.

Open the top cover and clean the platen.

Cleaning Inside the Top Cover

Check 2  Is Extension for borderless printing in the touch screen menu set to Large
or Standard?

Set Paper with adequate width in Extension for borderless printing to Small.

Menu Structure

Check 3  Is the media type specified in the printer driver the same as the media type in
the printer?

Make sure the same type of paper is specified on the printer as in the printer driver.

Changing the Type of Paper

Follow the steps below to change the printer driver settings.

1. To stop printing, press the Stop button.

2. Change the type of paper in the printer driver and try printing again.

Check 4  Is the paper creased or curled?

Straighten out the wrinkles or curls and reload the paper. Do not use paper that has been printed on previously.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Check 5  Is Cut-dust reduction in the touch screen menu Advanced paper settings
set to ON?

A cut dust reduction line is printed at the paper cut position when Cut-dust reduction is set to ON.

If cutting dust reduction is not required, set Cut-dust reduction to OFF.

Menu Structure

Check 6  Is the print head height set too low in the touch screen menu?

Set Paper Thickness (Head Height) to Auto.

Troubleshooting Paper Abrasion and Blurry Images

863



Check 7  Is the paper thick, or a type that curls easily or is prone to buckling after
absorbing ink?

If using paper-based printing material such as thick-coat paper, set Transport unit vacuum strength in the
touch screen menu to Medium-strong or Strong.

If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the touch screen
menu.

Adjusting Vacuum Strength
Troubleshooting Paper Abrasion and Blurry Images

If using film-based printing material such as tracing paper, set the Transport unit vacuum strength in the touch
screen menu to Standard, Medium-strong, or Strong.

If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the touch screen
menu.

Adjusting Vacuum Strength
Troubleshooting Paper Abrasion and Blurry Images

Check 8  Is the output guide clean?

Clean the output guide.

Cleaning the Printer Exterior
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The surface of the paper is dirty

Check 1  Is the paper retainer clean?

Clean the paper retainer.

Cleaning Inside the Top Cover

Check 2  Does this paper take longer to dry?

Set the Ink drying wait time in the touch screen menu to approximately 1 minute.

Menu Structure

Note
• When printing on paper that takes longer to dry, the paper may curl during printing and come in contact

with the output slot.

In such situations, set an Ink drying wait time and an Ink drying target area for Pause between scans
in the touch screen menu.

However, note that printing will now take longer.

Menu Structure

Note
• In a hot and humid environment, rolling paper printed with images containing areas of saturated color

may transfer ink to the contact surface, affecting print quality.

Move the printer to a different environment, or let the paper dry before rolling it.
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The back side of the paper is dirty

Check 1  Was the previous print job borderless, or printed on small paper?

Open the top cover and clean the platen.

Cleaning Inside the Top Cover

Check 2  Is Detect paper width in the touch screen menu set to OFF?

Printing with Detect paper width set to OFF may cause the platen to be dirtied.

Set Detect paper width in the touch screen menu to ON, and then open the top cover and clean the platen.

Cleaning Inside the Top Cover

To continue printing with Detect paper width set to OFF, first open the top cover and clean the platen, and then
manually feed roll paper over the platen when printing.

Cleaning Inside the Top Cover
Feeding Roll Paper Manually

Check 3  Paper may be gripped weakly over the platen.

Set a higher Transport unit vacuum strength in the touch screen menu.

Adjusting Vacuum Strength

Check 4  Is Extension for borderless printing in the touch screen menu set to Large
or Standard?

Set Paper with recommended width and Paper with adequate width in Extension for borderless printing to
Small.

Menu Structure

Note
• In a hot and humid environment, rolling paper printed with images containing areas of saturated color

may transfer ink to the contact surface, affecting print quality.

Move the printer to a different environment, or let the paper dry before rolling it.
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Immediately after borderless printing, the trailing edge margin is
soiled during regular printing

In some situations, borderless printing with automatic cutting of the leading and trailing edges on roll paper
may transfer ink on the cutter blade to the next item printed.

Follow the steps below to change Between Pages in Drying Time to between 30 seconds and 3 minutes
and perform borderless printing.

• Windows

1. Click Specify for Media Type on the Main sheet of the printer driver.

2. Select an ink drying time from the Between Pages list in Drying Time.

• macOS

Select an ink drying time from the Drying Time list on the Paper Detailed Settings sheet of the printer
driver.
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Printed colors are inaccurate

Check 1  Has color been adjusted in the printer driver?

Follow the steps below to adjust color settings.

• Windows

Adjust the color settings with Color Mode > Color Settings in Advanced Settings in the printer driver.

Main Tab Description (Windows)

• macOS

Adjust the color settings in the printer driver Color Options.

Color Options (macOS)

Check 2  Has the computer or monitor color been adjusted?

Take the actions below.

• Refer to the computer and monitor documentation to adjust the colors.

• Adjust the settings of the color management software, referring to the software documentation as needed.

Check 3  Is the print head nozzle blocked?

Print a test pattern to check the nozzles and see if they are clogged.

Checking for Nozzle Clogging

Check 4  Is Application Color Matching Priority set to Off in a Windows printer driver?

In the printer driver Layout sheet, click Special Settings, and then set Application Color Matching Priority to
On in the dialog box that appears.

Layout Tab Description (Windows)
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Banding in different colors occurs

Check 1  Are paper actually loaded on the printer and the media type selected on the
touch screen the same?

Select the correct media type in the touch screen menu when loading paper in the printer.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Check 2  Has the paper feed rate been calibrated properly?

Adjust the feed amount.

Adjusting Feed Amount

Check 3  Print job may have been interrupted while receiving, and therefore not printed
at a fast frame rate

Exit other applications and cancel other print jobs.

Check 4  Is Set priority in the touch screen menu set to Prioritize length accuracy?

Setting Set priority to Prioritize print quality and adjusting the feed amount can help.

Adjusting Feed Amount

Check 5  Check if the print head is in the right position

Adjust the print head position.

Automatic Adjustment to Straighten Lines and Colors

Check 6  Make sure that the print head nozzle is not blocked

Print a test pattern to check the nozzles and see if they are clogged.

Checking for Nozzle Clogging

Note
• To automatically check for nozzle blockages after printing, set Auto nozzle check in the touch screen

menu to a setting other than Disable.

To show warnings based on nozzle check results, set Nozzle check error display in the touch screen
menu to Enable.

However, printing may be stopped by warnings if this setting is set to Enable.

Menu Structure
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Check 7  Low Print Quality setting causing lines in the printing

Follow the steps below to set Print Quality to High, and then print.

• Windows

Change the Print Quality settings in the printer driver Advanced Settings.

Changing the Print Quality and Correcting Image Data (Windows)

• macOS

Change the Print Quality in the printer driver Quality & Media settings.

Changing the Print Quality and Correcting Image Data (macOS)

When Fast or Standard is selected, the printing time is shorter and less ink is used than with Highest or High,
but the print quality is reduced.

Check 8  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

Load paper of the same type as you have specified in the printer driver.

Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)
Loading Sheets in the Printer

Follow the steps below to change the printer driver settings.

1. To stop printing, press the Stop button.

2. Change the type of paper in the printer driver and try printing again.

Check 9  Make sure that lines are not printed around 100 mm from the paper edges.

If the printer is on standby or if you leave paper as it is for approximately over 30 minutes, paper may be curled
or wrinkled.

Set Sleep timer on Energy saving settings to a value shorter than 30 minutes, so that you can prevent paper
from being curled or wrinkled.

Device user settings
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Colors in printed images are uneven

Check 1  Does this paper curl easily?

Colors in printed images may be uneven at the leading edge of paper that curls easily. Change the Transport
unit vacuum strength in the touch screen to increase the grip on the paper, or set a margin of at least 0.8
inches (20 mm) at the front edge of the paper.

Adjusting Vacuum Strength

Check 2  Colors in printed images may be uneven if the Print Quality setting is too low

If using Windows, select Advanced Settings from the Main tab of the printer driver, and then select a higher
Print Quality setting.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality setting.

When Fast or Standard is selected, the printing time is shorter and less ink is used than with High, but the print
quality is reduced.

Changing the Print Quality and Correcting Image Data (Windows)
Changing the Print Quality and Correcting Image Data (macOS)

Check 3  Colors in printed images may be uneven on the boundary between shades if
there are dark and light areas in an image

Using the unidirectional printing function may reduce color unevenness in this situation.

Follow the steps below for unidirectional printing.

• Windows

Open Paper Detailed Settings from the Main tab of the printer driver, and then select Unidirectional
Printing.

• macOS

Open Paper Detailed Settings in the printer driver, and then select Unidirectional Printing.

Check 4  If printing borderless, colors in printed images may be a little uneven at the
leading edge of the paper because printing is interrupted to cut the paper

Set the printer driver Automatic Cutting settings to No, and then print. Doing this prints only the left and right
sides borderless. Cut the top and bottom borders with a cutting implement such as scissors after the printed
materials are output and cut.

Note
• Selecting a higher Print Quality in the printer driver Advanced Settings may resolve the problem.

Changing the Print Quality and Correcting Image Data (Windows)
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Changing the Print Quality and Correcting Image Data (macOS)

Check 5  Check if the print head is in the right position

Adjust the print head position.

Automatic Adjustment to Straighten Lines and Colors

Check 6  Color may be uneven if printing materials were stacked while drying

To avoid uneven colors, we recommend drying each sheet separately.

Check 7  Density may be uneven if using Glossy Paper or Coated Paper

Set Print Quality to High, and then print.

Check 8  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

Load paper of the same type as you have specified in the printer driver.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.

2. Change the type of paper in the printer driver and try printing again.

Check 9  Is Ink drying target area for Pause between scans in the touch screen menu
set to Leading edge?

If the Ink drying target area for Pause between scans is set to Leading edge, color may be uneven
approximately 4.3 to 6.3 inches (110 to 160 mm) from the front edge of the paper. (The position depends on the
Print Quality settings)

In this case, set Ink drying target area for Pause between scans to Overall.

However, note that printing will now take longer.

Menu Structure
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Image edges are blurred or white banding occurs

Check 1  Paper may be gripped too strongly over the platen

Set a lower Transport unit vacuum strength in the touch screen menu.

Adjusting Vacuum Strength

Check 2  Check if the print head is in the right position

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, set the print
head to the optimal height and then adjust the position of the print head.

Adjusting the Print Head

Setting a lower value for Paper Thickness (Head Height) in the touch screen menu may resolve the problem.

Troubleshooting Paper Abrasion and Blurry Images

Check 3  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

Load the printer with the media type specified in the printer driver.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.
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The contrast becomes uneven during printing

Check 1  Has the paper feed rate been calibrated properly?

Adjust the feed amount.

Adjusting Feed Amount

Check 2  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

Load the printer with the media type specified in the printer driver.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.

2. Change the type of paper in the printer driver and try printing again.
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The length of printed images is inaccurate in the feeding direction

Check 1  Is Set priority for Paper feed adjustment in the touch screen menu set to
Prioritize print quality?

Set Set priority for Paper feed adjustment to Prioritize length accuracy, and then carry out Adjust feed
length.

Adjusting Feed Amount

Check 2  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

Load the printer with the media type specified in the printer driver.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.
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Images are printed crooked

Check 1  Is Skew detection accuracy in the touch screen menu set to Loose or OFF?

Set Skew detection accuracy to Standard, and then reload the paper.

Menu Structure

Check 2  Is Detect paper width set to OFF?

Set Detect paper width in the touch screen menu to ON.

Menu Structure

Check 3  Has the roll paper been loaded at an angle?

If there is a gap between the roll paper and roll holder, reload the roll.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
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Documents are printed in monochrome

Check 1  Is Color Mode set to Monochrome, or Print Target set to Monochrome
(Photo) in a Windows printer driver?

In the Advanced Settings of the printer driver, specify Color in Color Mode and try printing again.

Check 2  Is Black and White Photo Print selected in a macOS printer driver?

Deselect Black and White Photo Print in the printer driver Quality & Media settings, and then print again.

Check 3  The print head nozzle may be blocked

Print a test pattern to check the color ink nozzles and see if they are clogged.

Checking for Nozzle Clogging
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Line thickness is not uniform

Check 1  Is Fast Graphic Process set to On in the Windows printer driver Special
Settings dialog box?

Access the printer driver Properties dialog box from Print in the File menu of the source application, and follow
these steps to print.

1. Deselect Preview before printing in the Main sheet.

2. Deselect Page Layout in the Layout sheet.

3. Click the Special Settings button in the Layout sheet, and then set Fast Graphic Process to Off in the
Special Settings dialog box that opens.

Check 2  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

Load the printer with the media type specified in the printer driver.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.

Check 3  Adjust the position of the print head

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, etc., set the
print head to the optimal height and then adjust the position of the print head.

Adjusting the Print Head

Note
• Setting a lower value for Paper Thickness (Head Height) in the touch screen menu may resolve the

problem.

Troubleshooting Paper Abrasion and Blurry Images
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Lines or colors are misaligned

Check 1  Adjust the position of the print head

If borders are misaligned or the print results are not uniform, adjust the position of the print head.

Adjusting the Print Head

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, etc., set the
print head to the optimal height and then adjust the position of the print head.

Changing the Print Quality and Correcting Image Data (Windows)
Changing the Print Quality and Correcting Image Data (macOS)

Note
• Setting a lower value for Paper Thickness (Head Height) in the touch screen menu may resolve the

problem.

Troubleshooting Paper Abrasion and Blurry Images

Check 2  Is the media type specified in the printer driver the same as the media type
loaded in the printer?

Load the printer with the media type specified in the printer driver.

Loading the Upper Roll on the Printer
Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.

Check 3  Perform print head angle alignment.

Select Print head angle adjustment in the touch screen menu to align the print head angle.

Adjusting Line Misalignment
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Borders appear in borderless printing

Check 1  If printing full-scale borderless, is the selected paper wider than the source
size?

For borderless printing at actual size, use roll paper that has the same width as the actual page size.

Printing Full-Size without Margins (Windows)
Printing Full-Size without Margins (macOS)

Check 2  Does the source file have margins?

Check that the printing image data does not have any objects like crop marks and transparent objects.

Check 3  Is a margin set in application software?

Check that no margins are configured in the application software you are using.

Check 4  Is the Extension for borderless printing set to Small?

In Extension for borderless printing in the touch screen menu, set Paper with recommended width and
Paper with adequate width to Standard.

Menu Structure

Check 5  Is the width of the paper recommended for borderless printing?

For paper sizes that are not recommended for borderless printing, a slight margin will automatically be generated
on the left and right.

You can set the amount of border at this time with Extension for borderless printing > Paper with adequate
width in the touch screen menu.

However, Extension for borderless printing is increased, the platen may become dirty.

For details on paper sizes recommended for borderless printing, see Paper Sizes.

Paper Sizes
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Cannot Print over Network

Cannot Connect Printer to Network

Cannot Print over TCP/IP Network

Cannot Print over Bonjour networks (macOS)
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Cannot Connect Printer to Network

Check1  Is the Ethernet cable connected correctly to the printer's Ethernet port?

Make sure the printer is connected to the network with the correct Ethernet cable, and then turn the printer on.
For instructions on connecting the cable, refer to the Setup Guide.

Check2  Make sure the Link indicator is lit.

The top and bottom indicators are lit if the printer is connected via 1000Base-T. The top indicator is green if the
printer is connected via 100Base-TX, and the bottom indicator is orange if connected via 10Base-T.

If the Link indicator is not lit, check the following points.

• The hub is on.
• The end of the Ethernet cable is connected correctly.

Insert the Ethernet cable until it clicks and locks in place.

• There is no problem with the Ethernet cable.

If there is any problem, replace the Ethernet cable.
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Cannot Print over TCP/IP Network

Check1  Is the printer's IP address configured correctly?

Make sure the printer's IP address is configured correctly.

Note
• For Windows, you can configure the printer's IP address using IJ Network Device Setup Utility.

• For wired LAN:

Performing/Changing Wired LAN Settings

• For wireless LAN:

Performing/Changing Wireless LAN Settings

Check2  Are the printer's TCP/IP network settings configured correctly?

Make sure the printer's TCP/IP network settings are configured correctly.

Check3  Is the computer you are trying to print from configured correctly?

Make sure the computer's TCP/IP network settings are configured correctly.
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Cannot Print over Bonjour networks (macOS)

Check1  Is the computer you are trying to print from configured correctly?

Make sure the computer is configured correctly.

Check2  Are the computer and printer on the same network?

Due to the nature of Bonjour, printing may not be possible if the printer is on another network behind a router.
Make sure the computer and printer are on the same network. For information about network settings, ask your
network administrator.

Check3  Are the printer's Bonjour settings configured correctly?

Make sure the Bonjour settings are configured correctly.
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Cannot Find Printer on Network

Cannot Find Printer on Check Printer Settings Screen (Windows)

Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen

Searching Printer by IP Address or Host Name During Setup

Cannot Find Printer while Using Wireless LAN

Cannot Find Printer while Using Wired LAN
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Cannot Find Printer on Check Printer Settings Screen (Windows)

If the printer cannot be found and the Check Printer Settings screen appears after searching the printer by
Automatic search on the Search for Printers screen, click Redetect and search for the printer again by
the IP address on the Search for Printers screen.

If the printer has not been found after searching it by the IP address, check network settings.
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Cannot Proceed beyond Printer Connection Screen/Connect Cable
Screen

If you cannot proceed beyond the Printer Connection screen or the Connect Cable screen, check the
following.

Check1  Make sure USB cable is securely plugged in to printer and computer.

Connect the printer and the computer using a USB cable as the illustration below. The USB port is located at the
back of the printer.

Check the items below only if you cannot proceed beyond the Printer Connection screen.

Check2  Follow procedure below to connect printer and computer again.

Important
• For macOS, make sure the lock icon is on the lower left of the Printers & Scanners screen (Print & Scan

screen in Mac OS X v10.8 or Mac OS X v10.7).

If the  icon (locked) is displayed, click the icon to unlock. (The administrator name and the password
are necessary to unlock.)
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1. Turn off printer.

2. Unplug USB cable from printer and computer and connect it again.

3. Turn on printer.

Check3  If you cannot resolve problem, follow procedure below to reinstall printer driver.

• For Windows:

1. Click Cancel.

2. Click Back to Top on Setup Canceled screen.

3. Click Exit on Start Setup screen and finish setup.

4. Turn off printer.

5. Restart computer.

6. Make sure you have no application software running.

7. Perform setup on web page.

Note
• You can use the Setup CD-ROM to redo setup.

• For Mac OS:

1. Click Next.

◦ If the screen telling you that installation has not been completed appears, click Abort on displayed
screen and finish setup.

◦ If the Connection failed. screen appears:

1. Click Next.

2. Click Next on displayed screen.

3. Click Back to Top on Select Printer screen.

4. Click Exit on Start Setup screen and finish setup.

3. Turn off printer.

4. Restart computer.

5. Make sure you have no application software running.

6. Perform setup on web page.
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Searching Printer by IP Address or Host Name During Setup

If the printer cannot be found on the Select Printer screen, search for the printer by an IP address or host
name. Select Specify the IP address and run the search radio button and click Next. The screen to select
searching criteria appears.

1. Check printer's IP address or host name.

To check the printer's IP Address or host name, print out the network settings information or use the
operation panel to display it.

• Display on the touch screen.

LAN settings

• Print the network settings.

Printing Network Settings

Note
• If you use the printer in an office, ask the network administrator.

2. Specify searching method.

Select one of the method below.

1. Search by IPv4 address

Select to search for printers by IPv4 address.

2. Search by IPv6 address

Select to search for printers by IPv6 address.
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3. Search by host name

Select to search for printers by host name. A host name is referred to as LLMNR host name or
Bonjour name.

3. Enter IP address or host name and click Next.

Printer search starts.

If an error screen appears:
Resolve the error according to the instruction on the screen.

If the IP address you entered is already used for another device, follow the procedure below to specify
printer's IP address.

1. Flick HOME screen and tap  Device settings.

Menu Operations

2. Tap LAN settings.

If you specify the administrator password, enter the password.

3. Tap Other settings.

4. Tap TCP/IP settings.

If you specify IPv4 address:
1. Tap IPv4.

2. Tap OK on the displayed screen.

3. Tap IP address.

4. Tap Manual setup.

Tapping Auto setup specifies the IP address automatically.

5. Enter IP address.

6. Tap OK.

7. Enter subnet mask.

8. Tap OK.

9. Enter default gateway.

10. Tap OK.

The IPv4 address has been specified.

If you specify IPv6 address:
1. Tap IPv6.

2. Tap OK on the displayed screen.

3. Tap Enable/disable IPv6.
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4. Tap Enable.

The IPv6 address has been specified.

Important
• If firewall is enabled on the computer, printers on a different subnet may not be detected. Disable

firewall.

If firewall interferes with printer search:

• If message appears:

If a message appears warning that Canon software is attempting to access the network, set the
security software to allow access.

After allowing the software to access, specify the IP address or host name and search for printers
again.

If the printer is found, follow the instructions on the screen to continue to set up the network
communication.

• If no message appears:

Cancel searching printers, and then set the security software to allow Canon software below to
access the network.

◦ For Windows:

Setup.exe or Setup64.exe in the win > Driver > DrvSetup folder on the Setup CD-ROM

◦ For macOS:

Setup.app, canonijnetwork.bundle, cnwidsd.plugin, cnwidss.plugin

After setting the security software, specify the IP address or host name and search for printers again.

Note
• For more on firewall settings of your operating system or security software, see instruction manual or

contact its manufacturer.
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Cannot Find Printer while Using Wireless LAN

Check1  Make sure printer is turned on.

If not, make sure the printer is securely plugged in and press ON button to turn on.

The ON lamp flashes while the printer is initializing. Wait until the ON lamp stops flashing and remains lit.

Check2  Check the network status on on the touch screen.

If the  icon is displayed, wireless LAN is disabled.

Select Activate wireless LAN on Change LAN in LAN settings.

If the  icon is displayed, see Check 3 or later checking items to make sure whether printer setup is
complete or the settings of wireless router to connect are correct.

Check3  Make sure printer setup is complete on the computer.

If it is not, perform setup.

• For Windows:

Perform setup using the Setup CD-ROM or from the web page.

• For Mac OS:

Perform setup from the web page.

Note
• IJ Network Device Setup Utility allows you to diagnose and repair the network status. Download it from the

web page.

For Windows
For Mac OS

Check4  Make sure printer and wireless router network settings match.

Make sure the network settings of the printer (e.g. wireless router name, SSID, network key, etc.) are identical
with those of the wireless router.

To check the settings of the wireless router, refer to the instruction manual provided with it or contact its
manufacturer.

Note
• Use 2.4 GHz frequency band to connect to a wireless router. Match the SSID set for the printer with that for

2.4 GHz frequency band of the wireless router.
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To check the SSID set for the printer, print out the network setting information or use the operation panel to
display it.

• Display on the touch screen.

LAN settings

• Print the network settings.

Printing Network Settings

Note
• IJ Network Device Setup Utility allows you to diagnose and repair the network status.

Select the link below to download IJ Network Device Setup Utility and install it.

Checking Printer Connection Status Using IJ Network Device Setup Utility

See below for starting up IJ Network Device Setup Utility.

• For Windows:

Starting Up IJ Network Device Setup Utility

• For Mac OS:

Starting Up IJ Network Device Setup Utility

Check5  Make sure the printer is not placed too far away from the wireless router.

If the distance between the printer and wireless router is too far, wireless communication becomes poor. Place
the printer and wireless router close to each other.

Note
• Though an antenna is attached to most wireless routers, note that some of them have it inside.

Check6  Make sure wireless signal is strong. Monitor signal strength and move printer
and wireless router as necessary.

Place the wireless router and printer where there are no obstacles between them. Wireless communication
between different rooms or floors is generally poor. Wireless communication can be impeded by building
materials containing metal or concrete. If the printer cannot communicate with the computer over a wireless LAN
due to a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a
wireless router is nearby, it may cause interference. Place the wireless router as far away from interference
sources as possible.

Note
• IJ Network Device Setup Utility allows you to diagnose and repair the network status.

Select the link below to download IJ Network Device Setup Utility and install it.

Checking Printer Connection Status Using IJ Network Device Setup Utility

See below for starting up IJ Network Device Setup Utility.

• For Windows:

Starting Up IJ Network Device Setup Utility

• For Mac OS:
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Starting Up IJ Network Device Setup Utility

Check7  Make sure the computer is connected to the wireless router.

For more on how to check the computer settings or connection status, see your computer instruction manual or
contact its manufacturer.

Note
• If you use a smartphone or tablet, make sure the Wi-Fi is enabled on the device.

Check8  Make sure Enable bidirectional support is selected in the Ports sheet of the
properties dialog box of the printer driver. (Windows)

If not, select it to enable bidirectional support.

Check9  Make sure security software's firewall is off.

If your security software's firewall is on, a message may appear warning you that Canon software is attempting
to access the network. If this warning message appears, set security software to always allow access.

If you are using any programs that switch between network environments, check their settings. Some programs
use a firewall by default.

Check10  If printer is connected to an AirPort Base Station via LAN, make sure you use
alphanumeric characters for network identifier (SSID). (Mac OS)

 

If the problem is not resolved, redo setup.

• For Windows:

Perform setup using the Setup CD-ROM or from the web page.

• For Mac OS:

Perform setup from the web page.
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Cannot Find Printer while Using Wired LAN

Check1  Make sure printer is turned on.

If not, make sure the printer is securely plugged in and press ON button to turn on.

The ON lamp flashes while the printer is initializing. Wait until the ON lamp stops flashing and remains lit.

Check2  Is  icon displayed on touch screen?

If the icon is not displayed, wired LAN is disabled.

Select Activate wired LAN on Change LAN in LAN settings.

Check3  Make sure LAN cable is connected properly.

Make sure the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the cable
properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.

Note
• IJ Network Device Setup Utility allows you to diagnose and repair the network status. Download it from the

web page.

For Windows
For Mac OS

895



Installation Problems

Removing Printer Software

Setup Processing Is Slow (Windows)

Cannot Install Printer Driver (Windows)
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Removing Printer Software

Follow the steps below to remove utility software installed on the computer.

Important
• You must log in as an administrator or have administrator permissions.

Note
• See the pages below for how to remove printer drivers.

Deleting the Unnecessary Printer Driver (Windows)
Deleting the Unnecessary Printer Driver (macOS)

Removing the IJ Network Device Setup Utility (Windows)
Follow the steps below to remove the IJ Network Device Setup Utility.

• Windows 10

1. Click the start button, select Windows System, and then select Control Panel.

2. Under Programs, select Programs and Features, select IJ Network Device Setup Utility from
the list of programs, and then click Uninstall.

• Windows 8.1

1. Use the Settings charm on the desktop to open the Control Panel.

2. Under Programs, select Programs and Features, select IJ Network Device Setup Utility from
the list of programs, and then click the Uninstall button.

• Windows 7

1. Select Control Panel from the start menu.

2. Select Uninstall a program.

3. Select IJ Network Device Setup Utility, and then click the Uninstall button.

Note
• If the User Account Control dialog box is displayed, click Yes.

Removing the IJ Network Device Setup Utility (macOS)
Follow the steps below to remove the IJ Network Device Setup Utility.

1. Select Applications from Go menu of Finder, double-click Canon Utilities > IJ Network
Tool, and then drag Canon IJ Network Tool icon into Trash.
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2. Restart computer.

Empty the Trash and restart your computer.

Note
• To reinstall IJ Network Tool, uninstall IJ Network Tool and install it again from the Canon

website.

898



Setup Processing Is Slow (Windows)

If Windows update starts during setup, or if you perform setup while Windows update is in progress, it may
take a while to register the printer or to perform other processes.

Wait for a while. This is not a malfunction.
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Cannot Install Printer Driver (Windows)

• If installation does not start when you insert Setup CD-ROM:

Follow the instructions below to start the installation.

1. Make the following settings.

◦ In Windows 10, click Start button > File Explorer, and then click This PC from list on left.

◦ In Windows 8.1, select Explorer icon in Taskbar on Desktop, and then select This PC from list
on left.

◦ In Windows 7, click Start, and then click Computer.

2. Double-click the  CD-ROM icon in the window that appears.

If the contents of the CD-ROM appear, double-click MSETUP4.EXE.

If you cannot install the printer driver with the Setup CD-ROM, install it from the Canon website.

Note
• If the CD-ROM icon does not appear, try the following:

• Remove the CD-ROM from your computer and reinsert it.

• Restart your computer.

If the icon still does not appear, try a different disc and see if it appears. If it does, there is a
problem with the Setup CD-ROM. Contact your nearest Canon service center to request a repair.
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• If you cannot get past the Printer Connection screen:

Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen

• Other cases:

Reinstall the printer driver.

If the printer driver was not installed correctly, uninstall the printer driver, restart your computer, and then
reinstall the printer driver.

Deleting the Unnecessary Printer Driver

Reinstall the printer driver with the Setup CD-ROM or install it from the Canon website.

Note
• If the installer was stopped due to a Windows error, Windows operation may be unstable, and you

may not be able to install the drivers. Restart your computer and then reinstall the drivers.
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HP-GL/2 problems

With HP-GL/2, printing is misaligned

Lines or images are missing in printed HP-GL/2 jobs.

Lines are printed too thick or thin in HP-GL/2 print jobs

HP-GL/2 jobs are printed in monochrome (or color)

Printed colors of lines are inaccurate during HP-GL/2 printing

HP-GL/2 jobs are printed 6 mm larger than specified

HP-GL/2 jobs are printed at maximum size, even if a standard size is specified

HP-GL/2 printing takes a long time

The printer stops when printing a HP-GL/2 job (the carriage stops moving)
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With HP-GL/2, printing is misaligned

Check 1  Make sure the plotter origin is correct.

Check the printing commands.

Set Detect image size to Command priority or Detected size in the touch screen menu.

Print settings

Check 2  Check the Margin setting.

Adjust the Margin setting values in the touch screen menu.

Print settings
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Lines or images are missing in printed HP-GL/2 jobs.

Check 1  Is the memory full?

Check the size of the data in the print job.

Check 2  Is the printer receiving an HP-GL/2 command not supported by this printer?

Check the print job and settings.

Check 3  Has the printer received print data that includes HP RTL commands when
Auto rotation is ON?

Set Auto rotation to OFF in the touch screen menu and print again.

Print settings

Check 4  Make sure the plotter origin is correct.

Check the printing commands.

Set Detect image size to Command priority or Detected size in the touch screen menu.

Print settings

Check 5  Is Oversize set to OFF?

Set Oversize to ON in the touch screen menu.

Print settings
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Lines are printed too thick or thin in HP-GL/2 print jobs

Check 1  Check the Width correction setting.

Change the Width correction setting in the touch screen menu.

Print settings

Check 2  Is Adjust faint lines set to OFF?

If fine lines are printed faintly, setting Adjust faint lines to ON will print the lines more distinctly.

Print settings
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HP-GL/2 jobs are printed in monochrome (or color)

Check  Check the Color mode setting.

Check the Color mode setting in the touch screen menu.

Print settings

However, for optimal Printhead performance, the printer consumes trace amounts of color ink even when
Monochrome is selected as Color mode.
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Printed colors of lines are inaccurate during HP-GL/2 printing

Check  Is Adjust faint lines set to ON?

Setting Adjust faint lines to OFF in the touch screen menu may help produce the expected results. However,
lines in some colors may appear broken.

Print settings
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HP-GL/2 jobs are printed 6 mm larger than specified

Check  Check the page size of the HP-GL/2 print job, as created in the source
application.

Set Oversize to OFF in the touch screen menu.

Print settings
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HP-GL/2 jobs are printed at maximum size, even if a standard size
is specified

Check  Check the page size of the HP-GL/2 print job, as created in the source
application.

Set Detect image size to Command priority or Detected size in the touch screen menu.

Set Conserve paper to ON in the touch screen menu.

Print settings
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HP-GL/2 printing takes a long time

Check 1  Is the print data size large?

Large print jobs with a lot of data take longer to print. Please wait a while until printing is finished.

Check 2  Is Input resolution set to 600 dpi?

Set Input resolution to 300 dpi.

Adjusting Feed Amount

910



The printer stops when printing a HP-GL/2 job (the carriage stops
moving)

Check 1  The printer is analyzing the print job.

Please wait a while until printing is finished.

Check 2  Is Input resolution set to 600 dpi?

Set Input resolution to 300 dpi.

Adjusting Feed Amount
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Other Problems

The printer does not turn on

The printer takes time to start up

If the Printer Makes a Strange Sound

Messages advising to check the maintenance cartridge are not cleared

The printer consumes a lot of ink

Printed pages are not collected cleanly in the basket

Printed pages are not collected cleanly in the stacker

Basket Lurches

When Trim edge first is set, the trimmed paper is drawn into the roll unit

Ink Level Detection
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The printer does not turn on

Check 1  Is the power cord plugged in?

Plug the power cord into the outlet, and then turn on the printer.

Check 2  Is the specified voltage being supplied?

Check the voltage of the outlet and breaker.

Specifications
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The printer takes time to start up

The printer may have shut down incorrectly last time. This may happen after power outages or if the printer
is unplugged before it is turned off.

In this case, the next time power is restored, the printer's hard disk is checked, and startup may take some
time.

Please wait a while, because it may take several minutes to finish checking the hard disk.

If an error message is displayed after the hard disk check, follow the instructions indicated to resolve the
problem.
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If the Printer Makes a Strange Sound

Check 1  Has an unusual noise been produced from the vicinity of the roll holder?

If dust accumulates on the gear (A) at the end of the roll holder, a noise may produced from that area.

When the noise starts, clean the gear with the following procedure.

1. Remove the roll holder from the printer.

2. Wipe the dust off the gear with a damp, tightly wrung cloth, and then dry with a dry cloth.

3. Insert the roll holder in the printer.

Check 2  Operating noise may be heard from the printer even when not printing.

The following sounds do not indicate a problem with the printer.

• A suction sound can be heard from the platen

To prevent the paper from rising, the surface of the platen has vacuum holes that create suction on the
paper.

• Roll paper makes a fluttering sound during printing.

There may be a fluttering sound when large paper is advanced.

• You suddenly hear the sound of cleaning operations.

Cleaning is automatically performed at specified intervals in order to keep the printer maintained.

• You suddenly hear the sound of ink agitation.

Ink is automatically agitated after specified intervals to maintain optimal print quality. Agitation takes
approximately 1 minute 30 seconds.
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Ink is also agitated automatically at the following times. Please note that no other operations can be
performed while "Agitating the ink" is on the touch screen.

◦ After the printer is turned on
◦ After data transmission
◦ After ink tank replacement

In other cases, contact your Canon dealer.
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Messages advising to check the maintenance cartridge are not
cleared

The newly replaced maintenance cartridge is not recognized.

Remove the newly replaced maintenance cartridge, and then reinsert it again firmly.

Replacing the Maintenance Cartridge
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The printer consumes a lot of ink

Check 1  Are lots of full-color materials being printed?

In print jobs such as photos, images are filled with color. This consumes a lot of ink. This does not indicate a
problem with the printer.

Check 2  Is System cleaning being carried out frequently?

System cleaning uses a lot of ink. This is normal. We recommend that you only carry out System cleaning
after the printer has been transported, if has not been used for a long time, or if there is a problem with the print
head.

Check 3  You have just finished initial installation, when more ink is consumed to fill the
system.

If using the printer for the first time, or using it after transport, the ink tank will supply an initial fill of ink to the print
head.

Although the amount of remaining ink may drop as a result, it does not indicate a problem.

Check 4  Is the print head nozzle blocked?

Check for nozzle clogging.

Checking for Nozzle Clogging
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Printed pages are not collected cleanly in the basket

Check 1  Is the roll unit in place?

The basket may not be able to catch printed paper properly if the roll unit is in place.

Refer to Example Basket Configurations and try another basket position.

Example Basket Configurations

Check 2  Is the basket in the right position for the media size?

The optimal basket position depends on factors such as media size and the conditions the printer is being used
under.

Refer to Example Basket Configurations and try another basket position.

Example Basket Configurations
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Printed pages are not collected cleanly in the stacker

Check  Is the stacker in the right position for the media size?

The optimal stacker position depends on factors such as media size and the conditions the printer is being used
under.

Refer to Example Stacker Configurations and try another stacker position.

Example Stacker Configurations
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Basket Lurches

Make sure a Basket Locking Support is attached to the Basket Arm. The basket may lurch if a force is
applied to the one without the Basket Locking Support. To prevent the basket from lurching, attach the
Basket Locking Supports to both sides of the Basket Arm.

Using the Basket
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When Trim edge first is set, the trimmed paper is drawn into the
roll unit

Check  Is the basket in position 1?

If the roll unit is being used as a paper feeder and the basket is in position 1, the paper strip discarded by Trim
edge first for borderless printing or paper loading may get drawn into the roll unit.

In this situation, refer to Example Basket Configurations and try another position.

Example Basket Configurations
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Ink Level Detection

The printer ink tank detects the amount of ink remaining to prevent running out of ink while printing and to
avoid printer failure.

Ink Tanks

When using an ink tank refilled with ink, the function for detecting the remaining ink level may not operate
properly and printing may stop. If you want to use an ink tank refilled with ink, you need to disable the
function for detecting the remaining ink level.

Printing with the ink level detection canceled may lead to printer damage and printing problems. Canon Inc.
is not liable for any damage that may occur as a result of refilling ink.

Important
• Once the function for detecting the remaining ink level is disabled, it cannot be restored for that ink

tank. To restore the function for detecting the remaining ink level, replace the ink tank with a new ink
tank for that printer.

• Repeatedly removing and inserting the same ink tank can cause the contacts between the ink tank and
printer to malfunction, ink may leak from the ink tank, and the printer may become damaged.

Releasing ink level detection
Ink level detection will be deactivated if you load ink tanks once emptied.

If The above ink tank may be an ink tank that ran out of genuine Canon ink or a counterfeit Canon
ink tank. appears on the touch screen, follow the steps below.

1. Move through the screens, performing the actions described in the messages that appear on the
touch screen.

2. If an instruction to disable detection of remaining ink appears on the touch screen, hold down the
Stop button for at least 5 seconds and then release it.

Ink level detection is now released.
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List of Support Code for Error

Support codes appear on the PC when an error occurs.

Support codes are error identification numbers that appear alongside error messages.

If an error occurs, check the support code and follow the recommended steps to resolve the issue.

Support code displayed

• 1000 to 1ZZZ

1005 100A 100B 100E 100F 1012

1018 1019 1021 1022 1023 1024

1025 1034 1035 1036 1039 1040

1051 1052 1054 1055 1056 1057

1058 1059 1061 1200 1201 1210

1213 1214 1300 1306 1317 1318

1322 1323 1324 1325 1326 1327

1328 1329 1401 1403 1408 1409

140A 140B 140C 140F 1468 1477

1478 1480 1481 1485 1492 1494

1495 1500 1551 1552 1570 1571

1660 168B 1720 1721 1722 1730

1731 1752 1753 1756 1757 1875

• 2000 to 2ZZZ

2001 2002 2130 2131 2132  

• 3000 to 3ZZZ

3000 3001 3200 3201 3250 3300

3301 3302 3303 3304 3306 3311

3312 3313 3314 3315 3316 3317

3330 3331 3332 3333 3334 3335

3336 3340 3341 3350 3351 3352

3414 3415 3416 3417 3418 3419

924



3420 3421 3422 3423 3424 3448

• 4000 to 4ZZZ

4107 4111 4112 4113 4114 4115

4116 4117 4118 4119 4120 4121

4801 4803 4804 4805 4806 4900

4901 4903 4905 4909 4910 4911

4913 4920 4922 4931 4932 4933

4934 4935 4937 4950 4952 4953

4954 4955 4956    

• 5000 to 5ZZZ

5106 5200 5A60 5A61 5B16 5B20

5B21 5C00     

• 6000 to 6ZZZ

6502 6700 6702 6820 6900 6901

6902 6910 6911 6920 6921 6930

6931 6932 6933 6940 6941 6942

6943 6944 6945 6946   

• 7000 to 7ZZZ

7001 7003 7004 7005 7006 7050

7051 7052     

• 8000 to 8ZZZ

8200      

• 9000 to 9ZZZ

9000 9110     

• A000 to ZZZZ

B20A B510     
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1005

Cause
You have attempted to print on a sheet, but no sheet is loaded.

What to Do
Check the media size and type for the print job on the touch screen, and then tap OK.

• Continuing to print

Tap Load paper, and then load the paper.

Loading and Printing on Sheets

• Stopping printing

To stop printing, tap Cancel on the touch screen or press the Stop button.
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100A

Cause
You have attempted to print from Roll 1 (Upper), but no roll is loaded.

What to Do
Tap Load paper on the touch screen, and then load the paper roll and print.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer

Note
• To stop printing, tap Cancel on the touch screen or press the Stop button.
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100B

Cause
Tried to print from Roll 2 (Lower) but no paper roll has been loaded.

What to Do
Tap Load paper on the touch screen, and then load the paper roll and print.

Loading Rolls on the Roll Holder
Loading the Lower Roll on the Roll Unit (Option)

Note
• To stop printing, tap Cancel on the touch screen or press the Stop button.
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100E

Cause
A printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC16-202E
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100F

Cause
A printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC17-202F
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1012

Cause
You have attempted to print on a sheet, but no sheet is loaded.

What to Do
Tap Load paper on the touch screen, and then load cut paper and print.

Loading and Printing on Sheets

Note
• To stop printing, tap Cancel on the touch screen or press the Stop button.
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1018

Cause
Roll 1 (Upper) feeder has not been calibrated.

What to Do
Calibrating, please remove the upper roll holder.

Removing the Upper Roll from the Printer
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1019

Cause
The roll unit feeder has not been calibrated.

What to Do
Calibrating, please remove the roll holder on the roll unit.

Removing the Lower Roll from the Roll Unit (Option)
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1021

Cause
The printer has received a print job longer than the amount of roll paper left.

What to Do

• Continuing to print

To continue printing, tap Print with the loaded paper. on the touch screen.

However, the roll paper may run out during the print job and you may not be able to print all of the
document.

• Replacing paper

Tap Replace the paper and print and print on the touch screen.

Change the Paper Source in the printer driver, or replace the paper with paper of the right length for
the print job, and then try again.

If using the Media Take-up Unit, tap Cancel on the touch screen to stop printing.

Remove the printed paper from the Media Take-up Unit, replace the paper with paper of the right
length for the print job, and then try again.

Removing the Upper Roll from the Printer
Loading the Upper Roll on the Printer
Removing Printed Paper from the Roll Unit

• Stopping printing

To stop printing, tap Cancel on the touch screen or press the Stop button.
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1022

Cause
Received print job that is longer than paper length remaining on Roll 1 (Upper).

What to Do

• Continuing to print

To continue printing, tap Print with the loaded paper. on the touch screen.

However, the roll paper may run out during the print job and you may not be able to print all of the
document.

• Replacing paper

Tap Replace the paper and print on the touch screen.

Change the Paper Source in the printer driver, or replace the paper with paper of the right length for
the print job, and then try again.

Removing the Upper Roll from the Printer
Loading the Upper Roll on the Printer

• Stopping printing

To stop printing, tap Cancel on the touch screen or press the Stop button.
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1023

Cause
Received print job that is longer than paper length remaining on Roll 2 (Lower).

What to Do

• Continuing to print

To continue printing, tap Print with the loaded paper. on the touch screen.

However, the roll paper may run out during the print job and you may not be able to print all of the
document.

• Replacing paper

Tap Replace the paper and print on the touch screen.

Change the Paper Source in the printer driver, or replace the paper with paper of the right length for
the print job, and then try again.

Removing the Lower Roll from the Roll Unit (Option)
Loading the Lower Roll on the Roll Unit (Option)

• Stopping printing

To stop printing, tap Cancel on the touch screen or press the Stop button.
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1024

Cause
Possible causes include the following.

• Roll paper is empty in Roll 1 (Upper).
• There is remaining roll paper in Roll 1 (Upper), but because it could not be advanced, it could not be

detected.

What to Do

• The roll paper has run out

Follow the steps below to replace the used roll with a new roll of the same type and size.

1. Lift up the release lever and remove the roll paper.

Removing the Upper Roll from the Printer
Removing Rolls From the Roll Holder

2. Load the new roll.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer

3. If no barcode was printed on the roll, specify the paper type.

Changing the Type of Paper

4. If Manage remaining roll amount is set to Barcodes in the touch screen menu and there is no
barcode printed on the paper roll, set the paper length.

Specifying the Paper Length

5. If "There is a job whose printing is not complete. Do you want to print this job?" appears on
the touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

• Feed stopped because the end of the paper roll is attached to the core with tape

Remove the used roll paper and insert a new roll paper.

Removing the Upper Roll from the Printer
Removing Rolls From the Roll Holder
Loading and Printing on Rolls

• Feed stopped because the remaining paper roll is too heavy

It may be helpful to change the printing mode, which will change the paper feed timing.

If using Windows, select a higher Print Quality setting under Advanced Settings in the printer driver.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality
setting.

Setting the Print Quality Level (Custom) (Windows)
Setting the Print Quality Level (Custom) (macOS)
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Note
• To stop printing, press the Stop button.
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1025

Cause
Roll paper in Roll 2 (Lower) is empty.

What to Do
Follow the steps below to replace the used roll with a new roll of the same type and size.

1. Lift up the release lever and remove the roll paper.

Removing the Lower Roll from the Roll Unit (Option)
Removing Rolls From the Roll Holder

2. Load the new roll.

Loading Rolls on the Roll Holder
Loading the Lower Roll on the Roll Unit (Option)

3. If no barcode was printed on the roll, specify the paper type.

Changing the Type of Paper

4. If Manage remaining roll amount is set to Barcodes in the touch screen menu and there is no
barcode printed on the paper roll, set the paper length.

Specifying the Paper Length

5. If "There is a job whose printing is not complete. Do you want to print this job?" appears on the
touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

Note
• To stop printing, press the Stop button.
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1034

Cause
No upper roll is loaded in printer.

What to Do

• Continuing to print

Load an upper roll in the printer and print.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer

If an upper roll is loaded in the printer, feed the roll paper manually.

Loading the Upper Roll on the Printer

• Stopping printing

To stop printing, tap OK on the touch screen.

Note
• When Roll paper auto feed is set to Disable, roll paper is not fed automatically. Check the settings.
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1035

Cause
No lower roll is loaded in roll unit.

What to Do

• Continuing to print

Load a lower roll in the roll unit and print.

Loading Rolls on the Roll Holder
Loading the Lower Roll on the Roll Unit (Option)

If a lower roll is loaded in the roll unit, feed the roll paper manually.

Loading the Lower Roll on the Roll Unit (Option)

• Stopping printing

To stop printing, tap OK on the touch screen.

Note
• When Roll paper auto feed is set to Disable, roll paper is not fed automatically. Check the settings.
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1036

Cause
Printer tried printing from Roll 2 (Lower), but optional roll unit is not installed in lower position of printer.

What to Do
Check if the roll unit is properly installed on the printer following the steps below.

1. Tap OK on the touch screen to stop printing.
2. Turn off the power and make sure the roll unit is properly installed on the printer.

Note
• For instructions on installing the roll unit, see the Roll Unit Setup Guide provided with the roll unit.
• Make sure the roll unit's connection cable is inserted all the way in.

If the error appears again, the printer may be damaged. Contact a Canon customer service center.
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1039

Cause
Unsupported roll unit is installed on printer.

What to Do
Turn off the power and remove the roll unit.

Check the model number of the roll unit. Install a roll unit supported by the printer.

Roll Unit

Note
• For instructions on installing the roll unit, see the Roll Unit Setup Guide provided with the roll unit.

If the error appears again, the printer may be damaged. Contact a Canon customer service center.
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1040

Cause
Unsupported roll unit is installed on printer.

What to Do
Turn off the power and remove the roll unit.

Check the model number of the roll unit. Install a roll unit supported by the printer.

Roll Unit

Note
• For instructions on installing the roll unit, see the Roll Unit Setup Guide provided with the roll unit.

If the error appears again, the printer may be damaged. Contact a Canon customer service center.
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1051

Cause
The media type specified in the printer driver is not the same as the media type loaded in the printer.

What to Do
You can continue to print, but note that this error may cause problems in the printing results.
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1052

Cause
The width of the roll paper set in Fit Roll Paper Width in the printer driver is not the same as the width of
the roll paper loaded in the printer.

What to Do
You can continue to print, but note that this error may cause problems in the printing results.
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1054

Cause
The paper in the printer is smaller than the paper size set in the printer driver.

What to Do
You can continue to print, but note that this error may cause problems in the printing results.
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1055

Cause
The paper size in the printer cannot be printed borderless.

What to Do
You can continue to print, but note that this error may cause problems in the printing results.
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1056

Cause
The paper position is not suitable for borderless printing.

What to Do
You can continue to print, but note that this error may cause problems in the printing results.
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1057

Cause
The paper position is not suitable for borderless printing.

What to Do
You can continue to print, but note that this error may cause problems in the printing results.
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1058

Cause
Roll paper in Roll 1 (Upper) has almost run out.

What to Do
Printing will continue. Replace the upper roll in the printer with one that has enough paper for printing as
soon as possible.

Removing the Upper Roll from the Printer
Loading the Upper Roll on the Printer

Note
• To stop printing, press the Stop button.

951



1059

Cause
Roll paper in Roll 2 (Lower) has almost run out.

What to Do
Printing will continue. Replace the lower roll in the roll unit with one that has enough paper for printing as
soon as possible.

Removing the Lower Roll from the Roll Unit (Option)
Loading the Lower Roll on the Roll Unit (Option)

Note
• To stop printing, press the Stop button.
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1061

Cause
The media type specified in the printer driver is not the same as the media type loaded in the printer.

What to Do
Tap OK on the touch screen.

Make sure that the media type that appears on the touch screen is the same as the media type that has
been loaded, and then tap OK.

• Printing again

Follow the steps below to match the media type in the printer driver and the media type specified for
the printer.

1. Tap Cancel to stop printing.
2. Change the media type in the printer driver settings to the media type loaded in the printer, and

then try again.

• Replacing paper

Follow the steps below to match the media type in the printer driver and the media type specified for
the printer.

1. Tap Replace the paper and print.
2. Load the paper with the media type specified in the printer driver.

Loading and Printing on Rolls

Loading and Printing on Sheets

• Continuing to print

To continue printing, tap Print with the loaded paper. on the touch screen.

However, note that this error may cause paper jams and affect the printing quality.
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1200

Cause
Top cover or print head lock lever is open.

What to Do
Open the top cover and make sure the print head lock lever is closed properly.

Make sure there are no foreign objects caught in the top cover, and then close the top cover.

If this error appears again, close the top cover, turn the power off, wait a moment, and then turn the power
back on.

Note
• If installing a print head, close the top cover after finishing.
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1201

Cause
The ink tank cover is open.

What to Do
Close the ink tank cover.
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1210

Cause
The ink tank cover is open.

What to Do
Close the ink tank cover.
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1213

Cause
Release lever is lifted up.

What to Do
Lower the release lever.

If the error occurs again, turn off the printer and wait a while before restoring power.
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1214

Cause
A printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC19-2F21 EC51-2F38

958



1300

Cause
Paper jammed inside the printer while printing.

What to Do
Follow these steps below to remove jammed paper.

1. Lift up the release lever and remove the jammed paper.

Clearing Jammed Roll Paper
Clearing a Jammed Sheet

2. Load the paper.

Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)
Loading Sheets in the Printer

3. If "There is a job whose printing is not complete. Do you want to print this job?" appears on the
touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

If the error appears again, the printer may be damaged. Contact a Canon customer service center.

959



1306

Cause
A print job for rolls was received when a sheet is loaded.

What to Do
Follow these steps to load and print on a roll.

1. To remove the cut paper, tap Remove paper on the touch screen.

Removing Sheets

2. Load a new roll.

Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

Note
• To stop printing, tap Cancel on the touch screen or press the Stop button.
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1317

Cause
Paper loaded crooked was detected when the paper was advanced.

What to Do
Lift up the release lever and reload the paper.

Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)
Loading Sheets in the Printer

If this error appears again even after reloading the paper roll, remove the roll holder from the printer, insert
the paper roll firmly into the roll holder until it is up against the flange, and then insert the roll holder into
the printer.

Loading Rolls on the Roll Holder

Important
• If this message continues to appear even after taking the steps above, or if you do not want this

message to appear, set Skew detection accuracy in the printer menu to OFF or Loose. However,
note that the paper will be printed skewed, which could cause paper jams and abnormal print results,
or dirty the platen and the reverse of the next printed sheet.
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1318

Cause
A printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC0F-2F93
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1322

Cause
Cannot detect paper size because paper is not in the correct position or because curled paper has been
loaded.

What to Do
Lift up the release lever and reload the paper.

Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)
Loading Sheets in the Printer

If "There is a job whose printing is not complete. Do you want to print this job?" appears on the
touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

Note
• If this error appears again even after reloading the paper roll, remove the roll holder from the printer,

insert the paper roll firmly into the roll holder until it is up against the flange, and then insert the roll
holder into the printer.

Loading Rolls on the Roll Holder

• This error might also appear if the platen has been dirtied by ink or another substance, or if the size
of clear film could not be detected. In this case, open the top cover and clean the entire platen area.

Cleaning Inside the Top Cover
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1323

Cause
An unsuitable paper size has been loaded.

What to Do
Lift up the release lever and reload paper of suitable size.

Paper Sizes

Note
• Load unused A4/letter size or larger paper if printing calibration and nozzle check patterns. Each

calibration may take several sheets of paper.
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1324

Cause
A print job for printing on sheets was sent when a roll is loaded.

What to Do
Follow the steps below to print again.

1. Tap Remove paper on the touch screen to stop printing.
2. Remove the paper roll, load cut paper of the size and type specified in the printer driver, and then try

again.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)
Loading and Printing on Sheets

Note
• To stop printing, tap Cancel on the touch screen or press the Stop button.
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1325

Cause
Received cut paper print data when using roll unit on Media Take-up Unit.

What to Do
Follow the steps below to print again.

1. Tap Cancel on the touch screen to stop printing.
2. Remove the paper roll, load cut paper of the size and type specified in the printer driver, and then try

again.

Removing Printed Paper from the Roll Unit
Loading and Printing on Sheets
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1326

Cause
Printer could not feed upper roll.

What to Do
Fully rewind the upper roll in the printer manually, check the following, and then tap OK on the touch
screen.

• Is the edge of the roll paper at a slant or folded?

If the edge of the roll paper is at a slant or is folded, use scissors or a cutting tool to cut it away and
straighten the edge of the roll paper.

• Is the roll paper loaded in the opposite orientation?

Load the roll paper in correct orientation.

• Is the roll paper loose?

If the roll paper is loose, remove the slack before loading the roll paper.

• Is the paper wrinkled or curled?

If the paper is wrinkled or curled, straighten it out before loading it.

To continue paper feeding, tap OK on the touch screen and feed the paper manually.

Loading the Upper Roll on the Printer
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1327

Cause
Printer could not feed roll paper from roll unit (lower).

What to Do
Fully rewind the roll paper in the roll unit (lower) manually, check the following, and then tap OK on the
touch screen.

• Is the edge of the roll paper at a slant or folded?

If the edge of the roll paper is at a slant or is folded, use scissors or a cutting tool to cut it away and
straighten the edge of the roll paper.

• Is the roll paper loaded in the opposite orientation?

Load the roll paper in correct orientation.

• Is the roll paper loose?

If the roll paper is loose, remove the slack before loading the roll paper.

• Is the paper wrinkled or curled?

If the paper is wrinkled or curled, straighten it out before loading it.

To continue paper feeding, tap OK on the touch screen and feed the paper manually.

Loading the Lower Roll on the Roll Unit (Option)
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1328

Cause
Upper roll jammed.

What to Do
Fully rewind the upper roll in the printer manually, check the following, and then tap OK on the touch
screen.

• Is the edge of the roll paper at a slant or folded?

If the edge of the roll paper is at a slant or is folded, use scissors or a cutting tool to cut it away and
straighten the edge of the roll paper.

• Is the roll paper loaded in the opposite orientation?

Load the roll paper in correct orientation.

• Is the roll paper loose?

If the roll paper is loose, remove the slack before loading the roll paper.

• Is the paper wrinkled or curled?

If the paper is wrinkled or curled, straighten it out before loading it.

To continue paper feeding, tap OK on the touch screen and feed paper manually.

Loading the Upper Roll on the Printer

If the error appears again, the printer may be damaged. Contact a Canon customer service center.
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1329

Cause
Roll paper jammed in roll unit (lower).

What to Do
Fully rewind the roll paper in the roll unit (lower) manually, check the following, and then tap OK on the
touch screen.

• Is the edge of the roll paper at a slant or folded?

If the edge of the roll paper is at a slant or is folded, use scissors or a cutting tool to cut it away and
straighten the edge of the roll paper.

• Is the roll paper loaded in the opposite orientation?

Load the roll paper in correct orientation.

• Is the roll paper loose?

If the roll paper is loose, remove the slack before loading the roll paper.

• Is the paper wrinkled or curled?

If the paper is wrinkled or curled, straighten it out before loading it.

To continue paper feeding, tap OK on the touch screen and feed paper manually.

Loading the Lower Roll on the Roll Unit (Option)

If the error appears again, the printer may be damaged. Contact a Canon customer service center.
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1401

Cause
Failed to recognize print head.

What to Do
Open the top cover and reattach the print head.

Replacing the Print Head
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1403

Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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1408

Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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1409

Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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140A

Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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140B

Cause
Failed to recognize print head.

What to Do
Open the top cover and reattach the print head.

Replacing the Print Head
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140C

Cause
There is a problem with the print head.

What to Do
Turn off the power, wait a moment, and then turn it back on.

977



140F

Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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1468

Cause
Printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC55-2F24
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1477

Cause
There is a problem with the print head.

What to Do
Open the top cover and replace the print head with a new one.

Replacing the Print Head
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1478

Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you
have the new one.
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1480

Cause
The attached print head was previously used in a different model.

What to Do
Attach the correct print head.

Replacing the Print Head
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1481

Cause
The attached print head was previously used in a model that uses a different ink set.

What to Do
Attach the correct print head.

Replacing the Print Head

983



1485

Cause
Cannot use attached print head.

What to Do
Attach the correct print head.

Replacing the Print Head
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1492

Cause
A printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC02-2F42 EC21-2F44 EC3F-2F40 EC3F-2F41
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1494

Cause
There may be a problem with the print head.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, remove and reattach the print head.

Replacing the Print Head

If that does not get rid of the error, replace the print head with a new one.
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1495

Cause
The print head nozzle is blocked.

What to Do
Follow the steps below to clean the print head.

1. Tap Cancel on the touch screen to stop printing.
2. Clean the print head.

Cleaning the Print Head

If this message still appears when printing, replace the print head.

Replacing the Print Head

Important
• To continue printing, use the touch screen and tap Continue printing. However, the print results may

not be satisfactory.
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1500

Cause
The ink in the ink tank is running low.

What to Do
Prepare a new ink tank.
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1551

Cause
A genuine Canon ink tank with a history of past use has been detected.

What to Do
To dismiss the message, tap OK on the touch screen.
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1552

Cause
A genuine Canon ink tank has been inserted.

What to Do
To dismiss the message, tap OK on the touch screen.
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1570

Cause
The ink in the ink tank has run out.

What to Do
Open the ink tank cover, and then replace the ink tank before the ink in the sub-ink tank of this printer
becomes insufficient.

Replacing Ink Tanks

Note
• You can replace the ink tank even while printing.
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1571

Cause
Ink tank removed during printing.

What to Do
If replacing the ink tank, insert a new ink tank.

Replacing Ink Tanks
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1660

Cause
Ink tank not inserted.

What to Do
Insert the ink tank correctly.

Replacing Ink Tanks
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168B

Cause
The ink tank cannot be recognized.

Printing cannot be executed because the ink tank may not be compatible with this printer.

What to Do
Install the appropriate ink tank.
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1720

Cause
The maintenance cartridge is full.

It needs to be replaced.

What to Do
Replace the maintenance cartridge.

Replacing the Maintenance Cartridge
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1721

Cause
The maintenance cartridge is not installed.

What to Do
Install the maintenance cartridge.

Replacing the Maintenance Cartridge
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1722

Cause
Incorrect type of maintenance cartridge.

What to Do
Insert the correct maintenance cartridge.

Replacing the Maintenance Cartridge

If this error continues to appear, contact a Canon customer service center.
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1730

Cause
The ink tank may be an ink tank that ran out of genuine Canon ink or a counterfeit Canon ink tank.

What to Do
To print, you must replace the ink tank or disable the function for detecting the remaining ink level.

To disable the function for detecting the remaining ink level, press and hold the printer's Stop button for at
least 5 seconds, and then release it.

By this operation, the fact that you have disabled the function for detecting the remaining ink level will be
memorized. Please be advised that Canon shall not be liable for any malfunction or trouble caused by
continuation of printing under the ink out condition or by using refilled ink tanks.

Note
• If the function for detecting the remaining ink level is disabled, the ink tank in gray is displayed on the

touch screen when checking the current ink level.

To report the counterfeit ink tank, access Canon website from the following link.

Report Counterfeit
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1731

Cause
Non-genuine Canon ink tank has been detected.

What to Do
To print, you must replace the ink tank or disable the function for detecting the remaining ink level.

To disable the function for detecting the remaining ink level, press and hold the printer's Stop button for at
least 5 seconds, and then release it.

By this operation, the fact that you have disabled the function for detecting the remaining ink level will be
memorized. Please be advised that Canon shall not be liable for any malfunction or trouble caused by
using a non-genuine Canon ink tank.

Note
• If the function for detecting the remaining ink level is disabled, the ink tank in gray is displayed on the

touch screen when checking the current ink level.

To report the counterfeit ink tank, access Canon website from the following link.

Report Counterfeit
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1752

Cause
The ink has run out.

What to Do
Open the ink tank cover, and then replace the ink tank.

Replacing Ink Tanks
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1753

Cause
The remaining level of the ink cannot be correctly detected.

What to Do
Replace the ink tank. Printing will restart.

Replacing Ink Tanks

An ink tank that was once empty is installed.

If you want to continue printing, you need to disable the function for detecting the remaining ink level.

To disable this function, press and hold the printer's Stop button for at least 5 seconds, and then release
it.

With this operation, disabling the function for detecting the remaining ink level is memorized.

Please be advised that Canon shall not be liable for any malfunction or trouble caused by continuation of
printing under the ink out condition or by using refilled ink tanks.
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1756

Cause
The ink may become insufficient.

What to Do
To perform the next process or to continue the specified process, replace the ink tank.

Replacing Ink Tanks
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1757

Cause
Cannot fill ink reserve tank.

What to Do
Check the touch screen, remove the ink tank for the affected color, and then reinsert it.

If the inserted ink tank is empty, replace it with a new ink tank.

Replacing Ink Tanks
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1875

Cause
Attempted to print on roll unit roll paper, but roll unit is not powered on or has been removed.

What to Do
Turn off the power and check the connection with the roll unit.

Roll Unit
Switching Roll Unit Modes

1004



2001

Cause
An incompatible device is connected.

What to Do
Check the device connected to the USB flash drive port.

Only USB flash drive can be connected to this device for direct printing.
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2002

Cause
An incompatible USB hub is connected.

What to Do
If USB flash drive is connected to this device through a USB hub, remove the USB hub.

Connect the USB flash drive directly to this device.
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2130

Cause
The roll paper width set in the print job is not the same as the width of the roll paper in the printer.

What to Do
Tap OK on the touch screen to go to the next screen.

Check the media type and size that appear and tap OK.

• Printing without changes

Tap Print with the loaded paper..

However, note that this error may cause paper jams and affect the printing quality.

• Stopping printing

Tap Cancel on the touch screen or press the Stop button.

• Replacing the roll paper

Follow the steps below to replace the paper with roll paper of the width set in the printer driver.

1. Tap Replace the paper and print, then remove the roll paper.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)
Removing Rolls From the Roll Holder

2. Replace the paper with paper of the width set in the printer driver.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

Printing begins.

Note
• To change print settings in Windows, select Fit Roll Paper Width in the printer driver and set the roll

paper width in the dialog box that appears.
• To change print settings in macOS, open the printer driver and select Fit Roll Paper Width, and then

set the roll paper width in that panel to the width of the paper loaded in the printer.
• To suppress this message, set Detect paper setting mismatch in the touch screen menu to Do not

detect. However, note that this error may affect the printing quality.

Menu Structure
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2131

Cause
The roll paper loaded in the printer is narrower than the roll paper width in the print job.

What to Do
Tap OK on the touch screen to go to the next screen.

Check the media type and size that appear and tap OK.

• Printing without changes

Tap Print with the loaded paper..

However, note that this error may cause paper jams and affect the printing quality.

• Stopping printing

Tap Cancel on the touch screen or press the Stop button.

• Replacing the roll paper

Follow the steps below to replace the paper with roll paper of the width specified in the print job paper
size settings.

1. Tap Replace the paper and print, then remove the roll paper.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)
Removing Rolls From the Roll Holder

2. Replace the paper with paper of the width set in the printer driver.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

Printing begins.

Note
• To change print settings in Windows, select Fit Roll Paper Width in the printer driver and set the roll

paper width in the dialog box that appears.
• To change print settings in macOS, open the printer driver and select Fit Roll Paper Width, and then

set the roll paper width in that panel to the width of the paper loaded in the printer.
• To suppress this message, set Detect paper setting mismatch in the touch screen menu to Do not

detect. However, note that this error may affect the printing quality.

Menu Structure
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2132

Cause
Cannot print internal printer data, such as test prints, for the following reasons.

• The paper roll loaded in the printer is too small.
• The cut paper loaded in the printer is the wrong size or type.

What to Do

• Roll

Tap Replace the paper and print on the touch screen, or lift up the release lever and replace the
paper with paper of the correct size.

To stop printing, tap Cancel or press the Stop button.

• Sheet

Lift up the release lever and load paper of the same size and type as the first page.

To stop printing, press the Stop button.
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3000

Cause
The print head has not been calibrated.

What to Do
Print head alignment is recommended.

Adjusting the Print Head

Note
• This message will appear until Print head alignment is carried out.
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3001

Cause
The print head nozzle is becoming blocked.

What to Do
Check the printed materials.

If the printed materials are scratched, clean the print head.

Cleaning the Print Head
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3200

Cause
It is almost time to replace consumables for which service is required.

What to Do
This can used for a little while, until the message "Part replacement needed." appears.

Contact your Canon dealer for assistance.
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3201

Cause
It is past the recommended time to replace consumables for which service is required.

What to Do
Contact your Canon dealer for assistance.
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3250

Cause
The maintenance cartridge is almost full.

What to Do
Prepare a new maintenance cartridge because an error may occur if you continue to use the printer while
the maintenance cartridge is full.

Replacing the Maintenance Cartridge
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3300

Cause
Printer memory is full in HP-GL/2 emulation mode.

What to Do
Check the print data.

Printing will continue, but you may not obtain correct printing results.

Check the printing results.
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3301

Cause
Parameter specified in HP-GL/2 command is not supported.

What to Do
Check the print data.

Printing will continue, but you may not obtain correct printing results.

Check the printing results.
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3302

Cause
Unsupported HP-GL/2 command was used.

What to Do
Check the print data.

Printing will continue, but you may not obtain correct printing results.

Check the printing results.
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3303

Cause
Printer memory is full in HP-GL/2 emulation mode.

What to Do
Check the print data.

Printing will continue, but you may not obtain correct printing results.

Check the printing results.
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3304

Cause
Printer memory is full in HP-GL/2 emulation mode.

What to Do
Check the print data.

Printing will continue, but you may not obtain correct printing results.

Check the printing results.
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3306

Cause
Media information cannot be recognized because the printer media information is corrupt.

What to Do
Start the Media Configuration Tool, and then recover the media information.

Media Configuration Tool Guide (Windows)
Media Configuration Tool Guide (macOS)

To set the Media Configuration Tool to recovery mode, open the Media Configuration Tool, select this
device and then click OK.

Select and load the media information backup file.

If you do not have a media information backup file, contact a Canon customer service center.
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3311

Cause
Incorrect print data.

Illegal number of parameters.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3312

Cause
Incorrect print data.

Required items have been omitted.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3313

Cause
Incorrect print data.

Data out of range.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3314

Cause
Incorrect print data.

Resolution value out of range.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3315

Cause
Incorrect print data.

Compression method value out of range.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3316

Cause
Incorrect print data.

Incorrect data formatting (color sequence, bit count).

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3317

Cause
Incorrect print data.

Illegal combination of resolution and image data format.

What to Do
Defective print data, please check the print results.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3330

Cause
Print data may be corrupt.

What to Do
Check the print job.
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3331

Cause
Print results may be abnormal as there is a large volume of print data.

What to Do
Check the print job.
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3332

Cause
Unsupported JPEG data format.

What to Do
Print from a PC.
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3333

Cause
Unsupported JPEG data format.

What to Do
Print from a PC.
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3334

Cause
PDF data is print protected.

What to Do
Open the PDF file in Adobe Acrobat and make sure it can be printed.
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3335

Cause
Corrupt PDF file.

What to Do
Open the PDF file in Adobe Acrobat and check it.

The file can also be printed from Acrobat.
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3336

Cause
Too many fonts are used in the PDF file, causing a memory shortage.

Printing will continue but some incorrect characters will be printed.

What to Do
Print the PDF file from a computer or convert the PDF file to JPEG and then print it.
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3340

Cause
There are no image processing parameters set in printing data.

What to Do
Check the media information at the printer driver.

If the media information set at the printer does not match the media information at the printer driver,
update the media information at the printer driver.

Updating Media Information in Printer Driver (Windows)
Updating Media Information in Printer Driver (macOS)

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3341

Cause
Print data contains illegal image processing table.

What to Do
Check the print job image processing table.

If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
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3350

Cause
Free space on the personal box on the printer hard disk is less than 1 GB.

What to Do
Delete unneeded jobs stored in personal boxes.

Deleting Saved Jobs
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3351

Cause
100 jobs are stored in the personal box.

What to Do
Delete any unneeded jobs saved in the personal box.

Deleting Saved Jobs
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3352

Cause
The printer hard disk is full, so the job will only be printed.

(The print job will not be saved to the hard disk.)

What to Do
To save the print job, delete any unneeded jobs saved in the personal box.

Deleting Saved Jobs
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3414

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the address and port numbers of the sending mail server (SMTP server) are correct in the
Remote UI mail server settings.

Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3415

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the address and port numbers of the receiving mail server (POP3 server) are correct in the
Remote UI mail server settings.

Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3416

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the mail server and device secure connection (SSL) settings match.

Check the secure connection (SSL) settings in Remote UI.

Setting Mail Server

Contact the mail server administrator to configure a secure connection (SSL) to the mail server.
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3417

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the mail server and device secure connection (SSL) settings match.

Check the secure connection (SSL) settings in Remote UI.

Setting Mail Server

Contact the mail server administrator to configure a secure connection (SSL) to the mail server.
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3418

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the sending mail server (SMTP server) is correctly configured in the Remote UI mail server
settings.

Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3419

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the sending account and password are correctly configured in the Remote UI mail server
settings.

Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3420

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the receiving mail server (POP3 server) is correctly configured in the Remote UI mail server
settings.

Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3421

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the receiving account and password are correctly configured in the Remote UI mail server
settings.

Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3422

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check that the settings on the mail server and the APOP settings on this device match.

Check this device's APOP settings in Remote UI.

Setting Mail Server

Contact the mail server administrator for configuring APOP on the mail server.
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3423

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Check if the Remote UI mail server settings are correct.

Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
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3424

Cause
Sending mail failed.

What to Do
Tap OK on the touch screen to dismiss the error.

Specify the correct destination mail address and try again.
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3448

Cause
IP address is conflicting.

What to Do
Tap OK on the touch screen to dismiss the error.

Check the network configuration and change the network configuration to prevent a conflict with other
network devices.

For details on changing the network configuration, refer to the documentation for your network device.
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4107

Cause
Possible causes include the following.

• Received print job for Roll 1 (Upper) while Roll 2 (Lower) is in use.
• Received print job for Roll 2 (Lower) while Roll 1 (Upper) is in use.

What to Do
Tap OK on the touch screen to dismiss the error.

Remove the printed matter, and then try again.
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4111

Cause
The media type specified is incompatible with this device.

What to Do
Tap OK on the touch screen to dismiss the error.

Check the media type settings, and then try again.
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4112

Cause
Received a print job specifying paper feed from the roll unit, but the roll unit is not set to paper feed.

What to Do
To stop printing, tap OK on the touch screen or press the Stop button.

Check the roll unit settings, and then try again.

Switching Roll Unit Modes
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4113

Cause
Cannot print borderless for the following reasons.

• Printer driver is not set to Fit Roll Paper Width.
• Roll paper is not wide enough, or the paper is out of position.

What to Do

• Stopping printing

Tap Cancel on the touch screen.

• Replacing paper

Follow the steps below to replace the printer paper with paper that can be printed borderless.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)
Removing Rolls From the Roll Holder

2. Replace the printer paper with paper that can be printed borderless.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.
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4114

Cause
The paper position is not suitable for borderless printing.

What to Do

• Stopping printing

Tap Cancel on the touch screen.

• Replacing paper

Follow the steps below to replace the printer paper with paper that can be printed borderless.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)
Removing Rolls From the Roll Holder

2. Replace the printer paper with paper that can be printed borderless.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.

Note
• Because paper expands or contracts depending on the environment of use, it may become narrower

or wider than the supported width for borderless printing.

Use each media type under the appropriate usage conditions. See the media information list for
usage conditions.

Paper Information List
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4115

Cause
The paper in the printer cannot be printed borderless.

What to Do

• Stopping printing

Tap Cancel on the touch screen.

• Replacing paper

Follow the steps below to replace the printer paper with paper that can be printed borderless.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)
Removing Rolls From the Roll Holder

2. Replace the printer paper with paper that can be printed borderless.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.
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4116

Cause
The paper is loaded askew.

What to Do

• Reloading paper

Tap Replace the paper and print on the touch screen, and then load the paper so that the edges are
inside the borderless printing ink grooves.

Insert the roll paper firmly until it is against the roll holder flange.

Loading Rolls on the Roll Holder

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.

• Stopping printing

Tap Cancel on the touch screen to stop printing.

Note
• To force the printer to print, set Detect paper setting mismatch in the touch screen menu to Do not

detect.

However, note that this error may affect the printing quality.
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4117

Cause
The print job received specifies a type or width of paper that is not compatible with borderless printing.

What to Do

• Changing the print job settings

Follow these steps to change the settings of the print job to enable borderless printing.

1. Tap Cancel on the touch screen to stop printing.
2. Check that the printer driver for the printer has been selected, and then try again.

See the media information list for media types compatible with borderless printing.

Paper Information List

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.

Note
• To force the printer to print, set Detect paper setting mismatch in the touch screen menu to Do not

detect.

However, note that this error may affect the printing quality.
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4118

Cause
The paper size in the printer cannot be printed borderless.

What to Do

• Stopping printing

Tap Cancel on the touch screen to stop printing.

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.

Note
• See the media information list for media types compatible with borderless printing.

Paper Information List
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4119

Cause
Cannot print borderless because the paper is out of position.

What to Do

• Reloading paper

Lift up the release lever and reload the roll paper.

Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.

• Stopping printing

Tap Cancel on the touch screen to stop printing.
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4120

Cause
The print job received specifies a type or width of paper that is not compatible with borderless printing.

What to Do

• Changing the print job settings

Follow these steps to change the settings of the print job to enable borderless printing.

1. Tap Cancel on the touch screen to stop printing.
2. Check that the printer driver for the printer has been selected, and then try again.

See the media information list for media types compatible with borderless printing.

Paper Information List

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.

Note
• To force the printer to print, set Detect paper setting mismatch in the touch screen menu to Do not

detect.

However, note that this error may affect the printing quality.
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4121

Cause
Cannot print borderless for the following reasons.

• Fit Roll Paper Width is not specified in the printer driver.
• Roll paper is not wide enough, or the paper is out of position.

What to Do

• Stopping printing

Tap Cancel on the touch screen to stop printing.

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.
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4801

Cause
A printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC01-2F90 EC01-2F95 EC04-2F31 EC04-2F91 EC05-2F92 EC06-2F9A EC06-2F9B EC06-2F9C
EC07-2F19 EC0F-2F96 EC11-2F2A EC12-2F29 EC12-2F2B EC12-2F2C EC13-2F17 EC15-2E23
EC16-2021 EC16-2022 EC16-2027 EC16-202A EC16-2038 EC17-2023 EC17-2024 EC17-2028
EC17-2029 EC17-2039 EC1B-2030 EC1B-2031 EC1B-2032 EC1B-2033 EC1C-2034 EC1C-2035
EC1C-2036 EC1C-2037 EC21-2F51 EC21-2F54 EC21-2F57 EC21-2F59 EC21-2F61 EC21-2F67
EC21-2F70 EC21-2F71 EC21-2F72 EC22-2F30 EC22-2F47 EC23-260E EC23-2F11 EC23-2F18
EC23-2F32 EC25-2F16 EC31-2F09 EC31-2F10 EC31-2F1B EC31-2F1C EC31-2F1D EC31-2F1E
EC31-2F1F EC31-2F22 EC31-2F23 EC31-2F94 EC34-2602 EC34-2605 EC34-2F3B EC51-2F14
EC51-2F15 EC51-2FDE EC51-3301 EC51-3302 EC51-3303 EC54-290A EC55-2F20 EC55-2F6C
EC58-2F12
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4803

Cause
Printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC51-203C
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4804

Cause
Printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC17-203D
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4805

Cause
Printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC1D-2050
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4806

Cause
Printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC1E-2053
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4900

Cause
The printer hard disk is full.

What to Do
Press the Stop button to stop printing, and then take the following action.

• Cancel the print job in the job queue.

Managing Job Queue (Deleting or Preempting Other Jobs)

• Delete unneeded jobs stored in personal boxes.

Deleting Saved Jobs
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4901

Cause
The printer hard disk has not been formatted.

What to Do
Tap OK on the touch screen to begin formatting the hard disk.

When formatting is complete, the data on the hard disc will be erased and the printer will automatically
restart.
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4903

Cause
The maximum number of jobs have been saved in the box.

What to Do
Take the actions below.

• Cancel the print job in the job queue.

Managing Job Queue (Deleting or Preempting Other Jobs)

• Delete unneeded jobs stored in personal boxes.

Deleting Saved Jobs

Note
• To stop printing, press the Stop button.
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4905

Cause
A printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC51-3304 EC51-3306 EC51-3307 EC51-3308 EC51-3309 EC51-330A
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4909

Cause
Printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC54-290C
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4910

Cause
The width of the roll paper set in Fit Roll Paper Width in the printer driver is not the same as the width of
the roll paper loaded in the printer.

What to Do
Tap OK on the touch screen to go to the next screen.

Check the media type and size that appear and tap OK.

• Printing without changes

Tap Print with the loaded paper..

However, note that this error may cause paper jams and affect the printing quality.

• Stopping printing

Tap Cancel on the touch screen or press the Stop button.

• Replacing the roll paper

Follow the steps below to replace the paper with roll paper of the width set in the printer driver.

1. Tap Replace the paper and print, then remove the roll paper.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)
Removing Rolls From the Roll Holder

2. Replace the paper with paper of the width set in the printer driver.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

Printing begins.

Note
• To change print settings in Windows, select Fit Roll Paper Width in the printer driver and set the roll

paper width in the dialog box that appears.
• To change print settings in macOS, open the printer driver and select Fit Roll Paper Width, and then

set the roll paper width in that panel to the width of the paper loaded in the printer.
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4911

Cause
The media type specified in the printer driver is not the same as the media type loaded in the printer.

What to Do

• Changing the printer driver print settings

Follow the steps below to match the media type in the printer driver and the media type specified for
the printer.

1. Tap Cancel on the touch screen to stop printing.
2. Change the media type in the printer driver settings to the media type loaded in the printer, and

then try again.

• Replacing paper

Follow the steps below to match the media type in the printer driver and the media type specified for
the printer.

1. Tap Cancel on the touch screen to stop printing.
2. Load the paper with the media type set in the printer driver, and then try again.

Loading and Printing on Rolls
Loading and Printing on Sheets

• Printing without changes

To continue printing, tap Print with the loaded paper. on the touch screen.

However, note that this error may cause paper jams and affect the printing quality.
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4913

Cause
Cannot print borderless for one of the following reasons.

• The paper size in the printer cannot be printed borderless.
• The paper is loaded askew.

What to Do

• Replacing paper

Follow the steps below to replace the printer paper with paper that can be printed borderless.

1. Tap Replace the paper and print on the touch screen, then remove the roll paper.

Removing the Upper Roll from the Printer
Removing the Lower Roll from the Roll Unit (Option)
Removing Rolls From the Roll Holder

2. Replace the printer paper with paper that can be printed borderless.

Loading Rolls on the Roll Holder
Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

Printing begins.

Note
See the media information list for media types compatible with borderless printing.

Paper Information List

• Reloading paper

Tap Replace the paper and print on the touch screen, and then load the paper so that the edges are
inside the borderless printing ink grooves.

Insert the roll paper firmly until it is against the roll holder flange.

Loading Rolls on the Roll Holder

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.

• Stopping printing

Tap Cancel on the touch screen to stop printing.
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4920

Cause
Cannot cut paper for one of the following reasons.

• Paper that has been cut remains on the output guide.
• There is a foreign object near the output slot that is obstructing the cutter blade.
• The paper is not being used under the recommended usage conditions.
• The paper in use cannot be used with Automatic cut.

What to Do

• Paper that has been cut remains on the output guide

Follow the steps below to resume printing.

1. Lift up the release lever and remove the paper.
2. Load the paper.
3. Lower the release lever.
4. If "There is a job whose printing is not complete. Do you want to print this job?" appears on

the touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

Loading the Upper Roll on the Printer
Loading the Lower Roll on the Roll Unit (Option)

• A foreign object near the output slot is obstructing the cutter blade

Follow the steps below to resume printing.

1. Open the top cover and remove any foreign objects.
2. If "There is a job whose printing is not complete. Do you want to print this job?" appears on

the touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

• Paper not being used under the recommended usage conditions

Every paper type has different recommended conditions of use. Use all paper under its recommended
usage conditions.

See the media information list for recommended usage conditions.

Paper Information List

• The paper in use cannot be used with Automatic cut

Set the roll paper cutting method to User cut and cut the roll paper with a cutting implement such as
scissors.

Specifying the Cutting Method for Rolls

See the media information list for paper types that can be used with Automatic cut.

Paper Information List

If this does not apply, there may be a cutter blade malfunction.
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Contact your Canon dealer for assistance.
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4922

Cause
The Media Take-up Unit cannot roll the paper for one of the following reasons.

• A paper jam has occurred and the roll cannot be rewound.
• The Media Take-up Unit malfunctioned.

What to Do

• The take-up unit's permitted capacity is exceeded

Remove paper from the take-up unit.

Tap OK on the touch screen to dismiss the error.

Note
• You can wind the paper until the outer diameter of the wound paper is the same as the outer

diameter of the paper core.

• Paper is jammed or could not be rolled

Remove the paper from the Media Take-up Unit.

Tap OK on the touch screen to dismiss the error.

Note
• When printing on lightweight paper or without a border, the border of the paper may get wrinkled

coming in contact with the roll holder, resulting in poor winding. If these problems occur when
winding using a 2-inch core, remove the spacer held in place by 4 hex screws on the roll holder
flange, and then wind.

• Media Take-up Unit malfunction

Contact your Canon dealer for assistance.

Important
• Printing will pause if there is a Media Take-up Unit error. If you do not want to printing to stop, set

Skip errors during take-up to ON. However, note that this error may cause paper jams and affect
the printing quality.
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4931

Cause
Paper feed adjustment may have failed for the following reasons.

• The paper for printing a test pattern is soiled. Otherwise, you have loaded colored paper.
• The printer may be exposed to strong light, such as direct sunlight, which can cause the sensors to

malfunction.
• The test pattern was printed too faintly.

What to Do
Tap OK on the touch screen to dismiss the error, and then take the following actions.

• Load unused paper.
• Make adjustments to ensure that the printer is not exposed to strong light.
• Print a nozzle check pattern to check the print head status.

If the pattern has gaps or horizontal white lines, the print head nozzle is blocked. Clean the print head.

Checking for Nozzle Clogging
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4932

Cause
The print head cannot be calibrated because the printer is loaded with very transparent film-type paper.

What to Do
Tap OK on the touch screen to dismiss the error.

We recommend calibrating the print head with a frequently used, non-film paper.

Automatic Adjustment to Straighten Lines and Colors
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4933

Cause
The print head nozzle may be blocked.

What to Do
Follow the steps below to repeat Print head alignment.

1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.

Checking for Nozzle Clogging

3. If the nozzle is blocked, clean the print head.

Cleaning the Print Head

4. Repeat Print head alignment.

Automatic Adjustment to Straighten Lines and Colors
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4934

Cause
The print head nozzle may be blocked.

What to Do
Follow the steps below to repeat Print head alignment.

1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.

Checking for Nozzle Clogging

3. If the nozzle is blocked, clean the print head.

Cleaning the Print Head

4. Repeat Print head alignment.

Automatic Adjustment to Straighten Lines and Colors
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4935

Cause
The print head nozzle may be blocked.

What to Do
Follow the steps below to repeat Print head alignment.

1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.

Checking for Nozzle Clogging

3. If the nozzle is blocked, clean the print head.

Cleaning the Print Head

4. Repeat Print head alignment.

Automatic Adjustment to Straighten Lines and Colors
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4937

Cause
Print head position adjustment failed.

What to Do
Tap OK on the touch screen to dismiss the error and retry Print head alignment following the steps
below.

1. Print a test pattern to check the nozzles.

Checking for Nozzle Clogging

2. If the nozzle is blocked, clean the print head.

Cleaning the Print Head

3. Retry Print head alignment.

Automatic Adjustment to Straighten Lines and Colors

If any print head nozzles are still blocked, replace the print head.

Replacing the Print Head

If the error appears again, the printer may be damaged. Contact a Canon customer service center.
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4950

Cause
WPS (Push button method) connection failed.

What to Do
Follow the instructions on the touch screen to try connecting to the wireless LAN router again.
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4952

Cause
Failed to connect to the wireless LAN router.

What to Do
Follow the instructions on the touch screen to try connecting to the wireless LAN router again.
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4953

Cause
Failed to acquire IP address.

What to Do
Check the information that appears on the touch screen, and then try connecting again.
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4954

Cause
Failed to set up wireless LAN using Easy wireless connect.

What to Do
Tap OK on the touch screen to dismiss the error, and then configure the settings again.
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4955

Cause
IPv4/IPv6 settings were changed, but wired LAN and wireless LAN are disabled.

What to Do
Tap OK on the touch screen to dismiss the error, and then enable wired LAN or wireless LAN.
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4956

Cause
Attempted to change LAN settings, but they cannot be changed for the following reasons.

• Printer is operating
• Printer currently being configured using Remote UI

What to Do
Tap OK on the touch screen to dismiss the error, exit other processes and then configure the settings
again.
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5106

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC03-4061
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5200

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC21-2F7E
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5A60

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC33-4020 EC33-4021 EC33-4022 EC33-4023 EC33-4026
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5A61

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC3F-4120 EC3F-4121 EC3F-4122 EC3F-4123 EC3F-4126
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5B16

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC22-4001
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5B20

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC25-4001 EC41-4001 EC43-4001 EC44-4001 EC47-4001
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5B21

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC48-4001
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5C00

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC31-4001
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6502

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC56-2FE0
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6700

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC57-404F
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6702

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC57-4040
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6820

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC07-4060 EC51-4041 EC51-4042 EC51-4045 EC51-4046 EC51-4047 EC51-404C EC51-404D
EC51-404E EC51-4070 EC51-4071 EC51-4072

1103



6900

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3000
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6901

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3001
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6902

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3006
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6910

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3002
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6911

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3003
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6920

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3004
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6921

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3005
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6930

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3100

1111



6931

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3101
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6932

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3102
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6933

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3103
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6940

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3104
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6941

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3105
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6942

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3106
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6943

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3107
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6944

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3108
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6945

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3109
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6946

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.

Wait at least 10 seconds, and then turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch
screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3110
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7001

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC54-401A
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7003

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC54-405A
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7004

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC54-405B
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7005

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC54-4080
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7006

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC54-4081
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7050

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC51-5001
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7051

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC51-5002
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7052

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC51-5003
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8200

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC24-4049 EC24-404A EC24-404B
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9000

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC51-2F07
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9110

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC52-4038 EC52-4039
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B20A

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC03-403A
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B510

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off
the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes
EC32-4001
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